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CHAPTER1

课程介绍

1.1 序言

欢迎来到我们的课程！我们将向您展示如何轻松有效地使用 QGIS。如果是地理信息系统新手，将告诉您
需要如何开始学习；如果是一位有经验的用户，您会看到 QGIS如何实现期望的 GIS程序的所有功能！

1.1.1 为什么选择 QGIS？

随着信息变得越来越具有空间意识，并不缺乏能够实现部分或所有常用 GIS功能的工具，但为什么有人
要使用 QGIS而不是其他 GIS软件包呢？
以下是其中的几个主要原因：

• 她就像免费的午餐。安装和使用 QGIS程序共消费零元。是的，您没听错，使用 QIGS没有初始安
装费，没有日常维护费，什么都没有。

• 她就像自由的女神。如果需要 QGIS的扩展功能，您可以做的不仅仅是希望它能出现在下一个版本，
也可以赞助某个功能的开发。如果您熟悉编程语言，尝试自己添加也是一个好方法。

• 她不断发展壮大。因为任何人都可以添加新功能并对现有功能不断完善，所以 QGIS永远不会停滞
不前。新工具的开发可以根据需要尽快进行。

• 她提供了大量帮助和文档。如果遇到问题，可以求助于数量庞大的文档，与您一起使用 QGIS的同
伴，甚至是开发者。

• Cross-platform. QGIS can be installed on macOS, Windows and Linux.
既然知道了为什么要使用 QGIS，培训手册中的练习将让您了解如何运用该软件。
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1.1.2 背景

2008年，我们推出了 GIS入门指南，这是完全免费、开放的内容资源，面向希望了解地理信息系统而又
不被行话和新术语所困扰的人。是由南非政府赞助并取得了惊人的成绩，全世界的人们纷纷写信给我们，
告诉我们他们是如何使用这些材料来举办大学的培训课程，自学地理信息系统等。入门指南并非软件教
程，而是供人员学习 GIS的通用文本 (尽管我们在所有示例中都使用了 QGIS)。还有 QGIS手册，其中提
供了 QGIS应用程序的详细功能概述。然而，它并不是教程，而是参考指南。在 Linfiniti Consulting CC我
们经常举办培训课程，并意识到需要第三种资源 -以导师-培训生的形式引导读者循序渐进学习 QGIS的
关键方面 -这促使我们完成此项工作。
本培训手册旨在提供 QGIS、PostgreSQL和 PostGIS的 5天课程所需的全部材料。本课程的内容结构适合
入门、中级和高级用户，并有许多练习，包括全文的注释答案。

1.1.3 许可证

Linfiniti Consulting CC.提供的免费 Quantum GIS培训手册，是基于 Linfiniti和 Creative Commons Attribution
4.0 International许可下的早期版本。超出本许可范围的权限可在如下获得。
我们以自由许可的方式发布了本 QGIS培训手册，允许您自由复制、修改和重新发布本作品。本文档结
尾提供了许可证的完整副本。简单来说，使用指南如下：

• 您不得将本著作视为自己的作品，也不得从本著作中移除任何原创作者文本或名单。
• 您不能在比提供给您的权限更严格的权限下重新分发此作品。
• 如果您在作品中添加了实质性的章节，并将其回馈给项目 (至少一个完整的单元)，您可以将您的姓
名添加到本文档作者列表的末尾 (将出现在首页)

• 如果您对作品进行了较小的更改和更正，可以将自己的姓名添加到下面的贡献者列表中。
• 如果您翻译了本文档的全部内容，可以将您的姓名以”Translated by Joe Bloggs”的形式添加到作者列
表。

• 如果您赞助了某单元或课，可以要求作者在所贡献的每课的开头包含一个致谢，例如：

备注: 本课由MegaCorp赞助。

• 如果您不确定根据本许可可以做些什么，请通过 office@linfiniti.com邮箱联系我们；如果您计划所
做的工作是可以接受的，我们会通知您。

• 如果您在 https://www.lulu.com等自发布网站下发布此作品，我们要求您将利润捐赠给 QGIS项目。
• 除非获得作者的明确许可，否则不得将本作品商业化。需要指出的是，商业化是指不得以盈利为目
的而销售，也不得创造商业衍生作品 (例如，销售内容作为杂志文章使用)。例外情况是，如果所有
的收益都捐给了 QGIS项目。在进行培训课程时，即使课程本身具有商业性质，您也可以将本手册
用作教科书 (我们鼓励您这样做)。换句话说，您可以通过举办培训课程来赚钱，并将这本书作为教
科书使用，但您不可以从书籍本身的销售中获利 -所有这些利润都应该回馈给 QGIS。

4 Chapter 1. 课程介绍
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1.1.4 赞助章节

此项工作绝不是 QGIS所能做的所有工作的完整论述，我们鼓励其他人添加内容来填补空白。Linfiniti
Consulting CC.还可以为您创建其他内容提供商业服务，并理解所有此类作品都应成为核心内容的一部
分，并在同一许可下发布。

1.1.5 作者

• Rüdiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.
• Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts. Tim also authored the custom sphinx theme used for this manual.

• Horst Düster (horst.duester@kappasys.ch ) -霍斯特与人合著了 PostgreSQL和 PostGIS部分章节
• Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 单独贡献者

您的名字在这里！

1.1.7 赞助商

• Cape Peninsula University of Technology

1.1.8 源文件和问题报告

本文档的源代码可从 GitHub QGIS 文档库 获取。有关如何使用 git 版本控制系统的说明，请咨询
GitHub.com。
尽管我们非常努力，但您在学习使用本培训手册时仍然可能会发现一些错误或遗漏一些信息。请在
https://github.com/qgis/QGIS-Documentation/issues报告。

1.1.9 最新版

通过访问 QGIS文档网站的在线版本，您始终可以获得本文档的最新版本 (https://docs.qgis.org)。

备注: 该文档网站包含指向培训手册以及 QGIS文档其他部分在线版和 PDF版的链接。

1.2 关于练习

既然知道了为什么要使用 QGIS，我们可以向您展示如何使用。

警告: 本课程包括添加、删除和更改 GIS数据集的说明，为此，我们提供了培训数据集。在对您自己
的数据使用本文介绍的技术之前，请务必确保已进行备份！

1.2. 关于练习 5
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1.2.1 如何使用本教程

任何看起来像这样的文本都是在 QGIS用户界面中可以看到的内容。
看起来 ►类似 ►这样的文本会引导您浏览菜单。
这种文本指的是可以输入的内容，例如命令。

This/kind/of.text指的是路径或文件名。

This+That指的是由两个按钮组成的键盘快捷键。

1.2.2 层级式课程目标

本课程适合不同层级的用户体验。根据您自认为的类别，可以选择适合自己的课程。每个类别都包含对
下一个类别至关重要的信息，因此进行所有等于或低于您的经验水平的练习非常重要。

初级

此类别中，本课程假设您之前很少或根本没有 GIS理论知识或 GIS软件操作经验。
我们将提供有限的理论知识来解释您将在程序中执行的操作意图，但重点是在实践中学习。

完成课程后，您将对 GIS的认识以及如何通过 QGIS发挥其力量有了更清晰的概念。

中级

在此类别中，假设您具有 GIS软件日常使用的工作知识和经验。
以初学者的指导为基础，将为您提供常见的专业基础知识，并让您了解 QGIS与您可能使用的其他软件
的异同。您还将学习如何在 QGIS中使用分析功能。
完成本课程后，您应该能够熟练使用 QGIS完成日常使用所需的所有功能。

高级

在此类别中，假设您有使用 GIS软件的经验，了解空间数据库相关知识，在远程服务器使用过数据，可
能为分析目的而编写过脚本等等。

基于其他两个级别介绍的基础上，您将熟悉 QGIS接口应遵循的方法，并确保您知道如何访问所需的基
本功能。还将向您展示如何使用 QGIS插件系统、数据库访问等知识。
完成本课程后，您应该熟悉 QGIS的日常操作，以及其更高级的功能。

1.2.3 数据

本培训手册附带的示例数据免费提供，并来源于以下提供方：

• 来自开放街道地图的街道和放置数据集 (https://www.openstreetmap.org/)
• Property boundaries (urban and rural), water bodies from NGI (https://ngi.dalrrd.gov.za/)
• 来自 CGIAR-CGI的 SRTM DEM (http://srtm.csi.cgiar.org/)

从培训数据存储库下载预备的数据集并解压文件。exercise_data文件夹提供了所有必要的数据。

如果您是教师，并且希望使用更多相关数据，您可以在准备练习数据附录中找到创建本地数据的说明。

6 Chapter 1. 课程介绍
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CHAPTER2

单元: 创建和探索基本地图

在本单元，您将创建一个用作演示 QGIS基础功能的基本地图。

2.1 课: 界面概述

我们先探索 QGIS用户界面，便于您熟悉构成界面基本构造的菜单、工具栏、地图画布和图层列表。
本课目标: 了解 QGIS用户界面的基本要素。

2.1.1 试一试: 基本要素

7
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上图中标识的要素是：

1. 图层列表 /浏览器面板
2. 工具栏
3. 地图画布
4. 状态栏
5. 侧工具栏
6. 搜索栏

图层列表

在图层列表，您可以随时查看所有可用图层的列表。

展开折叠项 (通过单击它们旁边的箭头或加号)，将为您提供有关图层当前外观的更多信息。
将鼠标悬停在图层名称行时将为您提供一些基本信息：图层名、几何图形类型、坐标参照系以及设备中
位置的完整路径。

右键点击图层将为您提供一个包含许多选项的菜单，您很快就会用到其中的一部分，请浏览并熟悉一下
该菜单所包含的条目！

备注: 矢量图层是一个数据集，通常是特定类型的对象，如道路、树木等。矢量图层可以由点、线或多
边形组成。

浏览器面板

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or MapInfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WFS connections. You can also view your GRASS data.

如果您已保存工程，浏览器面板还将允许快速访问 工程主目录下工程文件同一路径中储存的所有图
层。

此外，您可以将一个或多个文件夹设置为收藏夹: 在您的路径下搜索，找到文件夹后，右键单击该文件
夹，然后单击添加到收藏夹。之后，应该能够在 收藏夹项中看到您的文件夹。

小技巧: 添加到收藏夹项的文件夹可能有一个很长的名称：不用担心，右键单击路径，然后选择重命名
收藏条目...换个名字。

工具栏

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar
allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools
you use most often, adding or removing toolbars as necessary via the View ► Toolbars menu.
Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

8 Chapter 2. 单元: 创建和探索基本地图
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地图画布

这是显示地图和图层加载的区域。在地图画布中，您可以与可见图层进行交互：放大/缩小、移动地图、
选择要素，以及我们将在接下来的部分深入了解的其他操作。

状态栏

显示关于当前地图的信息。还允许您调整地图比例、地图旋转，并在地图上查看鼠标光标的坐标。

侧工具栏

默认情况下，侧工具栏包含加载图层的按钮和创建新图层的所有按钮。但是请记住，您可以把所有的工
具栏移动到您觉得更舒服的地方。

搜索栏

在此栏中，您可以访问几乎所有 QGIS的对象：图层、图层属性、算法、空间书签等。请检查 QGIS用户
手册 locator_options部分中的所有不同选项。

小技巧: 使用快捷键 Ctrl+K，您可以轻松访问该栏目。

2.1.2 试一试 1

尝试在自己的屏幕上识别上面列出的四个元素，不要参考上面的图示，看看您是否能识别出他们的名称
和功能。在接下来的几天里，您将使用并逐步了解这些元素。

回答

参考返回显示界面布局的图像，检查是否记住了屏幕元素的名称和功能。

2.1.3 试一试 2

尝试在屏幕上找到这些工具中的每一个，了解他们的作用是什么？

1.

2.

3.

4. 渲染

5.

备注: 如果这些工具中的某一个在屏幕上不可见，请尝试开启一些当前隐藏的工具栏。还要记住，如果
屏幕上没有足够的空间，工具栏可能会因为隐藏一些工具而缩短。通过单击此类折叠工具栏中的右双箭
头按钮，可以看到隐藏的工具。将鼠标在工具上停留一段时间，可以看到带有工具名称的工具提示。

回答

2.1. 课: 界面概述 9
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1. 另存为
2. 缩放到图层范围
3. 反选
4. 渲染开/关

5. 测量线

2.1.4 What’s Next?

现在，您已经熟悉了 QGIS界面的基本要素。下一课，我们将了解如何加载一些常见的数据类型。

2.2 课: 添加首个图层

我们将启动应用程序，并创建一个用于示例和练习的基本地图。

本课目标: 从示例地图开始。

备注: 在开始本练习之前，必须在计算机上安装 QGIS。此外，您还应该下载了示例数据供使用。

从桌面快捷方式、菜单项等启动 QGIS，具体取决于您如何配置其安装的方式。

备注: 本课程的截图是在 Linux运行的 QGIS 3.4中获取的。根据您的设置，遇到的屏幕可能会有所不同。
然而，所有相同的按钮仍将可用，并且说明适用于任何操作系统。使用本课程需要 QGIS 3.4 (撰写本文时
的最新版本)。

让我们马上开始吧！

10 Chapter 2. 单元: 创建和探索基本地图
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2.2.1 跟我做: 准备地图

1. 打开 QGIS，您会拥有一张新的空白地图。

2. 数据源管理器对话框允许您根据数据类型选择要加载的数据，我们将使用它加载数据集：单击
打开数据源管理器按钮。

如果找不到该图标，请检查视图 ►工具栏菜单中的数据源管理器工具栏是否已启用。

3. 加载 protected_areas.shp矢量数据集：

1. 单击矢量选项卡。

2.2. 课: 添加首个图层 11
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2. 启用 文件源类型。

3. 按矢量数据集旁边的 ... 按钮。

4. 选择 exercise_data/shapefile/protected_areas.shp培训目录中的文件。

5. 单击打开。您将看到初始对话框，其中填写了文件路径。

6. 单击此处的 添加按钮。现在将加载您指定的数据：可以在 图层面板 (左下方) 中看到
protected_areas项，其要素显示在主地图画布中。

12 Chapter 2. 单元: 创建和探索基本地图
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恭喜！您现在有了一个基本地图。此时正是保存工作的好时机。

1. 单击另存为按钮:
2. 将地图保存在 exercise_data旁边的 solution文件夹中，并命名为 basic_map.qgz。

2.2.2 Try Yourself

重复上述步骤，将同一文件夹 (exercise_data/shapefile)中的 places.shp和 rivers.shp图
层添加到地图。

回答

在对话框的主要区域，应该会看到许多不同颜色的形状。每个形状都属于一个图层，可以通过左侧面板
中的颜色来识别 (您的颜色可能与图 2.1中的颜色不同)：

2.2. 课: 添加首个图层 13
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图 2.1: 基本地图

2.2.3 跟我做: 从 GeoPackage数据库加载矢量数据

数据库允许在一个文件中储存大量相关数据。您可能已经熟悉数据库管理系统 (DBMS)，如 Libreoffice
Base或MS Access。GIS应用程序也可以使用数据库。特定于 GIS的 DBMS (如 PostGIS)具有扩展的功能，
因为它们需要处理空间数据。

GeoPackage开放格式是一个容器，允许您在单个文件中储存 GIS数据 (图层)。与 ESRI Shapefile格式 (例
如，您之前加载的 protected_areas.shp数据集)不同，单个 GeoPackage文件可以包含不同坐标参
照系的各种数据 (矢量和栅格数据)，以及不包含空间信息的表格。所有这些功能都允许您轻松共享数据
并避免文件重复。

为了从 GeoPackage加载图层，首先需要创建与该图层的连接：

1. 单击 打开数据源管理器 按钮。

2. 在左侧单击 GeoPackage选项卡。

3. 单击新建按钮，浏览到您之前下载的 exercise_data文件夹中的 training_data.gpkg文件。

4. 选择文件并按打开按钮，文件路径现在已添加到 Geopackage连接列表，并显示在下拉菜单中。
现在，您可以将此 GeoPackage中的任何图层添加到 QGIS。

1. 单击连接按钮。在窗口的中心部分，您现在应该可以看到 GeoPackage文件中包含的所有图层的列
表。

2. 选择 roads图层并单击添加按钮。

14 Chapter 2. 单元: 创建和探索基本地图
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roads图层被添加到图层面板，其中的要素显示在地图画布。

3. 单击关闭。
恭喜！您已经从 GeoPackage加载了首个图层。

2.2.4 跟我做: 使用浏览器从 SpatiaLite数据库加载矢量数据

QGIS提供了对许多其他数据库格式的访问。与 GeoPackage一样，SpatiaLite数据库格式也是 SQLite库的
扩展。从 SpatiaLite提供程序添加图层时，遵循与上述相同的规则：创建连接 -->启用 -->添加图层。
虽然这是 SpatiaLite数据添加到地图的一种方法，但并不妨碍我们探索另一种添加数据的强大方法: 浏览
器。

1. 单击 图标打开数据源管理器窗口。

2. 单击 浏览器选项卡。

3. 在此选项卡，您可以看见连接到计算机的所有存储磁盘，以及左侧大多数选项卡的条目。它们允许
快速访问连接的数据库或文件夹。

例如，单击 GeoPackage 条目旁边的下拉图标，您将看到我们之前连接的 training-data.
gpkg文件 (及其图层 -如果展开的话)。

4. 右键单击 SpatiaLite条目并选择新建连接... 。

5. 导航至 exercise_data文件夹，选择 landuse.sqlite文件，然后单击打开。

请注意，已在 SpatiaLite下添加了 landuse.sqlite条目。

6. 展开 landuse.sqlite条目。

7. 双击 landuse图层，或选择并将其拖放到地图画布。一个新图层添加到图层面板，其要素在地
图画布显示。

2.2. 课: 添加首个图层 15
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小技巧: 在视图 ►面板 ►中启用浏览器面板，并使用它添加数据。这是数据源管理器 ►浏览器选项
卡的便捷快捷方式，并具有相同的功能。

备注: 一定要经常保存您的工程哦！工程文件本身不包含任何数据，但它会记住您加载到地图中的图层。

2.2.5 试一试加载更多矢量数据

请使用上述任意方法将以下数据集从 exercise_data文件夹加载到地图：

• buildings

• water

回答

您的地图应该有七个图层：

• protected_areas

• places

• rivers

• roads

• landuse

16 Chapter 2. 单元: 创建和探索基本地图
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• buildings (从 training_data.gpkg获取)和
• water (从 exercise_data/shapefile获取)。

2.2.6 跟我做: 重新排列图层

图层列表中的图层在地图上按特定顺序绘制。首先绘制列表底部的图层，最后绘制顶部的图层。通过更
改它们在列表中的显示顺序，可以更改绘制顺序。

备注: 可以使用图层顺序面板下的控制渲染顺序复选框更改此行为。但是，我们暂时不会讨论此功能。

在这个阶段，图层加载到地图中的顺序可能不符合逻辑。road图层可能完全隐藏，因为其他图层位于其
上面。

例如，这个图层顺序...

... 将导致 roads和 places在 landuse图层的多边形下面运行时被隐藏。
要解决此问题，请执行以下操作：

1. 单击并拖动图层列表中的图层。
2. 将其重新排序，如下所示：

您会看到，现在的地图在视觉上更有意义，roads和 buildings出现在 landuse区域的上方。

2.2. 课: 添加首个图层 17
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2.2.7 In Conclusion

现在，您已经从几个不同的源添加了所需的所有图层，并创建了一个基本地图！

2.2.8 What’s Next?

现在您已经熟悉了打开数据源管理器按钮的基本功能，但是其他方面呢？这个界面是如何工作的？在继
续之前，让我们先来了解一下与 QGIS界面的一些基本交互操作。这是下一课的主题。

2.3 课: 地图画布导航

本节将重点介绍用于在地图画布中导航的基本 QGIS导航工具，这些工具允许您直观地浏览不同比例的
图层。

本课目标: 学习如何在 QGIS中使用平移和缩放工具，并了解地图比例。

2.3.1 跟我做: 基本导航工具

学习如何在地图画布中导航之前，让我们添加一些可以在本教程中使用的图层。

1. 打开一个新的空白工程，并使用在创建地图中学习的步骤，将之前看到的 protected_areas,
roads和 buildings图层加载到该工程中。最终视图应类似于图 2.2中的样式 (颜色无关紧要)：

18 Chapter 2. 单元: 创建和探索基本地图
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图 2.2: 添加 Protected areas、roads和 buildings图层

先来学习如何使用平移工具。

1. 在地图导航工具栏中，确保已激活 平移 按钮。

2. 将鼠标移动到地图画布区的中心。
3. 左键单击并按住，然后向任意方向拖动鼠标以平移地图。

接下来，放大并仔细查看我们导入的图层。

1. 在地图导航工具栏中，单击 放大 按钮。

2. 将鼠标移动到 buildings和 roads密度最高的左上角区域。
3. 左键单击并按住。
4. 然后拖动鼠标，将创建一个矩形，并覆盖 buildings和 roads的密集区域 (图 2.3)。
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图 2.3: 放大

5. 松开左键，这将放大以包括您用矩形选择的区域。
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6. 要缩小，请选择 缩小 按钮，并执行与放大相同的操作。

在平移、放大或缩小时，QGIS会将这些视图保存在历史记录中。这允许您返回到以前的视图。

1. 在地图导航工具栏，单击 回到上一视图按钮将转到上一视图。

2. 单击 下一视图 按钮继续在历史记录中向前浏览。

有时在浏览数据之后，我们需要将视图重置为所有图层的范围。QGIS没有尝试多次使用缩小工具，而是
为我们提供了一个按钮来执行该操作。

1. 单击 全图显示范围 按钮。

放大和缩小时，请注意状态栏中的比例值会发生变化。比例值表示地图比例。通常，右边的数字 : 表示
您在地图画布中看到的对象比现实世界中的实际对象小多少倍。
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也可以使用此字段手动设置地图比例。

1. 在状态栏，单击比例文本字段。
2. 输入 50000并按 Enter键。这将在地图画布重新绘制要素，以反映您输入的比例。

3. 或者，单击比例字段的选项箭头以查看预设的地图比例。

4. 选择 1:5000，这也将更新地图画布中的地图比例。

现在您了解了在地图画布进行导航的基础知识。查看有关缩放和平移的用户手册，了解导航地图画布的
其他方法。

2.3.2 In Conclusion

了解如何在地图画布导航很重要，因为它允许人们探索并直观地检查图层。这可以用于初始数据探索，
或者验证空间分析的输出。

2.4 课: 符号化

图层的符号是其在地图上的视觉外观。与其他用空间方面表示数据的方法相比，使用 GIS，您可以对正
在使用的数据进行动态可视化表示。

因此，地图的视觉外观 (取决于各个图层的符号)非常重要，您制作的地图的最终用户需要能够轻松查看
地图所代表的内容。同样重要的是，您需要在使用数据的同时对其进行探索，而优质的符号非常有用。

换句话说，使用合适的符号并不是一种奢侈，也不是一种享受。事实上，正确使用 GIS并制作其他人能
够使用的地图和信息对您来说至关重要。

本课目标: 能够为任何矢量图层创建任何符号。
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2.4.1 跟我做: 改变颜色

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the landuse layer.
1. Right-click on the landuse layer in the layers list.
2. 在出现的菜单中选择菜单项属性... 。

备注: 默认情况下，也可以通过双击图层列表中的图层来访问图层的属性。

小技巧: 图层面板顶部的 按钮将打开图层样式面板。可以使用此面板更改图层的某些属性：
默认情况下，将立即应用更改！

3. 在图层属性窗口，选择 符号化选项卡：

4. 单击颜色标注旁边的颜色选择按钮，将出现标准颜色对话框。
5. 选择灰色，然后单击确定。
6. 在图层属性窗口再次单击确定，您将看到颜色更改已应用于图层。
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2.4.2 Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

解答

• 检验颜色是否按照您预期的方式变化。

• It is enough to select the water layer in the legend and then click on the Open the Layer Styling panel button.
Change the color to one that fits the water layer.

如果一次只想处理一个图层，且不希望其他图层分散您的注意力，可以通过单击图层列表中图层名称旁
边的复选框来隐藏图层。如果该框为空白，此图层被隐藏。

2.4.3 跟我做: 更改符号构造

到目前为止，已经非常好，但图层的符号化不仅仅是颜色。接下来，我们希望消除不同土地利用区域之
间的界线，以便减少地图在视觉上的杂乱。

1. Open the Layer Properties window for the landuse layer.

在 符号化选项卡下，将看到与之前相同类型的对话框。然而，这一次，您所做的不仅仅是快
速更改颜色。

2. 在符号图层类型中，展开填充下拉列表并选择简单填充选项。
3. 单击描边样式下拉列表。目前，应该显示一条短线和实线字样。
4. 将此更改为无描边。
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5. 单击确定。
Now the landuse layer won’t have any lines between areas.

2.4.4 Try Yourself

• Change the water layer’s symbology again so that it has a darker blue outline.
• Change the rivers layer’s symbology to a sensible representation of waterways.

记住：您可以使用 打开图层样式面板按钮，立即查看所有更改。该面板还允许您在对图层进行符号化时
撤消单个更改。

回答

您的地图现在应该如下所示：
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如果您是初级用户，可以到此为止。

• 使用上述方法更改所有剩余图层的颜色和样式。
• 请尝试使用自然颜色来描绘对象。例如，道路不应该是红色或蓝色，但可以是灰色或黑色。
• 也可以随意尝试多边形不同的填充样式和描边样式设置。
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2.4.5 跟我做: 基于比例的可见性

有时，您会发现某个图层不适合给定的比例。例如，所有大陆数据集的细节可能都很低，在街道层面上
也不是很准确。当这种情况发生时，您希望能够隐藏不恰当比例的数据集。

在此示例，我们可能会决定在小比例内隐藏建筑物，例如这张地图...

... 不是很有用。在这种比例下，建筑物很难区分。
要启用基于比例的渲染，请执行以下操作：

1. Open the Layer Properties dialog for the buildings layer.

2. 激活 渲染选项卡。

3. 通过单击标注为依赖可见比例的复选框，启用基于比例的渲染：
4. 将最小比例更改为 1:10000。
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5. 单击确定。
Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

备注: 可以使用鼠标滚轮放大增量。或者，使用缩放工具缩放到窗口：

2.4.6 跟我做: 添加符号图层

现在您已经知道如何更改图层的简单符号，下一步是创建更复杂的符号。QGIS允许您使用符号图层来执
行此操作。

1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).
在本例中，当前符号没有轮廓 (即，它使用无描边边框样式)。
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2. 在树中选择填充级别，然后单击 添加符号图层 按钮。对话框将更改为如下所示，并添加了一个新
的符号图层：
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例如，它的颜色可能会有些不同，但无论如何您都会进行修改。

现在有了第二个符号图层。作为单色，它会完全隐藏前一种符号。另外，它有我们不想要的实线边框样
式。显然，这个符号必须更改。

备注: 请不要混淆地图图层和符号图层，这一点非常重要。地图图层是已加载到地图中的矢量 (或栅格)，
符号图层是用于表示地图图层的符号的一部分。本课程通常将地图图层称为图层，但为了避免混淆，符
号图层始终称为符号图层。

选择新增加的简单填充符号图层：

1. 如前所述，将边框样式设置为无描边。
2. 将填充样式更改为均匀填充或无填充。例如：
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3. 单击确定。
现在您可以查看结果，并根据需要进行调整。您甚至可以添加多个额外的符号图层，并通过这种方式为
您的图层创建一种纹理。

好有趣啊！但它可能因为颜色太多而无法在真实地图中使用...

2.4.7 Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

回答

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.
如下所示：
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2.4.8 跟我做: 排序符号层级

渲染符号图层时，它们也会按顺序渲染，类似于渲染不同地图图层的方式。这意味着在某些情况下，一
个符号中包含多个符号图层可能会导致意外的结果。

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. 给基线一个 1.5的描边宽度和黑色。

3. 给新添加的最上面的符号图层 0.8的厚度和白色。

您会注意到发生这种情况：

32 Chapter 2. 单元: 创建和探索基本地图



QGIS Training Manual

好吧，roads现在有了类似街道的符号，但您会看到在每个十字路口的线是相互重叠的，这根本不是我们
想要的结果！

为了防止这种情况发生，可以对符号层级进行排序，从而控制不同符号图层的渲染顺序。

要更改符号图层的顺序，请执行以下操作：

1. 在符号图层树中选择最顶层的线图层。
2. 单击窗口右下角高级 ►符号层级... 。
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这将打开如下对话框：

3. 选中 启用符号层级。然后，可以通过输入相应的层级编号来设置每个符号的图层顺序。0是底
图层。
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此例中，我们只想激活该选项，如下所示：

这将渲染粗黑线框上面的白线：

4. 单击两次确定，返回地图。
现在，地图将如下所示：

完成后，请记住保存符号，以免将来再次更改符号时丢失您的工作。通过单击图层属性对话框底部的保
存样式... 按钮，可以保存当前符号样式。我们将使用 QGIS QML格式样式文件格式。
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在 solution/styles/better_roads.qml文件夹保存您的样式。通过单击加载样式... 按钮，可以
随时加载以前保存的样式。在更改样式之前，请记住，要替换的任何未保存的样式都将丢失。

2.4.9 Try Yourself

Change the appearance of the roads layer again.
请设置使道路变窄变黄，轮廓呈浅灰色，中间是细黑色的线。请记住，您可能需要通过高级 ►符号层
级... 对话框更改图层渲染的顺序。

回答

要制作所需的符号，您需要三个符号图层：

最下面的符号图层是一条宽大的灰色实线，在它上面有一条稍微细一点的黄色实线，最上面是另一条更
细的黑色实线。

如果您的符号图层与上述类似，但没有得到想要的结果：
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1. 请检查您的符号层级是否如下所示：

2. 现在您的地图应该是这样的：

2.4.10 Try Yourself

符号层级也适用于分类图层 (即具有多个符号的图层)。由于我们还未涉及分类，您将使用一些基本的预
分类数据。

1. Create a new project and add only the roads dataset.
2. 将 exercise_data/styles文件夹中提供的应用样式文件 advanced_levels_demo.qml应
用于图层。这可以通过图层属性对话框底部的样式 ►加载样式... 组合框来完成。

3. 放大到 Swellendam区域。
4. 使用符号图层，确保图层的轮廓按照下图相互融合：
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回答

1. 将您的符号层级调整为以下值：

1. 请尝试使用不同的值以获得不同的结果。
2. 在继续下一个练习之前，请再次打开原来的地图。
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2.4.11 跟我做: 符号图层类型

除了设置填充颜色和使用预定义图案外，还可以完全使用不同的符号图层类型。到目前为止，我们唯一
使用的类型是简单填充类型。更高级的符号图层类型允许您进一步自定义符号。

每种类型的矢量 (点、线和多边形)都有自己的一组符号图层类型。首先，我们将查看可用于点的类型。

点符号图层类型

1. Uncheck all the layers except for places.
2. Change the symbol properties for the places layer:

3. 您可以通过在符号图层树中选择简单标记图层，然后单击符号图层类型下拉列表，访问各种符号
图层类型：
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4. 研究可以使用的各种选项，并选择一个您认为合适的样式符号。
5. 如果不确定，请使用带有白色边框和浅绿色填充的圆形简单标记，大小为 3.00，描边宽度为 0.5
。

线符号图层类型

要查看可用于线数据的各种选项，请执行以下操作：

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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2. 在符号图层树中选择简单标记图层，更改符号属性以匹配此对话框中的设置：
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3. 选择标记线图层并将间隔分布更改为 1.00：
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4. 在应用样式之前，请确保符号层级正确 (通过我们之前使用的高级 ►符号层级对话框)。
应用样式后，请在地图上查看其结果。正如您所见，这些符号会随着道路改变方向，但并不总是随着道
路拐弯。这对某些目的有用，但对其他目的却没有用处。如果您愿意，可以将相关的符号图层更改回原
来的样子。

多边形符号图层类型

要查看可用于多边形数据的各种选项，请执行以下操作：

1. Change the Symbol layer type for the water layer, as before for the other layers.
2. 研究列表中不同的选项各有什么作用。
3. 选择您认为合适的其中一个类型。
4. 如果不确定，请使用点图案填充和以下选项：
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5. 添加类型为简单填充的新符号图层。
6. 将其设为同样的浅蓝色，并带有深蓝色的边框。
7. 使用下移按钮将其移动到点图案符号图层下方：
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因此，您有一个用于 water图层的纹理符号，另外还有一个好处，那就是您可以改变构成纹理的各个点
的大小、形状和距离。

2.4.12 Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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回答

以下是符号构造的示例：
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2.4.13 跟我做: 几何图形生成器符号

可以将几何图形生成器符号用于所有图层类型 (点、线和多边形)。生成的符号直接取决于图层类型。
简而言之，几何图形生成器符号允许您在符号自身内运行一些空间操作。例如，可以在多边形图层运行
真正的质心空间操作，而无需创建点图层。

此外，您还可以使用所有样式选项来更改生成符号的外观。

让我们试一试吧！

1. Select the water layer.
2. 单击简单填充，并将符号图层类型更改为几何图形生成器。
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3. 在开始编写空间查询之前，我们必须在输出中选择几何图形类型。在本例中，我们将为每个要素创
建质心，因此将几何图形类型更改为点 /点集。

4. 现在，让我们在查询面板编写查询:

centroid($geometry)
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5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a
spatial operation within the layer symbology itself, isn’t that amazing?
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使用几何图形生成器符号，您可以真正超越普通符号的边界。

Try Yourself

几何图形生成器只是另一种符号层级。请尝试在几何图形生成器下面添加另一个简单填充。

还可以更改几何图形生成器符号的简单标记的外观。

最终结果应如下所示：
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回答

1. 单击 按钮添加另一个符号层级。

2. 单击 按钮，移动列表底部的新符号。

3. 选择合适的颜色来填充 water多边形。
4. 单击几何图形生成器符号的标记，并根据需要更改圆为其他形状。
5. 请尝试其他选项，以获得更有价值的成果。

2.4.14 跟我做: 创建自定义 SVG填充

备注: 要进行此练习，您需要安装免费的矢量编辑软件 Inkscape。

1. 启动 Inkscape程序，您将看到以下界面：
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如果您使用过其他矢量图像编辑程序，比如 Corel，会发现这是很熟悉的界面及操作。
首先，我们将画布更改为适合小纹理的尺寸。

2. 单击菜单项文件 ►文档属性，将弹出文档属性对话框。
3. 单位更改为 px。

4. 更改宽度和高度值为 100。

5. 完成后关闭对话框。
6. 单击菜单项视图 ►缩放 ►页面以查看正在使用的页面。
7. 选择圆形工具：
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8. 在页面上单击并拖动以绘制椭圆。要使椭圆变成圆形，请在绘制时按住 Ctrl键。

9. 右键单击刚创建的圆，打开其填充和描边选项。您可以修改其渲染参数，例如：
1. 将填充颜色更改为某种浅灰蓝色，
2. 在描边绘制选项卡为边框指定较深的颜色，
3. 并减小描边样式选项卡中的边框宽度。
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10. 使用铅笔工具绘制线：
1. 单击一次开始绘制线。按住 Ctrl键使其捕捉到 15度的增量。
2. 水平移动指针，只需单击即可放置一个点。
3. 单击并捕捉到线的顶点，然后追踪垂直线，只需单击即可结束绘制。
4. 现在连接两个端点。
5. 更改三角形符号的颜色和宽度，使其与圆形的描边相匹配，并根据需要将其移动到恰当位置，
以便最终得到如下符号：
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is
in, under exercise_data/symbols, as SVG file.

在 QGIS：
1. Open the Layer Properties for the landuse layer.

2. In the Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown
below.

3. 单击 ... 按钮，然后在选择文件... 对话框选择 SVG图像。
创建的 SVG图像被添加到符号树中，您现在可以自定义它的不同特征 (颜色、角度、效果、单位
等)。
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Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.
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2.4.15 In Conclusion

更改不同图层的符号将矢量文件集转换为易读的地图。您不仅能看到发生了什么，而且看起来还不错！

2.4.16 Further Reading

精美地图示例

2.4.17 What’s Next?

更改整个图层的符号很有用，但阅读这些地图的人还是无法获得每个图层所包含的信息。比如这些街道
叫什么？某些地方属于哪个行政区域？农场的相对表面积是多少？所有这些信息仍然隐藏着。下一课将
讲解如何在地图表示这些数据。

备注: 您最近记得保存地图吗？
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单元: 分类矢量数据

通过对矢量数据进行分类，允许您根据其属性为要素 (同一图层中的不同对象)指定不同的符号。这允许
使用地图的人能够轻易查看各种要素的属性。

3.1 课: 矢量属性数据

矢量数据可以说是 GIS日常使用中最常见的数据类型。矢量模型使用点、线和多边形 (对于 3D数据，也
包括表面和体积)表示地理要素的位置和形状，而其他属性则作为属性包含在内 (通常在 QGIS中以表的
形式显示)。
到目前为止，我们对地图所做的任何更改都没有受到正在显示的对象的影响。换句话说，所有土地利用
的区块、道路看起来都一样。当查看地图时，浏览者对他们看到的道路一无所知：只是在某个地区有一
条特定形状的道路。

但地理信息系统的全部优势在于，地图上所有可见的对象都具有属性。GIS中的地图不仅仅是图片，它
们不仅表示位置中的对象，还表示关于这些对象的信息。

本课目标: 了解矢量数据的构造，探索对象的属性数据

3.1.1 跟我做: 查看图层属性

重要的是要知道，您将处理的数据不仅表示对象在空间中的位置，还告诉您这些对象是什么。

在上一个练习中，您应该在地图中已加载 protected_areas 图层。如果未加载，请在目录
exercise_data/shapefile查找 protected_areas.shp ESRI Shapefile格式数据集。

表示保护区的多边形构成了空间数据，但我们可以通过探索属性表来了解更多关于保护区的信息。

1. 在图层面板，单击 protected_areas图层将其选中。

2. In the Layer menu, click the Open Attribute Table button (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.

59



QGIS Training Manual

行被称为记录，并与画布地图中的某个要素相关联，如多边形。列被称为字段 (或属性)，并使用
一个名称进行描述，例如名称或 ID。单元格中的值称为属性值。这些定义在地理信息系统中很
常用，所以熟悉它们是件好事。

在 protected_areas图层，有两个要素，由我们在地图画布中看到的两个多边形进行表示。

备注: 为了理解字段和属性值所表示的含义，可能需要找到描述属性值含义的文档 (或元数据)，
这通常是从数据集的创建者处获得。

接下来，让我们看看属性表中的记录如何链接到地图画布上看到的多边形要素。

1. 返回 QGIS主窗口。

2. In the Edit --> Select menu, click on the Select Feature(s) button.
3. 确保图层面板中的 protected_areas图层仍处于选中状态。

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn
yellow indicating it is selected.
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5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.
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您也可以使用属性表选择要素。

1. 在属性表窗口最左侧，单击当前未选中记录的行号。

2. 返回 QGIS主窗口，查看地图画布，您应该会看到两个多边形中较大的一个是黄色的。

3. 要取消选择要素，请转到属性表窗口，然后单击 取消选择图层中的所有要素 按钮。

有时，地图画布会显示许多要素，可能很难看到从属性表中选择了哪个要素。识别要素位置的另一种方
法是使用闪烁要素工具。

1. 在属性表，右键单击行中属性值为 r2855697的单元格，以获取字段 full_id。

2. 在上下文菜单，单击闪烁要素并观察地图画布。

您应该会看到多边形闪烁红色几次。如果错过了，请再试一次。

另一个实用的工具是缩放到要素范围工具，它告诉 QGIS缩放到感兴趣的要素。
1. 在属性表，右键单击行中属性值为 r2855697的单元格，以获取字段 full_id。

2. 在上下文菜单，单击缩放到要素范围
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Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.
现在可以关闭属性表。

3.1.2 试一试探索矢量数据属性

1. rivers图层有多少个可用字段？
2. 告诉我们一些关于您的数据集 town places的信息。
3. 打开 places图层的属性表。哪个字段最适合以标注形式表示，为什么？

回答

• rivers图层应该有 9个字段：
1. 在图层面板选择图层。

2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View ► Toolbars menu).

3. 计算列数。
一种更快的方法是双击 rivers图层，打开图层属性 ►字段选项卡，在此找到表字段的编号。

• 有关 towns的信息可在 places图层找到。像使用 rivers图层一样打开属性表：有两个要素的 place属
性设置为 town: Swellendam和 Buffeljagsrivier。如果您愿意，可以在这两条记录的其他字段添加注
释。

• name字段是最适合显示为标注。这是因为它的所有值对于每个对象都是唯一的，并且不太可能含
有 NULL值。如果您的数据包含一些 NULL值，只要大多数 places都有名称，就不用担心。
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3.1.3 In Conclusion

现在，您已经知道如何使用属性表来查看正在使用的数据中的实际内容。任何数据集只有您关心的属性
时才会对您有用。如果知道需要哪些属性，可以快速决定是否能够使用给定的数据集，或者是否需要寻
找另一个具有所需属性数据的数据集。

3.1.4 What’s Next?

不同的属性用于不同的目的。其中一些可以直接表示为文本，供地图用户查看。您将在下一课学习如何
执行此操作。

3.2 课: 标注

标注可以添加到地图，以显示有关对象的信息。任何矢量图层都可以有与其关联的标注。这些标注的内
容依赖于图层的属性数据。

本课目标: 将有用且美观的标注应用于图层。

3.2.1 跟我做: 使用标注

首先，请确保 按钮在 GUI中可见：
1. 转到菜单项视图 ►工具栏
2. 确保标注工具栏项旁边有复选标记。如果没有，请单击标注工具栏项将其激活。
3. 单击图层面板中的 places图层，使其高亮显示

4. 单击 工具栏按钮打开图层样式面板的标注选项卡

5. 从无标注切换到 单一标注

您需要选择属性中的哪个字段可用于标注。在上一课，您认为 name字段最适用于此目的。

6. 从值列表中选择 name字段：
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7. 单击应用
地图现在应该有这样的标注：
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3.2.2 跟我做: 更改标注选项

根据在之前课程中为地图选择的样式，您可能会发现标注的格式不正确，或者重叠，或者距离其点标记
太远。

备注: 以上，您使用标注工具栏中的 按钮打开图层样式面板。与符号化一样，通过图层样式面板
和图层属性对话框可以使用相同的标注选项。在此，您将使用图层属性对话框。

1. 双击 places图层，打开图层属性对话框

2. 选择 标注选项卡

3. 确保在左侧选项列表中选择了文本，然后更新文本格式选项，使其与此处显示的选项相匹配：
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4. 单击应用
这种字体可能更大，用户也更熟悉，但它的可读性仍然依赖于它下面渲染的图层。为了解决这个问
题，让我们看看描边选项。

5. 从左侧选项列表中选择描边
6. 勾选绘制文本描边旁边的复选框，然后选择与此处显示相匹配的选项：
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7. 单击应用
您将看到，这为地点标注添加了彩色描边或边框，使它们更容易在地图中被识别：
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现在我们可以解决标注相对于其点标记的位置问题。

8. 从左侧选项列表中选择位置
9. 选择点周围模式，并将距离的值更改为 2.0毫米：
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10. 单击应用
您将看到标注不再与其点标记重叠。

3.2.3 跟我做: 使用标注而不是图层符号

在多数情况下，点的位置不需要非常具体。例如，places图层中的大多数点都是指整个城镇或郊区，而
与这些要素相关联的指定点在很大程度上并不是那么具体。事实上，对于阅读地图的人来说，给出一个
过于具体的点往往令人感到困惑。

举个例子：例如，在世界地图，为欧盟给出的点可能在波兰的某个地方。对于阅读地图的人来说，看到
波兰有一个标有欧盟的点，感觉欧盟的总部似乎就在波兰。

因此，为了防止产生这种误解，通常可以停用点符号，并使用标注完全替换它们。

在 QGIS中，可以通过更改标注的位置来实现，标注将直接渲染在它们所指的点上。
1. 打开 places图层的图层属性对话框的 标注选项卡

2. 从选项列表中选择位置选项
3. 单击离点偏移量按钮
这将显示象限选项，可用于设置标注相对于点标记的位置。在这种情况下，我们希望标注以点为
中心，因此选择中心象限：
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4. 通过像之前一样编辑图层符号并将标记大小设置为 0.0来隐藏点符号：
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5. 单击应用，您将看到以下结果：
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如果缩小地图，您会看到一些标注在较大比例时消失，以避免重叠。有时，在处理具有多个点的数据集
时，这或许是您想要的，但在其他时候，这样会丢失有用的信息。处理这种情况还有另一种可能性，我

们将在本课后面的练习中介绍。现在，缩小并单击工具栏中的 按钮，看看会有什么变化。

3.2.4 试一试自定义标注

• 重置标注和符号设置，使点标记和标注偏移 2.0毫米。

回答

您的地图现在应该显示标记点，并且标注应该偏移 2毫米。标记和标注的样式应允许两者在地图上清晰
可见：
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• 将地图的比例设置为 1:100000。您可以在状态栏的比例框中输入来完成此操作，修改您的标注
以适合在此比例下查看。

回答

这是最终一种合理的解答方法：
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要达到这个结果，请按如下操作：

• 使用的字号是 10

• 使用 1.5 mm的点周围位置距离

• 使用的标记大小为 3.0 mm

• 此外，本示例还使用了按该字符换行选项：
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• 在此字段输入 space，然后单击应用以达到相同的效果。在此示例，一些地名很长，导致名称换
行，这对用户来说不是很友好。可能会发现此设置或许更适合您的地图。
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3.2.5 跟我做: 标注线

既然您知道了标注是如何工作的，还有一个问题。点和多边形很容易标注，但是线呢？如果与点相同的
方式进行标注，结果将如下所示：

我们现在将重新设置 roads图层标注，使其易于理解。

1. 隐藏 places图层，避免分散您的注意力

2. 为 roads图层激活 单一标注，就像上面为 places所做的那样

3. 将字体大小设置为 10，便于看到更多标注

4. 放大 Swellendam城镇范围
5. 在标注选项卡的位置选项卡中，选择以下设置：
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您可能会发现文本样式使用了默认值，因此标注很难阅读。将文本更新为深灰或黑色，描边使用
浅黄色。

根据比例设置，地图看起来有点像这样：
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您会看到某些道路名称出现了不止一次，这并不总是必要的。为了防止这种情况发生：

6. 在图层属性对话框的标注选项卡中，选择渲染选项，然后选择合并相连的线以防止重复标注，如
图所示：
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7. 单击确定
另一个实用的功能是防止要素太短而无法注意到的标注绘制。

8. 在同一渲染面板，设置小于如下尺寸的要素禁止标注... 的值为 5.00 mm，并留意观察单击应用
后的结果

还可以尝试不同的位置设置。正如我们之前看到的，在这种情况下，水平选项并不是最优选，所
以我们来试试弯曲选项。

9. 在标注选项卡的位置面板中选择弯曲选项
结果如下：
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如您所见，这隐藏了一些之前可见的标注，因为很难让其中一些标注沿着曲折的街道线放置，并同时清
晰可见。这使其他标注更加有用，因为它们跟踪道路，而不是漂浮在道路之间。您可以决定使用哪些选
项，具体取决于您认为哪些更有用或者哪些看起来更好。

3.2.6 跟我做: 数据定义的设置

1. 停用 roads图层的标注

2. 重新激活 places图层的标注

3. 通过 按钮打开 places的属性表

这里有一个我们现在感兴趣的字段: place，它定义了每条记录的市区类型。我们可以使用这些
数据来设置标注样式。

4. 导航到 places标注面板中的文本面板

5. 单击样式中的斜体文本按钮旁边的 按钮，然后选择编辑... ，并打开表达式字符串构建器：
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6. 在字段和值中，双击 place，然后单击所有唯一值按钮，这将列出该图层 place字段的所有唯
一值。在文本编辑器中添加 a =，然后双击 town。

或者，您可以直接在文本编辑器中输入: "place" = 'town'。

7. 单击两次确定按钮：

82 Chapter 3. 单元: 分类矢量数据



QGIS Training Manual

请注意，place字段与 town匹配的所有 places的标注都以斜体显示。

3.2.7 试一试使用数据定义的设置

备注: 在这里我们跳转到前面来演示一些高级标注设置。在高级阶段，假设您了解以下内容的含义。如
果不了解，请随意忽略这一部分，等您读完相关的资料后再回来。

1. 打开 places的属性表

2. 单击 按钮进入编辑模式

3. 使用 按钮添加一个新列

4. 进行如下配置：
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5. 使用此选项为每个不同 place的类型 ( place字段中的每个键)设置自定义字号

回答

1. 仍在编辑模式中，将 FONT_SIZE值设置为您喜欢的任意值。该示例 towns为 16，suburbs为 14，
localities为 12，hamlets为 10。

2. 记得保存更改并退出编辑模式

3. 返回到 places 图层的 文本格式选项，并在字号的属性字段 数据定义下拉列表中选择
FONT_SIZE：

如果使用上述值，结果应如下所示：
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3.2.8 标注的其它功能

我们无法在本课程中介绍所有选项，但请注意标注选项卡还有许多其他实用的功能。您可以设置基于比
例的渲染、更改图层中标注的渲染优先级，以及使用图层属性设置每个标注选项。甚至可以设置标注的
旋转角度、XY位置和其他属性 (如果为此目的分派了属性字段)，然后使用主图层标注选项按钮旁边的
工具编辑这些属性：

(如果存在所需的属性字段并且处于编辑模式，则这些工具将处于激活状态。)
欢迎探索标注系统的更多功能。

3.2.9 In Conclusion

您已经学习了如何使用图层属性创建动态标注，这可以让您的地图更具信息性和时尚感！
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3.2.10 What’s Next?

既然您知道了属性如何对地图的视觉效果产生影响，那么使用它们来更改对象自身的符号会怎样呢？这
就是下一课的主题！

3.3 课: 分类

标注是传递信息的好方法，比如各个地方的名称，但它们不能用于所有内容。例如，假设有人想知道每
个 landuse区域的用途。使用标注，您将得到以下结果：

这使得地图上的标注很难阅读，即使地图上有许多不同的土地利用区域，也会让人不知所措。

本课目标: 学习如何有效地对矢量数据进行分类。
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3.3.1 跟我做: 对定类数据进行分类

1. 打开 landuse图层的图层属性对话框

2. 转到符号化选项卡
3. 单击显示单一符号的下拉列表，并将其更改为分类:

4. 在新面板，将值更改为 landuse，将颜色渐变更改为随机颜色

5. 单击标有分类字样的按钮
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6. 单击确定
您将看到类似如下的变化：

7. 单击图层面板 landuse旁边的箭头 (或加号)，您将看到相应的类别说明：
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现在，我们的 landuse多边形是彩色的，并且被分类，在类别中相同土地利用的区域具有相同的颜
色。

8. 如果需要，可以通过双击图层面板或图层属性对话框中的相关颜色块来更改每块土地利用区域的
符号：
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请注意，有一个类别为空：
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此空类别用于为未定义 landuse值或具有 NULL值的任何对象着色。保留此空类别用处很大，这样具有
NULL值的区域在地图上仍会显示。您可能希望将颜色更改为更明显地表示空白或 NULL值。

请记住随时保存地图，以免丢失所有来之不易的更改！

3.3.2 试一试更多分类

使用上面学习的知识对 buildings图层进行分类。根据 building字段设置分类，并使用 Spectral -光
谱颜色渐变。

备注: 请记住要放大城市范围才能看到结果。

3.3.3 跟我做: 比值分类

分类有四种类型：定类、次序、区间和比值。

在定类分类中，对象被分类的类别是基于名称的，并且他们没有秩序。例如：城镇名称、地区代码等。
用于定类数据的符号不应意指任何排序或数量。

• 对于点，我们可以使用不同形状的符号。
• 对于多边形，我们可以使用不同类型的图案填充或不同的颜色 (避免混合明暗颜色)。
• 对于线，我们可以使用不同的虚线图案、不同的颜色 (避免混合明暗颜色)以及沿线的不同符号。

在次序分类中，类别是按一定顺序排列的。例如，世界城市根据其在世界贸易、旅游、文化等方面的重
要性进行排名。用于次序数据的符号应意指排序，而不是数量。

• 对于点，可以使用由浅色到深色的符号。
• 对于多边形，可以使用渐变颜色 (从浅到深)。
• 对于线，可以使用渐变颜色 (从浅到深)。
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在区间分类中，数字是以正值、负值和零值为标度的。例如：海平面以上或以下的高度，以摄氏度为单
位的温度。用于区间数据的符号应意指排序和数量。

• 对于点，可以使用大小不同 (从小到大)的符号。
• 对于多边形，可以使用渐变颜色 (从浅到深)或添加不同大小的几何图形。
• 对于线，可以使用粗细 (从细到粗)。

在比值分类中，数字的范围仅包含正值和零值。例如：绝对零度 (0度开尔文)以上的温度、与某一点的
距离、给定街道每月的平均交通量等。用于比值数据的符号应意指排序和数量。

• 对于点，可以使用大小不同 (从小到大)的符号。
• 对于多边形，可以使用渐变颜色 (从浅到深)或添加不同大小的几何图形。
• 对于线，可以使用粗细 (从细到粗)。

在上面的示例中，我们使用定类分类根据 landuse属性为 landuse图层中的每条记录着色。现在我们
将使用比值分类法按区域对记录进行分类。

我们将对该图层进行重新分类，如果不保存现有分类，它们将丢失。要储存当前分类，请执行以下操作：

1. 打开图层的属性对话框
2. 单击样式下拉菜单中的保存样式... 按钮。

3. 选择重命名当前样式... ，输入 land usage，然后按确定按钮。

类别及其符号现在已保存在图层的属性中。

4. 现在进入样式下拉菜单并单击增加... ，创建一个名为 ratio的新样式。这将储存新的分类。

5. 关闭图层属性对话框
我们想按大小对 landuse区域进行分类，但有一个问题：它们没有大小字段，所以我们必须创建一个。

1. 打开 landuse图层的属性表。

2. 单击 切换编辑模式 按钮进入编辑模式

3. 使用 新建字段 按钮添加一个新的小数列，名称是 AREA：

4. 单击确定
执行完毕后将添加新字段 (位于表格的最右侧，您可能需要使用水平滚动条才能看到)。然而，目前
它未填充内容，只是有很多 NULL值。

为了解决此问题，需要计算面积。

1. 使用 按钮打开字段计算器。

您将看到以下对话框：
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2. 勾选 更新现有字段

3. 在字段下拉菜单中选择 AREA

4. 在表达式选项卡下，展开列表中的几何图形函数组，然后查找 $area

5. 双击 $area，使其出现在表达式字段中
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6. 单击确定
7. 在属性表滚动到的 AREA字段，您会注意该字段已填充值 (您可能需要单击列标题来刷新数
据)。

备注: 这些区域遵守工程的面积单位设置，因此它们可能是平方米或平方度。

5. 按 保存编辑，然后使用 切换编辑模式退出编辑模式

6. 关闭属性表
现在有了数据，让我们用它们来渲染 landuse图层。

1. 打开 landuse图层的图层属性对话框的符号化选项卡

2. 将分类样式从分类更改为渐进
3. 将该值更改为 AREA

4. 在颜色渐变下拉列表中，选择新建颜色渐变... 选项：
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5. 选择梯度 (如果尚未选择)，然后单击确定。您将看到如下对话框：
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您将使用它来表示面积，小区域作为颜色 1，大区域作为颜色 2。

6. 选择合适的颜色
在本例中，结果如下所示：

96 Chapter 3. 单元: 分类矢量数据



QGIS Training Manual

7. 单击确定
8. 您可以通过选择颜色渐变下拉列表中的保存颜色渐变... 来保存颜色渐变。为颜色渐变选择合适的
名称，然后单击保存。现在，您可以在全部颜色渐变列表中轻松选择相同的颜色渐变。

9. 在模式中，选择 等数量 (分位数)。

10. 单击分类按钮
现在，您会有如下内容：
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其他一切都保持原样。

11. 单击确定:
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3.3.4 试一试优化分类

• 更改模式和类的值，直到获得有意义的分类。

回答

您使用的设置可能不同，但如果值类 = 6和模式 =自然间断点 (Jenks) (当然，要使用相同的颜色)，地图
将如下所示：

3.3.5 跟我做: 基于规则的分类

组合多个分类条件通常很有用，但不幸的是，正常分类只考虑一个属性。此时就可以考虑使用基于规则
的分类。

在本课，我们将以一种更容易识别 Swellendam市与其他居住区及其他 landuse类型 (基于其面积)的方式
表示 landuse图层。

1. 打开 landuse图层的图层属性对话框

2. 切换到符号化选项卡
3. 将分类样式切换为基于规则

QGIS将自动显示表示该图层当前应用的分类规则。例如，在完成上述练习后，您可能会看到如下
内容：
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4. 单击并拖动以选择所有规则

5. 使用 移除所选规则 按钮移除所有现有规则

现在让我们添加自定义规则。

1. 单击 添加规则 按钮

2. 然后出现编辑规则对话框
3. 输入 Swellendam city作为标注

4. 单击过滤器文本区域旁边的 按钮，打开表达式字符串构建器

5. 输入条件 "name" = 'Swellendam'并验证

6. 返回编辑规则对话框，为其指配较深的灰蓝色，表示该城镇在该地区的重要性，并移除边界
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7. 按确定
8. 重复上述步骤以添加以下规则：

1. Other residential 标 注 的 条 件 为 "landuse" = 'residential' AND "name" <>
'Swellendam'。选择浅蓝灰色:guilabel:‘填充颜色

2. Big non residential areas标注的条件为"landuse" <> 'residential' AND "AREA" >=
605000。选择中绿色。

这些过滤条件是具有排他性的，因为它们排除了地图上的其他区域 (小于 605000 (平方米)的
非住宅区不包括在任何规则中)。

3. 我们将使用标注为 Small non residential areas的新规则来捕捉其余要素。选择 否则，而不
是过滤表达式。给这个类别一个合适的淡绿色。
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您的规则现在应该如下所示：

9. 应用此符号
您的地图将如下所示：
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现在，你有了一张地图，其中 Swellendam是最突出的住宅区，其他非住宅区则根据其面积进行着色。

3.3.6 In Conclusion

符号化允许我们以易于阅读的方式表示图层的属性。它允许我们和地图审阅人使用我们选择的任何相关
属性来了解要素的重要性。根据面临的问题，您将应用不同的分类技术来解决这些问题。

3.3.7 What’s Next?

现在我们有了一张漂亮的地图，但如何将其从 QGIS中提取出来，并转换成可以打印出来的格式，或者
制作成图像或 PDF呢？这是下一课的主题！
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单元: 布局地图

在本单元，您将学习如何使用 QGIS打印布局生成包含所有必需地图组件的高质量地图。

4.1 课: 使用打印布局

您现在已经有了一张地图，可能需要打印或将它导出到文档中。而 GIS地图文件不是图像。相反，它保
存了 GIS程序的状态，并引用了所有图层、其标注、颜色等。因此，对于没有数据或相同 GIS程序 (如
QGIS)的人来说，地图文件将毫无用处。幸运的是，QGIS可以将地图文件导出到任何人的计算机都可以
读取的格式，如果连接了打印机，还可以打印地图。导出和打印都是通过打印布局进行处理。

本课目标: 使用 QGIS打印布局创建具有所有必需设置的基本地图。

4.1.1 跟我做: 布局管理器

QGIS允许您使用同一地图文件创建多个地图。因此，它有一个名为布局管理器的工具。
1. 单击工程 ►布局管理器... 菜单项以打开此工具，您将看到一个空白的布局管理器对话框出现。
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2. 在由模板新建，选择空白布局，然后按新建... 按钮

3. 将新布局命名为 Swellendam，然后单击确定。
4. 现在，您将看到打印布局窗口：

您还可以通过工程 ►新建打印布局... 菜单创建新布局。

无论您选择哪种方式，现在都可以从工程 ►布局 ►访问新的打印布局，如下图所示。
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4.1.2 跟我做: 基本地图构图

在此示例，构图已经是我们想要的了，确保您的也是。

1. 右键单击布局窗口中间部位的页面，然后在上下文菜单中选择页面属性... 。
2. 检查项属性选项卡中的值是否设置为以下值：

• 大小: A4
• 纸张方向: 横向

现在，您已经按照自己想要的方式进行了页面布局，但是这个页面仍然是空白的。它显然缺少地
图。我们来解决这个问题！

3. 单击 添加地图 按钮。

激活此工具后，您将能够在页面上放置地图。

4. 在空白页面上单击并拖动虚框：
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地图将出现在页面上。

5. 通过单击并拖动地图使其移动：

6. 通过单击并拖动边缘上的框来调整大小：
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备注: 当然，您的地图看起来可能会不大一样！这取决于您自己的工程是如何设置的。但别担心！
这些说明是通用的，因此无论地图本身看起来是什么样子，它们的操作方式都是一样的。

7. 确保沿边缘留有边距，并沿顶部留出足够的空间放置标题。
8. 使用以下按钮放大和缩小页面 (但不是地图!)：

9. 在 QGIS主窗口缩放和平移地图。还可以使用 移动项内容 工具平移地图。

地图视图会随着您的放大或缩小而更新。

10. 如果由于某种原因，地图视图未正确刷新，可以通过单击 刷新视图 按钮强制地图进行刷新。

请记住，您为地图设置的大小和位置不是最终结果。如果不满意，可以随时回来更改。目前，您需
要确保已在此地图上保存了您的工作。因为 QGIS中的打印布局是主地图文件的一部分，所以必须
保存工程。

11. 转到布局 ► 保存工程。这是主对话框中的快捷方式。

4.1.3 跟我做: 添加标题

现在，您的地图在页面上看起来不错，但是您的读者及用户还未被告知这是什么。他们需要一些辅助说
明，这就是您将通过添加地图元素为他们提供的内容。首先，让我们添加一个标题。

1. 单击 添加标注 按钮

2. 单击地图上方的空白页面，同意新建项属性对话框中的推荐值，地图顶部将显示一个标注。
3. 调整大小并将其放置在页面的顶部中心，可以调整其大小和位置，这与调整大小和移动地图的方式
相同。

移动标题时，可能会注意到出现的辅助线，这会帮助您将标题定位在页面中心。

不过，操作工具栏中还有一个工具，可以帮助相对于地图 (而不是页面)定位标题：
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4. 单击地图将其选中
5. 按住键盘上的 Shift键并单击标注，以便同时选中地图和标注。

6. 查找 左对齐选中的项 按钮，然后单击其旁边的下拉箭头以显示定位选项，然后单击 居中对齐:

现在标注框在地图上居中，而不是内容。要使标注内容居中，请执行以下操作：

1. 单击标注将其选中。
2. 单击布局窗口侧面板中的项属性选项卡。
3. 将标注文本更改为”Swellendam”:
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4. 使用此界面设置外观区段的字体和对齐选项：
1. 选择一种大字号而明显的字体 (示例将使用 36号的默认字体)
2. 将水平对齐设置为水平居中。
您也可以更改字体颜色，但最好按照默认设置将其保持为黑色。

5. 默认设置是未向标题的文本框中添加框架。但是，如果希望添加框架，可以执行以下操作：
1. 在项属性选项卡，向下滚动，直到看到框架选项。
2. 单击框架复选框以启用框架。您还可以更改框架的颜色和线宽。

在本例中，我们不会启用框架，因此这里是目前为止的页面内容：
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为了确保在对齐这些元素后不会意外移动它们，可以将项锁定到所在的位置：

1. 选择标注和地图项

2. 单击操作工具栏中的 锁定选中的项 按钮。

备注: 单击操作工具栏中的 解锁全部项 按钮，可以再次编辑项。

4.1.4 跟我做: 添加图例

地图读者还需要能够看懂地图上各种元素的实际含义。在某些情况下，比如地名，这是很明显的；而在
另一种情况下，则更难猜测，比如森林的颜色。让我们添加一个新的图例。

1. 单击 添加图例 按钮

2. 单击页面放置图例，在新建项属性对话框中使用推荐值。
3. 布局页面会添加一个图例，其中显示主对话框中设置的图层符号。
4. 与之前一样，您可以单击并将项移动到恰当的位置：
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4.1.5 跟我做: 自定义图例项

并不是图例上的所有内容都是必需的，因此让我们移除一些不需要的项。

1. 在项属性选项卡，找到图例项组。

2. 取消勾选 自动更新框，这允许您直接修改图例项

3. 选择带有 buildings的条目

4. 单击 按钮将其从图例中删除

您还可以重命名项。

1. 从同一列表中选择一个图层。

2. 单击 编辑所选项的属性 按钮。

3. 将图层重命名为 Places, Roads and Streets, Surface Water,和“Rivers‘。
您还可以对项重新排序：
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由于图例可能会因新图层名称而加宽，因此您可能希望对图例和 (或)地图进行移动并调整大小。结果如
下：
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4.1.6 跟我做: 导出地图

备注: 您记得经常保存您的工作吗？

地图终于可以导出了！您将在布局窗口左上角附近看到导出按钮：

• 打印布局: 与打印机接口。由于打印机选项会因您使用的打印机型号而不同，因此最好查阅打印
机手册或打印通用指南，以获取有关此主题的更多信息。

其他按钮允许您将地图页面导出到文件。

• 导出为图像: 提供多种常见图像格式供您选择。这可能是最简单的选项，但它创建的图像是”dead”
且难以编辑。

• 导出为 SVG文件: 如果要将地图发送给制图员 (他们可能需要编辑地图以供出版)，最好将其导出为
SVG格式。SVG是指”Scalable Vector Graphic -可缩放矢量图形”，可以导入到 Inkscape或其他矢量
图像编辑软件等程序中。

• 导出为 PDF文件: 如果需要将地图发送给客户，最常见的方法是使用 PDF，因为 PDF格式设置打印
选项更容易些。某些制图员如果有程序允许他们导入和编辑 PDF格式，他们可能也更喜欢这种格
式。

出于我们的目的，将使用 PDF格式。

1. 单击 导出为 PDF文件 按钮

2. 像往常一样选择保存位置和文件名，之后将显示以下对话框。
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3. 现在可以使用默认值，然后单击保存。
QGIS将继续导出地图，并在完成后立即在打印布局对话框的顶部推送一条信息。

4. 单击信息中的超链接，在系统文件管理器中打开保存 PDF的文件夹
5. 打开 PDF文件，看看您的第一个布局效果如何。
一切都好吗？祝贺您首次完成 QGIS地图工程！

6. 如果有不满意的地方，可以返回到 QGIS窗口，进行适当的修改并再次导出。
7. 请记住保存工程文件。
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4.1.7 In Conclusion

现在，您已了解如何创建基本的静态地图布局。我们可以更进一步，创建动态可调整的地图布局，其中
包含更多的布局项。

4.2 课: 创建动态打印布局

既然您已经学会了如何创建基本的地图布局，我们更进一步，创建一个地图布局，它可以动态地适应我
们的地图范围和页面属性，例如当您更改页面大小时。此外，创建日期也将动态调整。

4.2.1 跟我做: 创建动态地图画布

1. 加载 ESRI Shapefile格式数据集 protected_areas.shp, places.shp, rivers.shp和 water.
shp到地图画布，并调整其属性以适合自己的要求。

2. After everything is rendered and symbolized to your liking, click the New Print Layout icon in the Project
toolbar or choose Project ► New Print Layout. You will be prompted to choose a title for the new print
layout.

3. 我们想创建一幅地图布局，由标题和南非斯韦伦丹附近地区的地图组成。布局的边距应为 7.5 mm，
标题的高度应为 36 mm。

4. 在画布中创建一个名为 main map的地图项，然后转到布局面板，向下滚动到变量区段，找到布
局部分。在此，我们设置一些变量，您可以在整个动态打印布局中使用。第一个变量将定义边距。

按 按钮并输入名称 sw_layout_margin。将该值设置为 7.5。再次按 按钮，并输入名
称 sw_layout_height_header。将该值设置为 36。

5. 现在，您可以通过变量自动创建地图画布的位置和大小。确保已选中地图项，转到 项属性面
板，向下滚动至并打开 位置和大小区段。在 X 右侧单击 数据定义重写 ，并从 变量条目中选择
@sw_layout_margin。

6. 在 Y 右侧单击 数据定义重写 ，选择编辑... ，然后输入公式

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. 可以使用宽度和高度变量来创建地图项的大小。单击宽度右侧的 数据定义重写，然后选择编辑...
，再一次填写以下公式

@layout_pagewidth - @sw_layout_margin * 2

单击高度右侧的 数据定义重写 ，然后选择编辑... ，输入如下公式

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. 我们还要创建一个包含主画布地图范围坐标的网格。再次转到项属性并选择网格区段。通过单击
按钮插入网格。单击修改网格... ，并根据您在 QGIS主画布中选择的地图比例设置 X, Y 和偏

移量的间隔。网格类型十字非常适合我们的目标。
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4.2.2 跟我做: 创建动态标题

1. 使用 添加形状 按钮插入一个包含标题的矩形。在项面板输入名称 header。

2. 再次转到项属性，打开位置和大小区段。使用 数据定义重写，为 X和 Y选择 sw_layout_margin
变量。宽度应由以下表达式定义

@layout_pagewidth - @sw_layout_margin * 2

和使用 sw_layout_height_header变量设置高度。

3. 我们将插入一条水平线和两条垂直线，使用 添加结点项将标题分成不同的部分。创建一条水平线
和两条垂直线，并将它们命名为 Horizontal line, Vertical line 1 Vertical line 2。

1. 对于水平线：
1. 将 X设置为变量 sw_layout_margin

2. 将 Y 的表达式设置为

@sw_layout_margin + 8

3. 将宽度的表达式设置为

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. 对于第一条垂直线：
1. 将 X的表达式设置为

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. 将 Y 设置为变量 sw_layout_margin

3. 高度必须与我们创建的标题相同，因此将高度设置为变量sw_layout_height_header
。

3. 第二条垂直线位于第一条垂直线的左侧。
1. 将 X的表达式设置为

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. 将 Y 设置为变量 sw_layout_margin

3. 高度应与其他垂直线相同，因此将高度设置为变量 sw_layout_height_header。

下图显示了动态布局的结构，我们将用一些元素填充由线创建的区域。
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4.2.3 跟我做: 为动态标题创建标注

1. QGIS工程的标题可以自动包含在内。标题在工程属性中设置。使用 添加标注按钮插入标注，并
输入名称 project title (variable)。在项属性面板的主要属性中，输入以下表达式：

[%@project_title%]

设置标注的位置。

1. 对于 X，使用以下表达式

@sw_layout_margin + 3

2. 对于 Y ，使用以下表达式

@sw_layout_margin + 0.25

3. 对于宽度，使用以下表达式

@layout_pagewidth - @sw_layout_margin *2 - 90

4. 输入 11.25作为高度

在外观将字号设置为 16点。
2. 第二个标注将包含您创建的地图描述。同样，插入一个标注并将其命名为 map description。
在主要属性输入文本 map description。在主要属性中，我们还将包括

printed on: [%format_date(now(),'dd.MM.yyyy')%]

这里我们使用了两个日期和时间函数 (now和 format_date)。
设置标注的位置。

1. 对于 X，使用以下表达式

@sw_layout_margin + 3
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2. 对于 Y ，使用以下表达式

@sw_layout_margin + 11.5

3. 第三个标注将包含有关您团队的信息。首先，我们将在项属性的变量菜单中创建一些变量。转到
布局菜单，单击 按钮，输入名称 o_department, o_name , o_adress and o_postcode。在
第二行输入有关团队的信息。我们将在主要属性区段使用这些变量。

在主要属性中输入

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

设置标注的位置。

1. 对于 X，使用以下表达式

@layout_pagewidth - @sw_layout_margin - 49.5

2. 对于 Y ，使用以下表达式

@sw_layout_margin + 15.5

3. 对于宽度，使用 49.00

4. 对于高度，使用以下表达式

@sw_layout_height_header - 15.5
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4.2.4 跟我做: 向动态标题添加图片

1. 使用 添加图片 按钮将图片放置在标注 organisation information 上方。输入
organisation logo的名称后，定义标识的位置和大小：

1. 对于 X，使用以下表达式

@layout_pagewidth - @sw_layout_margin - 49.5

2. 对于 Y ，使用以下表达式

@sw_layout_margin + 3.5

3. 对于宽度，使用 39.292

4. 对于高度，使用 9.583

如果想包含团队的标识，您必须将标识保存在主目录，并在主要属性 ►图像源输入路径。

2. 我们的布局仍然需要指北针，这将使用 添加指北针插入，在此使用默认设置的指北针。定义位置：

1. 对于 X，使用以下表达式

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. 对于 Y ，使用以下表达式

@sw_layout_margin + 9

3. 对于宽度，使用 21.027

4. 对于高度，使用 21.157

4.2.5 跟我做: 创建动态标题的比例尺

1. 要在标题中插入比例尺，请单击 添加比例尺并将其放置在指北针上方的矩形中。在主要属性下的
地图中选择 main map(Map 1)。这意味着比例会根据您在 QGIS主画布中选择的范围自动更改。
选择样式数字。这意味着我们插入了一个没有比例尺的简单比例尺。比例尺仍然需要一个位置和
大小。

1. 对于 X，使用以下表达式

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. 对于 Y ，使用以下表达式

@sw_layout_margin + 1

3. 对于宽度，使用 25

4. 对于高度，使用 8

5. 将参照点放在中心。
祝贺！您已经创建了第一个动态地图布局。检查一下布局，看看是否一切都是您想要的样子！更改页面

属性时，动态地图布局会自动做出反应。例如，如果将页面大小从 DIN A4更改为 DIN A3，请单击
刷新视图 按钮，页面制图将自动进行调整。
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4.2.6 What’s Next?

在下一页，您需要完成一份作业。这将允许您能够练习到目前为止所学到的技术。

4.3 作业 1

打开现有地图工程并进行彻底修改。如果您注意到了一些小错误或者想早点解决的事情，现在就去做。

在配置地图的同时，要不断地问自己问题。例如：对于不熟悉数据的人来说，这张地图是否容易阅读和
理解？如果我在互联网、海报或杂志上看到这张地图，会不会吸引我的注意力？如果这张地图不是我制
作的，我会想看吗？

如果您是处于 初级或 中级水平学习本课程，请阅读更高级部分的技术。如果您在地图上看到你想做的
事情，为什么不尝试去实现呢？

如果向您讲解本课程，课程主持人可能会要求您提交地图的最终版本，导出为 PDF以供评测。如果是
独自学习本课程，建议您使用相同的标准评测自己的地图。您的地图将根据地图本身的整体外观和符号，
以及地图页面和元素的外观和布局进行评测。请记住，评测地图外观的重点始终是易用性。地图越好看，
容易一目了然，也就具有较高的价值。

祝您制图快乐！
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4.3.1 In Conclusion

前四个单元教您如何创建矢量地图并设置其样式。在接下来的四个单元中，您将学习如何使用 QGIS完
成 GIS分析。这将包括创建和编辑矢量数据；分析矢量数据；使用和分析栅格数据；培养使用 GIS从始
至终解决问题的能力，同时学会使用栅格和矢量数据源。
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单元: 创建矢量数据

使用现有数据创建地图仅仅是开始。在本单元，您将学习如何修改现有矢量数据并创建完整地新数据集。

5.1 课: 创建新的矢量数据集

您使用的数据必然来自某处。对于大多数常见的应用程序，数据已经存在；但是，项目越具体、越专业，
数据可用的可能性就越小。这种情况下，您需要创建自己的新数据。

本课目标: 创建新的矢量数据集。

5.1.1 跟我做: 图层创建对话框

在添加新的矢量数据之前，需要矢量数据集才能将其添加。在我们的示例中，您将从完全创建新数据开
始，而不是编辑现有数据集。因此，首先需要定义自己的新数据集。

1. 打开 QGIS并创建一个新的空白工程。
2. 导航至并单击菜单项图层 ►创建图层 ►新建 Shapefile图层。您将看到新建 Shapefile图层对话框，
该对话框允许您定义一个新图层。
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3. 单击用于文件名字段的 ... 按钮，将弹出保存对话框。

4. 导航到 exercise_data目录。

5. 将新图层另存为 school_property.shp。

在此阶段，确定所需数据集的类型是非常重要的。每种不同的矢量图层类型在后台是以”不同方式
构建”的，因此一旦创建了图层，就无法更改其类型。
在下一个练习，我们将创建描述面积的新要素。对于此类要素，需要创建多边形数据集。

6. 对于几何图形类型，请从下拉菜单中选择多边形：

这对对话框的其余部分没有影响，但会影响在创建矢量数据集时使用正确类型的几何图形。
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下一个字段允许您指定坐标参照系或 CRS。CRS是一种将数字坐标与地球表面位置相关联的方法。
有关详细信息，请参阅用户手册中的使用投影。

在本例中，我们将使用与该工程相关联的默认 CRS，即WGS84。

接下来是字段集合，分组在新建字段下。默认情况下，新图层只有一个属性，即 id字段 (您应该
在字段列表中能看到)。然而，为了使您创建的数据具有实用性，需要说明您将在此新建图层中创
建要素的属性。就我们目前的目标而言，添加一个名为 name的字段就足够了，该字段为文本数
据，并且将文本长度限制为 80个字符。

7. 如以下设置，然后单击添加到字段列表按钮：

8. 检查对话框是否如下所示：

5.1. 课: 创建新的矢量数据集 127



QGIS Training Manual

9. 单击确定
新图层应该出现在图层面板。

5.1.2 跟我做: 数据源

当您创建新数据时，它显然必须与地面上存在的对象有关。因此，您需要从某处获取相关信息。

获取有关对象的数据有许多不同的方法。例如，您可以使用 GPS捕捉现实世界中的点，然后将数据导入
QGIS；或者使用经纬仪测量点，然后手动输入坐标以创建新要素；或者使用数字化过程从遥感数据中追
踪对象，比如卫星影像或航空摄影。

在此示例，您将使用数字化方法。教程提供了示例栅格数据集，因此您需要根据实际导入相关数据集。

1. 单击 数据源管理器 按钮。

2. 选择左侧的 栅格。
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3. 在源面板，单击 ... 按钮：

4. 导航至 exercise_data/raster/。

5. 选择文件 3420C_2010_327_RGB_LATLNG.tif。

6. 单击打开关闭对话窗口。

7. 单击添加和关闭按钮，图像将加载到地图中。
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8. 如果没有看到航拍图像出现，请选择新图层，右键单击，然后在上下文菜单中选择缩放到图层。
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9. 单击 放大 按钮，然后放大到下面以蓝色突出显示的区域：
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现在，您可以数字化这三块场地：
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在开始数字化之前，让我们将 school_property图层移动到航拍图像上面。

1. 在图层窗格选择 school_property图层，将其拖动到顶部。

要开始数字化，需要进入编辑模式。GIS软件通常都是这样做，防止意外编辑或删除重要数据。每个图
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层的编辑模式分别打开或关闭。

要进入 school_property图层的编辑模式：

1. 单击图层面板中的 school_property图层，将其选中。

2. 单击 切换编辑模式 按钮。

如果找不到此按钮，请检查数字化工具栏是否已启用。视图 ►工具栏 ►数字化菜单项旁边应该有
一个复选标记。

在编辑模式下，您将发现一些数字化工具已处于激活状态：

• 添加多边形要素

• 顶点工具

其他相关按钮仍处于非激活状态，但在我们开始与新数据交互时将变为激活状态。

请注意，图层面板中的图层 school_property现在有铅笔图标，表示它处于编辑模式。

3. 单击 添加多边形要素 按钮开始数字化我们的校园场地。

您可能会注意到鼠标光标变成了十字形状，这样可以更准确地放置要数字化的点。请记住，即使在
使用数字化工具时，也可以通过滚动鼠标滚轮来放大和缩小地图，或是按住鼠标滚轮并在地图中拖
动进行平移操作。

您将数字化的第一个要素是 athletics field:

4. 通过单击沿着场地边缘某处的点开始数字化。
5. 通过沿边缘逐步单击来放置更多点，直到所绘制的形状完全覆盖该区域。
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6. 放置最后一点后，右键单击以完成多边形的绘制。这将完成要素绘制并显示要素属性对话框。
7. 填写如下值：

8. 单击确定，您已经创建了一个新要素！
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9. 在图层面板，选择 school_property图层。

10. 右键单击，然后在上下文菜单中选择打开属性表。
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在属性表，您将看到刚才添加的要素。在编辑模式下，可以双击要更新的单元格来更新属性数据。
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11. 关闭属性表。

12. 要保存我们刚刚创建的新要素，请单击 保存图层编辑 按钮。

请记住，如果您在数字化要素时出错，则始终可以在完成创建后对其进行编辑。如果出现错误，请继续
数字化，直到完成上述要素的创建。然后：

1. 单击 顶点工具 按钮。

2. 将鼠标悬停在要移动的顶点上，然后左键单击该顶点。
3. 将鼠标移动到顶点的正确位置，然后单击鼠标左键。这会将顶点移动到新位置。
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可以使用相同的步骤移动线段，但需要将鼠标悬停在线段的中点上。

如果要撤消更改，可以按 撤消按钮或 Ctrl+Z。

4. 请记住通过单击 保存图层编辑 按钮保存更改。

5. 编辑完成后，单击 切换编辑模式 按钮退出编辑模式。
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5.1.3 试一试数字化多边形

使用此图像可以帮助您将学校和上面的场地数字化：

请记住，每个新要素都需要有一个唯一的 id值！

备注: 向图层添加要素后，请记住保存编辑，然后退出编辑模式。

备注: 您可以使用之前课程中学习的技术，设置 school_property的填充、轮廓和标注位置及格式化
的样式。
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5.1.4 跟我做: 使用顶点编辑器表格

编辑要素的另一种方法是使用顶点编辑器表格，手动输入每个顶点的实际坐标值。

1. 确保图层 school_property处于编辑模式。

2. 如果尚未激活，请单击 顶点工具 按钮。

3. 将鼠标移到在 school_property图层创建的一个多边形要素上，然后右键单击。这将选择该要
素，并显现顶点编辑器窗格。

备注: 此表包含要素顶点的坐标。请注意，此要素有七个顶点，但在地图区域只有六个是视觉识别
的。仔细检查后，会发现第 0行和第 6行的坐标相同。这些是要素几何图形的起始和终止顶点，是
创建闭合多边形要素所必需的。

4. 单击并拖动一个框，此框包含选中要素的一个顶点或多个顶点。

142 Chapter 5. 单元: 创建矢量数据



QGIS Training Manual

选中的顶点将变为蓝色，顶点编辑器表格将高亮显示相应的行，其中包含顶点的坐标。
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5. 要更新坐标，请双击表格中要编辑的单元格，然后输入待更新的值。在本例中，第 4行的 x坐标从
20.4450更新为 20.4444。
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6. 输入更新的值后，按 Enter键应用更改。您将看到顶点在地图窗口中移动到新的位置。

7. 编辑完成后，单击 切换编辑模式 按钮以退出编辑模式，并保存编辑内容。

5.1.5 试一试数字化线

我们将数字化两条尚未在道路图层上标记的路线：一条是路径，另一条是轨迹。我们的路径沿着 Railton
郊区的南部边缘延伸，起点和终点为标记道路：
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我们的轨迹在更往南的地方：
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1. 如果 roads图层未包含在地图中，请从您下载的训练数据 exercise_data文件夹中查找 GeoPack-
age文件，并在 training-data.gpkg里找到 roads图层，添加到地图。您可以阅读 Follow
Along: Loading vector data from a GeoPackage Database章节以获取操作指南。

2. 在 exercise_data目录创建一个名为 routes.shp的新 ESRI Shapefile线数据集，属性里包含
id和 type两个字段 (请使用上述方法指导操作)。

3. 激活 routes图层的编辑模式。

4. 由于您正在处理线要素，请单击 添加线要素 按钮以启动线数字化模式。

5. 每次一个，在 routes图层上数字化路径和轨迹。尽量准确地沿着路线走，在拐角或转弯处多增加
点。

6. 将 type属性值设置为 path或 track。

7. 使用图层属性对话框为 routes添加样式，可以随意使用不同的路径和轨迹样式。

8. 保存编辑并按 切换编辑模式 按钮切换关闭编辑模式。
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回答

符号并不重要，但结果应该大致如下：

5.1.6 In Conclusion

现在您知道如何创建要素了！本课程不包括添加点要素，因为一旦您学会处理更复杂的要素 (线和多边
形)，就没有必要了。它的工作原理完全相同，只需单击一次所需的点的位置，并为其赋予属性，然后就
创建了要素。

了解如何数字化非常重要，因为这是 GIS程序中非常常见的操作。

5.1.7 What’s Next?

GIS图层中的要素不仅仅是图片，而且还是空间中的对象。例如，邻接多边形知道它们彼此之间的关系，
这称为拓扑。在下一课，您将看到一个示例，说明为什么这会很有用。

5.2 课: 要素拓扑

拓扑是矢量数据图层的一个非常有用的功能，因为它可以最大限度地减少重叠或间隙等错误。

例如：如果两个要素共享一个边界，如果您使用拓扑编辑边界，那么就不需要先编辑一个要素，再编辑
另一个要素，然后仔细对齐边界以使其相匹配。相反，您可以编辑其共享边界，并且这两个要素也将同
时更改。

本课目标: 使用示例理解拓扑。
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5.2.1 跟我做: 捕捉

捕捉使拓扑编辑更容易。这允许您在数字化时将鼠标光标捕捉到其他对象。要设置捕捉选项，请执行以
下操作：

1. 导航至菜单项工程 ►捕捉选项... 。
2. 在捕捉选项对话框激活 landuse图层，并设置类型为顶点，容差是 12像素，如下图所示：

3. 确保勾选避免重叠列中的框。
4. 离开对话框。

5. 选择 landuse图层并进入编辑模式 ( )
6. 检查 (视图 ►工具栏)高级数字化工具栏是否已启用。
7. 缩放到该区域 (必要时启用图层和标注)：
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8. Digitize this new (fictional) area shown in red:

9. 当出现提示时，将 OGC_FID设置为 999，其他值可以保持不变。

如果在数字化时非常小心，并允许光标捕捉到邻接区域的顶点，您会注意到新区域和现有邻接区域
之间不会有任何间隙。

10. 请注意数字化工具栏中的 撤销和 重做工具。

5.2.2 跟我做: 恰当的拓扑要素

拓扑要素有时需要更新。在我们的研究区域中，一个区域已经变成了林区，因此 landuse图层需要更
新。所以，我们将扩展并加入该地区的一些林区要素：
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我们将使用顶点工具编辑和连接现有多边形，而不是创建新的多边形来连接森林区域。

1. 进入编辑模式 (如果尚未激活)

2. 选择 顶点工具 工具。

3. 选择一个森林区域，并选择一个顶点，然后将其移动到邻接的顶点，以便两个林区要素相交：
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4. 单击其他顶点并将其捕捉到位。
拓扑正确的边界如下所示：
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继续使用顶点工具连接更多区域。

也可以使用 添加多边形要素 工具来填充两个林区多边形之间的间隙。如果启用了避免重叠，则不
必添加每一个顶点 -如果新多边形与现有多边形重叠，将自动添加顶点。
如果您使用的是我们的示例数据，应该有一个森林区域，看起来像这样：

如果您连接了更多、更少或不同的森林区域，请不要担心。

5.2.3 跟我做: 简化要素工具

继续在同一图层，我们将测试 简化要素 工具：

1. 单击将其激活。
2. 单击使用顶点工具或添加要素工具连接的其中一个区域，您将看到以下对话框：
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3. 修改容差并观察有什么变化：

这样可以减少顶点的数量。

4. 单击确定
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该工具的优点是，它为您提供了一个简单而直观的通用界面。但请注意，此工具会破坏拓扑结构，简化
的多边形不再与其邻接多边形共享边界。因此，该工具更适合于单独的要素。

在继续之前，请使用撤消命令返回上一次更改，将多边形恢复其原始状态。

5.2.4 试一试添加环工具

添加环 工具允许将内环添加到多边形要素 (在多边形中切孔)，只要孔完全包含在多边形之内 (或接触
边界)即可。例如，如果您已将南非的外部边界数字化，并且需要为莱索托添加一个孔，则可以使用此工
具。

如果尝试该工具，或许会注意到捕捉选项可能会阻止您在多边形内创建环。因此，建议在切孔之前关闭
捕捉。

1. 使用 启用捕捉 按钮 (或使用快捷键 s )禁用 landuse图层的捕捉。

2. 使用 添加环 工具在多边形几何图形的中间创建一个孔。

3. 在目标要素上绘制多边形，就像使用 添加多边形要素 工具一样的方法。

4. 当您右键单击时，该孔将可见。

5. 使用 删除环 工具移除刚才创建的孔，方法是在孔内单击将其删除。

回答

确切的形状无关紧要，但是应该在您的要素中间有一个洞，比如这个：

• 在继续下一个工具的练习之前，请撤消您的编辑。
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5.2.5 试一试添加部件工具

添加部件 工具允许您向未直接连接到主要素的要素添加新部件。例如，如果您已经将南非大陆的边界
数字化，但尚未添加爱德华王子群岛，则可以使用此工具创建它们。

1. 使用 框选或单击选择要素 工具，选择要添加部件的多边形。

2. 使用添加部件工具添加边远地区。

3. 使用 删除部件 工具删除刚才创建的部件。

备注: 在部件内部单击，将其删除。

回答

1. 首先选择 Bontebok National Park:

2. 现在添加新部件：
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3. 在继续下一个工具的练习之前，请撤消您的编辑。

5.2.6 跟我做: 重塑要素工具

重塑要素 工具用于扩展多边形要素或剪切其一部分 (沿边界)。
扩展：

1. 使用 框选或单击选择要素 工具选择多边形。

2. 在多边形内单击鼠标左键开始绘制。
3. 在多边形外绘制形状，最后一个顶点应该返回多边形内部。
4. 右键单击以完成形状：
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这将产生与以下类似的结果：

切除一部分：

1. 使用 框选或单击选择要素 工具选择多边形。

2. 在多边形外单击。
3. 在多边形内绘制形状，最后一个顶点必须返回到多边形外部。
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4. 在多边形外部右键单击：

上述结果：
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5.2.7 试一试分割要素工具

分割要素 工具与 重塑要素 工具类似，不会删除这两个部件中的任何一个。相反，它让他们两个都保
留着。

我们将使用该工具从多边形中分割一个角。

1. 首先，选择 landuse图层并为其重新启用捕捉。

2. 选择 分割要素 工具并单击顶点开始绘制线。

3. 绘制边界线。
4. 单击要分割的多边形”相对”边的顶点，然后右键单击以完成线：

5. 此时，似乎什么都没有发生。但是请记住，landuse图层渲染没有边界线，因此不会显示新的分
割线。

6. 使用 框选或单击选择要素 工具选择刚刚分割的部分，新要素现在将突出显示：
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5.2.8 试一试合并要素工具

现在，我们把刚才分割的要素重新连接到多边形的其余部分：

1. 试验 合并所选要素和 合并所选要素的属性 工具。

2. 请注意这两个工具的差异。

回答

• 使用合并所选要素工具，确保首先选择要合并的两个多边形。
• 使用 OGC_FID为 1的要素作为属性源 (在对话框中单击其条目，然后单击取所选要素的属性按钮)：

如果使用不同的数据集，原始多边形的 OGC_FID很可能不是 1。只需选择具有 OGC_FID的要素即可。
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使用合并所选要素的属性工具将保留几何图形的不同，但赋予它们相同的属性。

5.2.9 In Conclusion

拓扑编辑是一个功能强大的工具，允许您快速轻松地创建和修改对象，同时确保它们的拓扑正确。

5.2.10 What’s Next?

现在，您了解如何轻松愉快地数字化对象的形状，但添加属性仍然有点头疼！接下来，我们将向您展示
如何使用表单，使属性编辑更简单、更有效。

5.3 课: 表单

通过数字化添加新数据时，系统会显示一个对话框，让您填写该要素的属性。然而，默认情况下，这个
对话框并不是很友好。这可能会导致易用性的问题，尤其是当您需要创建大型数据集，或者希望其他人
帮助您进行数字化，而他们发现默认表单令人困惑。

幸运的是，QGIS允许您为图层创建自定义对话框。这节课将向您演示如何操作。
本课目标: 为图层创建表单。

5.3.1 跟我做: 使用 QGIS的表单设计功能

1. 在图层面板选择 roads图层

2. 像以前一样进入编辑模式
3. 打开 roads图层的属性表

4. 右键单击表格中的任意单元格。将出现一个简略菜单，其中包括打开表单条目。
5. 单击并查看 QGIS为该图层生成的表单

很明显，在查看地图时能够这样做会非常好，而不需要一直在属性表中搜索特定的街道。

1. 在图层面板选择 roads图层

2. 使用 识别要素 工具，单击地图中的任意街道。

3. 识别结果面板随即打开，并显示字段值的树状视图，以及其他有关单击要素的一般信息。
4. 在面板顶部，勾选 识别设置 菜单中的对于单个要素结果自动打开表单复选框。

5. 现在，再次单击地图上的任意街道。随着前面的识别结果对话框，您将看到现在熟悉的表单：
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6. 每次使用识别工具单击单个要素时，只要勾选自动打开表单，就会弹出其表单。

5.3.2 试一试使用表单编辑值

如果处于编辑模式，就可以使用此表单编辑要素的属性。

1. 激活编辑模式 (如果尚未激活)。

2. 使用 识别要素 工具，单击贯穿 Swellendam的主要街道：
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3. 将其 highway值编辑为 secondary

4. 退出编辑模式并保存编辑
5. 打开属性表，注意属性表和源数据中的值都已更新

5.3.3 跟我做: 设置表单字段类型

使用表单编辑内容固然很好，但仍然需要手动输入所有内容。幸运的是，表单有不同类型的所谓控件，
允许您以各种不同的方式编辑数据。

1. 打开 roads图层的属性...

2. 切换到字段选项卡，您将看到以下内容：
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3. 切换到属性表单选项卡，您将看到以下内容：

4. 单击 oneway行，并在选项列表中选择复选框作为控件类型：
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5. 单击确定
6. 进入编辑模式 (如果 roads图层尚未处于编辑模式)

7. 单击 识别要素 工具

8. 单击之前选择的同一条主干道
现在，您将看到 oneway属性旁边有一个复选框，表示 True (选中)或 False (未选中)。

5.3.4 Try Yourself

为 highway字段设置更合适的表单控件。

回答

对于 TYPE ，道路可以使用的类型明显是有限的，如果检查该图层的属性表，就会发现它们是预定义的。

1. 将控件设置为值映射，然后单击从图层加载数据。
2. 在图层下拉列表中选择 roads，并在值和描述选项中选择 highway：
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3. 单击确定三次。
4. 如果您现在在编辑模式处于活动状态时在街道上使用识别工具，则会出现如下对话框：
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5.3.5 试一试创建测试数据

您还可以完全从头开始设计自己的自定义表单。

1. 创建一个名为 test-data简单的点图层，该图层有两个属性：

• name (文本)
• age (整数)

2. 使用数字化工具在新图层上采集少许点，这样您就有了少量数据可供使用。每次采集新点时，都应
显示默认的 QGIS生成的属性表单。

备注: 如果之前的作业启用了捕捉功能，现在可能需要禁用。
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5.3.6 跟我做: 创建新表单

现在，我们想为属性数据采集阶段创建自己的自定义表单。为此，您需要安装 QT Designer (仅创建表单
的人员需要)。

1. 启动 QT Designer。

2. 在出现的对话框中，创建一个新对话框：

3. 在屏幕 (默认)左侧查找Widget Box，它含有一个名为 Line Edit的项。

4. 单击并将此项拖到表单，这将在表单中创建一个新的 Line Edit。

5. 选中新 Line Edit元素后，您将在屏幕一侧 (默认位于右侧)看到其属性：
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6. 将其名称设置为 name。

7. 使用相同的方法，创建一个新的 Spin Box并其名称设置为 age。

8. 添加带有粗体文本 Add a New Person的 Label (查看对象属性了解如何设置此项)。或者，您可
能希望设置对话框自身的标题 (而不是添加标签)。

9. 为 Line Edit和 Spin Box添加 Label。

10. 根据自己的想法排列元素。
11. 单击对话框中的任意位置。
12. Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays

out your dialog automatically.
13. 将对话框的最大尺寸 (在其属性中)设置为 200 (宽度)乘以 150 (高度)。
14. 您的表单现在应该类似于以下所示：
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15. 将新表单另存为 exercise_data/forms/add_people.ui

16. 保存完成后，可以关闭 Qt Designer

5.3.7 跟我做: 将表单与图层关联

1. 返回到 QGIS
2. 双击图例中的 test-data图层以访问其属性。

3. 单击图层属性对话框中的属性表单选项卡
4. 在选择属性布局编辑器下拉列表中，选择提供界面文件选项。
5. 单击省略号按钮，然后选择刚才创建的 add_people.ui文件：

6. 在图层属性对话框中单击确定
7. 进入编辑模式并采集新点
8. 执行此操作时，您会看到自定义对话框 (而不是 QGIS通常创建的通用对话框)。
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9. 如果使用 识别要素 工具单击其中一个点，现在可以通过在识别结果窗口中右键单击并从上下文
菜单中选择查看要素表单来打开表单。

10. 如果处于该图层的编辑模式，则此上下文菜单将显示编辑要素表单，即使在初始采集之后，您也
可以调整新表单中的属性。

5.3.8 In Conclusion

使用表单，您可以在编辑或创建数据时让自己的生活更轻松。通过编辑控件类型或从头创建一个全新的
表单，您可以控制为该图层数字化新数据的用户体验，从而最大限度地减少误解和不必要的错误。

5.3.9 Further Reading

如果您已经完成了上面的高级章节，并且了解 Python，那么您可能想看看有关使用 Python逻辑创建自定
义要素表单的博客文章，它允许使用高级功能，包括数据验证、自动补全等。

5.3.10 What’s Next?

在识别要素时打开表单是 QGIS可以执行的标准动作之一。但是，也可以指示它执行您定义的自定义动
作。这是下一课的主题。

5.4 课: 动作

现在，您已经在上一课中看到了默认动作，现在是定义自己动作的时候了。

动作是指单击要素时发生的事情。可以为地图添加许多额外的功能，例如，允许您检索有关对象的其他
信息。设定动作可以为地图提升一个全新的维度！

本课目标: 学习如何添加自定义动作。
在本课程中，您将使用之前创建的 school_property图层。示例数据包括您数字化的三个属性的每张照片。
我们要做的是将每个属性与其图像进行关联。然后，创建动作，在单击某个属性时打开该属性的图像。

5.4.1 跟我做: 为图像添加字段

school_property图层还无法将图像与属性相关联。首先，我们将为此创建字段。

1. 打开图层属性对话框。
2. 单击字段选项卡。
3. 切换编辑模式：
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4. 新增一列：

5. 输入以下值：
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6. 创建字段后，移动到属性表单选项卡并选择 image字段。

7. 将控件类型设置为附件：

8. 在图层属性对话框中单击确定。
9. 使用识别工具单击 school_property图层中的三个要素中的一个。

由于您仍处于编辑模式，该对话框应处于激活状态，如下所示：

174 Chapter 5. 单元: 创建矢量数据



QGIS Training Manual

10. 单击浏览按钮 ( image字段旁边的 ... )。
11. 选择图像的路径。这些图像位于 exercise_data/school_property_photos/，并与它们应
该关联的要素命名相同。

12. 单击确定。
13. 使用此方法将所有图像与正确的要素相关联。
14. 保存编辑并退出编辑模式。

5.4.2 跟我做: 创建动作

1. 打开 school_property图层属性的动作选项卡，然后单击 添加新动作 按钮。

2. 在添加新动作对话框中的描述字段输入 Show Image字符：
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下一步要执行的动作因操作系统而异，因此请选择适当的课程：

• Windows
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单击类型下拉列表并选择打开。

• Ubuntu Linux
在动作中，为 Gnome Image Viewer编写 eog，或编写 display以使用 ImageMagick。请记住
在命令后面加一个空格！

• macOS
1. 单击类型下拉列表，并选择 Mac。

2. 在动作中，写入 open。记住在命令后面加一个空格！

现在可以继续编写命令了。

您要打开图像，QGIS需要知道图像的位置。它所要做的就是告诉动作图像在哪儿。
3. 从动作文本列表中选择 image：
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4. 单击插入按钮。QGIS将在动作文本字段中添加短语 [% "image" %]。

5. 单击确定按钮关闭添加新动作对话框
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6. 单击确定，关闭图层属性对话框
现在是测试新动作的时候了：

1. 单击图层面板中的 school_property图层，使其高亮显示。

2. 查找 执行要素动作 按钮 (在属性工具栏中)。
3. 单击此按钮右侧的向下箭头。到目前为止，只为该图层定义了一个动作，即您刚刚创建的动作。

4. 单击按钮本身以激活该工具。
5. 使用此工具，单击三个学校属性中的任意一个。
应该可以打开该属性的图像。

5.4.3 跟我做: 搜索互联网

假设我们正在查看地图，并希望了解更多有关农场所在区域的信息。假设您对所讨论的区域一无所知，
并希望找到有关它的一般信息。考虑到您现在正在使用电脑，首先想到的可能是用谷歌搜索该地区的名
称。所以，让我们告诉 QGIS为我们自动执行此操作！

1. 打开 landuse图层的属性表。

我们将使用每个土地利用区域的 name字段进行谷歌搜索。

2. 关闭属性表。
3. 返回图层属性中的动作。
4. 单击创建默认动作按钮添加一些预定义的动作。

5. 使用 移除选中的动作 按钮，移除除打开 URL动作之外的所有动作，并使用短名称搜索Web。

6. 双击所剩动作进行编辑
7. 将描述更改为 Google Search，并移除短名称字段的内容。

8. 确保作用域中的画布被勾选。
下一步要执行的动作因操作系统而异，因此请选择适当的课程：

• Windows
在类型中，选择打开。这将告诉Windows使用默认浏览器打开互联网地址，如 Internet Explorer。

• Ubuntu Linux
在 动作中，写入 xdg-open 。这将告诉 Ubuntu 在您的默认浏览器中打开互联网地址，如
Chrome或 Firefox。

• macOS
Under Action, write open. This will tell macOS to open an Internet address in your default browser,
such as Safari.

现在可以继续编写命令了

无论您在上面使用哪个命令，都需要告诉它下一步要打开哪个互联网地址。您希望它访问谷歌，并
自动搜索短语。
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通常，当您使用谷歌浏览器时，会在谷歌搜索栏输入待搜索的短语。但在这种情况下，您希望
计算机为您执行此操作。您告诉谷歌搜索某个东西 (如果不想直接使用它的搜索栏) 的方式是给
您的互联网浏览器提供地址 https://www.google.com/search?q=SEARCH_PHRASE，其中
SEARCH_PHRASE`是您要搜索的内容。因为我们还不知道要搜索哪个短语，所以只需输入第一部
分 (不包括搜索短语)。

9. 在动作字段里，写入 https://www.google.com/search?q=。请记住在写入此命令之前，在
初始命令后添加一个空格！

现在，您希望 QGIS告诉浏览器，让谷歌搜索您可以单击的任意要素 name的值。

10. 选择 name字段。

11. 单击插入按钮：
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这意味着 QGIS 将打开浏览器并将其发送到地址 https://www.google.com/search?q=[%
"name" %]，其中 [% "name" %]告诉 QGIS使用 name字段的内容作为要搜索的短语。

例如，如果您单击的土地利用区域被命名为 Marloth Nature Reserve，QGIS将把此短语发
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送到浏览器 https://www.google.com/search?q=Marloth%20Nature%20Reserve ，这
将导致您的浏览器访问谷歌，而谷歌将反过来搜索”Marloth Nature Reserve”。

12. 如果您还没有这样做，请按照上述说明进行设置。
13. 单击确定按钮关闭添加新动作对话框
14. 单击确定，关闭图层属性对话框
现在来测试新动作。

1. 在图层面板激活 landuse图层后，单击 执行要素动作 按钮右侧的向下箭头，然后选择为该图层定
义的唯一动作 (Google Search)。

2. 单击地图上您能看到的任意土地利用区域。您的浏览器现在将打开，并将启动谷歌搜索记录为该区
域 name值的位置。

备注: 如果您的动作没有反应，请检查输入的所有内容是否正确，打字错误在这类工作中很常见！

5.4.4 跟我做: 直接在 QGIS中打开网页

以上，您已经了解了如何在外部浏览器打开网页。这种方法存在一些缺点，因为它增加了一种不可知的
依赖关系 -最终用户是否拥有在其系统上执行动作所需的软件？正如您所见，如果您不知道将使用哪个
操作系统，甚至不一定有相同类型的基本命令来执行相同的动作。对于某些操作系统版本，上述用于打
开浏览器的命令可能根本不起作用。这可能是一个无法克服的问题。

然而，QGIS基于功能强大且用途广泛的 Qt库。此外，QGIS动作可以是任意、标记化的 (即使用基于字
段属性内容的变量信息) Python命令！
现在，您将看到如何使用 python动作来显示网页。这与在外部浏览器打开网站的总体思路相同，但它不
需要用户系统上的浏览器，因为是使用 Qt QWebView类 (这是一个基于 webkit的 html控件)在弹出窗口
中显示内容。

这次让我们访问维基百科。因此，您请求的 URL如下所示：
https://wikipedia.org/wiki/SEARCH_PHRASE

要创建图层动作，请执行以下操作：

1. 打开图层属性对话框，转到动作选项卡。
2. 使用动作的以下属性设置新动作：

• 类型: Python
• 描述: Wikipedia
• Scope: Feature, Canvas
• Action Text:

from qgis.PyQt.QtCore import QUrl
from qgis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView(None)
myWV.load(QUrl('https://wikipedia.org/wiki/[%name%]'))
myWV.show()
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在此强调几点：

• [%name%]将在调用动作时替换为实际属性值 (如前所述)。
• 这段代码只是创建一段新的 QWebView实例，设置 URL，然后对其调用 show()，使其在用
户桌面上显示为窗口。

您还可以使用这种方法显示图像，而无需用户在其系统上使用指定的图像查看器。

3. 尝试使用上述方法，用刚刚创建的维基百科动作加载维基百科页面。
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5.4.5 In Conclusion

动作允许您为地图提供额外的功能，这对于在 QGIS中查看同一地图的最终用户非常有用。由于可以对
任何操作系统以及 Python使用 shell命令，因此可以使用的功能是无限的！

5.4.6 What’s Next?

现在，已经完成了各种矢量数据的创建，您将学习如何分析数据以解决问题。这是下一单元的主题。
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单元: 矢量分析

现在已经编辑了一些要素，您一定想知道还可以用它们做些什么。拥有属性的要素是不错，但当所有内
容都尘埃落定时，这并不能真正告诉您任何普通的非 GIS地图无法告诉您的内容。
地理信息系统的主要优势在于: GIS可以回答问题。
在接下来的三个单元，我们将努力使用 GIS功能回答研究问题。例如，您是一名房地产经纪人，正在
Swellendam为符合以下条件的客户寻找一处住宅物业：

1. 必须位于 Swellendam。
2. 必须在学校的合理驾驶距离内 (比如 1千米)。
3. 它的面积必须超过 100m的平方。
4. 距离主干道 50米以内。
5. 距离餐厅 500米以内。

在接下来的几个单元，我们将利用 GIS分析工具的强大功能，为这一新住宅开发找到心怡的场所。

6.1 课: 重投影和数据转换

让我们再来聊聊坐标参照系 (CRS)。之前简单地讨论过，但没有谈到它的实际含义。
本课目标: 重投影和转换矢量数据集。

6.1.1 跟我做: 投影

所有数据以及地图本身现在所在的 CRS称为WGS84，这是用于表示数据非常常见的地理坐标系 (GCS)。
但有一个问题，我们来看。

1. 保存当前地图
2. 然后在 exercise_data/world/world.qgs找到并打开世界地图工程文件

3. 使用放大工具放大到南非
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4. 尝试在屏幕底部状态栏的比例字段中设置比例。在南非上方时，将该值设置为 1:5 000 000 (1
至 500万)。

5. 在地图周围平移，同时注意比例字段
注意到比例变化了吗？这是因为正在远离您在 1:5 000 000时放大的那个点，该点位于屏幕中心。在
这一点的周围，比例是不同的。

知道为什么吗？想想地球仪。它有从北到南连续的线，这些经度线在赤道相距最远，但在两极相遇。

在 GCS中，您在使用这个球体，但屏幕是平的。当您试图在平面上表示球体时，就会发生变形，这与您
切开网球并试图将其压平时所发生的情况类似。这在地图上的意思是，即使在两极 (它们应该相遇的地
方)，经度线彼此之间也应该保持相等的距离。意味着当您远离地图上的赤道时，所看到对象的比例会越
来越大。实际上，这说明我们的地图没有恒定的比例！

为了解决这个问题，让我们使用投影坐标系 (PCS)。PCS ”投影”或转换数据的方式应考虑比例的变化，
并对其进行校正。因此，为了保持比例不变，我们应该使用 PCS重投影数据。

6.1.2 跟我做: ”动态”重投影

默认情况下，QGIS ”动态”重投影数据。这意味着，即使数据本身在另一个 CRS中，QGIS也可以将其
投影为您选择的 CRS。

通过单击 QGIS右下角的 当前投影 按钮，可以更改工程的 CRS。
1. 在出现的对话框中，在过滤器字段输入 global。下面的预定义坐标参照系字段应该出现一些

CRS。
2. 单击并选择WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933条目，然后单击确定。

注意南非的形状是如何变化的。所有的投影都是通过改变地球上对象的表面形状来实现的。

3. 像之前一样，再次缩放到 1:5 000 000的比例。

4. 在地图周围平移。
注意比例是如何保持不变的！

”动态”重投影也适用于组合不同 CRS中的数据集。
1. 将另一个矢量图层添加到地图中，该图层仅包含南非的数据。您可以在 exercise_data/world/

RSA.shp找到。

2. 将其加载。查看 CRS的快速方法是将鼠标悬停在图例中的图层上，它是 EPSG:3410。

您注意到了什么？

即使该图层不同于各大洲的 CRS，也是可见的。

6.1.3 跟我做: 将数据集保存到另一个 CRS

有时，您需要使用另一个 CRS导出现有数据集。正如我们将在下一课中看到的，如果需要对图层进行距
离计算，最好将图层置于投影坐标系。

请注意，’动态’重投影与工程有关，而不是单个图层。这意味着，即使在正确的位置看到某个图层，该
图层也可以具有与工程不同的 CRS。
您可以使用另一个 CRS轻易导出图层。

1. 从 training_data.gpkg添加 buildings数据集。

2. 右键单击图层面板中的 buildings图层

3. 在显示的菜单中选择导出 ►要素另存为... ，您将看到矢量图层另存为... 对话框。
4. 单击文件名字段旁边的浏览按钮
5. 导航至 exercise_data/并将新图层的名称指定为 buildings_reprojected.shp。
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6. 更改 CRS的值。下拉菜单中仅显示最近使用的 CRS，单击下拉菜单旁边的 选择投影 按钮。

7. 此时将出现坐标参照系选择器对话框。在其过滤器字段，搜索 34S。

8. 从列表中选择WGS 84 / UTM zone 34S | EPSG:32734

9. 其他选项保持不变，矢量图层另存为... 对话框现在如下所示：
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10. 单击确定
现在，您可以比较图层的新旧投影，并看到它们位于两个不同的 CRS中，但仍然重叠。
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6.1.4 跟我做: 创建自己的投影

默认情况下，除了 QGIS中包含的投影之外，还有更多的投影。您还可以创建自己的投影。
1. 新建一个地图
2. 加载 world/oceans.shp数据集

3. 转到设置 ►自定义投影... ，您会看到这个对话框。

4. 单击 添加新的 CRS 按钮创建新投影

5. 要使用的感兴趣的投影是 Van der Grinten I。请在名称字段输入其名称。

这个投影表示圆磁场上的地球，而不是像大多数其他投影那样是矩形的。

6. 在格式中，选择WKT (推荐)

7. 在参数字段添加以下字符串:

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

CONVERSION["unknown",
METHOD["Van Der Grinten"],
PARAMETER["Longitude of natural origin",0,

ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

(续下页)
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(接上页)
PARAMETER["False easting",0,

LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. 单击确定

9. 单击状态栏右侧的 当前 CRS 按钮，更改工程的 CRS
10. 选择新定义的投影 (在过滤器字段搜索其名称)
11. 应用此投影后，地图将重投影，如下所示：
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6.1.5 In Conclusion

不同的投影对应不同的目的。通过选择正确的投影，您可以确保准确表示地图上的要素。

6.1.6 Further Reading

本课高级部分的素材摘自本文。

请阅读有关坐标参照系的详细信息。

6.1.7 What’s Next?

下一课，您将学习如何使用 QGIS的各种矢量分析工具分析矢量数据。

6.2 课: 矢量分析

矢量数据也可以分析，以揭示不同要素在空间中是如何相互作用的。有许多不同的与分析相关的函数，
因此不会一一介绍。相反，我们将提出问题，并尝试使用 QGIS提供的工具来解决。
本课目标: 提出问题并使用分析工具进行解决。
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6.2.1 GIS流程

在开始之前，简要叙述一下可用于解决问题的流程是很有用的。相关过程为：

1. 陈述问题
2. 获取数据
3. 分析问题
4. 结果展示

6.2.2 问题

让我们从决定要解决的问题开始这个过程。例如，您是一名房地产经纪人，并且正在为符合以下条件的
客户在 Swellendam寻找一处住宅物业：

1. 必须位于 Swellendam
2. 必须在学校的合理驾驶距离内 (比如 1千米)
3. 它的面积必须超过 100m的平方
4. 距离主干道 50米以内
5. 距离餐厅 500米以内

6.2.3 数据

为了回答这些问题，我们需要以下数据：

1. 该地区的住宅物业 (建筑物)
2. 中心区内外的道路
3. 学校和餐馆的位置
4. 建筑物的面积

这些数据可以通过 OSM获得，您应该会发现，本手册使用的数据集也可以用于本课程。
如果您想从另一位置下载数据，请转到简介章节阅读如何下载。

备注: 虽然 OSM下载具有一致的数据字段，但覆盖范围和详细信息确实有所不同。例如，如果您发现
所选地区不包含餐厅信息，则可能需要选择其他地区。

6.2.4 跟我做: 启动工程并获取数据

我们首先需要加载要使用的数据。

1. 新建 QGIS工程
2. 如果需要，可以添加背景地图。打开浏览器并从 XYZ瓦片菜单加载 OSM 背景地图。
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3. 在 training_data.gpkg Geopackage数据库，您将找到我们在本章中使用的大多数数据集：
1. buildings
2. roads
3. restaurants
4. schools
请加载上述数据，以及 landuse.sqlite。

4. 缩放到图层范围以查看南非的 Swellendam
在继续之前，我们将过滤 roads图层，以便只处理某些指定的道路类型。

OSM数据集中的一些道路被分为 unclassified, tracks, path和 footway。我们希望从数据
集中排除这些道路，并将重点放在更适合本练习的其他道路类型。

此外，OSM数据可能不会在所有地方更新，我们还将排除 NULL值。

5. 右键单击 roads图层并选择过滤... 。

6. 在弹出的对话框中，我们使用以下表达式过滤这些要素:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

两个运算符 NOT和 IN的连接将排除 highway字段中具有这些属性值的所有要素。

IS NOT NULL与 AND运算符结合使用时，排除在 highway字段中空值的道路。

请注意 roads图层旁边的 图标。这有助于您记住，该图层有已激活的过滤器，因此某些要素可
能在工程中不可用。

包含所有数据的地图应如下所示：
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6.2.5 试一试转换图层的 CRS

因为我们要测量图层内的距离，所以需要更改图层的 CRS。为此，依次选择每个图层，使用新投影将图
层保存到新图层，然后将新图层导入地图。

您有许多不同的选项，例如，可以将每个图层导出为 ESRI Shapefile格式的数据集，也可以将图层附加到
现有的 GeoPackage文件，或是创建另外的 GeoPackage文件并用新的重投影图层填充。我们将选择最后
的选项，这样 training_data.gpkg将保持原样。请随意为自己选择最佳的工作流程。

备注: 在此示例，我们使用的是 WGS 84 / UTM zone 34S CRS，但您应该使用更符合您所在地区的 UTM
CRS。

1. 右键单击图层面板中的 roads图层

2. 单击导出 -->要素另存为...

3. 在矢量图层另存为对话框中，选择格式为 GeoPackage

4. 单击文件名后面的 ... ，选择保存位置并将新的 GeoPackage命名为 vector_analysis

5. 将图层名更改为 roads_34S

6. 将 CRS更改为WGS 84 / UTM zone 34S

7. 单击确定:
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这将创建新的 GeoPackage数据库并添加 roads_34S图层。

8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file
with _34S appended to the original name.
OnmacOS, press theReplace button in the dialog that pops up to allowQGIS to overwrite the existingGeoPack-
age.

备注: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project
10. 完成所有图层的处理后，右键单击任意图层，然后单击缩放到图层范围，将地图聚焦到关注区。
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现在，我们已经将 OSM数据转换为 UTM投影，可以开始计算了。

6.2.6 跟我做: 分析问题 -学校和道路的距离

QGIS允许您计算任何矢量对象之间的距离。
1. 确保只有 roads_34S和 buildings_34S图层可见 (以便在使用时简化地图)
2. 单击数据处理►工具箱打开 QGIS分析核心工具箱。基本上，所有算法 (用于矢量和栅格分析)都
可以在此工具箱中获取。

3. 我们首先使用缓冲区算法计算 roads_34S周围的面积。您可以在矢量几何图形组中找到。
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也可以在工具箱上部的搜索栏中键入 buffer或缓冲区：

4. 双击它以打开算法对话框
5. 在输入图层中选择 roads_34S，将距离设置为 50，其余参数使用默认值。
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6. 默认 default距离以米为单位，因为我们的输入数据集位于投影坐标系中，该坐标系使用米作为基
本测量单位。您可以使用组合框选择其他投影单位，如千米、码等。

备注: 如果尝试在具有地理坐标系的图层上创建缓冲区，数据处理将警告您，并建议将图层重投影
到度量坐标系。

7. 默认情况下，数据处理会创建临时图层并将其添加到图层面板。还可以通过以下方式将结果追加
到 GeoPackage数据库：
1. 单击 ... 按钮并选择保存到 GeoPackage...

2. 将新图层命名为 roads_buffer_50m

3. 将其保存在 vector_analysis.gpkg文件
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8. 单击运行，然后关闭缓冲区对话框
现在，您的地图应该如下所示：
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如果您的新图层位于图层列表顶部，它可能会遮挡大部分地图，但这将为您提供所在地区距离道路 50
米范围以内的所有区域。

请注意，缓冲区内有不同的区域，对应于每条单独的道路。要解决此问题，请执行以下操作：

1. 取消勾选 roads_buffer_50m图层，并在启用融合结果的情况下重新创建缓冲区。
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2. 将输出保存为 roads_buffer_50m_dissolved

3. 单击运行并关闭缓冲区对话框
将图层添加到图层面板后，它将如下所示：
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现在没有多余的细分。

备注: 对话框右侧的简短帮助解释了算法的工作原理。如果需要更多信息，只需单击底部的帮助按钮，
即可打开更详细的算法指南。

6.2.7 试一试学校的距离

使用与上面相同的方法，为您的学校创建缓冲区。

其 半 径 应 为 1 km ， 在 vector_analysis.gpkg 文 件 保 存 新 图 层 为
schools_buffer_1km_dissolved。

回答

• 您的缓冲区对话框应如下所示：
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缓冲距离为 1千米。

• 近似线段数值设置为 20。这是可选的，但建议这样做，因为这会使输出缓冲区看起来更平滑。比
较一下：
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对此：
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第一幅图显示的缓冲区是将近似线段数值设置为 5，第二幅图显示的是设置为 20的值。在我们的示例
中，差异很小，但您可以看到，缓冲区的边随着值的增加而变得更平滑。

6.2.8 跟我做: 重叠区域

现在，我们已经确定了道路距离不到 50米的区域，以及 1千米以内有学校的区域 (直线，而不是公路)。
但很明显，我们只想要同时满足这两个条件的区域。为此，需要使用相交工具，您可以在处理工具箱中
的矢量叠加组中找到。

1. 使用这两个缓冲区图层作为输入图层和叠加图层，在相交中选择 vector_analysis.gpkg的
GeoPackage，并将图层名命名为 road_school_buffers_intersect。其它参数按建议 (默认)
处理。
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2. 单击运行。
下图中，蓝色区域是同时满足两个距离条件的区域。
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3. 您可以移除两个缓冲区图层，只保留显示它们重叠位置的缓冲区图层，因为这是我们一开始真正想
知道的：
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6.2.9 跟我做: 提取建筑物

现在，您已获得了建筑必须重叠的区域。接下来，是要提取该地区的建筑物。

1. 在处理工具箱查找菜单项矢量选择 ►按位置提取
2. 在提取要素于中选择 buildings_34S；在要素位置 (几何图形空间关系)中勾选相交；在与以
下要素进行比较中选择缓冲区相交图层。保存到 vector_analysis.gpkg，并将该图层命名为
well_located_houses。

3. 单击运行并关闭对话框
4. 您可能会发现似乎没有太大变化。如果是这样，请将 well_located_houses图层移到图层列表的顶部，
然后放大。
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红色的建筑符合我们的条件，而绿色的建筑则不符合我们的要求。

5. 现在您有了两个独立的图层，可以从图层列表中移除 buildings_34S。

6.2.10 试一试进一步过滤建筑物

我们现在有一个图层，显示了学校 1千米和道路 50米范围以内的所有建筑。现在需要减少选择，只显示
距离餐厅 500米以内的建筑。
使用上述流程，创建一个名为 houses_restaurants_500m的新图层，该图层可进一步过滤 well_located_houses
图层，仅显示餐厅 500m范围内的房屋。

回答

要创建 houses_restaurants_500m新图层，需要经过两个步骤：

1. 首先，在餐厅周围创建 500米的缓冲区，并将图层添加到地图：
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2. 接下来，提取该缓冲区内的建筑物：
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您的地图现在应该只显示距离道路 50米、学校 1千米和餐厅 500米范围以内的建筑：
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6.2.11 跟我做: 选择面积合适的建筑

要查看哪些建筑的面积符合要求 (超过 100平方米)，我们需要计算它们的面积。

1. 选择 houses_restaurants_500m图层，通过单击主工具栏或属性表窗口中的 打开字段计算器 按钮打开
字段计算器

2. 选择新建字段，将输出字段名称设置为 AREA，选择输出字段类型为小数 (实型)，然后从几何
图形组中选择 $area。

新字段 AREA将包含每栋建筑的面积，单位是平方米。

3. 单击确定。AREA字段已添加到属性表的末尾。

4. 单击 切换编辑模式 按钮完成编辑，并在出现提示时保存编辑。

5. 在图层属性的源选项卡中，将提供程序的要素过滤设置为 "AREA >= 100。
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6. 单击确定。
您的地图现在应该只显示那些符合我们开始的条件，并且面积超过 100平方米的建筑。

6.2.12 Try Yourself

使用上述学到的方法，将解决方案另存为一个新图层。该文件应保存在同一 GeoPackage数据库中，名称
是 solution。
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6.2.13 In Conclusion

将 GIS问题解决方法和 QGIS矢量分析工具结合使用，您能够快速轻松地解决含有多个条件的问题。

6.2.14 What’s Next?

在下一课，我们将学习如何计算沿道路从一个点到另一个点的最短距离。

6.3 课: 网络分析

计算两点之间的最短距离是一项常见的 GIS任务。可在处理工具箱中找到相关工具。
本课目标: 学习使用网络分析算法。

6.3.1 跟我做: 工具和数据

您可以在处理工具箱 ►网络分析菜单找到所有网络分析算法，在此您可以看到有许多可用的工具：

打开工程 exercise_data/network_analysis/network.qgz，它包含两个图层：

6.3. 课: 网络分析 215



QGIS Training Manual

• network_points

• network_lines

network_lines图层已经有了有助于理解道路网络的样式。

最短路径工具提供了计算网络两点之间最短或最快路径的方法，给定：

• 在地图上选择的起点和终点
• 在地图上选择的起点和从点图层获取的终点
• 从点图层获取的起点和在地图上选择的终点

让我们开始吧。

6.3.2 计算最短路径 (点到点)

网络分析 ►最短路径 (点到点)允许您计算地图上两个手动选择的点之间的最短距离。

在本例中，我们将计算两点之间的最短 (不是最快)路径。
1. 打开最短路径 (点到点)算法

2. 为描绘网络的矢量图层选择 network_lines

3. 要计算的路径类型使用最短
使用以下两个点作为分析的起点和终点：
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4. Click on the ... button next to Start point (x, y) and choose the location tagged with Starting Point in the
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. 执行相同的操作，但选择标记终点的位置作为终点 (x, y)

6. 单击运行按钮：

7. 将创建一个新的线图层，表示所选点之间的最短路径。取消勾选 network_lines图层可以更好
地查看结果：
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8. 打开输出图层的属性表。它包含三个字段，表示起点和终点的坐标以及 cost。
我们选择最短作为要计算的路径类型，因此 cost表示两个位置之间的距离 (使用图层单位表示)。
在我们的例子中，所选点之间的最短距离约为 1000米：

既然您已经知道如何使用该工具，那就可以自由地测试其他位置了。

6.3.3 试一试最快路径

使用与上一个练习相同的数据，尝试计算两点之间的最快路径。

从起点到终点需要多长时间？

回答

1. 打开网络分析 ►最短路径 (点到点)并将对话框填写为：
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2. 确保要计算的路径类型是最快。
3. 单击运行并关闭对话框。
4. 现在打开输出图层的属性表。cost字段包含两点之间的行进时间 (以时的小数形式表示)：

6.3.4 跟我做: 高级选项

让我们探索一下网络分析工具的更多选项。在之前的练习中，我们计算了两点之间的最快路线。您可以
想象，时间取决于行进速度。

我们将使用前面练习相同的图层、起点和终点。

1. 打开最短路径 (点到点)算法

2. 像之前一样填写输入图层,起点 (x, y)和终点 (x, y)

3. 选择最快作为要计算的路径类型
4. 打开高级参数菜单
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5. 将默认速度 (千米/小时)从默认值 50更改为 4

6. 单击运行
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7. 算法完成后，关闭对话框并打开输出图层的属性表。
cost字段包含依据您选择的速度参数的值。我们可以将 cost字段从带有小数的小时数转换为可读性
更强的分钟值。

8. Open the field calculator by clicking on the icon
9. Add a new field to store the path cost in minutes.

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network
speed is at 4 km/h.

6.3.5 有限速的最短路径

网络分析工具箱还有其他有趣的选项。请看下面的地图：
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考虑到每条道路的速度限制，我们想知道最快的路线 (标签表示以 km/h为单位的速度限制)。不考虑限
速的情况下，最短路径当然是紫色路径。但是在那条路上限速是 20千米/小时，而在绿色道路上您可以
以 100千米/小时的速度行驶！
正如在第一个练习中所做的那样，我们将使用网络分析 ►最短路径 (点到点)，并手动选择起点和终点。

1. 打开网络分析 ►最短路径 (点到点)算法

2. 为描绘网络的矢量图层参数选择 network_lines

3. 选择最快作为要计算的路径类型
4. Select the Start point (x, y) and End point (x, y) as we did before
5. 打开高级参数菜单
6. 选择速度字段作为速度字段参数。通过此选项，算法将考虑每条道路的速度限制情况。
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7. 单击运行按钮
8. 为更好地查看结果，请关闭 network_lines图层
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正如您所见，最快的路线并不对应最短的路线。

6.3.6 服务区 (从图层)

网络分析 ►服务区 (从图层)算法可以回答以下问题：给定一个点图层，给定距离或时间值，所有可达区
域是什么？

备注: 网络分析 ►服务区 (从点)是相同的算法，但它允许您手动选择地图上的点。

给定 250米的距离，我们想知道从 network_points图层的每个点在网络上可以走多远。

1. 取消勾选除 network_points以外的所有图层

2. 打开网络分析 ►服务区 (从图层)算法

3. 为描绘网络的矢量图层选择 network_lines

4. 为包含起始点的矢量图层选择 network_points

5. 在要计算的路径类型中选择最短
6. 输入 250作为出行成本参数

7. 单击运行并关闭对话框
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输出图层表示从给定 250米距离的点要素可以到达的最大路径：
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很酷，不是吗？

6.3.7 In Conclusion

现在您知道如何使用网络分析算法来解决最短和最快的路径问题。

我们现在准备对矢量图层数据执行一些空间统计。出发！

6.3.8 What’s Next?

接下来，您将看到如何对矢量数据集运行空间统计算法。

6.4 课: 空间统计

备注: 本课程由 Linfiniti和 S Motala开发 (Cape Peninsula University of Technology)

空间统计允许您分析和理解给定矢量数据集中发生的情况。QGIS包括许多有用的统计分析工具。
本课目标: 了解如何在处理工具箱中使用 QGIS的空间统计工具。
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6.4.1 跟我做: 创建测试数据集

我们将创建一组随机点，以获取要使用的数据集。

为此，您需要一个多边形数据集来定义要在其中创建点的区域。

我们将使用覆盖街道的区域。

1. 开始一个新工程
2. 添加 roads数据集，以及在 exercise_data/raster/SRTM/中找到的 srtm_41_19 (高程数
据)。

备注: 您可能会发现 SRTM DEM图层与 roads图层的 CRS不同，QGIS正在一个 CRS中重投影这
两个图层。对于以下练习，这种差异并不重要，但可以随意重投影 (如本单元前面所示)。

3. 打开处理工具箱
4. 使用矢量几何图形►最小边界几何图形工具，选择凸包作为几何图形类型，生成包围所有道路的
区域：

如您所知，如果未指定输出，处理工具将创建临时图层。由您决定是否立即或在后期保存图层。

创建随机点

• 使用矢量创建 ►图层边界内生成随机点工具在该区域创建 100个随机点，最小距离为 0.0：
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备注: 黄色警告标志告诉您该参数与距离有关，算法只是提醒您边界几何图形图层位于地理坐标
系中。在本示例，我们不使用此参数，因此您可以忽略。

如果需要，将生成随机点的图层移到图例顶部，以便更好地查看它们：
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数据采样

要从栅格创建采样数据集，需要使用栅格分析 ►对栅格值取样算法。此工具在点的位置对栅格进行采
样，并根据栅格中的波段数在新字段中添加栅格值。

1. 打开对栅格值取样算法对话框
2. 选择随机点作为包含采样点的图层，选择 SRTM栅格作为要从中获取值的波段。新字段的默认名
称为 rvalue_N，其中 N是栅格波段的编号。如果需要，可以更改前缀的名称。

3. 按运行
现在，可以在 Sampled Points图层的属性表检查栅格文件中的采样数据。它们位于您选择名称的新
字段中。

此处显示了可能出现的采样图层：
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使用 rvalue_1字段对采样点进行分类，使红色点位于较高的高度。

您将在剩余的统计练习中使用此采样图层。

6.4.2 跟我做: 基本统计

现在获取该图层的基本统计信息。

1. 单击属性工具栏中的 显示统计汇总 图标，将弹出新面板。

2. 在出现的对话框中，指定 Sampled Points图层作为源。

3. 在字段组合框中选择 rvalue_1字段。这是您用于计算统计数据的字段。

4. 统计面板将自动更新计算出的统计数据：
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备注: 您可以通过单击 复制统计数据到剪贴板 按钮来复制这些值，并将结果粘贴到电子表格。

5. 完成后关闭统计面板
有许多不同的统计数据可用：

计数
采样或值的数量。

总和
这些值相加之和。

均值
均值 (平均值)就是值的总和除以值的个数。

中值
如果将所有值按最小到最大顺序进行排列，中间值 (或两个中间值的平均值，如果 N是偶数)是这
些值的中值。

标准差 (pop)
标准差，指示值围绕均值聚合的紧密程度。标准差越小，值越接近均值。

最小值
最小的值。

最大值
最大的值。

范围
最小值和最大值之间的差。

Q1
数据的第一四分位数。

Q3
数据的第三四分位数。

缺失 (空)值
缺失值的数量。

6.4.3 跟我做: 计算点之间距离的统计信息

1. 创建新的临时点图层。
2. 进入编辑模式，在其他点中的某个位置数字化三个点。
或者，使用与之前相同的随机点生成方法，但仅指定三个点。

3. 以您喜欢的格式将新图层保存为 distance_points。

要生成两个图层中的点之间距离的统计数据，请执行以下操作：

1. 打开矢量分析 ►距离矩阵工具。
2. 选择 distance_points图层作为输入点图层，选择 Sampled Points图层作为目标点图层。

3. 设置如下：
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4. 如果需要，可以将输出图层另存为文件，或者运行算法后再保存临时输出图层。
5. 单击运行生成距离矩阵图层。
6. 打开生成的图层属性表：值是指 distance_points要素与其在 Sampled Points图层中两个最近点之间的
距离：

利用这些参数，距离矩阵工具计算输入图层每个点相对于目标图层最近点的距离统计数据。输出图层的
字段包含输入图层中的点的最邻近距离的均值、标准差、最小值和最大值。
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6.4.4 跟我做: 最近邻分析 (图层内)

要对点图层进行最近邻分析，请执行以下操作：

1. 选择矢量分析 ►最近邻分析。
2. 在出现的对话框中，选择 Random points图层，然后单击运行。

3. 结果将显示在结果查看器面板。

4. 单击蓝色链接打开 html页面的结果：
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6.4.5 跟我做: 平均坐标

要获取数据集的平均坐标，请执行以下操作：

1. 启动矢量分析 ►平均坐标
2. 在出现的对话框中，将 Random points指定为输入图层，其他可选选项不变。

3. 单击运行。
让我们将其与用于创建随机采样的多边形中心坐标进行比较。

1. 启动矢量几何图形 ►质心
2. 在出现的对话框中，选择 Bounding geometry - 边界几何图形作为输入图层。

如您所见，平均坐标 (粉红点)和研究区域的中心 (绿色)不一定重叠。
质心是图层的重心 (正方形的重心是正方形的中心)，而平均坐标表示所有结点坐标的平均值。
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6.4.6 跟我做: 图像直方图

数据集的直方图显示其值的分布。在 QGIS中演示这个最简单方法是通过图像直方图，可以在任何图像
图层 (栅格数据集)的图层属性对话框中找到。

1. 在图层面板，右键单击 srtm_41_19图层

2. 选择属性
3. 选择直方图选项卡。您可能需要单击计算直方图按钮来生成图形。您将看到一个显示栅格值的频
率分布的图表。

236 Chapter 6. 单元: 矢量分析



QGIS Training Manual

4. 可以使用 保存图 按钮将图表导出为图像

5. 您可以在信息选项卡中查看有关该图层的更多详细信息 (平均值和最大值是估算值，可能不准确)。
平均值是 332.8 (估算为 324.3)，最大值是 1699 (估算为 1548)！您可以放大直方图。因为有很多像素的
值为 0，所以直方图看起来是垂直压缩的。通过放大以覆盖除 0处峰值以外的所有内容，您将看到更多
信息：
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备注: 如果平均值和最大值与上述不同，可能是由于最小值/最大值的计算。打开符号化选项卡并展开
最小/最大值设置菜单，选择 最小值/最大值并单击应用。

请记住，直方图显示值的分布，并非所有值必须在图表上可见。
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6.4.7 跟我做: 空间插值

假设有一个采样点集合，您希望从中推测数据。例如，您可以访问我们之前创建的 Sampled points数据集，
并且希望对地形有所了解。

1. 首先，在处理工具箱中启动 GDAL ►栅格分析 ►网格化 (最近邻搜索反距离权重法)工具。

2. 对于点图层请选择 Sampled points

3. 将加权功率设置为 5.0

4. 在高级参数中，将字段 Z值设置为 rvalue_1

5. 最后单击运行并等待处理结束
6. 关闭对话框

下面是原始数据集 (左)与从采样点构建的数据集 (右)的比较。由于采样点位置的随机性，您的可能看起
来有所不同。

如您所见，100个采样点并不足以获得地形的详细印象。它给出了一个非常笼统的概念，但也可能会产
生误导。

6.4.8 试一试不同的插值方法

1. 使用上面显示的流程创建一组 10 000个随机点

备注: 如果点的数量很大，可能处理时间会很长。

2. 使用这些点对原始 DEM进行采样
3. 在此数据集上使用网格化 (最近邻搜索反距离权重法)工具。

4. 将加权功率和平滑分别设置为 5.0和 2.0。

结果 (取决于随机点的位置)大致如下：
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由于采样点的密度更大，可以更好地表示地形。请记住，采样越多，结果越好。

6.4.9 In Conclusion

QGIS有许多用于分析数据集空间统计属性的工具。

6.4.10 What’s Next?

既然已经介绍了矢量分析，为什么不看看用栅格可以做些什么呢？这就是我们在下一单元要学习的内容！
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单元: 栅格

我们之前使用过栅格进行数字化，但也可以直接使用栅格数据。在本单元，您将了解在 QGIS中是如何
完成的。

7.1 课: 使用栅格数据

栅格数据与矢量数据完全不同。矢量数据具有离散特征，几何图形由顶点构成，并且可能与线和 (或)区
域相连。然而，栅格数据就像任何图像一样。虽然可以描绘现实世界中对象的各种属性，但这些对象并
不是作为单独的对象而存在。相反，它们使用具有不同值的像素来表示。

在本单元，您将使用栅格数据来补充现有的 GIS分析。
本课目标: 学习如何在 QGIS中使用栅格数据。

7.1.1 跟我做: 加载栅格数据

可以使用与矢量数据相同的方法加载栅格数据。但是，我们建议使用浏览器面板。

1. 打开浏览器面板，并展开 exercise_data/raster文件夹。

2. 请加载此文件夹的如下数据：
• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

您应该看到以下地图：
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此时有四张航拍图像，涵盖了我们的研究区域。

7.1.2 跟我做: 创建虚拟栅格

现在，正如您可以从中看到的，您的解决方案图层位于所有四个图像中。意味着必须一直使用四个栅格，
这并不理想，最好只使用一个文件。

所幸，QGIS允许您完全这样做，而无需实际创建新的栅格文件。您可以创建虚拟栅格，通常也被称为
目录，这阐明了它的作用。这并不是一个真正的新栅格。相反，它是一种将现有栅格组织到一个目录中
的方法：一个文件便于访问。

为了制作目录，我们将使用数据处理 ►工具箱。
1. 从 GDAL ►栅格杂项打开构建虚拟栅格算法。
2. 在出现的对话框中，单击输入图层参数旁边的 ... 按钮，并勾选所有图层或使用全选按钮。

3. Uncheck Place each input file into a separate band. Notice the code that is generated at the bottom of the
dialog under GDAL/OGR console call. This is the command that will be executed when you click Run. The
text updates as you change different options in the dialog.

备注: 请记住，您可以将文本复制并粘贴到 OSGeo Shell (Windows用户)或 Terminal (Linux和
OSX用户)中运行该命令。还可以为每个 GDAL命令创建脚本。当这个过程需要很长时间，或者当
您想安排特定的任务时，这是非常方便的。请使用帮助按钮获取有关命令语法的更多帮助。

4. 最后单击运行。

备注: As you know from the previous modules, Processing creates temporary layers by default. To save the file,
click on the ... button under Virtual.
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现在可以从图层面板移除原来的四个栅格，只保留输出虚拟目录栅格。
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7.1.3 转换栅格数据

上述方法允许您使用目录虚拟合并数据集，并”动态”重投影。但是，如果您要设置的数据将使用相当长
一段时间，创建已合并并重投影的新栅格可能会更有效。这样可以提高在地图中使用栅格时的性能，但
初始设置可能需要一些时间。

重投影栅格

从 GDAL ►栅格投影打开变形 (重投影)。

您还可以重投影虚拟栅格 (目录)，启用多线程处理等等。
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合并栅格

如果需要创建新的栅格图层并将其保存到磁盘，可以使用合并算法。

备注: 根据要合并的栅格文件数量及其分辨率，创建的新栅格文件可能非常大。请考虑按照创建虚拟栅
格部分中的描述创建栅格目录。

1. 从 GDAL ►栅格杂项菜单中单击合并算法。
2. 正如我们对创建虚拟栅格所做的那样，使用 ... 按钮选择要合并的图层。

您还可以指定虚拟栅格作为输入图层，然后它所包含的所有栅格都将被处理。

3. 如果您了解 GDAL库，还可以通过打开高级参数菜单添加自己的选项。
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7.1.4 In Conclusion

QGIS可以轻松地将栅格数据包含到现有工程中。

7.1.5 What’s Next?

接下来，我们将使用非航拍影像的栅格数据，并了解符号化在栅格中的作用。

7.2 课: 更改栅格符号

并非所有栅格数据都是航拍照片。还有许多其他形式的栅格数据，在许多情况下，必须对它们进行符号
化，才能正确地显示和使用。

本课目标: 更改栅格图层的符号。

7.2.1 Try Yourself

1. 使用浏览器面板加载 srtm_41_19.tif，可在 exercise_data/raster/SRTM/下找到

2. 在图层面板右键单击该图层并选择缩放到图层，可以缩放至其范围。
该数据集是数字高程模型 (DEM)。这是一张有关地形的高程 (海拔)地图，例如可以看出山脉和峡谷的
位置。

上节课讲到数据集的每个像素都包含颜色信息，但在 DEM 中，每个像素都包含高程值。

加载 DEM后，您会注意到它是用灰度表示：
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QGIS已自动将拉伸应用于图像的像素值，以便实现可视化目的，我们将在接下来的教学中进一步了解其
工作原理。

7.2.2 跟我做: 更改栅格图层符号

您有两个不同的选项来更改栅格符号：

1. 在图层属性对话框中，右键单击图层树中的图层并选择属性选项。然后切换到符号化选项卡

2. 单击图层面板正上方的 打开图层样式面板 按钮 (快捷键 F7 )。这将打开图层样式面板，从中可以
切换到 符号化选项卡。

选择您喜欢使用的方法。

7.2.3 跟我做: 单波段灰度

加载栅格文件时，如果它不是上节课中的照片图像，默认样式将设置为灰度渐变。

让我们探索一下这个渲染器的一些功能。
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默认颜色梯度设置为黑到白，这意味着低像素值为黑色，而高像素值为白色。尝试将此设置为白到黑，
然后查看结果。

对比度增强参数非常重要：默认设置为拉伸至极小极大，这意味着像素值被拉伸到最小值和最大值。

看看增强 (左)和未增强 (右)的区别：
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但是拉伸应该使用的最小值和最大值是多少？目前是在最小/最大值设置下进行设置。有许多方法可以计
算最小值和最大值，并将其用于拉伸：

1. 用户定义: 手动输入最小和最大值
2. 累计计数削减: 当您有一些极低或极高的值时，这非常有用。它会削减这些值中的 2% (或您选择的
值)

3. 最小值/最大值: 栅格的实际或估计最小值和最大值
4. 均值 +/-标准差: 将根据平均值和标准差计算这些值

7.2.4 跟我做: 单波段伪彩色

对于栅格图层来说，灰度并不总是很好的样式。让我们尝试让 DEM更加丰富多彩。
• 将渲染类型更改为单波段伪彩色。如果不喜欢加载的默认颜色，请选择其他颜色渐变
• 单击分类按钮，生成新的颜色分类
• 如果未自动生成，请单击确定按钮将该分类应用于 DEM
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您将看到栅格如下所示：
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这是一种查看 DEM的有趣方式。现在，您将看到栅格的值再次适当地显示，从较低区域的蓝色变为较
高区域的红色。

7.2.5 跟我做: 更改透明度

有时，更改整个栅格图层的透明度可以帮助您查看栅格本身覆盖的其他图层，并更好地了解研究区域。

要更改整个栅格的透明度，请切换到透明度选项卡，并使用全局不透明度的滑块降低不透明度：
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更有趣的是更改某些像素值的透明度。例如，在我们使用的栅格中，您可以在边角处看到均匀的颜色。
要将这些像素设置为透明，请转到透明度选项卡中的自定义透明度选项。

• 单击 手动添加值 按钮，可以添加范围值并设置其透明度百分比

• 对于单值， 从显示添加值 按钮更加有用

• 单击 从显示添加值 按钮。对话框消失，您可以与地图进行交互。

• 单击 DEM边角中的均匀颜色
• 您将看到透明度表格将被单击的值填充：
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• 单击确定关闭对话框并查看更改情况。

看？边角现在是 100%透明的。
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7.2.6 In Conclusion

以上这些是帮助您开始使用栅格符号的一些基本功能。QGIS 还提供了许多其他选项，例如使用调色
板/唯一值对图层进行符号化，在多光谱图像中用不同的颜色表示不同的波段，或生成自动山体阴影效果
(仅适用于 DEM栅格文件)。

7.2.7 参考

SRTM数据集来自 http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

现在可以恰当地显示数据了，让我们研究如何进一步进行分析。

7.3 课: 地形分析

某些类型的栅格允许您更深入地了解它们所表示的地形。数字高程模型 (DEM)在这方面特别有用。在本
课中，您将使用地形分析工具，了解更多关于之前提出的住宅开发研究区域的信息。

本课目标: 使用地形分析工具获取有关地形的更多信息。

7.3.1 跟我做: 计算山体阴影

我们将使用与上一课相同的 DEM图层。如果您从头开始本节练习，请使用浏览器面板加载 raster/
SRTM/srtm_41_19.tif文件。

DEM图层显示地形的高程，但有时看起来有点抽象。它包含了您需要的有关地形的所有 3D信息，但看
起来并不像 3D对象。为了更好地了解地形，可以计算山体阴影，这种栅格使用光和阴影来映射地形，
以创建 3D外观图像。
我们将使用的算法位于栅格 ►栅格地形分析菜单中。

1. 单击山体阴影菜单
2. 该算法允许您指定光源的位置: 方位角的值从 0 (北)到 90 (东)、180 (南)和 270 (西)，而垂直角设
置光源的高度 (0到 90度)。

3. 我们将使用以下值：
• Z因子是 1.0

• 方位角 (水平角度)是 300.0°
• 垂直角是 40.0°
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4. 将文件保存在新文件夹 exercise_data/raster_analysis/中，命名为 hillshade

5. 最后单击运行
现在，您拥有一个名称为 hillshade的新图层，如下所示：
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这看起来还不错，而且是 3D效果，但我们可以完善一下吗？就其本身而言，山体阴影看起来就像石膏
模型。就不能以某种方式把它和其他颜色更丰富的栅格一起使用吗？当然可以，我们通过使用山体阴影
作为叠加图层来实现。

7.3.2 跟我做: 使用山体阴影作为叠加图层

山体阴影可以提供在一天中的某个特定时间关于阳光的非常有用的信息。但它也可以用于美学目的，使
地图看起来更好。关键是设置山体阴影的透明度。

1. 将原来 srtm_41_19图层的符号更改为使用上一练习中的伪彩色方案

2. 隐藏除 srtm_41_19和 hillshade图层之外的所有图层

3. 单击并拖动 srtm_41_19，使其位于图层面板中的 hillshade图层下方

4. 单击图层属性中的透明度选项卡，设置 hillshade图层的透明度

5. 将全局不透明度设置为 50%。

您将得到如下结果：

6. 在图层面板中关闭并重新打开 hillshade图层，查看其不同之处。

以这种方式使用山体阴影，可以改善地形的美化效果。如果效果对您来说不够明显，可以更改 hillshade
图层的透明度。当然，山体阴影越亮，其后面的颜色就越暗。这需要找到适合您的平衡点。

完成后记得保存工程。
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7.3.3 跟我做: 寻找最佳区域

回想一下房地产代理问题，我们上次在矢量分析课中讨论了这个问题。让我们想象一下，买家现在希望
购买一栋房屋，并在所属地产上建造一座较小的平房。在南半球，我们知道，理想的开发地块需要有以
下区域：

• 朝向为北
• 坡度小于 5度
• 但如果坡度小于 2度，则无需考虑坡向问题。

让我们为他们找到最好的地方。

7.3.4 跟我做: 计算坡度

坡度表示地形的陡峭程度。例如，如果想在那里的土地上建造房屋，那么您需要相对平坦的土地。

要计算坡度，需要使用处理工具箱 ►栅格地形分析中的坡度算法。
1. 打开算法
2. 选择 srtm_41_19作为高程图层

3. 将 Z因子保留为 1.0

4. 将输出另存为与 hillshade位于同一文件夹中并命名为 slope的文件

5. 单击运行
现在，您将看到地形的坡度，每个像素都有相应的坡度值。黑色像素显示为平坦地形，白色像素显示陡
峭地形：

7.3. 课: 地形分析 257



QGIS Training Manual

7.3.5 试一试计算坡向

坡向是地形坡度所面对的罗盘方向。坡向为 0表示坡度朝北、朝东 90度、朝南 180度、朝西 270度。
因为这项研究是在南半球进行的，所以理想情况下，房屋应该建在朝北的坡度上，这样就可以一直沐浴
阳光。

使用处理工具箱 ►栅格地形分析中的坡向算法，以获得 aspect图层随 slope一起保存。

回答

按如下设置坡向对话框：
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您的结果是：
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7.3.6 跟我做: 寻找朝北坡向

现在，您可以通过栅格显示坡度和坡向，但您无法立即知道理想条件在哪里可以满足要求。如何进行这
种分析？

答案在于栅格计算器。

QGIS提供了不同的栅格计算器供选用：
• 栅格 ►栅格计算器
• 在处理工具箱中：

– 栅格分析 ►栅格计算器
– GDAL ►栅格杂项 ►栅格计算器
– SAGA ► Raster calculus ► Raster calculator

以上每种工具都会产生相同的结果，但语法可能略有不同，而且可用的运算符可能会有所不同。

我们将使用处理工具箱中的栅格分析 ►栅格计算器
1. 双击打开此工具。

• 对话框的左上角列出了所有加载的栅格图层，正如 name@N，其中 name是图层名，N是波段。

• 在右上角，会看到许多不同的运算符。停下来想一想，栅格就是图像。您应该将其看作填充有
数字的 2D矩阵。

2. 北为 0 (零)度，因此要使地形朝北，其坡向必须大于 270度或小于 90度。因此，公式为:

aspect@1 <= 90 OR aspect@1 >= 270

3. 现在，您必须设置栅格详细信息，如像元大小、范围和 CRS。这可以手动完成，也可以通过选择参
照图层自动设置。单击参照图层参数旁边的 ... 按钮来选择最后一个选项。

4. 在对话框中，选择 aspect图层，因为我们希望获得具有相同分辨率的图层。

5. 将图层另存为 aspect_north。

对话框应如下所示：
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6. 最后单击运行。
您的结果将是这样的：
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输出值为 0或 1，这是什么意思？对于栅格中的每个像素，我们编写的公式将返回它是否符合条件。因
此，最终结果将是 False (0)和 True (1)。

7.3.7 试一试更多条件

现在已经完成了坡向，请从 DEM创建两个新图层。
• 首先应确定坡度小于或等于 2度的区域

• 第二个类似，但坡度应小于或等于 5度。

• 将 它 们 保 存 在 exercise_data/raster_analysis 命 名 为 slope_lte2.tif 和
slope_lte5.tif。

回答

• 使用以下选项设置栅格计算器对话框：
• 使用如下表达式: slope@1 <= 2

• slope图层作为参照图层
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• 对于 5度，将表达式和文件名中的 2替换为 5。

您的结果：

• 2度：
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• 5度：
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7.3.8 跟我做: 组合栅格分析结果

现在，您已经从 DEM生成了三个栅格图层：
• aspect_north: 朝北的地形
• slope_lte2: 坡度等于或低于 2度
• slope_lte5: 坡度等于或低于 5度

满足条件时，像素值为 1，其他为 0。因此，如果将这些栅格相乘，所有值为 1的像素将得到 1的值 (其
余像素将得到 0 )。
需要满足的条件包括：

• 坡度等于或低于 5度时，地形必须朝北
• 坡度等于或低于 2度时，地形的朝向无关紧要。

因此，您需要找到坡度在 5度或以下 AND地形朝北，OR坡度在 2度或以下的区域。这样的地形适合开
发。

要计算满足这些条件的区域：

1. 再次打开栅格计算器
2. 在表达式中使用如下表达式:
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( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. 将 Reference layer(s) -参照图层参数设置为 aspect_north (如果您选择另一个也没关系 -它们都是
根据 srtm_41_19计算的)

4. 将输出保存在 exercise_data/raster_analysis/中的 all_conditions.tif

5. 单击运行
其结果为：

提示: 使用以下命令可以简化前面的步骤:

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2
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7.3.9 跟我做: 简化栅格

正如您从上图看到的，组合分析给我们留下了许多非常小的满足条件的区域 (白色)。但这些对我们的分
析并没有真正的用处，因为它们太小而无法构建任何东西。让我们把这些极小的不能使用的地方都处理
掉。

1. 打开滤除碎斑工具 (位于处理工具箱中的 GDAL ►栅格分析)
2. 将输入图层设置为 all_conditions，并将碎斑处理结果设置为 all_conditions_sieve.

tif (位于 exercise_data/raster_analysis/ )。
3. 将阈值设置为 8 (至少八个连续像素)，并勾选使用 8向连通。

处理完成后，将加载新图层。

7.3. 课: 地形分析 267



QGIS Training Manual

现在发生了什么呢？答案位于新栅格文件的元数据中。

4. 在图层属性对话框的信息选项卡中查看元数据。请查找 STATISTICS_MINIMUM的值：
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这个栅格，像其派生，应仅包含值 1和 0，但它也有一个非常大的负数。对数据的检查显示，这个
数字是一个空值。因为我们只关注未被过滤掉的区域，所以将这些空值设置为零。

5. 打开栅格计算器，并构建以下表达式:

(all_conditions_sieve@1 <= 0) = 0

这将维持所有非负值，并将负数设置为零，保持所有值为 1的区域不变。

6. 将输出保存在 exercise_data/raster_analysis/ 并命名为 all_conditions_simple.
tif。

您的输出如下所示：

这就是预期的结果：早期结果的简化版本。请记住，如果从工具中获得的结果与预期不符，那么请查看
元数据 (以及矢量属性，如果适用)，这对解决问题至关重要。

7.3.10 跟我做: 重分类栅格

我们使用栅格计算器对栅格图层进行计算，还可以使用另一个强大的工具从现有图层提取信息。

回到 aspect图层。我们现在知道它的数值范围在 0到 360之间。现在要做的是根据不同的坡向，将该
图层重分类为其他离散值 (从 1到 4)：

• 1 =北 (从 0到 45和从 315到 360)
• 2 =东 (从 45到 135)
• 3 =南 (从 135到 225)
• 4 =西 (从 225到 315)

该运算可以使用栅格计算器来实现，但是公式会变得非常大。

另一种工具是处理工具箱中栅格分析的按表格重分类工具。
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1. 打开工具
2. 选择 aspect作为输入栅格图层

3. 单击重分类表的 ... 。将弹出一个类似表格的对话框，您可以在其中为每个类选择最小值、最大值
和新值。

4. 单击新增行按钮，添加 5行。如下图所示填写每一行内容，然后单击确定:

该算法用于处理每个类的阈值的方法由范围边界定义。

5. 在 exercise_data/raster_analysis/文件夹中将图层保存为 reclassified.tif文件
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6. 单击运行
如果将原 aspect图层与其重分类后的进行比较，差别不大。但通过查看图例，可以看到值从 1到 4。

让我们给此图层一个更好的样式。

1. 打开图层样式面板
2. 选择调色板/唯一值，而不是单波段灰度
3. 单击分类按钮自动获取值并为其分配随机颜色：
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输出可能是这样的 (可以有不同的颜色，因为它们是随机生成的)：
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通过对图层应用此重分类和调色板样式，可以立即区分坡向地区。

7.3.11 跟我做: 查询栅格

与矢量图层不同，栅格图层没有属性表。每个像素包含一个或多个数值 (单波段或多波段栅格)。
我们在本练习中使用的所有栅格图层仅由一个波段组成。根据图层的不同，像素值可能表示高程、坡向
或坡度值。

我们如何查询栅格图层获取像素值呢？这可以使用 识别要素 按钮！

1. 从属性工具栏选择该工具。
2. 单击 srtm_41_19图层的随机位置，识别结果将显示单击位置的波段值：
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3. 通过在面板底部的视图菜单中选择表格，可以将识别结果面板的输出从当前树形模式更改为表
格模式：

单击每个像素获取栅格的值可能会在一段时间后令人烦躁，我们可以使用 Value Tool插件来解决此问题。

1. 转到插件 ►管理并安装插件...

2. 在全部选项卡中的搜索框里键入 value t

3. 选择 Value Tool插件，按安装插件，然后关闭对话框。
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此时将显现新的 Value Tool面板。

小技巧: 如果您关闭了面板，可以通过在视图 ►面板 ► Value Tool中启用或单击工具栏中的图标
重新打开。

4. 要使用插件，只需勾选启用复选框，并确保图层面板中的 srtm_41_19图层处于激活状态 (已选
中)。

5. 将光标在地图上移动以查看像素值。
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6. 但还有很多操作，如：Value Tool插件允许您在图层面板中查询所有激活的栅格图层。将 aspect和
slope图层再次设置为激活状态，并将鼠标悬停在地图上：

7.3.12 In Conclusion

您已经了解了如何从 DEM获取各种分析成果，其中包括山体阴影、坡度和坡向计算。还了解了如何使
用栅格计算器进一步分析和组合这些结果。最后，您学习了如何重分类图层以及如何查询结果。

7.3.13 What’s Next?

现在有两种分析：矢量分析显示可能适合的地块，栅格分析显示可能适合的地形。如何将这些组合起来，
从而得出问题的最终结果？这是下一课的主题，从下一个单元开始学习。
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单元: 完成分析

现在，您有两个分析成果：矢量和栅格部分。在此单元，您将看到如何进行组合，从而得到分析结论并
展示最终的成果。

8.1 课: 栅格转换为矢量

通过在栅格和矢量格式之间进行转换，允许您在解决 GIS问题时同时使用栅格和矢量数据，以及使用这
两种地理数据格式特有的不同分析方法。这增加了您在考虑解决 GIS问题的数据源和处理方法时的灵活
性。

要组合栅格和矢量分析，需要将一种类型的数据转换为另一种类型。让我们将上一课的栅格成果转换为
矢量。

本课目标: 将栅格结果转换为用于完成分析的矢量数据。

8.1.1 跟我做: 栅格转矢量工具

从上一单元 raster_analysis.qgs 中的地图开始。您应该有在之前练习期间进行计算的
all_conditions_simple.tif数据。

• 单击菜单栅格 ►转换 ►栅格矢量化 (栅格转矢量)，此时将出现算法工具对话框。

• 设置如下：
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• 将字段名 (描述栅格的值)更改为 suitable。

• 将图层保存在 exercise_data/residential_development为 all_terrain.shp。

现在有了一个包含栅格所有值的矢量文件，但您感兴趣的只有那些合适的区域，例如，suitable的值为 1
的那些多边形。如果想更清晰地可视化该图层，请更改其样式。

8.1.2 Try Yourself

请参阅矢量分析单元。

• 创建一个新的矢量文件，该文件仅包含 suitable值为 1的多边形。

• 将新建文件保存在 exercise_data/residential_development/为 suitable_terrain.
shp。

回答

1. 右键单击图层面板中的 all_terrain图层，然后选择属性 ►源选项卡，在此打开查询构建器。
2. 然后构建查询 "suitable" = 1。

3. 单击确定过滤掉未满足此条件的所有多边形。在原栅格上查看时，这些区域应完全重叠：
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4. 您可以通过右键单击图层面板中的 all_terrain图层并选择另存为... 来保存该图层，然后按照指令
继续操作。

8.1.3 跟我做: 矢量转栅格工具

虽然对于我们当前的问题来说没有必要，但是了解与上面执行相反的转换是很有意义。将您刚刚在上一
步创建的 suitable_terrain.shp矢量文件转换为栅格。

• 单击栅格 ►转换 ►矢量栅格化 (矢量转栅格)启动此工具，然后按照以下屏幕截图进行设置：
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• 输入图层是 all_terrain。

• 字段名是 suitable。

• 输出栅格尺寸的单位是像素。
• 宽度和高度分别是 837和 661。

• 从 all_terrain图层获取输出范围。

• 设 置 输 出 文 件 栅 格 化 为 exercise_data/residential_development/
raster_conversion.tif。

备注: 此处指定输出图像的大小与矢量化的原栅格相同。要查看图像的尺寸，请打开其元数据 (图层属
性中的元数据选项卡)。

• 单击对话框上的确定按钮开始转换处理。
• 完成后，通过对比新栅格和原栅格来判断其是否成功。它们应该像素到像素完全匹配。
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8.1.4 In Conclusion

在栅格和矢量格式之间进行转换可以扩大数据的适用性，并且不会导致数据退化。

8.1.5 What’s Next?

现在我们有了矢量格式的地形分析结果，可以用来解决住宅开发中应该考虑哪些建筑比较适合的问题。

8.2 课: 组合分析

使用栅格分析的矢量化结果将允许您仅选择适合地形上的建筑。

本课目标: 使用矢量化地形结果选择合适的地块。

8.2.1 Try Yourself

1. 保存当前地图 (raster_analysis.qgs)。
2. 打开之前在矢量分析期间创建的地图 (您应该将文件保存为 analysis.qgs)。
3. 在图层面板，启用以下图层：

• hillshade,
• solution (或 buildings_over_100)

4. 除了这些图层之外 (应该在您之前处理地图时已经加载到地图中)，还需要添加
suitable_terrain.shp数据集。

5. 如果缺少某些图层，您应该在 exercise_data/residential_development/中找到它们。

6. 使用相交工具 (矢量 ►地理处理工具)来创建一个名为 new_solution.shp新的矢量图层，其中
仅包含与 suitable_terrain图层相交的建筑物。

现在，您应该有一个显示某些建筑的图层作为解决方案，例如：
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8.2.2 试一试检查结果

查看 new_solution图层中的每个建筑物。通过更改 new_solution图层的符号，将其与 suitable_terrain图层进
行比较，使其仅具有轮廓。您注意到了一些建筑物的什么？它们都适合仅仅因为它们与 suitable_terrain图
层相交吗？为什么？您认为哪些不合适？

回答

您可能会注意到，new_solution图层中的一些建筑物已被相交工具”切片”。这表明，只有部分建筑
物 -因此只有部分房产 -位于合适的地形上。所以，我们可以明智地从数据集中剔除这些建筑物。

8.2.3 试一试细化分析

从结果可以看出，其中一些建筑并不真正适合，因此我们现在可以细化分析。

我们希望确保我们的分析只返回完全位于 suitable_terrain图层内的建筑。您将如何实现这一目标？使用一
个或多个矢量分析工具，并记住我们的建筑面积都超过 100平方米。

回答

目前，您的分析应该是这样的：

视为一个圆形区域，在所有方向上持续 100米。
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如果它的半径大于 100米，那么从它的尺寸 (从各个方向)减去 100米将导致它的一部分留在中间。

因此，您可以在现有的 suitable_terrain矢量图层上运行 100米的内部缓冲区。在缓冲区函数的输出中，原
图层的剩余部分将表示 100米以外有适合地形的区域。
例如：

1. 转到矢量 ►地理处理工具 ►缓冲区打开缓冲区对话框。
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2. 设置如下：

3. 使用 suitable_terrain图层为输入图层，线段为 10，缓冲距离为 -100。(距离自动以米为单位，因
为您的地图使用的是投影 CRS)

4. 在 exercise_data/residential_development/ 保 存 输 出 为
suitable_terrain_continuous100m.shp。

5. 如有必要，将新图层移到原 suitable_terrain图层之上。

您的结果将如下所示：
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6. 现在使用按位置选择工具 (矢量 ►研究工具 ►按位置选择).
7. 设置如下：

8. 在 new_solution选择与 suitable_terrain_continuous100m.shp中的要素相交的要素。

结果是：
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黄色建筑被选中。尽管某些建筑的一部分位于新 suitable_terrain_continuous100m图层之外，但它们
位于原 suitable_terrain图层内，因此满足了我们的所有要求。

9. 将选择保存在 exercise_data/residential_development/为 final_answer.shp。

8.2.4 In Conclusion

现在，您已经回答了最初的研究问题，并且可以就开发哪处房产提出建议 (有理由，有分析支持)。

8.2.5 What’s Next?

接下来，您将在第二次作业中展示这些结果。

8.3 作业 2

使用打印布局，制作一张表示分析结果的新地图。包括以下图层：

• places (带标注),
• hillshade,
• solution (或 new_solution),
• roads和

• aerial_photos或 DEM 。

写一篇简短的说明性文档。在文档中包括用于考虑购买和后续开发房屋时使用的条件，以及说明您对哪
些建筑比较适宜的建议。
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8.4 课: 补充练习

在本课，您将在 QGIS中引导完成完整的 GIS分析。

备注: 本课由 Linfiniti Consulting (南非)和 Siddique Motala (开普半岛科技大学)共同开发

8.4.1 问题陈述

您的任务是在开普半岛及其周边寻找适合珍稀植物凡波斯物种栖息地的区域。调查范围涵盖开普敦和位
于北部Melkbosstrand及南部 Strand之间的开普敦半岛。植物学家为您提供了有关物种的以下特性：

• 生长在朝东的山坡上
• 山坡坡度在 15%和 60%之间
• 年总降雨量 > 1000毫米的地区
• 距离人类居住区至少 250米
• 植被面积至少应为 6000平米的区域

作为这所大学的学生，您已同意在四个不同的适宜土地寻找这种植物，并希望这四个适生区是最靠近您
居住的开普敦大学。使用所学的 GIS技术来确定应该去哪里寻找。

8.4.2 方案概要

本练习数据可在 exercise_data/more_analysis文件夹找到。

您将找到离开普敦大学最近的四个适生区。

解决方案包括：

1. 分析 DEM栅格图层，找到朝东的山坡并具有合适坡度的斜坡
2. 分析雨量栅格图层，找到适合降雨量的地区
3. 分析分区矢量图层，找到远离人类居住区且大小合适的区域

8.4.3 跟我做: 设置地图

1. 单击屏幕右下角的 当前 CRS按钮。在出现的对话框 CRS选项卡中，使用”过滤器”工具搜索”33S”
。选择条目WGS 84 / UTM zone 33S (EPSG代码 32733 )。

2. 单击确定
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图 8.1: Setting up the CRS

3. 单击 保存工程 工具栏按钮保存工程文件，或使用工程 ►另存为... 菜单项。

将其保存在一个名为 Rasterprac的新目录中，您应该在计算机上的某个位置创建该目录，此目
录还要保存将要创建的图层。保存工程为 your_name_fynbos.qgs。

8.4.4 将数据加载到地图

为了处理数据，需要将必要的图层 (街道名、分区、降雨量、DEM、行政区)加载到地图画布。

矢量数据...

1. 单击数据源管理器工具栏中的 打开数据源管理器 按钮，并在出现的对话框中启用 矢量选项卡，

或使用图层 ►添加图层 ► 添加矢量图层... 菜单项。

2. 确保已选择 文件。

3. 单击 ... 按钮浏览矢量数据集。

4. 在出现的对话框中，打开 exercise_data/more_analysis/Streets目录。

5. 选择文件 Street_Names_UTM33S.shp。

6. 单击打开。
该对话框关闭后并显示原对话框，在矢量数据集旁边的文本字段中给定了文件路径，这样可以确
保选择了正确的文件。如果您愿意，也可以在该字段手动输入文件路径。

7. 单击添加，矢量图层将加载到地图中。它的颜色是自动分配的，您稍后要进行更改。
8. 将图层重命名为 Streets：
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1. 在图层面板右键单击该图层 (默认情况下，屏幕左侧的窗格)。
2. 在出现的快捷菜单中单击重命名图层并进行重命名，完成后按 Enter键。

9. 重 复 矢 量 添 加 过 程， 但 这 次 选 择 的 是 Zoning 目 录 中 的
Generalised_Zoning_Dissolve_UTM33S.shp文件。

10. 重命名为 Zoning。

11. 将矢量图层 admin_boundaries/Western_Cape_UTM33S.shp加载到地图。

12. 重命名为 Districts。

栅格数据...

1. 单击 打开数据源管理器 按钮，并在出现的对话框中启用 栅格选项卡，或使用图层 ►添加图层
► 添加栅格图层... 菜单项。

2. 确保已选择 文件。

3. 导航到相应的文件，选择栅格数据并单击打开。
4. 对 DEM/SRTM.tif 和 rainfall/reprojected/rainfall.tif 两个栅格文件中的每一个都
执行上述操作。

5. 将 SRTM栅格重命名为 DEM，rainfall栅格重命名为 Rainfall (首字母大写)。

8.4.5 更改图层顺序

在图层面板单击并上下拖动图层，更改它们在地图上的显示顺序，以便可以看到尽可能多的图层。

现在，所有数据都已加载并正确可见，分析就可以开始了。最好先执行裁剪运算，这样就不会浪费处理
资源来计算那些无论如何都不会被使用区域的值。

8.4.6 查找正确的地区

鉴于上述调查区域，需要将我们的地区限制为以下地区：

• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg

1. 在图层面板中的 Districts图层上右键单击。

2. 在出现的菜单中，选择过滤... 菜单项。此时会出现查询构建器对话框。
3. 现在，您将构建一个查询仅选择候选地区：

1. 在字段列表，双击 NAME_2字段，使其出现在下面的 SQL where clause文本字段中。

2. 单击 IN 按钮将其追加到 SQL查询。
3. 打开括号。
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4. 单击 (当前为空)值列表下方的全部按钮。
短暂延迟后，将用所选字段 (NAME_2)的值填充值列表。

5. 双击值列表中的值 Bellville，将其追加到 SQL查询中。
6. 添加逗号并双击值列表添加 Cape地区。

7. 对其余地区重复上一步进行添加。
8. 关闭括号。

图 8.2: Query builder
最终的查询应该是 (括号中的地区顺序无关紧要):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

备注: 也可以使用 OR运算符，查询如下所示：

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

1. 单击确定两次。
地图中显示的地区现在仅限于上面列表中的地区。

8.4.7 裁剪栅格

现在您已经有了关注区，可以将栅格裁剪到此区域。

1. 选择菜单项栅格 ►提取 ►按掩膜图层裁剪栅格... ，打开裁剪对话框。

2. 在输入图层下拉列表中，选择 DEM图层。

3. 在掩膜图层下拉列表中，选择 Districts图层。

4. 向下滚动，通过单击 ... 按钮并选择保存到文件... ，在已裁剪 (掩膜)文本字段中指定输出位置。

1. 导航到 Rasterprac目录

2. 输入文件名 - DEM_clipped.tif
3. 保存

5. 确保已勾选 执行算法后打开输出文件

6. 单击运行
裁剪运算完成后，让按掩膜图层裁剪栅格对话框处于打开状态，便于能够重新使用裁剪区域。

7. 在输入图层下拉列表中选择 Rainfall栅格图层，并将输出保存为 Rainfall_clipped.tif。

8. 其他选项不要更改，然后单击运行。
9. 第二次裁剪运算完成后，可以关闭按掩膜图层裁剪栅格对话框。
10. 保存地图
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图 8.3: Map view with filtered vector, clipped raster and reordered layers

对齐栅格

为了进行分析，我们需要栅格具有相同的 CRS，并且它们必须对齐。
首先，我们将降雨数据的分辨率更改为 30米 (像素大小)：

1. 在图层面板，确保 Rainfall_clipped是活动图层 (即，单击可高亮显示)
2. 单击栅格 ►投影 ►变形 (重投影)... ，打开变形 (重投影)对话框

3. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
4. 设置以目标地理参考单位表示的输出文件分辨率为 30

5. 向下滚动至重投影，在您的 rainfall/reprojected目录中保存输出为 Rainfall30.tif

6. 确保已勾选 执行算法后打开输出文件

图 8.4: Wrap (Reproject) Rainfall_clipped

然后我们对齐 DEM：
1. 在图层面板，确保 DEM_clipped是活动图层 (即，单击可高亮显示)
2. 单击栅格 ►投影 ►变形 (重投影)... ，打开变形 (重投影)对话框

3. 在目标 CRS，从下拉菜单中选择工程 CRS: EPSG:32733 - WGS 84 / UTM zone 33S

4. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu

8.4. 课: 补充练习 291



QGIS Training Manual

5. 设置以目标地理参考单位表示的输出文件分辨率为 30

6. 向下滚动到新建输出文件配准后的范围，使用文本框右侧的按钮选择从图层计算 ► Rainfall30

7. 向下滚动至重投影，在您的 DEM/reprojected目录中保存输出为 DEM30.tif

8. 确保已勾选 执行算法后打开输出文件

为了正确看到发生的变化，需要更改图层的符号。

8.4.8 更改矢量图层的符号

1. 在图层面板，右键单击 Streets图层

2. 从出现的菜单中选择属性
3. 在出现的对话框中切换到符号化选项卡
4. 单击顶部控件中的线条目
5. 在下面的列表中选择符号或设置新符号 (颜色、透明度等)
6. 单击确定关闭图层属性对话框。这将更改 Streets图层的渲染

7. 对 Zoning图层执行类似的处理，并为其选择合适的颜色

8.4.9 更改栅格图层的符号

栅格图层符号有点不同。

1. 打开 Rainfall30栅格图层的属性对话框

2. 切换到符号化选项卡。您会注意到，此对话框与用于矢量图层的样式大不一样。
3. 展开最小/最大值设置
4. 确保选择了均值 +/-标准差按钮

5. 确保关联框中的值为 2.00

6. 为了对比度增强，确保显示为拉伸至极小极大
7. 对于颜色梯度，将其更改为白到黑
8. 单击确定

图 8.5: Raster symbology

Rainfall30栅格 (如果可见)应该会改变颜色，使您可以看到每个像素的不同亮度值
9. 对 DEM30图层重复相同的处理，但将用于拉伸的标准差设置为 4.00
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8.4.10 清理地图

1. 从图层面板移除原 Rainfall和 DEM图层，以及 Rainfall_clipped和 DEM_clipped：

• 在这些图层上右键单击，然后选择移除图层。

备注: 这不会从存储设备删除数据，只是将其从地图中移除。

2. 保存地图
3. 现在可以通过取消勾选图层面板中矢量图层旁边的框来隐藏它们。这将使地图渲染速度更快，并
为您节省一些时间

8.4.11 创建山体阴影

为了创建山体阴影，您需要使用为此目的而编写的算法。

1. 在图层面板，确保 “DEM30“是活动图层 (即，单击可高亮显示)
2. 单击栅格 ►分析 ►山体阴影... 菜单项，打开山体阴影对话框

3. 向下滚动到山体阴影，在您的 Rasterprac目录中保存输出为 hillshade.tif

4. 确保已勾选 执行算法后打开输出文件

5. 单击运行
6. 等待完成处理

图 8.6: Raster analysis Hillshade

新的 hillshade图层已出现在图层面板。

1. 在图层面板中的 hillshade图层上右键单击，然后打开属性对话框

2. 单击透明度选项卡，将全局不透明度滑动条设置为 20%

3. 单击确定
4. 请注意，透明山体阴影叠加在裁剪后的 DEM 时的效果。您可能需要更改图层的顺序，或单击

Rainfall30图层查看效果

8.4.12 坡度

1. 单击栅格 ►分析 ►坡度... 菜单项，打开:guilabel:坡度算法对话框
2. 选择 DEM30作为输入图层

3. 勾选 用百分比而不是度来表示坡度。坡度可以用不同的单位 (百分比或度)表示。评估条件表
明，适合的植物生长的坡度在 15%到 60%之间的斜坡上。所以需要确保我们的坡度数据是用百分
比表示

4. 为您的输出指定适当的文件名和位置

5. 确保已勾选 执行算法后打开输出文件
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6. 单击运行

图 8.7: Raster analysis Slope

坡度图像已计算并添加到地图中。和往常一样，是以灰度渲染的。将符号更改为更有趣的符号：

1. 打开图层属性对话框 (通常使用图层的右键单击菜单）
2. 单击符号化选项卡
3. 在显示单波段灰度的地方 (渲染类型下拉菜单中)，请将其更改为单波段伪彩色
4. 为最小/最大值设置选择均值 +/-标准差 x，其值为 2.0

5. 选择适当的颜色渐变
6. 单击运行

8.4.13 试一试坡向

使用与计算坡度相同的方法，在栅格 ►分析菜单中选择坡向... 。

请记住定期保存工程。

8.4.14 重分类栅格

1. 选择栅格 ►栅格计算器...
2. 指定 Rasterprac目录作为输出图层的位置 (单击 ... 按钮)，并将其保存为 slope15_60.tif

3. 确保选中执行算法后打开输出文件的方框
在左侧的栅格波段列表中，显示您在图层面板看到的所有栅格图层。如果您的坡度图层被称为
slope，它将被列为 slope@1，表示坡度栅格的波段是 1。

4. 坡度需要介于 15和 60度之间。

使用界面中的列表项和按钮，构建以下表达式:

(slope@1 > 15) AND (slope@1 < 60)

5. 将输出图层字段设置为适当的位置和文件名。
6. 单击运行

图 8.8: Raster calculator Slope

现在使用同样的方法找到正确的坡向 (朝东: 45到 135度)。
1. 构建以下表达式:

(aspect@1 > 45) AND (aspect@1 < 135)

当生成栅格中所有朝东的斜坡都是白色时，您就会知道它起作用了 (就像被早晨的阳光照亮一样)。
使用同样的方法找到符合要求的降雨量 (大于 1000毫米)。使用以下表达式:
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Rainfall30@1 > 1000

现在，在单独的栅格中分别拥有所有三个条件，您需要将它们组合起来，便于查看哪些区域满足所有条
件。为此，栅格将彼此相乘。产生这种情况时，所有重叠像素的值为 1时将保留 1的值 (即位置符合要
求)，但如果三个栅格中的任何一个像素的值为 0 (即位置不符合条件)，则结果将为 0。这样，结果将只
包含满足所有适合条件的重叠区域。

8.4.15 组合栅格

1. 打开栅格计算器 (栅格 ►栅格计算器...)
2. 构建以下表达式 (为图层使用适当的名称):

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. 将输出位置设置为 Rasterprac目录

4. 将输出栅格命名为 aspect_slope_rainfall.tif

5. 确保已勾选 执行算法后打开输出文件

6. 单击运行
新栅格现在可以正确显示满足所有三个条件的区域。

保存工程。

图 8.9: Map view where all three criteria are satisfied

需要满足的下一个条件是，该区域必须距离市区 250米。将通过确保我们计算的面积在农村地区内，并
且距离该地区边缘 250米或以上来满足这一要求。因此，需要首先找到所有的农村地区。

8.4.16 寻找农村地区

1. 在图层面板隐藏所有图层
2. 取消隐藏 Zoning矢量图层

3. 右键单击并打开属性表对话框。请注意，这片土地有许多不同的分区方式，我们想分离农村地区。
关闭属性表

4. 右键单击 Zoning图层并选择过滤... ，打开查询构建器对话框

5. 构建以下查询:

"Gen_Zoning" = 'Rural'

如果您遭到困难，请参阅前面的操作指南。

6. 单击确定关闭查询构建器对话框。查询应该返回一个要素

Query builder Zoning
应该可以从 Zoning图层看到表示农村的多边形。您需要进行保存。

1. 在 Zoning图层的右键单击菜单中，选择导出 ►要素另存为...
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2. 将图层保存在 Rasterprac目录中

3. 命名输出文件为 rural.shp

4. 单击确定
5. 保存工程

现在需要排除距离农村地区边缘 250 米以内的区域，这通过创建负缓冲区来实现。如下所述。

8.4.17 创建负缓冲区

1. 单击菜单项矢量 ►地理处理工具 ►缓冲区...

2. 在出现的对话框中，选择 rural图层作为输入矢量图层 (不应勾选仅选中的要素)
3. 将距离设置为 -250，负值表示缓冲区将是一个内部缓冲区。确保下拉菜单中的单位为米。

4. 勾选 融合结果

5. 在缓冲区建立后，将输出文件保存在 Rasterprac目录中，并将其命名为 rural_buffer.shp

6. 单击保存
7. 单击运行并等待完成数据处理
8. 关闭缓冲区对话框
为确保您的缓冲区正常工作，请注意 rural_buffer图层与 rural图层的差异。为了观察差异，
可能需要更改绘图顺序。

9. 移除 rural图层

10. 保存工程
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图 8.10: Map view with rural buffer

现在，您需要将 rural_buffer矢量图层与 aspect_slope_rainfall栅格相结合。要将它们组合
起来，我们需要更改其中一个图层的数据格式。在这种情况下，您将对栅格进行矢量化，因为在计算面
积时，矢量图层更方便。

8.4.18 矢量化栅格

1. 单击菜单项栅格 ►转换 ►栅格矢量化 (栅格转矢量)...

2. 选择 aspect_slope_rainfall栅格作为输入图层

3. 将新建字段名称设置为 suitable (默认字段名为 DN - Digital Number数据)
4. 保存输出。在 矢量化中选择 文件另存为，将位置设置为 Rasterprac ，并命名文件为

aspect_slope_rainfall_all.shp

5. 确保已勾选 执行算法后打开输出文件

6. 单击运行
7. 数据处理完成后关闭对话框
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图 8.11: Raster to Vector

栅格的所有区域都已矢量化，因此只需在 suitable的字段中选择值为 1的区域 (数字量化值 - Digital
Number)。

1. 打开新矢量图层的查询构建器对话框 (右键单击 -过滤...)
2. 构建此查询:

"suitable" = 1

3. 单击确定
4. 确定查询完成后 (只有满足所有三个条件的区域，即值为 1的区域可见)，从结果新建矢量文件，在
图层的右键单击菜单中使用导出 ►要素另存为...

5. 将该文件保存在 Rasterprac目录中

6. 命名文件为 aspect_slope_rainfall_1.shp

7. 从地图中移除 aspect_slope_rainfall_all图层

8. 保存您的工程
当我们使用算法对栅格进行矢量化时，有时该算法会产生所谓的”无效几何图形”，即存在空多边形，或
其中存在错误的多边形，这将在未来很难进行分析。所以，我们需要使用”修正几何图形”工具。
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8.4.19 修正几何图形

1. 在处理工具箱搜索并执行... ”修正几何图形”
2. 对于输入图层请选择 aspect_slope_rainfall_1

3. 在 已修正几何图形中选择 文件另存为，将输出保存到 Rasterprac ，并将文件命名为
fixed_aspect_slope_rainfall.shp

4. 确保已勾选 执行算法后打开输出文件

5. 单击运行
6. 数据处理完成后关闭对话框

现 在， 已 经 对 栅 格 进 行 了 矢 量 化， 并 修 复 了 生 成 的 几 何 图 形， 可 以 通 过
fixed_aspect_slope_rainfall 图层和 rural_buffer 图层的交集，将坡向、坡度和降雨
条件与距离人类居住区条件进行组合。

8.4.20 确定矢量的交集

1. 单击菜单项矢量 ►地理处理工具 ►相交...

2. 在出现的对话框中，选择 rural_buffer图层作为输入图层

3. 对于叠加图层，选择 fixed_aspect_slope_rainfall图层

4. 在相交中，将输出文件保存在 Rasterprac目录

5. 将输出文件命名为 rural_aspect_slope_rainfall.shp

6. 单击保存
7. 单击运行并等待完成数据处理
8. 关闭相交对话框
请注意仅保留重叠区域，以确保您的相交处理正确。

9. 保存工程
列表中的下一个条件是面积必须大于 6000平米。现在，您将计算多边形区域，以确认适合此工程的区
域大小。

8.4.21 计算每个多边形的面积

1. 打开新矢量图层的右键单击菜单
2. 选择打开属性表

3. 单击表格左上角的 切换编辑模式 按钮，或按 Ctrl+E

4. 单击表格顶部工具栏的 打开字段计算器 按钮，或按 Ctrl+I

5. 在出现的对话框中，确保勾选了 新建字段，并将输出字段名称设置为 area，输出字段类型应
为小数 (实型)，将精度设置为 1 (一位小数)。

6. 在表达式文本框中，键入:

$area

这意味着字段计算器将计算矢量图层中每个多边形的面积，然后用计算值填充一个新的整型列 (称
为 area)。
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图 8.12: Field Calculator

7. 单击确定
8. 对另一个名为 id的新字段执行同样的操作。在字段计算器表达式中，键入:

$id

这样可以确保每个多边形都有一个唯一的 ID，便于识别。

9. 再次单击 切换编辑模式 ，并在提示时保存编辑
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图 8.13: Attribute table with area and id columns

8.4.22 选择给定大小的区域

现在，这些区域都已经知道了：

1. 构建查询 (像之前一样)，只选择大于 6000平米的多边形。查询是:

"area" > 6000

2. 在 Rasterprac目录保存选择并命名为 suitable_areas.shp的新矢量图层。

现在，已经拥有了满足稀有植物凡波斯所有生活环境符合条件的区域，您将从中选择离开普敦大学最近
的四个区域。

8.4.23 数字化开普敦大学

1. 和之前一样，在 Rasterprac目录中新建一个矢量图层，但这次，使用点作为几何图形类型，并
将其命名为 university.shp

2. 确保其是合适的 CRS (工程 CRS:EPSG:32733 - WGS 84 / UTM zone 33S)
3. 完成创建新图层 (单击确定)
4. 隐藏除新建 university图层和 Streets图层之外的所有图层

5. 添加背景地图 (OSM):
1. 转到浏览器面板并导航至 XYZ瓦片 ►开放街道地图
2. 将开放街道地图条目拖放到图层面板的底部
使用您的互联网浏览器，查找开普敦大学的位置。鉴于开普敦独特的地形，该大学位于非常知名的
位置。在返回 QGIS之前，请注意大学所在的位置，以及附近的情况。
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6. 确保已单击 Streets图层，并且图层面板中高亮显示 university图层

7. 导航至视图 ►工具栏菜单项，并确保已选中数字化工具栏。然后您会看到一个带有铅笔的工具栏
图标 ( 切换编辑模式)。这是切换编辑按钮

8. 单击切换编辑模式按钮进入编辑模式。这允许您编辑矢量图层

9. 单击 添加点要素 按钮，该按钮应位于 切换编辑模式 按钮附近

10. 激活添加要素工具后，左键单击开普敦大学位置的最佳估计值
11. 当要求输入 id时，请提供任意整数

12. 单击确定

13. 单击 保存图层编辑 按钮

14. 单击切换编辑模式按钮停止编辑会话
15. 保存工程

8.4.24 查找距离普敦大学最近的位置

1. 转到处理工具箱，找出并执行按最近的方式连接属性算法 (矢量通用 ►按最近的方式连接属性)
2. 输入图层应为 university，输入图层 2是 suitable_areas

3. 设置适当的输出位置和名称 (被连接图层)
4. 将最大近邻设置为 4

5. 确保已勾选 执行算法后打开输出文件

6. 保留其余参数的默认值
7. 单击运行

生成的点图层将包含四个要素 -它们都将具有大学的位置及其属性，此外，附近合适区域的属性 (包括
id )以及到该位置的距离。

1. 打开连接结果的属性表
2. 记录四个最近合适区域的 id，然后关闭属性表

3. 打开 suitable_areas图层的属性表

4. 构建查询，以选择离大学最近的四个合适区域 (使用 id字段选择它们)
这是本课探索问题的最终答案。

提交时，请创建完整标注的布局，其中包括半透明的山体阴影图层，覆盖在您选择的引人入胜的栅格上
(例如 DEM或坡度栅格)。还包括大学和 suitable_areas图层，突出显示离大学最近的四个合适区域。
在创建输出地图时，应遵循所有制图的最好做法。
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CHAPTER9

单元: 插件

插件允许您扩展 QGIS提供的功能。在本单元，您将了解如何激活和使用插件。

9.1 课: 安装和管理插件

要开始使用插件，您需要了解如何下载、安装和激活它们。为此，您将学习如何使用插件安装程序和插
件管理器。

本课目标: 了解和使用 QGIS的插件系统。

9.1.1 跟我做: 管理插件

1. 要打开插件管理器，请单击菜单项插件 ►管理并安装插件。
2. 在打开的对话框中，请查找 Processing插件：
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3. 单击此插件旁边的方框，取消勾选以停止使用。
4. 单击关闭。
5. 查看菜单，您会注意到数据处理菜单现在不见了。这意味着您以前使用过的许多数据处理功能都
消失了！例如，矢量►和栅格►菜单。这是因为它们是数据处理插件的一部分，需要激活该插件
才能使用。

6. 再次打开插件管理器，单击 Processing旁边的复选框重新激活该插件。

7. 关闭对话框，数据处理菜单及相应功能应再次可用。

9.1.2 跟我做: 安装新插件

可以激活和停用的插件列表，来自您当前已安装的插件。要安装新插件，请执行以下操作：

1. 在插件管理器对话框中选择未安装选项卡。这里将列出可供您安装的插件，此列表根据您现有的
系统设置而有所不同。
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2. 通过在列表中选择插件来查找有关插件的信息。

3. 点击插件信息面板下方的安装插件按钮，安装您感兴趣的插件。

备注: 如果插件有错误，将被列在无效选项卡中。然后，您可以联系插件所有者来解决这个问题。

9.1.3 跟我做: 配置其他插件库

可供您安装的插件取决于配置使用的插件库。

QGIS插件在线存储在插件库中。默认情况下，只有官方插件库处于启用状态，这意味着您只能访问在
那里发布的插件。鉴于可用工具的多样性，此插件库应该能够满足您的大部分需求。

然而，可以尝试使用除默认插件库外更多的插件。首先，您需要配置其他插件库。为此：

1. 打开插件管理器对话框中的设置选项卡。
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2. 单击增加按钮，查找并添加新插件库。
3. 为您要配置的新插件库输入名称和 URL，并确保勾选启用复选框。

4. 现在，您在已配置插件库列表中将看到新添加的插件库。
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5. 您还可以通过勾选显示试验性插件复选框来选择显示实验插件的选项。
6. 如果现在切换回未安装选项卡，您将看到其他插件可供安装。
7. 要安装插件，请单击列表中的插件，然后单击安装插件按钮。

9.1.4 In Conclusion

在 QGIS中安装插件应该简单有效！

9.1.5 What’s Next?

接下来，我们将向您介绍一些常用的插件作为示例。

9.2 课: 常用的 QGIS插件

现在，您可以安装、启用和禁用插件了。让我们通过一些常用插件的示例，来了解这在实践中如何操作。

本课目标: 熟悉插件界面，并了解一些有用的插件。
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9.2.1 跟我做: QuickMapServices插件

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. 新建工程并从 training_data Geopackage中添加 roads图层。

2. 安装 QuickMapServices插件。
3. Click on Web ► QuickMapServices. The first menu lists different map providers (OSM, NASA) with available

maps.
4. Click on an entry and you would load the base map into your project.

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click onWeb ► QuickMapServices ► Settings

2. Go to the More services tab.
3. 仔细阅读此选项卡的信息，如果您同意，请单击 Get Contributed pack按钮。

4. Click Save.
5. Reopen theWeb ► QuickMapServices menu you will see that more providers are available.
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6. Choose the one that best fits your needs, and load the data in the project!
It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking onWeb► QuickMapServices► Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.
4. The base map will be loaded and you will have a background for the map.
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9.2.2 跟我做: QuickOSM插件

QuickOSM插件有着令人难以置信的简洁界面，可以让您下载开放街道地图数据。
1. 启动一个新的空工程，并从 training_data GeoPackage添加 roads图层。

2. 安装QuickOSM插件。该插件在 QGIS工具栏中添加了两个新按钮，并可以在矢量► QuickOSM 菜
单访问。由于 QuickOSM已完全汉化，以下涉及到该软件的界面将使用中文。

3. 打开 QuickOSM对话框。该插件有许多不同的选项卡：我们将使用快速查询。
4. 您可以通过选择常用关键字下载指定要素，也可以更具体地选择指定的关键字和值对。

小技巧: 如果您不熟悉关键字和值的方法，请单击关键字/值帮助按钮，它将打开完整描述开放街
道地图概念的网页。

5. 在关键字菜单查找 railway，并将其值设为空：如此，我们将下载所有 railway要素，而不指定具
体值。

6. 在下一个下拉菜单中选择图层范围，然后选择 roads。

7. 单击运行查询按钮。

几秒钟后，插件将下载开放街道地图中标记为 railway的所有要素，并将它们直接加载到地图中。

仅此而已！所有图层都加载到图例中，并显示在地图画布。

310 Chapter 9. 单元: 插件

https://www.openstreetmap.org/


QGIS Training Manual

警告: QuickOSM在下载数据时创建临时图层。如果要永久保存，请单击图层旁边的 图标，然后
选择您喜欢的选项。或者，可以在 QuickOSM中打开高级菜单，并在目录菜单中选择保存数据的位
置。

9.2.3 跟我做: QuickOSM查询引擎

从 QuickOSM插件下载数据的最快方法是使用快速查询选项卡并设置一些小参数。但如果您需要更具体
的数据呢？

如果您是开放街道地图查询大师，也可以在个性查询中使用 QuickOSM插件。
QuickOSM有一个令人难以置信的数据解析器，再加上令人惊叹的 Overpass查询引擎，可以让您根据自
己的特定需求下载数据。

例如：我们想下载属于 Dolomites指定山区的山峰。
使用快速查询选项卡无法完成此任务，必须更具体编写自己的查询。让我们尝试完成这样的任务。

1. 启动一个新工程。
2. 打开 QuickOSM插件并单击查询选项卡。
3. 将以下代码复制并粘贴到查询画布中:

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

备注: 此查询是用类似 xml语言编写的。如果您更习惯 Overpass QL，也可以用这种语言编写
查询。

4. 然后单击运行查询：
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将下载山峰图层，并在 QGIS中显示：

您可以使用 Overpass查询语言编写复杂的查询。查看一些例子，并尝试探索该查询语言。

9.2.4 跟我做: DataPlotly插件

The DataPlotly plugin allows you to create D3 plots of vector attributes data thanks to the plotly library.
1. 开始一个新工程
2. 从 exercise_data/plugins文件夹加载 sample_points图层

3. 按照 Follow Along: Installing New Plugins中描述的方法搜索 Data Plotly插件并进行安装

4. 单击工具栏中的新图标或插件 ► Data Plotly菜单打开该插件

在下面的示例中，我们将创建 sample_points图层的两个字段的散点图。在 DataPlotly面板中：
1. 在图层过滤器中选择 sample_points，X Field选择 cl，Y Field选择 mg：
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2. 如果需要，可以更改颜色、标记类型、透明度和许多其他设置。尝试更改一些参数以创建下面的图
表。
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3. 设置完所有参数后，单击 Create Plot按钮创建图表。

图表是交互式的：这意味着您可以使用上面的所有按钮来重新调整图表画布的大小、移动或放大/缩小。
此外，图表的每个元素都是交互式的：通过单击或选择图表上的一个或多个点，将在图表画布中选择相
应的点。

通过单击 或图表右下角的 按钮，可以将图表保存为 png静态图像或 html文件。

还有更多。有时，在同一页面上有两个 (或更多)显示不同图表类型和不同变量的图表是非常有用的。让
我们开工吧！

1. 单击插件面板左上角的 按钮，返回主图表设置选项卡

2. 将 Plot Type更改为 Box Plot

3. 选择 group作为 Grouping Field，选择 ph作为 Y Field

4. 在面板下部，将 Type of Plot从 SinglePlot更改为 SubPlots，并选择默认选项 Plot in Rows。

5. 完成后，单击 Create Plot按钮绘制图表
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现在散点图和箱形图都显示在同一图表页面中。您仍然可以单击每个图表项，并在地图画布中选择相应
的要素。

小技巧: 每个图表在 选项卡中都有自己的手册页。尝试探索所有图表类型，并查看所有其他可用设
置。

9.2.5 In Conclusion

QGIS有很多实用的插件。使用内置工具来安装和管理这些插件，您可以找到新的插件并充分利用它们。

9.2.6 What’s Next?

接下来，我们将了解如何实时使用托管在远程服务器上的图层。
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单元: 在线资源

在考虑地图的数据源时，无需仅限于保存在正在使用的计算机上的数据。只要连接到互联网，就可以从
在线数据源加载数据。

在本单元，我们将介绍两种基于Web的 GIS服务：Web地图服务 (WMS)和Web要素服务 (WFS)。

10.1 课: Web地图服务

Web地图服务 (WMS)是托管在远程服务器上的服务。与网站类似，只要连接到服务器，就可以进行访
问。使用 QGIS，您可以将WMS直接加载到现有地图中。
例如，从插件的课程中，您将想起，可以从谷歌加载新的栅格图像。然而，这是一次性事务：一旦您下
载了图像，就无法更改。WMS不同之处在于，它是实时服务，如果您在地图上平移或缩放，就会自动刷
新视图。

本课目标: 使用WMS并了解其局限性。
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10.1.1 跟我做: 加载WMS图层

在本练习中，您可以使用课程开始时制作的底图，也可以启动新地图并将一些现有图层加载到其中。在
本例中，我们使用了新地图，加载了原始 places, landuse和 protected_areas图层，并调整了符号：

1. 将这些图层加载到新地图中，或使用仅显示这些图层的原始地图。
2. 开始添加WMS图层之前，请停用”动态”投影 (工程 ►工程属性... ► CRS 选项卡,勾选无 CRS (或
未知/非地球投影)。这可能会导致图层不再正确重叠，但别担心，我们稍后会解决这个问题。

3. 要添加WMS图层，请单击 按钮打开数据源管理器对话框，并启用 WMS/WMTS选项卡。
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还记得您在课程开始时是如何连接 SpatiaLite或 GeoPackage数据库的吗？landuse, buildings和 roads
图层存储在数据库中。要使用这些图层，首先需要连接到数据库。使用WMS与此类似，只是图层
位于远程服务器上。

4. 要创建与WMS的新连接，请单击新建按钮。
您需要WMS地址才能继续。互联网上有几台免费的WMS服务器。其中一台是 terrestris，它使用
了 OpenStreetMap数据集。

5. 要使用此WMS，请在当前对话框中进行如下设置：
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• 名称字段的值应为 terrestris。

• URL字段的值应为 https://ows.terrestris.de/osm/service。

6. 单击确定。您应该会看到新的WMS服务器列表：
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7. 单击连接。在下面的列表中，您现在应该可以看到加载的这些新条目：
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这些都是此WMS服务器托管的图层。
8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the

number of CRSes supported by the dataset:
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Since we’re not using EPSG:4326 - WGS 84 for our map, let’s find one that meets our needs.

1. Click the Select CRS button. Youwill see a standardCoordinate Reference System Selector dialog showing
all the CRS the data is published with.

2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG:3857. You can use
the top Filter widget.
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1. 单击确定。与条目关联的坐标参照系已更改。
9. Click Add to load the layer in your project using Layer name‘ (default is OpenStreetMap WMS - by terrestris).
10. 如果未自动完成，请关闭数据源管理器对话框。
11. 在图层面板，单击并将其拖动到列表底部。
12. 缩小以获得图层的全局视图。您会注意到图层的位置不正确 (靠近非洲西部)，这是因为”动态”投
影被禁用。
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13. 再次启用重投影，但使用与开放街道地图WMS图层相同的投影，即WGS 84 / Pseudo Mercator。

1. 打开工程 ►工程属性... ► CRS选项卡

2. 取消勾选无 CRS (或未知/非地球投影)

3. 从列表中选择WGS 84 / Pseudo Mercator。
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4. 单击确定。
14. 现在，在图层面板中您自己的一个图层上右键单击，然后单击缩放到图层。您应该看到 Swellendam
地区：
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请注意WMS图层的街道和我们自己的街道是如何重叠的。这是个好兆头！

WMS的特点和局限性

到目前为止，您可能已经注意到，这个WMS图层实际上有很多要素，比如街道、河流、自然保护区等
等。更重要的是，尽管看起来像是由矢量组成的，但它似乎是栅格，您无法更改其符号。为什么？

这就是WMS的工作原理：它是一张地图，类似于纸上的普通地图，您可以将其作为图像接收。通常的
情况是，你有矢量图层，QGIS将其渲染为地图。但是使用WMS时，这些矢量图层位于WMS服务器，
该服务器将其渲染为地图，并将该地图作为图像发送给您。QGIS可以显示此图像，但不能更改其符号，
因为所有这些都是在服务器上处理的。

这有几个优点，因为您无需担心符号。这已经解决了，在任何设计得当的WMS上都可以看到。
另一方面，如果您不喜欢符号，也无法将其修改。如果WMS服务器上进行了更改，那么您的地图也随
之变化。这就是为什么有时需要使用Web要素服务 (WFS)，它单独提供矢量图层，而不是作为WMS样
式地图的一部分。

This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 Try Yourself

1. Add the eAtlasWMS server at this URL: https://maps.eatlas.org.au/maps/wms
2. Load aWorld: Hillshading layer into the map.
3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.
4. Your map should look like this (you may need to re-order the layers, and apply some transparency):

回答

1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry
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2. Use the text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 Try Yourself

使用WMS的部分困难在于找到一个好的 (免费)服务器。
• 在 directory.spatineo.com (或其他在线网站)中查找新的WMS。不得有相关费用或限制，且必须覆盖
Swellendam研究区域。
请记住，使用WMS所需的只是其 URL (最好是某种描述)。

回答

Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.
You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes it
is permanent. An example of a WMS server that worked at the time of writing is the MapServer Demonstra-
tion Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&REQUEST=
GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does satisfy the
requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers to choose
from.
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10.1.4 Try Yourself

• Add the bluemarble layer from the MapServer Demonstration Server. Is that a suitable dataset for our study
area?

回答

1. 隐藏所有其他WMS图层，防止它们在后台进行不必要的渲染。
2. 使用与之前相同的方法添加新服务器和该服务器上托管的相应图层：

3. 如果放大 Swellendam地区，您会注意到该数据集的分辨率较低：
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因此，最好不要将这些数据用于当前地图。Blue Marble数据更适用于全球或全国范围

10.1.5 In Conclusion

使用WMS，可以将非活动地图添加为现有地图数据的后面。

10.1.6 Further Reading

• Spatineo Directory
• OpenStreetMap.org list of WMS servers

10.1.7 What’s Next?

现在，已经添加了非活动地图作为背景，您将很高兴地知道，还可以添加要素 (例如之前添加的其他矢量
图层)。通过使用Web要素服务 (WFS)，可以从远程服务器添加要素。这是下一课的主题。

10.2 课: Web要素服务

Web要素服务 (WFS)为用户提供可以直接在 QGIS中加载的格式的 GIS数据。与WMS不同，WMS只为
您提供无法编辑的地图，而WFS则为您提供对要素本身的访问。
本课目标: 使用WFS并了解与WMS的区别。
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10.2.1 跟我做: 加载WFS图层

1. 新建地图。这仅用于演示目的，不会被保存。

2. 单击 打开数据源管理器 按钮。

3. 开启 WFS / OGC API -要素选项卡。

4. 单击新建按钮。
5. 在出现的对话框中，输入 名称为 nsidc.org ，URL 为 https://nsidc.org/cgi-bin/

atlas_south?version=1.1.0。

6. 单击确定，新建连接将显示在服务器连接中。
7. 单击连接。将显示可用图层的列表：
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8. 取消勾选图层列表下方的仅请求与视图范围重叠的要素选项，因为您当前的地图画布可能无法涵
盖我们关注区：南极洲。

9. 查找 antarctica_country_border图层。您可以使用顶部的过滤器栏。

10. 单击图层将其选中。
11. 查找并选择 south_poles_wfs图层。您可能需要按住 Ctrl键。
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12. 单击添加。
加载图层可能需要一段时间。加载后它们将出现在地图上，显示南极洲的轮廓和几个点。
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这与使用WMS图层有什么不同呢？
13. 选择任意图层，您都会注意到要素选择和属性表工具已启用。这些是矢量图层。
14. 选择 south_poles_wfs图层并打开其属性表。您应该看到以下内容：

由于这些点具有属性，我们可以为其添加标注，并更改符号。下面是一个例子：
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与WMS图层的差异

Web要素服务返回图层本身，而不仅仅是从图层渲染的地图。这使您可以直接访问数据，并可以更改其
符号并运行分析功能。然而，这是以传输大量数据为代价的。如果正在加载的图层具有复杂的形状、大
量属性或许多要素，这一点尤其明显；或者即使只是加载了很多图层。因此，WFS图层通常需要很长时
间才能加载完毕。

10.2.2 跟我做: 查询WFS图层

虽然可以在加载WFS图层后进行查询，但在加载之前对其查询通常更有效。这样，只需请求所需的要
素，这意味着您使用的带宽要少得多。

例如，在我们目前使用的WFS服务器中，有一个名为 countries (不包括南极洲)的图层。比如，我们想知
道南非相对于已经加载的 south_poles_wfs图层 (可能还有 antarctica_country_border图层)的位置。
有两种方法可以做到。加载整个 countries ... 图层，然后在加载后像往常一样构建查询。然而，传输世界
上所有国家的数据，然后只使用南非的，似乎有点浪费带宽。根据您的连接，加载此数据集可能需要几
分钟。

另一种方法是从服务器加载图层之前将查询构建为过滤器。

1. 在 Data Source Manager对话框中启用WFS / OGC API要素选项卡

2. 连接到我们之前使用的服务器，您应该会看到可用图层的列表。
3. 查 找 并 双 击 countries (不 包 括 南 极 洲) 图 层。 图 层 名 为

country_borders_excluding_antarctica 。也可以选择图层，然后按对话框底部的
构建查询按钮：
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4. 在 出 现 的 对 话 框 的 SQL 语 句 框 中 键 入 以 下 SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South
Africa'查询内容。

5. 按确定。
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6. 使用的表达式将显示为目标图层的 Sql值：

7. 单击添加选中的如上所示图层。只有 Countryeng值为 South Africa的国家才能从该图层加
载：
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您注意到 country_borders_excluding_antarctica图层旁边的 图标了吗？它表示加载
的图层已过滤，不会在工程中显示其所有要素。

8. 您不必这么做，但是如果尝试了这两种方法，会注意到这比在过滤所有国家之前加载数据要快得
多！

关于WFS有效性的说明

如果需求非常具体，那么很难找到您需要的WFS托管要素。Web要素服务相对较少的原因是：为了描述
整个要素，必须传输大量数据。因此，相对于WMS仅发送图像而言，托管WFS并不是很划算。
所以，您遇到最常见的WFS类型可能是在本地网络，甚至是在您自己的计算机中，而不是在互联网上。
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10.2.3 In Conclusion

如果需要直接访问图层的属性和几何图形，WFS图层优于WMS图层。然而，考虑到需要下载的数据量
(这会导致速度问题，也会缺乏易于使用的公共WFS服务器)，并不总是可以使用WFS而不是WMS。

10.2.4 What’s Next?

接下来，您将看到如何使用 QGIS服务器提供 OGC服务。
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单元: QGIS服务器

本单元由 Tudor Bărăscu投稿。
在本单元，我们将介绍如何安装和使用 QGIS服务器。
要了解有关 QGIS服务器的更多信息，请阅读 QGIS-Server-manual。

11.1 课: 安装 QGIS Server

本课目标: 了解如何在Debian Stretch安装QGIS Server。您也可以在任何基于Debian的发行版 (如Ubuntu
及其衍生系统)中安装与使用，只是有点微不足道的差异。

备注: 在 Ubuntu中，您可以是普通用户身份，并在使用 sudo命令时获取管理员权限。在 Debian中，您
可以作为管理员 (root)工作，而无需使用 sudo。

11.1.1 跟我做: 从软件包安装

在本课，我们将只从此处所示的软件包中进行安装。

安装 QGIS Server使用：

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python3-qgis

QGIS Server不应与 QGIS Desktop (以及附带的 X服务器)安装在同一台机器的情况下用于生产环境。
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11.1.2 跟我做: QGIS Server可执行文件

QGIS Server 可 执 行 文 件 是 qgis_mapserv.fcgi 。 您 可 以 通 过 运 行 find / -name
'qgis_mapserv.fcgi'来检查它的安装位置，应该输出如 /usr/lib/cgi-bin/qgis_mapserv.
fcgi这样的内容。

或者，如果此时要执行命令行测试，可以运行 /usr/lib/cgi-bin/qgis_mapserv.fcgi
--version命令，应该输出如下内容：

QGIS 3.21.0-Master 'Master' (1c70953f1e)
QGIS code revision 1c70953f1e
Qt version 5.15.2
Python version 3.9.5
GDAL/OGR version 3.2.2
PROJ version 7.2.1
EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2
SQLite version 3.34.1
OS Ubuntu 21.04

稍后我们将了解如何发出WMS请求。

11.1.3 HTTP Server配置

为了从互联网浏览器访问已安装的 QGIS服务器，我们需要使用 HTTP服务器。Apache HTTP服务器的
安装方法在 httpserver一节中有详细说明。

备注: 如果安装 QGIS Server时没有运行 X服务器 (包含在 Linux Desktop中)，并且还想使用 GetPrint
命令，那么应该安装一个模拟 X服务器，并告诉 QGIS服务器使用它。您可以通过学习 Xvfb安装方法来
实现。

11.1.4 跟我做: 创建另一个虚拟主机

让我们创建另一个指向 QGIS服务器的 Apache虚拟主机。可以选择任何您喜欢的名称 (coco.bango,
super.duper.training, example.com等等)，但为了简单起见，我们将使用 myhost。

• 让我们使用以下命令: sh -c "echo '127.0.0.1 myhost' >> /etc/hosts"，或手动编辑
文件 gedit /etc/hosts，将 127.0.0.1 x添加到 /etc/hosts来设置 myhost名称以指向
本地主机 IP。

• 可以通过在终端运行 ping myhost命令来检查 myhost是否指向本地主机，该命令应输出：

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms

• 让我们尝试一下是否可以通过执行以下命令从 myhost站点访问 QGIS服务器: curl http://
myhost/cgi-bin/qgis_mapserv.fcgi或者从 Debian box浏览器访问 URL。您可能会得到：

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>

(续下页)
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(接上页)
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache不知道他应该回答指向名为 myhost服务器的请求。为了设置虚拟主机，最简单的方法是
在 /etc/apache2/sites-available目录中创建一个 myhost.conf文件，其内容与 qgis.
demo.conf相同，但 ServerName行应为 ServerName myhost。您还可以更改日志的位置，
否则两个虚拟主机的日志将被共享，但这是可选的。

• 现在让我们使用 a2ensite myhost.conf 启用虚拟主机，然后使用 service apache2
reload重新加载 Apache服务。

• 如果您再次尝试访问 http://myhost/cgi-bin/qgis_mapserv.fcgi URL，您会注意到现在一切正常！

11.1.5 In Conclusion

您学习了如何从软件包中安装不同的 QGIS服务器版本，如何在基于 Debian的 Linux发行版使用 QGIS
服务器配置 Apache。

11.1.6 What’s Next?

现在您已经安装了 QGIS服务器，并且可以通过 HTTP协议访问，我们需要了解如何访问它可以提供的
一些服务。下一课的主题是学习如何访问 QGIS Server WMS服务。

11.2 Lesson: Serving WMS

The data used for this exercise are available in the qgis-server-tutorial-data subdirectory of the training
data you downloaded. For convenience and to avoid possible permissions problems, we will assume that these files
are stored in /home/qgis/projects directory. Hence, adapt the following instructions to your path.
The demo data contains a QGIS project named world.qgs that is already prepared to be served with QGIS Server.
If you want to use your own project or you want to learn how a project is prepared see the Creatingwmsfromproject
section.

备注: This module presents the URLs so that the audience can easily distinguish the parameters and parameters
values. While the normal format is:

...&field1=value1&field2=value2&field3=value3

this tutorial uses:

&field1=value1
&field2=value2
&field3=value3

Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces
between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the
URLs so that they’re in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:
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http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to /
home/qgis/projects/world.qgs. However, in the above request we made use of themap parameter to be
explicit and to show it can be used to point at any project. If you delete the map parameter from the above request
QGIS Server will output the same response.
By pointing any WMS client to the GetCapabilities URL, the client gets in response an XML document with
metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in what
format, what version of WMS etc.
As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabilities
url. See the Lesson: Web Mapping Services or the ogc-wms-servers section on how to do it.
By adding the countriesWMS layer to your QGIS project you should get an image like the one below:

图 11.1: QGIS Desktop consuming the QGIS Server countries layer WMS service
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备注: QGIS Server serves layers that are defined in the world.qgs project. By opening the project with QGIS
you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can choose
the style you want in your request. The classified_by_population style was chosen in the above image.

11.2.1 Logging

When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup in
the *.conf file the following logs:

• QGIS Server log at /logs/qgisserver.log
• qgisplatform.demo Apache access log at qgisplatform.demo.access.log
• qgisplatform.demo Apache error log at qgisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tail command
in a terminal: sudo tail -f /logs/qgisserver.log.
This will continuously output in the terminal what’s written in that log file. You can also have three terminals opened
for each of the log files like so:
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图 11.2: Using the tail command to visualise QGIS Server logs output

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS sends
to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

备注:
• If you look at the logs in the following sections you should get a better understanding on what’s happening.
• By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things
work.
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11.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.
A simple request looks like:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

The above request should output the following image:
Figure: simple GetMap request to QGIS Server

图 11.3: Qgis Server response after a simple GetMap request
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11.2.3 Try Yourself Change the Image and Layers parameters

Based on the request above, let’s replace the countries layer with another.
In order to see what other layers are available you could open up the world.qgs project in QGIS and look at its
contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the
capabilities document contents.
Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS when
serving the WMS service.
So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could
try yourself finding other layer names in the GetCapabilities XML response.
One of the layer names that you could find and works is countries_shapeburst. You may find others but
keep in mind some may not be visible at such a small scale so you could get a blank image as response.
You can also play around with others parameters from above, like changing the returned image type to image/png.

11.2.4 Follow Along: Use Filter, Opacities and Styles parameters

Let’s do another request that adds another layer, some basic parameters, FILTER and OPACITIES, but also uses
the standard STYLES parameter.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

The above request should output the following image:
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图 11.4: Response to a GetMap request with FILTER and OPACITIES parameters

As you can see from the above image, among other things, we told QGIS Server to render only Germany and Italy
from the countries layer.

11.2.5 Follow Along: Use Redlining

Let’s do another GetMap request that makes use of the redlining feature and of the SELECTION parameter detailed
in the Basics section:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣

(续下页)
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(接上页)
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Pasting the above request in your web browser should output the following image:

图 11.5: Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania
and France) by using the SELECTION parameter and we used theREDLINING feature to overlay a rectangle with
the QGIS Tutorial label.
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11.2.6 GetPrint requests

One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print layouts. You can learn about it
in the wms_getprint section.
If you open the world.qgs project with QGIS Desktop you will find a print layout named Population
distribution. A simplified GetPrint request that exemplifies this amazing feature is:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

图 11.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.
QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish your
projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.
You can install it like this:

• As user qgis go to the home directory with cd /home/qgis.
• Download the QWC project from here and unzip it.
• Make a symbolic link to the /var/www/html directory as it’s the DocumentRoot that we’ve setup
in the virtual host configuration. If you unzipped the archive under /home/qgis/Downloads/
QGIS-Web-Client-master we can do that with sudo ln -s /home/qgis/Downloads/
QGIS-Web-Client-master /var/www/html/.

• Access http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs from your Web browser.

Now you should be able to see the Map as in the following figure:
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图 11.7: QGIS Web Client consuming the world.qgs project

If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ? icon
in the QWC to access the available help so that you can better discover the QWC possibilities.

11.2.7 In Conclusion

You learned how use QGIS Server to provide WMS Services.

11.2.8 What’s Next?

Next, you’ll see how to use QGIS as a frontend for the famous GRASS GIS.
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Module: GRASS

GRASS (Geographic Resources Analysis Support System) 是一款著名的、具有广泛用途且功能强大的开源
GIS系统。于 1984年首次发布以来，做了大量改进，加入许多新功能。QGIS允许您直接使用 GRASS强
大的 GIS工具集。

12.1 课: GRASS安装

在 QGIS中使用 GRASS，需要适应略微不同工作方式的界面。请记住，您不是直接使用 QGIS，而是通
过 QGIS在 GRASS中工作。因此，请确保已经安装了支持 GRASS的 QGIS Desktop。
要在Windows使用 GRASS打开 QGIS会话，您必须单击 QGIS Desktop with GRASS图标。

本课目标: 在 QGIS中创建 GRASS工程。
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12.1.1 跟我做: 新建 GRASS会话

要从 QGIS启动 GRASS，您需要像使用任何其他插件一样先进行激活：
1. 首先，打开一个新的 QGIS工程。
2. 在插件管理器的列表中启用 GRASS：

GRASS工具栏和 GRASS面板将出现：

图 12.1: GRASS工具栏
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图 12.2: GRASS面板

GRASS面板未激活，因为在使用 GRASS之前，需要创建地图集。GRASS始终在数据库环境中工作，这
意味着您需要将所有要使用的数据导入 GRASS数据库。
GRASS数据库的结构非常简单，尽管第一次看到时感觉似乎非常复杂。您应该知道的最重要的一点是，
数据库的上层是位置。每个位置可以包含不同的地图集：在每个地图集中，您都会找到永久地图集，
因为它默认由 GRASS创建。每个地图集都包含特定结构的数据 (栅格、矢量等)，但不用担心，GRASS
会为您处理这些数据。

请记住: 位置` 包含 ``地图集包含的数据。有关更多信息，请访问 GRASS网站。
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图 12.3: GRASS数据库结构 (来自 GRASS文档)

12.1.2 跟我做: 启动新的 GRASS工程

1. 单击插件 ► GRASS ►新建地图集菜单:

系统首先要求您选择 GRASS数据库的位置 -注意：文件夹及路径不能有中文等其他字符，否则创
建失败。

2. 将所选文件夹设置为 GRASS用于设置其数据库的目录：
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3. 单击下一步。
GRASS需要创建一个位置，它描述了您将要使用的地理区域的最大范围，也称为 Grass域。

备注: 域对 GRASS极其重要，因为它描述了 GRASS将解释所有被纳入图层的区域，而外面的一切都不
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会顾及。不用担心，在创建位置后，随时可以更改 GRASS域的范围。

1. 新建位置并命名为 SouthAfrica:

2. 单击下一步。
3. 我们将使用 WGS 84，因此搜索并选择此 CRS：
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4. 单击下一步。
5. 现在从下拉列表中选择域 South Africa，然后单击设置:
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6. 单击下一步。
7. 创建地图集，这将是您使用的地图文件。
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完成后，您将看到一个对话框，其中包含所有输入信息的摘要。
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8. 单击完成。
9. 在成功创建对话框中单击确定按钮。

您将看到 GRASS面板变为激活状态，并可以使用所有 GRASS工具。
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12.1.3 跟我做: 将矢量数据加载到 GRASS

您现在有一个空白地图，在开始使用所有 GRASS工具之前，必须将数据加载到 GRASS数据库，特别是
加载至地图集。不能对未加载到 GRASS地图集中的图层使用 GRASS工具。
在 GRASS数据库中加载数据有许多不同的方法，让我们从第一个开始。

跟我做: 使用 QGIS浏览器加载数据

在 The Browser Panel中我们发现，QGIS加载数据最简单快捷的方法是使用浏览器面板。
GRASS数据在 QGIS浏览器中被识别为真正的 GRASS数据，您可能会注意到它，因为您将在 GRASS地

图集旁边看到 GRASS图标。此外，也可以在打开的地图集旁边看到 图标。

备注: 您将看到 GRASS位置可以作为普通文件夹进行复制：GRASS地图集数据是 文件夹中的数据。

可以轻松地将图层从文件夹拖放到 GRASS地图集。
让我们尝试将 roads图层导入到 SouthAfrica位置的 grass_mapset地图集。

转到浏览器，只需将 roads图层从 training_data.gpkg GeoPackage文件拖进 grass_mapset地图
集。

12.1. 课: GRASS安装 363



QGIS Training Manual

就这样！如果展开地图集，您将看到导入的 roads图层。现在，您可以像其他所有图层一样，在 QGIS
中加载导入的图层。

364 Chapter 12. Module: GRASS



QGIS Training Manual

小技巧: 也可以将图层从图层图例面板加载到浏览器面板中的地图集，这将大大加快您的工作流程！

跟我做: 使用 GRASS面板加载数据

我们现在使用 long方法将 rivers.shp图层加载到同一地图集中。

1. 像往常一样将数据加载到QGIS中。使用 rivers.shp数据集 (在 exercise_data/shapefile/
文件夹中查找)

2. 加载后，单击 GRASS面板的过滤器输入框，通过输入术语 v.in.ogr.qgis查找矢量导入工具：

警告: 有两个类似的工具: v.in.ogr.qgis和 v.in.ogr.qgis.loc，我们正在寻找第一
个。

v 代表 矢量，in 意味着将数据导入 GRASS 数据库的函数，ogr 是用于读取矢量数据的程序库，
qgis表示工具将从已加载到 QGIS中的矢量进行查找。

3. 找到此工具后，单击打开。在 Loaded Layer框中选择 rivers图层，然后键入并将其命名为 g_rivers
，以防混淆：
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备注: 请注意 高级选项中提供的其他导入选项，其中包括为用于导入数据的 SQL 查询添加
WHERE子句的功能。

4. 单击运行开始导入。
5. 完成后，单击查看输出按钮，在地图中查看新导入的 GRASS图层。
6. 首先关闭导入工具 (单击查看输出右侧的关闭按钮)，然后关闭 GRASS工具窗口。

7. 移除原 rivers图层。

现在只剩下 QGIS地图中仅显示导入的 GRASS图层。
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12.1.4 跟我做: 将栅格数据加载到 GRASS

可以使用与导入矢量图层相同的方法导入栅格图层。

我们将在 GRASS地图集中导入图层 srtm_41_19_4326.tif。

备注: 栅格图层已在恰当的 CRS WGS 84中。如果您的图层处于不同的 CRS，则必须在 GRASS地图集
的相同 CRS中进行重投影。

1. 在 QGIS中加载 srtm_41_19_4326.tif图层。

2. 再次打开 GRASS工具对话框。

3. 单击模块选项卡。
4. 搜索 r.in.gdal.qgis并双击以打开该工具的对话框。

5. 将输入图层设置为 srtm_41_19_4326.tif，输出为 g_dem。
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6. 单击运行。
7. 完成该处理后，单击查看输出。
8. 关闭当前选项卡，然后关闭整个对话框。
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9. 您现在可以移除原 srtm_41_19_4326.tif图层。

12.1.5 试一试添加图层到地图集

尝试从 exercise_data/shapefile/ 文件夹在 GRASS 地图集中导入矢量图层 water.shp 和
places.shp 。正如我们对 rivers 所做的那样，将导入的图层重命名为 g_water 和 g_places ，
避免混淆。

回答

可以在浏览器中拖放图层 (矢量和栅格)，将其添加到 GRASS 地图集中 (请参阅 Follow Along: Load
data using the QGIS Browser)或者使用 v.in.gdal.qgis (矢量图层)和 r.in.gdal.qgis (栅格图层)。

12.1.6 打开现有 GRASS地图集

如果您已经有了 GRASS地图集，可以在 QGIS的另一个会话中轻松地重新打开。
有几种方法可以打开 GRASS地图集，让我们来探索其中的一些方法。
单击 GRASS工具窗口的关闭地图集按钮来关闭地图集。

跟我做: 使用 GRASS插件

1. 单击我们在上一节中看到的插件 --> GRASS -->新建地图集菜单旁边的插件 --> GRASS -->打开地图
集菜单。

2. 浏览到 GRASS数据库文件夹：小心！您必须选择父文件夹，而不是 GRASS地图集文件夹。实际
上，GRASS将读取数据库的所有位置以及每个位置的所有地图集：
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3. 选择我们之前创建的位置 SouthAfrica和地图集 grass_mapset。

就是这样！GRASS面板将变为激活状态，表示地图集已正确打开。

跟我做: 使用 QGIS浏览器

使用 QGIS浏览器打开地图集更快捷、更简单：
1. 通过单击 GRASS工具窗口的关闭地图集按钮来关闭地图集 (如果已打开)。
2. 在 QGIS浏览器，浏览到 GRASS数据库的文件夹。

3. 右键单击地图集 (请记住，地图集旁边有 GRASS图标)，您会看到一些选项。
4. 单击打开地图集:
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地图集现已打开，并可以使用了！

小技巧: 右键单击 GRASS地图集可为您提供许多不同的设置。尝试探索，并查看所有有用的选项。
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12.1.7 In Conclusion

GRASS获取数据的工作流程与 QGIS方法有所不同，这是因为 GRASS将其数据加载到空间数据库结构
中。但是，使用 QGIS作为前端，可以通过使用 QGIS中的现有图层作为 GRASS的数据源，简化 GRASS
地图集的设置。

12.1.8 What’s Next?

现在数据已经导入到 GRASS，我们可以看看 GRASS提供的高级分析运算。

12.2 课: GRASS工具

在本课，我们将介绍一些工具，让您更深入了解 GRASS的功能。

12.2.1 跟我做: 创建坡向地图

1. 打开 GRASS工具选项卡

2. 从 grass_mapset地图集加载 g_dem栅格图层

3. 在模块列表选项卡的过滤器字段中搜索 r.aspect模块

4. 打开工具并按如下进行设置，然后单击运行按钮：
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5. 完成该过程后，单击查看输出将生成的图层加载到画布中：
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该 g_aspect图层存储在 grass_mapset地图集，因此您可以从画布中移除图层，并随时重新加载。

12.2.2 跟我做: 获取栅格图层的基本统计信息

我们想知道 g_dem栅格图层的一些基本统计数据。

1. 打开 GRASS工具选项卡

2. 从 grass_mapset地图集加载 g_dem栅格图层

3. 在模块列表选项卡的过滤器字段中搜索 r.info模块

4. 如下设置工具，然后单击运行:
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5. 在输出选项卡，您将看到输出的一些栅格信息，如文件路径、行数和列数以及其他有用信息：

12.2. 课: GRASS工具 375



QGIS Training Manual

12.2.3 跟我做: 重分类工具

重分类栅格图层是一项非常有用的工作。我们刚刚从 g_dem图层创建了 g_aspect图层。数值范围从
0 (北)经过 90 (东)、180 (南)、270 (西)，最后到 360 (北)。可以根据指定规则 (北 = 1,东 = 2,南 = 3和西 =
4)将 g_aspect图层重分类为 4个类别。
Grass重分类工具接受具有定义规则的 txt文件。编写规则非常简单，GRASS手册有详细的描述。

小技巧: 每个 GRASS工具都有自己的帮助选项卡。花点时间阅读您正在使用工具的描述，不要错过一
些有用的参数

1. 加载 g_aspect图层，如果您没有创建，请返回 Follow Along: Create an aspect map章节。

2. 在模块列表选项卡的过滤器字段中搜索 r.reclass模块
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3. 打开工具，如下图所示进行设置。包含规则的文件位于 exercise_data/grass/文件夹，命名
为 reclass_aspect.txt。

4. 单击运行并等待处理完成：

5. 单击查看输出，将重分类的栅格加载到画布中
新图层仅由 4个值 (1、2、3和 4)组成，更易于管理和处理。
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小技巧: 使用文本编辑器打开 reclass_aspect.txt查看规则并开始熟悉它们。此外，请深入阅读
GRASS手册：其中指出了许多不同的示例。

12.2.4 试一试按照您的规则重分类

尝试将 g_dem图层重分类为 3个新类别：
• 从 0到 1000，新值 = 1
• 从 1000到 1400，新值 = 2
• 从 1400到最大栅格值，新值 = 3

回答

要找到栅格的最大值，请运行 r.info工具：在控制台，将看到最大值是 1699。您现在可以写规则了。
1. 打开文本编辑器并添加以下规则:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. 保存为 my_rules.txt文件并关闭文本编辑器。

3. 运行 r.reclass工具：选择 g_dem图层并加载刚刚保存的包含规则的文件。

4. 单击运行，然后单击查看输出。您可以更改颜色，最终结果应如下图所示：
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12.2.5 跟我做: Mapcalc工具

Mapcalc工具类似于 QGIS的栅格计算器。可以对一个或多个栅格图层执行数学运算，最终结果将是一个
具有计算值的新图层。

下一个练习的目的是从 g_dem栅格图层提取大于 1000的值。
1. 在模块列表选项卡的过滤器字段中查找 r.mapcalc模块。

2. 启动工具。
Mapcalc对话框允许构建在栅格或栅格集合上执行分析序列。您将使用以下工具来执行此操作：

依次为：

• 添加地图: 从当前 GRASS地图集添加栅格文件。
• 添加常量值: 添加要在函数中使用的常量值，本例中为 1000
• 添加运算符或函数: 添加要连接到输入和输出的运算符或函数，我们将使用运算符大于等于
• 添加连接: 连接元素。使用此工具，从一项的红点单击并拖动到另一项上的红点。正确连接到
连接线的点将变为灰色。如果线或点为红色，表示连接不正确！

• 选择项: 选择一项并移动所选项。
• 删除所选项: 从当前 Mapcalc工作表中移除选中项，但不是从地图集中删除 (如果它是现有栅
格)

• 打开: 打开已定义运算的现有文件
• 保存: 将所有运算保存在一个文件中
• 另存为: 将所有运算另存为磁盘上的新文件。
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3. 使用这些工具，构建以下算法：

4. 单击运行，然后单击查看输出，查看地图中显示的输出内容：
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这显示了地形高于 1000米的所有区域。

小技巧: 通过单击 GRASS Mapcalc工具栏上的最后一个按钮，还可以保存已创建的公式，并将其加载到
另一个 QGIS工程中。

12.2.6 In Conclusion

在本课，我们只介绍了 GRASS提供的众多工具中的一小部分。要亲自探索 GRASS功能，请打开 GRASS
工具对话框并向下滚动模块列表。或者，要了解更结构化的方法，请查看模块树选项卡，该选项卡按类
型组织工具。
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单元: 评估

在本课中将使用您自己的数据，并需要：

• 兴趣点的点矢量数据集，具有点名称和多个类别
• 道路的线矢量数据集
• 土地利用的多边形矢量数据集 (使用地产边界)
• 可见光谱图像 (如航拍照片)
• DEM (如果您自己没有，可以从 CGIAR-CSI下载)

13.1 创建底图

在进行任何数据分析之前，您需要一个底图，它将为您的分析成果提供所需的环境。

13.1.1 添加点图层

• 添加点图层。根据您正在学习的课程级别，只需执行以下适当部分中列出的内容即可：

• 根据唯一属性 (例如地名)标注点，使用小字型并保持标注不太明显。这些信息应该是可用的，但不
应该是地图的主要要素。

• 根据类别将点分类为不同的颜色。例如，类别可以包括”tourist destination”, ”police station”和”town
center”。
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• 执行与 级别相同的操作。
• 按重要性对点大小进行分类：要素越重要，其点越大。但是，点大小不要超出 2.00。

• 对于未定位单个点的要素 (例如，省/地区名称，或大比例的城镇名称)，根本不分配任何点。

• 不要使用点符号来符号化图层。相反，使用以点为中心的标注，点符号本身应该没有大小。
• 使用数据定义设置将样式标注为有意义的类别。
• 如有必要，向属性数据添加适当的列。执行此操作时，不要创建虚构数据，而是使用字段计算器
根据数据集中适当的现有值填充新列。

13.1.2 添加线图层

• 添加道路图层，然后更改其符号。不要标注道路。

• 将道路符号更改为宽线的浅色，并有点透明。

• 创建具有多个符号图层的符号。由此生成的符号应该看起来像一条真实的道路。您可以为此使用简
单符号，例如，一条黑线，中间一条细白实线沿着中心延伸。也可以更复杂，但生成的地图看起来
不应该太杂乱。

• 如果您的数据集在想要显示地图的比例下具有较高密度的道路，则应该有两个道路图层：精心制作
的类似道路符号，以及较小比例更简单的符号。(使用基于比例的可见性便于以适当的比例进行切
换。)

• 所有符号都应具有多个符号图层，并使用符号将其正确显示。

• 执行与上面 级别相同的操作。
• 此外，道路应分类。当使用逼真的道路符号时，每种类型的道路都应该有一个合适的符号。例如，
高速公路在两个方向上应该有两条车道。

13.1.3 添加多边形图层

• 添加土地利用图层并更改其符号。
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• 根据土地利用情况对该图层进行分类，并使用纯色。

• 根据土地利用情况对该图层进行分类。在适当的情况下，合并符号图层、不同的符号类型等。但
是，要保持结果的柔和且统一。请记住，这将是背景的一部分！

• 使用基于规则的分类法将土地利用分为常规类别，如”城市”、”农村”、”自然保护区”等。

13.1.4 创建栅格背景

• 从 DEM创建山体阴影，并将其用作 DEM本身不同分类的叠加图层。您还可以使用 Relief 插件 (如
插件课程中所示)。

13.1.5 完成底图

• 使用上述资源的部分或所有图层创建底图。该地图应包括定位于用户所需的所有基本信息，以及视
觉的统一和”简明”。

13.2 分析数据

• 您正在寻找满足特定条件的房产。
• 您可以自行决定并记录条件。
• 这些条件有一些指导原则：

– 目标地产应为土地利用的特定类型
– 应该与道路保持一定距离，或者被道路穿过
– 应该在某类点的给定距离内，例如医院

13.2.1 /

• 在您的成果中包含栅格分析。应考虑至少有一个栅格的衍生属性，例如其坡向或坡度。

13.3 最终地图

• 使用打印布局创建最终地图，其中包含您的分析成果。
• 在文档中包含此地图以及您记录的条件。如果由于添加了图层，地图在视觉上变得过于杂乱，请取
消选择您认为最不需要的图层。

• 您的地图必须包含标题和图例。
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单元: 林业应用

在 1到 13单元中，您已经学习了很多关于 QGIS以及如何使用的知识。如果有兴趣学习 GIS的一些基本
林业应用，关注本单元将使您能够应用所学知识，并向您展示一些新的有用工具。

该单元的开发由欧盟赞助。

14.1 课: 林业单元说明

按照本单元有关林业应用的内容，需要您通过本培训手册的单元 1至 11学习到的知识。以下课程中的练
习假设您已经能够在 QGIS中执行许多基本操作，并且只会更详细地介绍以前未使用过的工具。
尽管如此，本单元在整个课程中都遵循基本级别的原则。因此，如果您以前有使用 QGIS的经验，可以
毫无问题地按照说明进行操作。

请注意，您需要下载此单元的附加数据包。

14.1.1 林业样本数据

备注: 本单元使用的样本数据是培训手册数据集的一部分，可在 exercise_data\forestry\文件夹
中找到。

EVO-HAMK林业学校提供了与林业相关的样本数据 (林业地图和森林数据)。数据集已被修改，以适应
课程需求。

一般样本数据 (航拍图像、LiDAR数据、底图)已从芬兰国家土地调查开放数据服务器获得，并为练习目
的进行了调整。开放数据文件下载服务器可以在这里用英语访问。
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警告: 至于培训手册的其余部分，本单元包括有关添加、删除和更改 GIS数据集的说明。我们为此提
供了培训数据集。在对您自己的数据使用本文介绍的技术之前，请务必确保进行了正确的备份！

14.2 课: 地理配准地图

常见的林业任务是更新林区的信息。有可能该地区以前的信息可以追溯到几年前，并以类似方式收集 (即
以纸质形式)，也可能是数字化的，但现存的只是该库存量数据的纸质版。
例如，很可能您希望在 GIS中使用这些信息，以便与以后的库存进行比较。这意味着您需要使用 GIS软
件将手头的信息数字化。但在开始数字化之前，首先要做的是扫描和地理配准您的纸质地图。

本课目标: 学习在 QGIS中使用地理配准工具。

14.2.1 扫描地图

您要做的第一件事就是扫描地图。如果地图太大，那么可以在不同的部位进行扫描，但要记住，必须为
每个部位重复预处理和地理配准任务。因此，如果可能的话，尽可能少地扫描地图。

如果要使用与本手册提供的不同地图，请使用扫描仪将地图扫描为图像文件，分辨率为 300 DPI即可。
如果是彩色地图，请以彩色扫描图像，便于以后可以使用这些颜色将地图中的信息分为不同的图层 (例
如，林分、等高线、道路等)。
在本练习中，将使用之前扫描的地图，您可以在数据文件夹 exercise_data/forestry 中找到
rautjarvi_map.tif

14.2.2 跟我做: 对扫描的地图进行地理配准

1. 打开 QGIS 并在 工程 ► 工程属性 ► CRS 中设置工程的 CRS 为 EPSG:3067 - ETRS89 /
TM35FIN(E,N)，这是芬兰目前使用的 CRS。
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2. 将 QGIS工程另存为 map_digitizing.qgs。

您将使用的是 QGIS中名为配准工具的地理配准工具。要对地图进行配准：

1. Open the georeference tool, Layer ► Georeferencer....
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2. 使用文件 ►打开栅格添加地图图像文件 rautjarvi_map.tif，作为要配准的图像。

3. 单击确定。
接下来，应定义地理配准地图的变换设置：

1. 打开设置 ►变换设置。
2. 将变换类型设置为线性，将重采样方法设置为最近邻。

3. 按目标 SRS选项旁边的 选择 CRS按钮，并选择 EPSG:2392 - KKJ / Finland zone 2 CRS。
这是 1994年创建此地图时芬兰使用的 CRS。

4. 单击输出栅格方框旁边的图标，转到文件夹，新建 exercise_data\forestry\digitizing
文件夹，并将文件命名为 rautjarvi_georef.tif。

5. 勾选 完成后加载到 QGIS

6. 将其余参数保留为默认值。

7. 单击确定。
该地图有几个十字标线，用于标记地图中的坐标，我们将使用这些十字标线对图像进行配准。您可以像
通常在 QGIS中那样使用缩放和平移工具来检查配准工具窗口中的图像。

1. 放大到地图的左下角，注意有一个带有坐标对X和Y的十字标线，如前所述，位于KKJ / Finland
zone 2 CRS中。您将使用该点作为地图地理配准的第一个地面控制点。

2. 选择添加控制点工具，并单击十字标线的交叉点 (根据需要进行平移和缩放)。
3. 在 输入地图坐标对话框中，填写地图中显示的坐标 (X: 2557000 和 Y: 6786000) 及其 CRS

(EPSG:2392 - KKJ / Finland zone 2)
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4. 单击确定。
地理配准的第一个坐标现已准备就绪。

5. 在图像中寻找其他黑色十字标线，它们在北向和东向上彼此间隔 1000米。您应该能够计算出这些
点相对于第一个点的坐标。

6. 缩小图像并向右或向上移动，直到找到其他十字标线，然后估算移动了多少千米。尽量让地面控制
点彼此远离。

7. 以与第一个相同的方式数字化至少三个以上的地面控制点。您最终应该得到类似的结果：
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由于已经有三个数字化地面控制点，您将能够看到地理配准误差，即从这些点出来的一条红线。像素误
差也可以在地面控制点列表的 dX[像素]和 dY[像素]列中看到。像素误差不应超过 10像素。如果是，您
应该检查已经数字化的点和输入的坐标，以找出问题所在。可以使用上面的图像作为参考。

一旦您对控制点感到满意，可以将其保存以备后用：

1. 转到文件 ►地面控制点另存为... 。

2. 保存到 exercise_data\forestry\digitizing 文件夹，并命名文件为 rautjarvi_map.
tif.points。

最后，对您的地图进行配准：

1. 转到文件 ►开始配准。
2. 请注意，在编辑地理配准工具设置时您已将该文件命名为 rautjarvi_georef.tif
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现在，您可以在 QGIS工程中将地图视为已配准栅格。请注意，栅格似乎略微旋转，但这仅仅是因
为数据位于 KKJ / Finland zone 2，而您的工程在 ETRS89 / TM35FIN(E,N)中。

3. 要检查数据是否正确地进行了地理配准，可以
1. 在 exercise_data\forestry文件夹中打开名为 rautjarvi_aerial.tif的航拍图像。

2. 您的地图和这张图像应该非常匹配：设置地图透明度为 50%，将其与航拍图像进行比较。

4. 保存对 QGIS工程所做的更改，您将从此继续学习下一课。
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14.2.3 In Conclusion

现在，您已经对纸质地图进行了地理配准，可以将其用作 QGIS中的地图图层。

14.2.4 What’s Next?

在下一课，您将把地图中的林分数字化为多边形，并向其添加库存量数据。

14.3 课: 林分数字化

除非打算将配准地图用作简单的背景图像，否则下一步自然是将其元素数字化。当您对学校场地数字化
时，已经在Lesson: Creating a New Vector Dataset的有关创建矢量数据的练习中完成了此操作。在本课，您
将对地图中显示为绿线的林分边界进行数字化，此地图不是使用航拍图像，而是使用配准地图。

本课目标: 学习一种帮助完成数字化任务的技术，将林分数字化，并最终将清查数据添加到其中。

14.3.1 跟我做: 提取林分边界

Open your map_digitizing.qgs project in QGIS, that you saved from the previous lesson.
扫描和配准地图后，可以通过查看图像作为辅助直接开始数字化。例如，如果要数字化的图像是航拍照
片，那么这很可能是一种方法。

如果您用来数字化的是一张不错的地图，就像我们的示例一样，很可能会清晰地显示每种元素类型不同
颜色的线条信息。使用类似 GIMP这样的图像处理软件，可以相对容易地提取用来辅助数字化的单独图
像，如下所示。

第一步是使用 GIMP获取仅包含林分的图像，即可以在原始扫描地图中看到的所有绿色线条：
1. 打开 GIMP (如果您还未安装，可以从网上下载或咨询您的老师)。
2. Open the original map image, File► Open, rautjarvi_map.tif in the exercise_data/forestry

folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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3. 现在，您可以选择图像中构成林分边界的像素 (绿色像素)：
1. 打开工具选择 ►按颜色。
2. With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close

enough to differentiate the pixels forming the line. See the left image below.
3. 在线中间单击并拖动鼠标光标，以便该工具收集多个像素颜色值。
4. 释放鼠标左键并等待几秒钟，与工具收集的颜色相匹配的像素将在整个图像中被选中。
5. 缩小视图，查看在整个图像中绿色像素的选择情况。
6. 如果对结果不满意，请重复单击并拖动操作。
7. 您的像素选择应该类似于下右图。
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4. 完成选择后，需要将此选择复制为新图层，然后另存为单独的图像文件：
1. Copy (Ctrl+C or Edit ► Copy) the selected pixels.
2. And paste the pixels directly as a new layer (Edit► Paste as► New Layer). GIMP will display the pasted

pixels as a new layer (Pasted Layer) in the Layers panel.
3. 单击原图像图层旁边的”眼睛”图标将其关闭，这样只有被粘贴的图层可见：
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5. Finally, select File► Export As..., set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it rautjarvi_map_green.tif. Select no compression when asked.

您可以对图像中的其他元素执行相同的处理，例如提取表示道路的黑线或表示地形等高线的棕色线。但
对我们来说，林分就足够了。

14.3.2 试一试配准绿色像素图像

正如在上一课中所做的那样，您需要对该新图像进行地理配准，以便能够将其与其他数据一起使用。

Note that you don’t need to digitize the ground control points anymore because this image is basically the same image
as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should remember:

• This image is also, of course, in KKJ / Finland zone 2 CRS.
• 应该使用您保存的 GCP文件 ►加载地面控制点。
• 请查看变换设置。
• Name the output raster as rautjarvi_green_georef.tif in the digitizing folder.

检查新栅格是否与原地图完美匹配。

14.3.3 跟我做: 为数字化创建支点

考虑到 QGIS中的数字化工具，您可能已经认为，在数字化时捕捉这些绿色像素会很有帮助。这正是您
接下来要做的，通过使用 QGIS中可用的捕捉工具，从这些像素创建点，以便稍后使用它们来帮助您在
数字化时跟踪林分的边界。

1. 使用栅格►转换►栅格矢量化 (栅格转矢量)工具将绿线矢量化为多边形。如果忘记如何操作，可
以温习Lesson: Raster to Vector Conversion。

2. Save as rautjarvi_green_polygon.shp inside the digitizing folder.
3. 放大并查看多边形的外观，您会得到这样的结果：
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4. Next option to get points out of those polygons is to get their centroids:
1. Open Vector ► Geometry Tools ► Centroids....

2. Set Input Layer to rautjarvi_green_polygon (the polygon layer you have just created)
3. Set Centroids output to green_centroids.shp file within the folder digitizing

4. Check Open output file after running algorithm

5. Press Run. This will calculate the centroids for the polygons as a new layer and add it to the project.
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5. Now you can remove the rautjarvi_green_polygon layer from the TOC.
6. Change the symbology of the centroids layer as follows:

1. Open the Layer Properties for green_centroids.
2. 转到符号化选项卡。
3. Set Size to 1.00 and choose Map Units

不需要将点相互区分开，只需要它们在那里，捕捉工具就可以使用。现在，您可以使用这些点来跟随原
线条，这比不使用它们要容易得多。
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14.3.4 跟我做: 数字化林分

现在，您可以开始真正的数字化工作了。可以先创建多边形类型的矢量文件，但对于本练习，有一个
Shapefile，其中关注区的一部分已经数字化。您只需将主要道路 (宽粉色线)和湖泊之间剩下的一半林分
数字化即可：

1. Go to the digitizing folder using your file manager browser.
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2. Drag and drop the forest_stands.shp vector file to your map.
3. Change the new layer’s symbology so that it will be easier to see the polygons that have already been digitized.

1. Set Fill color to green - and change the Opacity to 50%.
2. Select Simple Fill and set Stroke width to 1.00 mm.

现在，您还记得之前单元学习的内容吗？我们必须设置并激活捕捉选项：

1. Go to Project ► Snapping options...

2. Press Enable Snapping and select Advanced Configuration
3. Check the green_centroids and forest_stands layers
4. Set Type for each layer to Vertex
5. Set Tolerance for each layer to 10
6. Set Units for each layer to pixels

7. Check Avoid Overlap for the forest_stands layer

8. Press Topological editing

9. Choose Follow Advanced Configuration

10. Close the pop-up

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the
centroids layer or any vertex of your digitized polygons, a pink square will appear on the point that will be
snapped to.

11. Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the
map image has not transparency any more.

A few important things to note before you start digitizing:
• 不要试图过于精确数字化边界。
• 如果边界是一条直线，只需两个结点即可将其数字化。通常，使用尽可能少的结点进行数字化。
• 仅当您认为需要精确时才放大到近距离，例如，在某些拐角处，或者当您希望某个多边形在某个结
点与另一个多边形连接时。

• 在数字化时，使用鼠标中键进行放大/缩小和平移。
• 一次仅能数字化一个多边形。
• 数字化一个多边形后，写出从地图上可以看到的林分 ID。

现在您可以开始数字化了：

1. Locate the forest stand number 357 in the map window.
2. Select the forest_stands layer.

14.3. 课: 林分数字化 401



QGIS Training Manual

3. Click the Toggle Editing button to enable editing

4. Select Add Polygon Feature tool.
5. Start digitizing the stand 357 by connecting some of the dots. Note the pink crosses indicating the snapping.

When you are done:
1. Right click to end digitizing that polygon.
2. Enter the forest stand ID within the form (in this case 357).
3. 单击确定。

If a form did not appear when you finished digitizing the polygon, go to Settings ► Options ► Digitizing and make
sure that the Suppress attribute form pop-up after feature creation is not checked.
您的数字化多边形如下所示：
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Now for the second polygon, pick up the stand number 358. Make sure that Avoid Overlap is checked for the
forest_stands layer (as shown above). This option ensures polygons do not overlap. So, if you digitize over an existing
polygon, the new polygon will be trimmed to meet the border of the existing polygons. You can use this option to
automatically obtain a common border.

1. 在林分 357的一个公共角开始数字化林分 358。
2. Continue normally until you get to the other common corner for both stands.
3. 最后，数字化多边形 357内的几个点，确保公共边界不相交。见下左图。
4. 右键单击完成对林分 358的编辑。
5. Enter the ID as 358.
6. Click OK. Your new polygon should have a common border with the stand 357 as you can see in the image

below.
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The part of the polygon that was overlapping the existing polygon has been automatically trimmed and you are left
with a common border - as you intended it to be.

14.3.5 试一试完成林分的数字化

现在您已完成两个林分，和如何数字化的好方法。继续您的数字化，直到已经数字化了所有主要道路和
湖泊之间的林分。

这看起来工作量很大，但您很快就会习惯数字化林分。整个过程大概需要 15分钟。
在数字化过程中，可能需要编辑或删除结点、分割或合并多边形。您可在Lesson: Feature Topology中学习
了有关必要的工具，现在可能是复习的好时机。

请记住，启用拓扑编辑激活后，可以移动两个多边形的公共结点，以便同时编辑两个多边形的公共边界。

您的成果将如下所示：
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14.3.6 跟我做: 连接林分数据

有可能地图上的森林资源清查数据写在纸上。在这种情况下，您必须首先将数据录入文本文件或电子表
格。对于本练习，1994年清单 (与地图相同的清单)中的信息以逗号分隔文本 (csv)文件的形式准备就绪。

1. Open the rautjarvi_1994.csv file from the exercise_data\forestry directory in a text editor
and note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those
numbers are the same as the forest stands ids you have entered for your polygons and can be used to link
the data from the text file to your vector file. You can see the metadata for this inventory data in the file
rautjarvi_1994_legend.txt in the same folder.

2. Now add this file into the project:
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1. Use the Add Delimited Text Layer tool. This is accessed via Layer ► Add Layer ► Add Delimited Text
Layer....

2. Set details in the dialog as follows:

3. Press Add to load the formatted csv file in the project.
3. To link the data from the .csv file with the digitized polygons, create a join between the two layers:

1. Open the Layer Properties for the forest_stands layer.
2. 转到连接选项卡。

3. Click Add new join on the bottom of the dialog box.
4. Select rautjarvi_1994.csv as the Join layer
5. Set the Join field to ID
6. Set the Target field to ID
7. 单击确定两次。

The data from the text file should be now linked to your vector file. To see what has happened, select the
forest_stands layer and use Open Attribute Table. You can see that all the attributes from the inventory data file
are now linked to your digitized vector layer.
You will see that the field names are prefixed with rautjarvi_1994_. To change this:

1. Open the Layer Properties for the forest_stands layer.
2. 转到连接选项卡。
3. Select Join Layer rautjarvi_1994

4. Click the Edit selected join button to enable editing

5. Under Custom field name prefix remove the prefix name
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The data from the .csv file is just linked to your vector file. To make this link permanent, so that the data is actually
recorded to the vector file you need to save the forest_stands layer as a new vector file. To do this:

1. Right click on forest_stands layer
2. Choose Export ► Save Features As...

3. Set Format to ESRI Shapefile
4. Set file name to forest_stands_1994.shp under the forestry folder

5. To include the new file as a layer in the project, check Add saved file to map
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14.3.7 Try Yourself Adding Area and Perimeter

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of
the stands. You calculated areas for polygons in Lesson: Supplementary Exercise. Go back to that lesson if you need
to and calculate the areas for the forest stands. Name the new attribute Area and make sure that the values calculated
are in hectares. You could also do the same for the perimeter.
Now your forest_stands_1994 layer is ready and packed with all the available information.
Save your project to keep the current map layers in case you need to come back later to it.
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14.3.8 In Conclusion

只需点击几下鼠标，您就有了数字格式的旧清查数据，并可以在 QGIS中使用。

14.3.9 What’s Next?

可以开始使用新数据集进行不同的分析，但您可能更感兴趣的是在更加新的数据集中执行分析。下一课
的主题是使用当前的航拍照片创建林分，并将一些相关信息添加到数据集。

14.4 课: 更新林分

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step is to create the inventory of the current state of the forest.
You will digitize new forest stands using an aerial photo. As with the previous lesson, you will use an aerial Color
Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, is
widely used to study vegetated areas.
将林分数字化后，您将添加信息，例如资源保护条例给出的新制约条款。

The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other datasets.

14.4.1 将旧林分与当前航拍照片进行比较

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographicmaps, DEM, LiDAR data, etc. The service can be accessed in English
here. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from
that service (M4134F_21062012 and M4143E_21062012).

1. Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project ► Properties... ► CRS

2. Add the CIR image rautjarvi_aerial.tif to the project:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file rautjarvi_aerial.tif onto your project

3. Save the QGIS project as digitizing_2012.qgs
该 CIR图像来自 2012年，可以将 1994年创建的态势图与近 20年后的情况进行比较。

1. Add the forest_stands_1994.shp layer created in the previous lesson:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file forest_stands_1994.shp onto your project

2. Set the symbology for the layer so that you can see through your polygons:
1. Right click forest_stands_1994
2. Select Properties

3. Go to the Symbology tab
4. Set Fill color to transparent fill
5. Set Stroke color to purple
6. Set Stroke width to 0.50 mm
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3. 查看旧林分是如何遵循 (或不遵循)您可能在视觉上解释为同质森林的内容。
4. 围绕该地区缩放和平移。您可能会注意到，一些旧林分可能仍与图像对应，但其他林分则不然。

This is a normal situation, as some 20 years have passed and different forest operations have been carried
out (harvesting, thinning...). It is also possible that the forest stands looked homogeneous back in 1992 to the
person who digitized them but as time has passed some forest has developed in different ways. It is also possible
that that forest inventory priorities back then were different from those of today.

接下来，您将为该图像创建新的林分，而不是使用旧林分。稍后可以比较它们的异同。

14.4.2 解读 CIR图像

让我们将旧清单覆盖的同一区域数字化，该区域受到道路和湖泊的限制。您不必将整个区域数字化，就
像在上一个练习一样，您可以从已经包含大部分林分的矢量文件开始。

1. Remove the layer forest_stands_1994

2. Add the file exercise_data\forestry\forest_stands_2012.shp to the project
3. Set the styling of this layer so that the polygons have no fill and the borders are visible

1. Open Properties dialog of the forest_stands_2012 layer

2. Go to the Symbology tab
3. Set Fill color to transparent fill
4. Set Stroke color to green
5. Set Stroke width to 0.50 mm
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You can see that the northern section of the inventory area is still missing. Your task is to digitize the missing forest
stands.
Before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the
image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.
Some points to consider:

• Which forests have deciduous species (in Finland these are mostly birch forests) and which ones have conifers
(in this area these are pine or spruce)? In CIR images, deciduous species usually show up as a bright red color
whereas conifers show as a dark green color.
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• How old is the forest? The size of the tree crowns can be identified in the imagery.
• How dense are the different forest stands? A forest stand where a thinning operation has recently been done
would show spaces between the tree crowns and should be easy to differentiate from other forest stands around
it.

• 青色区域表示荒芜地带、道路和城市区域、尚未开始生长的农作物等。
• Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5
000 should be enough for this imagery. See the image below (1:4000 scale):

14.4.3 试一试从 CIR影像数字化林分

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of
tree species, forest age, stand density... Don’t be too detailed though, or you will end up making hundreds of small
forest stands - and that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).
With these points in mind, you can now digitize the missing forest stands.

1. Set up the snapping and topology options:
1. Go to Project ► Snapping options...

2. Press Enable Snapping and select Advanced Configuration

3. Check the forest_stands_2012 layer
1. Set Type to Vertex
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2. Set Tolerance to 10
3. Set Units to pixels
4. Check the box under Avoid Overlap

5. Press Topological editing

6. Choose Follow Advanced Configuration

7. Close the pop-up

2. Select the forest_stands_2012 layer on the Layers list

3. Click the Toggle Editing button to enable editing
4. Start digitizing using the same techniques as in the previous lesson. The only difference is that you don’t have

any point layer that you are snapping to. For this area you should get around 14 new forest stands. While
digitizing, fill in the StandID field with numbers starting at 901.

5. 完成后，您的图层应如下所示：
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Now you have a new set of polygons showing the different forest stands in 2012 - as interpreted from the CIR images.
However, you are missing the forest inventory data. For that you will need to visit the forest and get some sample
data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the
next lesson.
You can add some extra information about conservation regulations that need to be taken into account for this area.

14.4.4 跟我做: 使用保护信息更新林分

For the area you are working in, there are some conservation regulations that must be taken into account when doing
the forest planning:

• 已经确定了两个西伯利亚鼯鼠 (Pteromys volans)保护物种的位置。根据规定，位置周围 15米范围内
不得触碰。

• A riparian forest of special interest that is growing along a stream in the area must be protected. In a visit to
the field, it was found that 20 meters to both sides of the stream must be protected.

You have a vector file containing the information about the squirrel locations and another containing the digitized
stream running from the North area towards the lake.

1. From the exercise_data\forestry\ folder, add the squirrel.shp and stream.shp files to the
project.

2. Use the Open Attribute Table tool to view the squirrel layer
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您可以看到，有两个位置被定义为西伯利亚鼯鼠栖息地，要保护的区域由距这些位置 15米的距离
表示。

Let’s more accurately delimitate that area to protect. We will create a buffer around the point locations, using the
protection distance.

1. 打开矢量 ►地理处理工具 ►缓冲区。

2. Set Input layer to squirrel

3. Set Distance to 15 meters

4. Set Buffered to exercise_data\forestry\squirrel_15m.shp

5. Check Open output file afer running algorithm

6. 单击运行
7. Once the process is completed, click Close
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If you zoom in to the location in the northern part of the area, you will notice that the buffer area extends over two
neighbouring stands. This means that whenever a forest operation takes place in that stand, the protected location
should also be taken into account.

For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that
will contain information about locations that have to be protected. This information will then be available whenever
a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the
work starts.
To join the information about the squirrels to your forest stands, you can use the Join attributes by location algorithm:

1. 打开矢量 ►数据管理工具 ►按位置连接属性。

2. Set Join to features in to forest_stands_2012

3. In Geometric predicate, check intersect

4. Set By comparing to to squirrel_15m

5. Set Join type as Take attributes of the first matching feature only (one-to-one)
6. Leave unchecked Discard records which could not be joined
7. Set Joined layer to exercise_data\forestry\stands_squirrel.shp

8. Check Open output file afer running algorithm

9. 单击运行
10. Once the process is completed, you can Close the dialog.
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Now you have a new forest stands layer, stands_squirrel.shp showing the protection information for the
Siberian flying squirrel.

1. Open the attribute table of the stands_squirrel layer
2. Sort the table by clicking on point_pr field in the table header.
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You can see that there are some forest stands that have the information about the protection locations. The
information in the forest stands data will indicate to the forest manager that there are protection considerations
to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to
mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the
squirrels environment.

14.4.5 试一试更新林分与溪流的距离

Following the same approach as for the protected squirrel locations you can now update your forest stands with
protection information related to the stream. A few points:

• Remember the buffer is 20 meters around the stream
• You want to have all the protection information in the same vector file, so use stands_squirrel.shp as
the base layer

• Name your output as forest_stands_2012_protect.shp
Once the process is completed, open the attribute table of the output layer and confirm that you have all the protection
information for the riparian forest stands associated with the stream.
When you are happy with the results, save your QGIS project.

14.4.6 In Conclusion

您已经了解了如何领会 CIR图像并将林分数字化。当然，制作更准确的林分需要一些实际操作，通常使
用其他信息 (如土壤分布图)会得到更好的结果。现在您已具备了完成此类任务的基础，而从其他数据集
添加信息则是一项非常琐碎的任务。
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14.4.7 What’s Next?

您数字化的林分将用于规划未来的林业作业，但仍需获取有关森林的更多信息。在下一课，您将了解如
何设计一组采样图表，以清查刚刚数字化的森林面积，并获得森林参数的总估算。

14.5 课: 系统抽样设计

您已经数字化了一组表示林分的多边形，但还没有关于森林的信息。为此，您可以设计一项调查，来清
查整个森林面积，然后估算其参数。在本课程，您将创建一组系统取样地。

在开始规划森林资源清查时，必须明确定义目标、将使用的取样地类型以及为实现目标而收集的数据。
对于每个个案，这些将取决于森林类型和管理目的，并应该由林业专业人员仔细规划。在本课程，您将
实施基于系统取样地设计的理论清查。

本课目标: 创建系统取样地设计，以调查森林面积。

14.5.1 清查森林

森林清查有几种方法，每种方法适用于不同的目的和条件。例如，清查森林 (如果只考虑树种)的一种非
常准确的方法是实地考察森林，列出每棵树及其特征。可以想象，除了一些小区域或某些特殊情况外，
这并不普遍适用。

调查森林最常见的方法是对其进行抽样，即在森林的不同位置进行测量，并将该信息普及到整个森林。
这些测量通常是在较小的森林区域的取样地中进行的，这些森林面积很容易测量。取样地可以是任意大
小 (例如，50平方米、0.5公顷)和形状 (例如，圆形、矩形、可变大小)，并且在森林中可以以不同的方式
进行 (例如，随机、系统、沿路线)。取样地的大小、形状和位置通常是根据统计、经济和实际考虑确定
的。如果您缺乏林业知识，可能有兴趣阅读这篇维基百科文章。

14.5.2 跟我做: 实施系统取样地设计

对于您正在使用的林区，管理人员已决定系统抽样设计最适合该森林，并决定取样地和抽样线之间 80米
的固定距离将产生可信的结果 (对于这种情况，平均误差为 +- 5%，概率为 68% )。对于生长和成熟的林
分，可变大小的地块被确定为本次最有效的清查方法，但对于苗木林分，将使用 4米固定半径的地块。
实际上，您只需将取样地表示为稍后将由现场团队使用的点：

1. 打开上一课的 digitizing_2012.qgs工程。

2. 移除除 forest_stands_2012之外的所有图层。

3. 现在将工程另存为 forest_inventory.qgs。

现在，您需要创建一个由相互间隔 80米的点组成的矩形网格：

1. 打开矢量 ►研究工具 生成规则点。

2. 按下输入范围字段旁边的下拉按钮，然后从图层计算菜单中，选择 forest_stands_2012。

3. 在点间距或数目设置中，输入 80米。

4. 勾选使用点间距框，指示该值表示点之间的距离。
5. 在生成规则点下，将输出保存在 forestry\sampling\文件夹为 systematic_plots.shp文
件。

6. 勾选执行算法后打开输出文件。
7. 按运行。
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备注: 推荐的生成规则点从选中的多边形图层范围的左上角开始创建作物系点。如果要向此规则点添加
一些随机性，可以使用 0到 80之间随机计算的数字 (80是点之间的距离)，然后将其作为从角落处开始
插入 (左手边)的参数写入工具对话框。

您注意到，该工具使用了林分图层的整个范围生成点的矩形网格。但您只对实际位于森林区域内的那些
点感兴趣 (请参见下图)：

1. 从处理工具箱，打开 GDAL ►矢量地理处理 ►按掩膜图层裁剪矢量。
2. 选择 systematic_plots作为输入图层。

3. 将 forest_stands_2012设置为掩膜图层。

4. 将已裁剪 (掩膜)的结果保存在 forestry\sampling\文件夹中的 systematic_plots_clip.
shp。

5. 勾选执行算法后打开输出文件。
6. 按运行。

现在您有了现场团队将用于导航到设计的取样地位置的点。您仍然可以继续完善这些点，以便对现场作
业发挥更大作用。至少您必须为这些点添加有意义的名称，并将其导出为可在 GPS设备中使用的格式。
让我们从取样地的命名开始。如果检查林区内地块的属性表，可以看到生成规则点工具默认自动生成的
id字段。标注点以在地图中显示，并考虑是否可以将这些数字用作取样地命名的一部分：

1. 为 systematic_plots_clip图层打开图层属性 ► 标注。

2. 将顶部菜单切换为 单一标注。

3. 对于值条目，选择字段 id。

4. 转到 描边选项卡，勾选绘制文本描边并将描边大小大小设置为 1。
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5. 单击确定。
现在查看地图上的标注。您可以看到，这些点已经创建并按先从西到东，然后从北到南的顺序编号。如
果再次查看属性表，您将注意到表中的顺序也遵循该规律。除非您有理由以不同的方式命名取样地，否
则以”西-东/北-南”的方式命名取样地符合逻辑顺序，是一个不错的选项。
然而，id 字段中的数值并不太理想，如果命名类似于 p_1, p_2... 应该是不错的选择。可以为
systematic_plots_clip图层创建新列：

1. 转到 systematic_plots_clip的属性表。

2. 启用 编辑模式。

3. 打开 字段计算器:
1. 勾选新建字段
2. 输入 Plot_id作为输出字段名称

3. 将输出字段类型设置为文本 (字符串)。

4. 在表达式字段中，写入、复制或构建此公式 concat('P_', @rownum )。您还可以双击
函数列表中的元素。concat函数位于字符串组，@rownum位于变量和值组 (新版是”变量”
组中的”@row_number”)。

4. 单击确定。
5. 禁用编辑模式并保存更改。

现在，您有了一个新列，其中包含对您有意义的地块名称。对于 systematic_plots_clip图层，将
用于标注的字段更改为新 Plot_id字段。
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14.5.3 跟我做: 将取样地导出为 GPX格式

现场团队可能会使用 GPS设备定位您设计的取样地，下一步是将创建的点导出为 GPS可以读取的格式。
QGIS允许您以 GPS交换格式 (GPX)保存点和线矢量数据，这是一种标准的 GPS数据格式，大多数专业
软件都可以读取。保存数据时，您需要谨慎选择 CRS：

1. 右键单击 systematic_plots_clip图层，选择导出 ►要素另存为... 。

2. 在格式中，选择 GPS交换格式 [GPX]，新版为”GPS交换文件 [GPX]”。
3. 在 forestry\sampling\文件夹将输出文件名保存为 plots_wgs84.gpx。

4. 在 CRS中点击选择 CRS按钮。

5. 浏览至 EPSG:4326 - WGS 84。

备注: GPX格式只适配此 CRS，如果选择其他 CRS，QGIS不会给出错误提示，但会得到一个空文
件。

6. 单击确定。
7. 在打开的对话框中，仅选择 waypoints图层 (其余图层为空)。

清查取样地现在采用的标准格式，可由大多数 GPS软件管理。现场团队现在可以将取样地的位置上传到
他们的设备，这将通过使用特定设备自己的软件和您刚才保存的 plots_wgs84.gpx文件来完成。另一
种选项是使用 GPS工具插件，但很可能需要将该工具设置为与您的指定 GPS设备一起使用。如果您正在
使用自己的数据，并且希望了解该工具的工作原理，可以在QGIS用户手册的 working_gps章节中找到有
关该工具的详细信息。

现在保存 QGIS工程。
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14.5.4 In Conclusion

您刚才看到了创建一个用于森林资源清查的系统抽样设计是多么容易。创建其他类型的抽样设计将涉及
使用 QGIS中的不同工具、电子表格或脚本来计算取样地的坐标，但总体思路保持不变。

14.5.5 What’s Next?

在下一课，您将了解如何使用 QGIS中的地图集功能自动生成详细地图，现场团队将使用这些地图导航
至分配给他们的取样地。

14.6 课: 使用地图集工具创建详细地图

系统抽样设计已准备就绪，现场团队也已将 GPS坐标加载到其导航设备中。他们还有一个现场数据表
单，在那里将收集每个取样地测量的信息。为了更容易地找到每个取样地，他们要求提供一些详细地图，
其中可以清楚地看到一些地面信息，以及较小取样地子集和一些有关地图区域的信息。您可以使用地图
集工具自动生成许多具有共同格式的地图。

本课目标: 学习使用 QGIS中的地图集工具生成详细的可打印地图，以协助实地清查工作。

14.6.1 跟我做: 准备打印布局

在我们可以自动操作林区和取样地块的详细地图之前，需要创建一个地图模板，其中包含我们认为对实
地工作有用的所有元素。当然，最重要的是正确的样式，但正如您之前所看到的，还需要添加许多其他
元素来完成打印地图。

1. Open the QGIS project from the previous lesson forest_inventory.qgs. You should have at least the
following layers:

• forest_stands_2012 (with a 50% transparency, green fill and darker green border lines)
• systematic_plots_clip

• rautjarvi_aerial

2. Save the project with a new name, map_creation.qgs.
要创建可打印地图，请记住要使用布局管理器:

1. Open Project ► Layout Manager....
2. In the Layout manager dialog:

1. Under New from template, press the Create... button next to the Empty layout entry
2. Name your print layout forest_map.
3. Press OK. A new print layout is created and opened, showing a blank paper.

3. In the print Layout window, ensure properties are set for an A4 paper:
1. Right-click over the paper and select Page properties. The Page properties panel is open on the right side

of the layout.
2. Check Size is A4.
3. Check Orientation is Landscape.

4. Enable the Layout tab next to the Page properties panel and set Export resolution to 300 dpi.
如果使用画布网格来定位不同的元素，则排版地图会更容易。检查布局网格的设置：

1. In the Layout tab expand the Guides and Grid region.

424 Chapter 14. 单元: 林业应用



QGIS Training Manual

2. Check that Grid spacing is set to 10 mm and that Snap tolerance is set to 5 px.
您需要激活网格的使用：

1. 打开视图菜单。
2. Check Show grid.
3. 勾选捕捉到网格。
4. Notice that options for using Guides are checked by default, which allows you to see guiding lines when you

are moving elements in the layout.
5. 现在可以开始向布局中添加元素了。首先添加地图元素，以便在更改图层符号时查看地图画布的外
观：

1. 单击 添加地图 按钮。

2. 在画布上单击并拖动一个框，使地图占据其中大部分。

请注意鼠标光标是如何捕捉到画布网格的，添加其他元素时也可以使用此功能。如果要获得更高的精度，
请更改网格间距设置。如果出于某种原因不想在某个点捕捉到网格，可以随时在视图菜单中勾选或取消
勾选。

14.6.2 跟我做: 添加背景地图

Leave the layout open but go back to the map. Let’s add some background data and create some styling so that the
map content is as clear as possible.

1. 添加背景栅格 basic_map.tif，您可以在 exercise_data\forestry\文件夹找到此文件。

2. If prompted select the ETRS89 / ETRS-TM35FIN CRS for the raster.
如您所见，背景地图已经设置了样式。这种即用类型制图栅格非常常见。它是从矢量数据创建，以
标准格式设置样式并储存为栅格，这样您就不必费心设置多个矢量图层的样式，也不必担心会得到
不理想的结果。

3. 现在缩放到取样地，以便您只能看到大约四到五行的地块。
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The current styling of the sample plots is not the best:

While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image
is mostly white you barely can see the labels. But how does it look in the print layout? Let’s check it:

1. Go to the print layout window.

2. Use the Select/Move item button to select the map element in the layout.
3. 转到项属性标签页。

4. Click on Set map extent to match main canvas extent.

5. If you need to refresh the element, click on Update map preview.
Obviously this is not good enough; you want to make the plot numbers as clearly visible as possible for the field teams.

14.6.3 试一试更改图层符号

您曾经在Module: Creating and Exploring a Basic Map使用符号，在Module: Classifying Vector Data使用过标
注。如果需要重新了解某些可用选项和工具，请返回这些单元。您的目标是在始终允许查看背景地图元
素的前提下使地块位置及其名称尽可能清晰可见。可以从这张图像中得到一些启发：
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You will use later the the green styling of the forest_stands_2012 layer. In order to keep it, and have a
visualization of it that shows only the stand borders:

1. Right click on forest_stands_2012 and select Duplicate
2. You get a new layer named forest_stands_2012 copy that you can use to define a different style, for

example with no filling and red borders.
现在，您有了两种不同的林分可视化，可以决定哪一个显示详细地图。

3. Go back to the print layout window often to see what the map would look like. For the purposes of creating
detailed maps, you are looking for a symbology that looks good not at the scale of the whole forest area (left
image below) but at a closer scale (right image below). Remember to use Update map preview and Set map
extent to match main canvas extent whenever you change the zoom in your map or the layout.

14.6.4 试一试创建底图模板

1. Once you have a symbology you are happy with, you are ready to add some more information to your printed
map. Add at least the following elements:

• 标题。
• 比例尺。
• 地图的网格框架。
• 网格两侧的坐标。

2. You have created a similar layout already inModule: Laying out the Maps. Go back to that module as you need.
You can look at this example image for reference:
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3. 将地图导出为图像并查看效果。
1. 布局 ►导出为图像... 。

2. Use for example the JPG format.
这就是打印时的样子。

14.6.5 跟我做: 向打印布局添加更多元素

正如您可能在推荐地图模板图像中注意到的，画布的右侧有很多空间。让我们看看还有什么可以放进去。
就我们的地图而言，图例并不是真正需要的，但鹰眼图和一些文本框可以为地图增加实用价值。

鹰眼图将帮助现场团队将详细地图放置在整个森林区域内显示：

1. 将另一个地图元素添加到画布，位于标题文本的正下方。
2. 在项属性标签页，打开鹰眼图下拉列表。
3. 将地图框架 (鹰眼图框架)设置为 Map 0。这将在较小的地图上创建一个阴影矩形，表示较大地图
的可见范围。

4. Check also the Frame option with a black color and a Thickness of 0.30.
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请注意，您的鹰眼图并没有真正给出您想要的林区总览。您希望此地图表示整个林区，并希望仅显示背
景地图和 forest_stands_2012图层，而不显示取样地。此外，还需要锁定其视图，以便在更改图层
的可见或顺序时不再更改。

1. 返回地图，但不要关闭打印布局窗口。
2. Right click the forest_stands_2012 layer and click on Zoom to Layer Extent.
3. Deactivate all layers except for basic_map and forest_stands_2012.
4. Expand the Manage map themes tool on the Layers panel and select Add theme.
5. Name it basic_overview.
6. Go back to the print layout.
7. With the small map selected, click the Set map extent to match main canvas extent to set its extents to what you

can see in the map window.
8. Lock the view for the overview map by checking Follow map theme and selecting basic_overview under

Main properties.
Now your overview map is more what you expected and its view will not change anymore. But, of course, now your
detail map is not showing anymore the stand borders nor the sample plots. Let’s fix that:

1. Go to the map window again and select the layers you want to be visible (systematic_plots_clip,
forest_stands_2012 copy and Basic_map).

2. 再次缩放，仅显示几行取样地即可。
3. 返回打印布局窗口。
4. Select the bigger map in your layout.
5. In Item properties click on Update preview and Set map extent to match main canvas extent.

请注意，只有较大的地图显示当前地图视图，而较小的鹰眼图保持与锁定时相同的视图。

还请注意，鹰眼图显示了详细地图所示范围的阴影框架。
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您的模板地图即将就绪。现在在鹰眼图下方添加两个文本框，一个包含文本’Detailed map zone: ’，另一个
为’Remarks: ’。如上图所示。
您还可以将指北针添加到鹰眼图 (新版中有专门的指北针工具，可自行尝试)：

1. Select the Add North Arrow tool.
2. Click and drag a rectangle at the upper right corner of the overview map.
3. In Item properties Check SVG image

4. Browse SVG Browser ► SVG Groups for an arrow image.
5. Under Image rotation, check the Sync with map and select Map 1 (the overview map).
6. 将箭头图像调整为在小地图上看起来不错的尺寸。

基本地图布局已就绪，现在需要使用地图集工具以这种格式生成您认为必要的尽可能多的详细地图。

14.6.6 跟我做: 创建地图集覆盖范围

地图集覆盖范围只是一个矢量图层，将用于生成详细地图，覆盖范围内的每个要素对应一幅地图。为了
了解接下来的工作，这里有一整套林区的详细地图，供参考：
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覆盖范围可以是任何现有图层，但通常为特定目标创建一个范围更有意义。让我们创建一个遮盖林区的
多边形网格：

1. In the QGIS map view, open Vector ► Research Tools ► Create grid.
2. 如图所示设置工具：
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3. Save the output as atlas_coverage.shp.
4. Style the new atlas_coverage layer so that the polygons have no filling.

新多边形覆盖了整个林区，让您了解每幅地图 (从每个多边形创建)将包含哪些内容。
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14.6.7 跟我做: 设置地图集工具

最后一步是设置地图集工具：

1. Go back to the print layout.
2. 在右侧面板，转到生成地图集 (地图集)标签页。

3. 设置选项如下所示：
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这告诉地图集工具使用 atlas_coverage内的要素 (多边形)作为每幅详细地图的焦点。它将为
图层中的每个要素输出一幅地图。隐藏范围图层告诉地图集不要在输出地图中显示多边形。

还有一件事需要做，您需要告诉地图集工具每幅输出地图将更新哪些地图元素。到目前为止，您可能已
经猜测，要为每个要素更改的地图是您准备好的包含取样地详细视图的地图，即画布中较大的地图元素：

1. Select the bigger map element (Map 0).
2. 转到项属性标签页。
3. 在列表中，勾选受控于地图集。
4. And set the Marging around feature to 10%. The view extent will be 10% bigger than the polygons, which

means that your detail maps will have a 10% overlap.
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现在，您可以使用地图集的预览工具查看地图的外观：

1. 使用按钮 激活地图集预览，如果您的地图集工具栏不可见，请使用地图集 ►预览地图集。
2. 可以使用地图集工具栏或地图集菜单中的箭头浏览每个要素创建的地图。

Note that some of them cover areas that are not interesting. Let’s do something about it and save some trees by not
printing those useless maps.

14.6.8 跟我做: 编辑范围图层

除了移除那些不感兴趣区域的多边形外，还可以自定义地图中的文本标注，以生成范围图层属性表中的
内容：

1. 返回地图视图。
2. Enable editing for the atlas_coverage layer.
3. 选择下图中选中的多边形 (黄色)。
4. 移除选中的多边形。
5. 关闭并保存编辑。
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You can go back to the print layout and check that the previews of the Atlas use only the polygons you left in the
layer.
您正在使用的范围图层还没有可用于自定义地图中标注内容的有用信息。第一步是进行创建，例如您可
以添加多边形区域的区号和带有一些备注的字段，供现场团队参考：

1. Open the Attribute table for the atlas_coverage layer.
2. 启用编辑。

3. 使用 字段计算器创建并填充以下两个字段。

4. Create a field named Zone of typeWhole number (integer).
5. In the Expression box write/copy/construct $rownum.
6. Create another field named Remarks, of type Text (string) and a width of 255.
7. In the Expression box write 'No remarks.'. This will set all the default value for all the polygons.

The forest manager will have some information about the area that might be useful when visiting the area. For
example, the existence of a bridge, a swamp or the location of a protected species. The atlas_coverage layer is
probably in edit mode still, add the following text in the Remarks field to the corresponding polygons (double click
the cell to edit it):
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• For the Zone 2: Bridge to the North of plot 19. Siberian squirrel between
p_13 and p_14.

• For the Zone 6: Difficult to transit in swamp to the North of the lake.‘
• For the Zone 7: Siberian squirrel to the South East of p_94.

• 关闭并保存编辑。
Almost ready, now you have to tell the Atlas tool that you want some of the text labels to use the information from
the atlas_coverage layer’s attribute table.

1. 返回打印布局窗口。
2. Select the text label containing Detailed map....
3. Set the Font size to 12.
4. 将光标设置在标注文本的末端。
5. 在项属性标签页的主要属性内，单击插入/编辑表达式... 。
6. In the Function list double-click on the field Zone under Field and Values.
7. 单击确定。
8. The text inside the box in the Item properties should show Detail map inventory zone: [%

"Zone" %]. Note that the [% "Zone" %] will be substituted by the value of the field Zone for the corre-
sponding feature from the layer atlas_coverage.

9. 通过查看不同地图集预览图来测试标注的内容。
10. Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a

break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:

11. 使用地图集预览浏览您即将创建的所有地图，并尽情享受吧！
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14.6.9 跟我做: 打印地图

最后，将地图打印或导出为图像文件或 PDF文件。你可以使用地图集 ►地图集导出为图像... 或地图集
►地图集导出为 PDF文件... 。目前 SVG导出格式仍不理想，结果不佳，请注意查看提示信息。
将地图导出为单个 PDF文件，您可以将其发送到现场办公室进行打印：

1. 转到右侧面板的生成地图集 (地图集)标签页。

2. 在输出中，勾选可能时导出为单个文件。这将把所有地图放在一个 PDF文件中，如果未勾选此选
项，则每幅地图导出一个文件。

3. 打开布局 ►导出为 PDF文件... 。

4. Save the PDF file as inventory_2012_maps.pdf in your exercise_data\forestry\
samplig\map_creation\ folder.

5. 打开 PDF文件，检查一切是否按预期进行。
6. 可以同样轻松地为每幅地图创建单独的图像 (记住取消勾选单个文件创建)，在此您可以看到将创建
图像的缩略图：

7. In the Print Layout, press Save in order to save your print layout changes in the project. This also saves the
project file. You can reopen the project at any time and run or edit the atlas.
It is also possible to save your map as a layout template as forestry_atlas.qpt in your
exercise_data\forestry\map_creation\ folder. Use Layout ► Save as Template. You will be
able to use this template again and again in other projects.

8. Close the Print Layout and the project.

14.6.10 In Conclusion

您已经成功创建了一个模板地图，可用于自动生成要在现场中使用的详图地图，以帮助导航到不同的地
块。正如您所注意到的，这不是一项简单的任务，但当您需要为其他地区创建类似的地图时，可以使用
刚刚保存的模板，这将节省许多时间。
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14.6.11 What’s Next?

In the next lesson, you will see how you can use LiDAR data to create a DEM and then use it to enhance your data
and maps visibility.

14.7 课: 计算森林参数

森林资源清查的目标是估算森林的参数。继续上一课的示例，您将使用现场收集的资源清查信息来计算
森林参数，首先计算整个林区，然后计算之前数字化林分的森林参数。

本课目标: 计算常规和林分水平的森林参数。

14.7.1 跟我做: 添加清查结果

现场团队勘查了森林，并在您提供的信息的帮助下，收集了每个取样地的森林信息。

通常情况下，这些信息将在现场被收集到纸质表格中，然后再输入电子表格。样地信息已压缩为 .csv
文件，并可以在 QGIS中轻松打开。
继续有关设计清查课程的 QGIS工程，您可能将其命名为 forest_inventory.qgs。

首先，将样地测量值添加到 QGIS工程中：
1. 转到图层 ►添加图层 ►添加分隔文本图层... 。

2. 浏览至位于exercise_data/forestry/results/中的systematic_inventory_results.
csv文件。

3. 确保已选中点坐标选项。
4. 将坐标字段设置为 X和 Y 字段。

5. 单击确定。
6. 出现提示时，选择 ETRS89 / ETRS-TM35FIN 作为 CRS。新版是在分隔文本对话框中直接选择坐标

EPSG:3067。
7. 打开新图层的属性表并查看数据。

您可以在文本文件 legend_2012_inventorydata.txt中读取样地测量值所包含的数据类型，该文
件位于 exercise_data/forestry/results/文件夹。

刚才添加的 systematic_inventory_results图层实际只是 .csv文件中文本信息的虚拟描述。继
续之前，请将资源清查结果转换为真正的空间数据集：

1. 右键单击 systematic_inventory_results图层，在快捷菜单中单击”导出 >要素另存为”。
2. ”格式”选择 ESRI Shapefile，并浏览至 exercise_data/forestry/results/文件夹。

3. 命名文件为 sample_plots_results.shp。

4. 勾选将已保存的文件添加到地图中。
5. 从工程中移除 systematic_inventory_results图层。

14.7. 课: 计算森林参数 439



QGIS Training Manual

14.7.2 跟我做: 全林参数估算

您可以根据一些有趣参数的清查结果计算整片森林面积的平均值，如每公顷的材积和树干数量。由于系
统取样地表示相等的面积，因此可以从 sample_plots_results图层直接计算每公顷的材积和树干
数量的平均值。

可以使用基本统计工具计算矢量图层中字段的平均值：

1. 打开矢量 ►分析工具 ►字段基本统计。
2. 选择 sample_plots_results作为输入图层。

3. 选择 Vol为目标字段 (依赖的统计字段)。

4. 单击确定。
森林的平均材积量为 135.2 m3/ha。

您可以使用同样的方法计算树干数量的平均值，其结果为 2745 stems/ha。

14.7.3 跟我做: 估算林分参数

您可以使用这些相同的系统样地来计算之前数字化的不同林分的估算值。一些林分没有得到任何样地，
对于这些样地，将无法获得信息。在规划系统清查时，可以规划一些额外的取样地，以便现场团队为此
目的而测量一些额外的样地。或者可以稍后派一个现场团队来估算缺失的林分，完成林分清查。然而，
仅使用规划的地块，就可以获得大量林分的信息。

您需要的是获得每个林分内取样地的平均值。当您想根据它们的相对位置组合信息时，请执行空间连接：

1. 打开矢量 ►数据管理工具 ►按位置连接属性工具。
2. 将 forest_stands_2012设置为目标矢量图层。想要其结果的图层。

3. 将 sample_plots_results设置为连接矢量图层。要从中计算估计值的图层

4. 勾选获取相交要素的汇总。
5. 勾选仅计算平均值。
6. 将结果命名为 forest_stands_2012_results.shp ，并将其保存在 exercise_data/

forestry/results/文件夹。

7. 最后选择保留所有记录... ，这样您可以稍后查看哪些林分未获得信息。

8. 单击确定。
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9. 出现提示时同意将新图层添加到工程中。
10. 关闭按位置连接属性工具。
打开 forest_stands_2012_results的属性表，并查看获取的结果。请注意，许多林分的计算值为 NULL，这
些林分没有样地。全部选中并在地图中查看，它们是一些较小的林分：

现在让我们像之前一样计算整片森林的平均值，只是这次您将使用林分的平均值作为计算的基础。请记
住，在前一种情况下，每个样地代表一个 80x80 m的理论林分。现在您必须单独考虑每个林分的面积。
这样，它们的参数平均值 (例如，m3/ha)将再次转换为林分的总林积。
您需要首先计算林分的面积，然后计算每个林分的总材积和树干数量：
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1. 在属性表中启用编辑。
2. 打开字段计算器。
3. 创建一个名为 area的新字段。

4. 将输出字段类型设置为小数 (实型)。

5. 将精度设置为 2。

6. 在表达式框中，写入 $area / 10000。这将以公顷为单位计算林分的面积。

7. 单击确定。
现在，用每个林分估算的总材积和树干数量计算字段：

1. 将字段命名为 s_vol和 s_stem。

2. 字段可以是整数，也可以使用实数。
3. 表达式 "area" * "MEANVol"和 "area" * "MEANStems"分别用于总材积和总树干数。

4. 完成后保存编辑。
5. 禁用编辑。

在以前的情况下，每块样地所代表的面积都是相同的，因此计算样地的平均值就足够了。现在要计算估
计值，需要将林分材积或树干数量之和除以包含信息的林分面积之和。

1. 在 forest_stands_2012_results图层的属性表中，选择包含信息的所有林分。

2. 打开矢量 ►分析工具 ►字段基本统计。
3. 选择 forest_stands_2012_results作为输入图层。

4. 选择 area作为依赖的统计字段。

5. 勾选仅选中的要素。
6. 单击确定。
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如您所见，林分总面积为 66.04 ha。请注意，缺失林分的面积只有约 7 ha。

同样，可以计算出这些林分的总材积为 8908 m3/ha，总树干数为 179594 stems。

使用来自林分的信息，而不是直接使用来自取样地的信息，得出以下平均估计值：

• 184.9 m3/ha和

• 2719 stems/ha。

保存 QGIS工程 forest_inventory.qgs。
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14.7.4 In Conclusion

您设法使用系统样地中的信息计算整片森林的森林估算值，首先不考虑森林特性，也不使用航拍图像到
林分的说明。您还获得了一些关于特定林分有价值的信息，这些信息可以用来规划未来几年的森林管理。

14.7.5 What’s Next?

下一课，您将首先从 LiDAR数据集创建山体阴影背景，用于使用刚才计算的森林结果准备地图报告。

14.8 课: 基于 LiDAR数据的 DEM

通过使用不同的背景图像，可以改善地图的外观。您可以使用之前使用过的底图或航拍图像，但在某些
情况下，地形的山体阴影栅格看起来会更好。

您将使用 LAStools从 LiDAR数据集中提取 DEM，然后创建山体阴影栅格，以便稍后在地图表达中使用。
本课目标: 安装 LAStools并根据 LiDAR数据和山体阴影栅格计算 DEM。

14.8.1 跟我做: 安装 Lastools

使用 LAStools提供的处理框架和算法，可以在 QGIS中管理 LiDAR数据。
您可以从 LiDAR点云获取数字高程模型 (DEM)，然后创建一个更直观的山体阴影栅格，便于报告。首
先，为正确使用 LAStools必须设置处理框架设置：

• 如果已经启动 QGIS，请关闭。
• 默认情况下，您的系统可能会安装旧版 LiDAR 插件，该插件位于 C:/Program Files/QGIS
Valmiera/apps/qgis/python/plugins/processing/文件夹。

• 如果您有一个名为 lidar的文件夹，请将其删除。这对 QGIS 2.2和 2.4的某些安装有效。
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• Go to the exercise_data\forestry\lidar\ folder, there you can find the file
QGIS_2_2_toolbox.zip. Open it and extract the lidar folder to replace the one you just deleted.

• If you are using a different QGIS version, you can see more installation instructions in this tutorial.
Now you need to install the LAStools to your computer. Get the newest lastools version here and extract the content of
the lastools.zip file into a folder in your system, for example, C:\lastools\. The path to the lastools
folder cannot have spaces or special characters.

备注: Read the LICENSE.txt file inside the lastools folder. Some of the LAStools are open source and other
are closed source and require licensing for most commercial and governmental use. For education and evaluation
purposes you can use and test LAStools as much as you need to.

The plugin and the actual algorithms are now installed in your computer and almost ready to use, you just need to set
up the Processing framework to start using them:

• Open a new project in QGIS.
• Set the project’s CRS to ETRS89 / ETRS-TM35FIN.
• Save the project as forest_lidar.qgs.

To setup the LAStools in QGIS:
• Go to Processing ► Options and configuration.
• In the Processing options dialog, go to Providers and then to Tools for LiDAR data.
• Check Activate.
• For LAStools folder set c:\lastools\ (or the folder you extracted LAStools to).
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14.8.2 Follow Along: Calculating a DEM with LAStools

You have already used the Processing toolbox in Lesson: Spatial Statistics to run some SAGA algorithms. Now you
are going to use it to run LAStools programs:

• Open Processing ► Toolbox.
• In the dropdown menu at the bottom, select Advanced interface.
• You should see the Tools for LiDAR data category.
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• Expand it to see the tools available, and expand also the LAStools category (the number of algorithms may
vary).

• Scroll down until you find the lasview algorithm, double click it to open.
• At Input LAS/LAZ file, browse to exercise_data\forestry\lidar\ and select the
rautjarvi_lidar.laz file.

• 单击运行。
Now you can see the LiDAR data in the just a little LAS and LAZ viewer dialog window:
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There are many things you can do within this viewer, but for now you can just click and drag on the viewer to pan
the LiDAR point cloud to see what it looks like.

备注: If you want to know further details on how the LAStools work, you can read the README text files about
each of the tools, in the C:\lastools\bin\ folder. Tutorials and other materials are available at the Rapidlasso
webpage.

• Close the viewer when you are ready.
Creating a DEM with LAStools can be done in two steps, first one to classify the point cloud into ground and no
ground points and then calculating a DEM using only the ground points.

• Go back to the Processing Toolbox.
• Note the Search... box, write lasground.
• Double click to open the lasground tool and set it as shown in this image:
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• The output file is saved to the same folder where the rautjarvi_lidar.laz is located and it is named
rautjarvi_lidar_1.las.

You can open it with lasview if you want to check it.
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The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README.txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

• Close the viewer again.
• In the Processing Toolbox, search for las2dem.
• Open the las2dem tool and set it as shown in this image:
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The result DEM is added to your map with the generic name Output raster file.

备注: The lasground and las2dem tools require licensing. You can use the unlicensed tool as indicated in the license
file, but you get the diagonals you can appreciate in the image results.

14.8.3 Follow Along: Creating a Terrain Hillshade

For visualization purposes, a hillshade generated from a DEM gives a better
visualization of the terrain:

• Open Raster ► Terrain analysis ► Hillshade.
• As the Output layer, browse to exercise_data\forestry\lidar\ and name the file hillshade.
tif.

• Leave the rest of parameters with the default settings.
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• Select ETRS89 / ETRS-TM35FIN as the CRS when prompted.
Despite the diagonal lines remaining in the hillshade raster result, you can clearly see an accurate relief of the area.
You can even see the different soil drains that have been dug in the forests.
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14.8.4 In Conclusion

Using LiDAR data to get a DEM, specially in forested areas, gives good results with not much effort. You could also
use ready LiDAR derived DEMs or other sources like the SRTM 9m resolution DEMs. Either way, you can use them
to create a hillshade raster to use in your map presentations.
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14.8.5 What’s Next?

In the next, and final step in this module, lesson you will use the hillshade raster and the forest inventory results to
create a map presentation of the results.

14.9 课: 地图表达

In the previous lessons you have imported an old forest inventor as a GIS project, updated it to the current situ-
ation, designed a forest inventory, created maps for the field work and calculated forest parameters from the field
measurements.
It is often important to create maps with the results of a GIS project. A map presenting the results of the forest
inventory will make it easier for anyone to have a good idea of what the results are in a quick glance, without looking
at the specific numbers.
The goal for this lesson: Create a map to present the inventory results using a hillshade raster as background.

14.9.1 Follow Along: Preparing the Map Data

Open the QGIS project from the parameters calculations lesson, forest_inventory.qgs. Keep at least the
following layers:

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial。

• lakes (if you don’t have it, add it from the exercise_data\forestry\ folder).
You are going to present the average volumes of your forest stands in a map. If you open the Attribute table for the
forest_stands_2012_results layer, you can see the NULL values for the stands without information. To
be able to get also those stands into your symbology you should change the NULL values to, for example, -999,
knowing that those negative numbers mean there is no data for those polygons.
For the forest_stands_2012_results layer:

• Open the Attribute table and enable editing.
• Select the polygons with NULL values.
• Use the calculator to update the values of the MEANVol field to -999 only for the selected features.
• Disable editing and save the changes.

Now you can use a saved style for this layer:
• 转到符号化选项卡。
• Click on Style ► Load Style....
• Select the forest_stands_2012_results.qml from the exercise_data\forestry\
results\ folder.

• 单击确定。
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您的地图将如下所示：
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14.9.2 Try Yourself Try Different Blending Modes

The style you loaded:

456 Chapter 14. 单元: 林业应用



QGIS Training Manual

is using the Hard light mode for the Layer blending mode. Note that the different modes apply different filters
combining the underlying and overlying layers, in this case the hillshade raster and your forest stands are used. You
can read about these modes in the User Guide.
Try with different modes and see the differences in your map. Then choose the one you like better for your final map.

14.9.3 Try Yourself Using a Layout Template to Create the Map result

Use a template prepared in advanced to present the results. The template forest_map.qpt is located in the
exercise_data\forestry\results\ folder. Load it using the Project ► Layout Manager... dialog.
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Open the print layout and edit the final map to get a result you are happy with.
The map template you are using will give a map similar to this one:
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Save your QGIS project for future references.
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14.9.4 In Conclusion

Through this module you have seen how a basic forest inventory can be planned and presented with QGIS. Many
more forest analysis are possible with the variety of tools that you can access, but hopefully this manual has given you
a good starting point to explore how you could achieve the specific results you need.
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单元: PostgreSQL数据库概念

关系数据库是所有 GIS系统的重要组成部分。在本单元，您将了解关系数据库管理系统 (RDBMS)的概
念，并使用 PostgreSQL创建新的数据库来储存数据，还要了解其他典型的 RDBMS功能。

15.1 Lesson: Introduction to Databases

Before using PostgreSQL, let’s make sure of our ground by covering general database theory. You will not need to
enter any of the example code; it’s only there for illustration purposes.
The goal for this lesson: To understand fundamental database concepts.

15.1.1 What is a Database?

A database consists of an organized collection of data for one or more uses, typically in digital form. - Wikipedia
A database management system (DBMS) consists of software that operates databases, providing storage, access,
security, backup and other facilities. - Wikipedia

15.1.2 Tables

In relational databases and flat file databases, a table is a set of data elements (values) that is organized using a model
of vertical columns (which are identified by their name) and horizontal rows. A table has a specified number of
columns, but can have any number of rows. Each row is identified by the values appearing in a particular column
subset which has been identified as a candidate key. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

In SQL databases a table is also known as a relation.
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15.1.3 Columns / Fields

A column is a set of data values of a particular simple type, one for each row of the table. The columns provide
the structure according to which the rows are composed. The term field is often used interchangeably with column,
although many consider it more correct to use field (or field value) to refer specifically to the single item that exists at
the intersection between one row and one column. - Wikipedia
A column:

| name |
+-------+
| Tim |
| Horst |

A field:

| Horst |

15.1.4 Records

A record is the information stored in a table row. Each record will have a field for each of the columns in the table.

2 | Horst | 88 <-- one record

15.1.5 Datatypes

Datatypes restrict the kind of information that can be stored in a column. - Tim and Horst

There are many kinds of datatypes. Let’s focus on the most common:
• String - to store free-form text data
• Integer - to store whole numbers
• Real - to store decimal numbers
• Date - to store Horst’s birthday so no one forgets
• Boolean - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field
content is referred to as a ’null’ value:

insert into person (age) values (40);

select * from person;

Result:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

There are many more datatypes you can use - check the PostgreSQL manual!
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15.1.6 Modelling an Address Database

Let’s use a simple case study to see how a database is constructed. We want to create an address database.

Try Yourself

Write down the properties which make up a simple address and which we would want to store in our database.

回答

For our theoretical address table, we might want to store the following properties:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

When creating the table to represent an address object, we would create columns to represent each of these properties
and we would name them with SQL-compliant and possibly shortened names:

house_number
street_name
suburb
city
postcode
country

Address Structure

The properties that describe an address are the columns. The type of information stored in each column is its datatype.
In the next section we will analyse our conceptual address table to see how we can make it better!

15.1.7 Database Theory

The process of creating a database involves creating a model of the real world; taking real world concepts and repre-
senting them in the database as entities.

15.1.8 Normalisation

One of the main ideas in a database is to avoid data duplication / redundancy. The process of removing redundancy
from a database is called Normalisation.
Normalization is a systematic way of ensuring that a database structure is suitable for general-purpose querying and
free of certain undesirable characteristics - insertion, update, and deletion anomalies - that could lead to a loss of data
integrity. - Wikipedia
There are different kinds of normalisation ’forms’.
Let’s take a look at a simple example:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------

(续下页)
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(接上页)
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imagine you have many friends with the same street name or city. Every time this data is duplicated, it consumes
space. Worse still, if a city name changes, you have to do a lot of work to update your database.

15.1.9 Try Yourself

Redesign the theoretical people table above to reduce duplication and to normalise the data structure.
You can read more about database normalisation here

回答

The major problem with the people table is that there is a single address field which contains a person’s entire address.
Thinking about our theoretical address table earlier in this lesson, we know that an address is made up of many
different properties. By storing all these properties in one field, we make it much harder to update and query our
data. We therefore need to split the address field into the various properties. This would give us a table which has the
following structure:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

In the next section, you will learn about Foreign Key relationships which could be used in this example to further
improve our database’s structure.

15.1.10 Indexes

A database index is a data structure that improves the speed of data retrieval operations on a database table. -
Wikipedia

Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index!
You will have to start reading at one cover and work your way through the entire book until you find the information
you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

create index person_name_idx on people (name);

Now searches on name will be faster:
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Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Sequences

A sequence is a unique number generator. It is normally used to create a unique identifier for a column in a table.
In this example, id is a sequence - the number is incremented each time a record is added to the table:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Entity Relationship Diagramming

In a normalised database, you typically have many relations (tables). The entity-relationship diagram (ERDiagram) is
used to design the logical dependencies between the relations. Consider our non-normalised people table from earlier
in the lesson:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who live
in the same street:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

and:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)
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We can then link the two tables using the ’keys’ streets.id and people.streets_id.
If we draw an ER Diagram for these two tables it would look something like this:

The ER Diagram helps us to express ’one to many’ relationships. In this case the arrow symbol show that one street
can have many people living on it.

Try Yourself

Our peoplemodel still has some normalisation issues - try to see if you can normalise it further and show your thoughts
by means of an ER Diagram.

回答

Our people table currently looks like this:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

The street_id column represents a ’one to many’ relationship between the people object and the related street object,
which is in the streets table.
One way to further normalise the table is to split the name field into first_name and last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We can also create separate tables for the town or city name and country, linking them to our people table via ’one to
many’ relationships:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

An ER Diagram to represent this would look like this:
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15.1.13 Constraints, Primary Keys and Foreign Keys

A database constraint is used to ensure that data in a relation matches the modeller’s view of how that data should be
stored. For example a constraint on your postal code could ensure that the number falls between 1000 and 9999.
A Primary key is one or more field values that make a record unique. Usually the primary key is called id and is a
sequence.
A Foreign key is used to refer to a unique record on another table (using that other table’s primary key).
In ER Diagramming, the linkage between tables is normally based on Foreign keys linking to Primary keys.
If we look at our people example, the table definition shows that the street column is a foreign key that references the
primary key on the streets table:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
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15.1.14 Transactions

When adding, changing, or deleting data in a database, it is always important that the database is left in a good state if
something goes wrong. Most databases provide a feature called transaction support. Transactions allow you to create
a rollback position that you can return to if your modifications to the database did not run as planned.
Take a scenario where you have an accounting system. You need to transfer funds from one account and add them
to another. The sequence of steps would go like this:

• remove R20 from Joe
• add R20 to Anne

If something goes wrong during the process (e.g. power failure), the transaction will be rolled back.

15.1.15 In Conclusion

Databases allow you to manage data in a structured way using simple code structures.

15.1.16 What’s Next?

Now that we’ve looked at how databases work in theory, let’s create a new database to implement the theory we’ve
covered.

15.2 Lesson: Implementing the Data Model

Now that we’ve covered all the theory, let’s create a new database. This database will be used for our exercises for
the lessons that will follow afterwards.
The goal for this lesson: To install the required software and use it to implement our example database.

15.2.1 Install PostgreSQL

备注: You can find PostgreSQL packages and installation instructions for your operating system at https://www.
postgresql.org/download/. Please note that the documentation will assume users are running QGIS under Ubuntu.

Under Ubuntu:

sudo apt install postgresql-9.1

You should get a message like this:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.

(续下页)
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(接上页)
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Press Y and Enter and wait for the download and installation to finish.

15.2.2 帮助

PostgreSQL has very good online documentation.

15.2.3 Create a database user

Under Ubuntu:
After the installation is complete, run this command to become the postgres user and then create a new database user:

sudo su - postgres

Type in your normal log in password when prompted (you need to have sudo rights).
Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix login
name: it will make your life much easier, as postgres will automatically authenticate you when you are logged in as
that user:

createuser -d -E -i -l -P -r -s qgis

Enter a password when prompted. You should use a different password to your login password.
What do those options mean?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Now you should leave the postgres user’s bash shell environment by typing:

exit

15.2.4 Verify the new account

psql -l

Should return something like this:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Type Q to exit.
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15.2.5 Create a database

The createdb command is used to create a new database. It should be run from the bash shell prompt:

createdb address -O qgis

You can verify the existence of your new database by using this command:

psql -l

Which should return something like this:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Type Q to exit.

15.2.6 Starting a database shell session

You can connect to your database easily like this:

psql address

To exit out of the psql database shell, type:

\q

For help in using the shell, type:

\?

For help in using sql commands, type:

\help

To get help on a specific command, type (for example):

\help create table

See also the Psql cheat sheet.

15.2.7 Make Tables in SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

psql address

Then create a streets table:

create table streets (id serial not null primary key, name varchar(50));
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serial and varchar are data types. serial tells PostgreSQL to start an integer sequence (auto-number) to
populate the id automatically for every new record. varchar(50) tells PostgreSQL to create a character field of
50 characters in length.
You will notice that the command ends with a ; - all SQL commands should be terminated this way. When you press
Enter, psql will report something like this:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

That means your table was created successfully, with a primary key streets_pkey using streets.id.
Note: If you hit return without entering a ;, then you will get a prompt like this: address-#. This is because PG
is expecting you to enter more. Enter ; to run your command.
To view your table schema, you can do this:

\d streets

Which should show something like this:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

select * from streets;

Which should show something like this:

id | name
---+------
(0 rows)

As you can see, our table is currently empty.

Try Yourself

Use the approach shown above to make a table called people:
Add fields such as phone number, home address, name, etc. (these aren’t all valid names: change them to make them
valid). Make sure you give the table an ID column with the same data-type as above.

回答

The SQL required to create the correct people table is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

The schema for the table (enter \\d people) looks like this:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

For illustration purposes, we have purposely omitted the fkey constraint.

15.2.8 Create Keys in SQL

The problem with our solution above is that the database doesn’t know that people and streets have a logical rela-
tionship. To express this relationship, we have to define a foreign key that points to the primary key of the streets
table.

There are two ways to do this:
• Add the key after the table has been created
• Define the key at time of table creation

Our table has already been created, so let’s do it the first way:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

That tells the people table that its street_id fields must match a valid street id from the streets table.
The more usual way to create a constraint is to do it when you create the table:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

After adding the constraint, our table schema looks like this now:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |

(续下页)
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house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Create Indexes in SQL

We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column
of our people table:

create index people_name_idx on people(name);

\d people

Which results in:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 Dropping Tables in SQL

If you want to get rid of a table you can use the drop command:

drop table streets;

In our current example, the above command would not work. Why not?

回答

The reason the DROP command would not work in this case is because the people table has a Foreign Key constraint
to the streets table. This means that dropping (or deleting) the streets table would leave the people table with references
to non-existent streets data.
It is possible to ’force’ the streets table to be deleted by using the CASCADE command, but this would also delete the
people and any other table which had a relationship to the streets table. Use with caution!

If you used the same drop table command on the people table, it would be successful:

drop table people;
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备注: If you actually did enter that command and dropped the people table, now would be a good time to rebuild
it, as you will need it in the next exercises.

15.2.11 A word on pgAdmin III

We are showing you the SQL commands from the psql prompt because it’s a very useful way to learn about databases.
However, there are quicker and easier ways to do a lot of what we are showing you. Install pgAdmin III and you can
create, drop, alter etc tables using ’point and click’ operations in a GUI.
Under Ubuntu, you can install it like this:

sudo apt install pgadmin3

pgAdmin III will be covered in more detail in another module.

15.2.12 In Conclusion

You have now seen how to create a brand new database, starting completely from scratch.

15.2.13 What’s Next?

Next you’ll learn how to use the DBMS to add new data.

15.3 Lesson: Adding Data to the Model

The models we’ve created will now need to be populated with the data they’re intended to contain.
The goal for this lesson: To learn how to insert new data into the database models.

15.3.1 Insert statement

How do you add data to a table? The sql INSERT statement provides the functionality for this:

insert into streets (name) values ('High street');

A couple of things to note:
• After the table name (streets), you list the column names that you will be populating (in this case only the
name column).

• After the values keyword, place the list of field values.
• Strings should be quoted using single quotes.
• Note that we did not insert a value for the id column; this is because it is a sequence and will be auto-generated.
• If you do manually set the id, you may cause serious problems with the integrity of your database.

You should see INSERT 0 1 if it is successful.
You can see the result of your insert action by selecting all the data in the table:

select * from streets;
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Result:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Use the INSERT command to add a new street to the streets table.

回答

The SQL command you should use looks like this (you can replace the street name with a name of your choice):

insert into streets (name) values ('Low Road');

15.3.2 Sequencing Data Addition According to Constraints

15.3.3 Try Yourself

Try to add a person object to the people table with the following details:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

备注: Recall that in this example, we defined phone numbers as strings, not integers.

At this point, you should have an error report if you try to do this without first creating a record for Main Street in
the streets table.
You should have also noticed that:

• You can’t add the street using its name
• You can’t add a street using a street id before first creating the street record on the streets table

Remember that our two tables are linked via a Primary/Foreign Key pair. This means that no valid person can be
created without there also being a valid corresponding street record.
Using the above knowledge, add the new person to the database.

回答

Here is the correct SQL statement:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');

If you look at the streets table again (using a select statement as before), you’ll see that the id for the Main Road
entry is 2.
That’s why we could merely enter the number 2 above. Even though we’re not seeing Main Road written out fully
in the entry above, the database will be able to associate that with the street_id value of 2.
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If you have already added a new street object, you might find that the new Main Road has an id of 3 not 2.

15.3.4 Select data

We have already shown you the syntax for selecting records. Let’s look at a few more examples:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

In later sessions we will go into more detail on how to select and filter data.

15.3.5 Update data

What if you want to make a change to some existing data? For example, a street name is changed:

update streets set name='New Main Road' where name='Main Road';

Be very careful using such update statements - if more than one record matches your WHERE clause, they will all be
updated!
A better solution is to use the primary key of the table to reference the record to be changed:

update streets set name='New Main Road' where id=2;

It should return UPDATE 1.

备注: the WHERE statement criteria are case sensitive Main Road is not the same as Main road

15.3.6 Delete Data

In order to delete an object from a table, use the DELETE command:

delete from people where name = 'Joe Smith';

Let’s look at our people table now:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)
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15.3.7 Try Yourself

Use the skills you have learned to add some new friends to your database:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Now you know how to add new data to the existing models you created previously. Remember that if you want to
add new kinds of data, you may want to modify and/or create new models to contain that data.

15.3.9 What’s Next?

Now that you’ve added some data, you’ll learn how to use queries to access this data in various ways.

15.4 Lesson: Queries

When you write a SELECT ... command it is commonly known as a query - you are interrogating the database
for information.
The goal of this lesson: To learn how to create queries that will return useful information.

备注: If you did not do so in the previous lesson, add the following people objects to your people table. If you
receive any errors related to foreign key constraints, you will need to add the ’Main Road’ object to your streets table
first

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Ordering Results

Let’s retrieve a list of people ordered by their house numbers:

select name, house_no from people order by house_no;

Result:

name | house_no
--------------+----------
Joe Bloggs | 3

(续下页)

15.4. Lesson: Queries 477



QGIS Training Manual

(接上页)
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

You can sort the results by the values of more than one column:

select name, house_no from people order by name, house_no;

Result:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 Filtering

Often you won’t want to see every single record in the database - especially if there are thousands of records and you
are only interested in seeing one or two.
Here is an example of a numerical filter which only returns objects whose house_no is less than 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can combine filters (defined using the WHERE clause) with sorting (defined using the ORDER BY clause):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can also filter based on text data:

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Here we used the LIKE clause to find all names with an s in them. You’ll notice that this query is case-sensitive, so
the Sally Norman entry has not been returned.
If you want to search for a string of letters regardless of case, you can do a case in-sensitive search using the ILIKE
clause:
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select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

That query returned every people object with an r or R in their name.

15.4.3 Joins

What if you want to see the person’s details and their street’s name instead of the ID? In order to do that, you need
to join the two tables together in a single query. Lets look at an example:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

备注: With joins, you will always state the two tables the information is coming from, in this case people and streets.
You also need to specify which two keys must match (foreign key & primary key). If you don’t specify that, you will
get a list of all possible combinations of people and streets, but no way to know who actually lives on which street!

Here is what the correct output will look like:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We will revisit joins as we create more complex queries later. Just remember they provide a simple way to combine
the information from two or more tables.

15.4.4 Sub-Select

Sub-selections allow you to select objects from one table based on the data from another table which is linked via a
foreign key relationship. In our case, we want to find people who live on a specific street.
First, let’s do a little tweaking of our data:

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Let’s take a quick look at our data after those changes: we can reuse our query from the previous section:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Result:
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name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Now let’s show you a sub-selection on this data. We want to show only people who live in street_id number 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Result:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Although this is a very simple example and unnecessary with our small data-sets, it illustrates how useful and important
sub-selections can be when querying large and complex data-sets.

15.4.5 Aggregate Queries

One of the powerful features of a database is its ability to summarise the data in its tables. These summaries are
called aggregate queries. Here is a typical example which tells us how many people objects are in our people table:

select count(*) from people;

Result:

count
-------

4
(1 row)

If we want the counts to be summarised by street name we can do this:

select count(name), street_id
from people
group by street_id;

Result:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

备注: Because we have not used an ORDER BY clause, the order of your results may not match what is shown here.
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Try Yourself

Summarise the people by street name and show the actual street names instead of the street_ids.

回答

Here is the correct SQL statement you should use:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Result:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

You will notice that we have prefixed field names with table names (e.g. people.name and streets.name). This needs
to be done whenever the field name is ambiguous (i.e. not unique across all tables in the database).

15.4.6 In Conclusion

You’ve seen how to use queries to return the data in your database in a way that allows you to extract useful information
from it.

15.4.7 What’s Next?

Next you’ll see how to create views from the queries that you’ve written.

15.5 Lesson: Views

When you write a query, you need to spend a lot of time and effort formulating it. With views, you can save the
definition of an SQL query in a reusable ’virtual table’.
The goal for this lesson: To save a query as a view.

15.5.1 Creating a View

You can treat a view just like a table, but its data is sourced from a query. Let’s make a simple view based on the
above:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

As you can see the only change is the create view roads_count_v as part at the beginning. We can now
select data from that view:
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select * from roads_count_v;

Result:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Modifying a View

A view is not fixed, and it contains no ’real data’. This means you can easily change it without impacting on any data
in your database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(This example also shows the best practice convention of using UPPER CASE for all SQL keywords.)
You will see that we have added an ORDER BY clause so that our view rows are nicely sorted:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Dropping a View

If you no longer need a view, you can delete it like this:

drop view roads_count_v;

15.5.4 In Conclusion

Using views, you can save a query and access its results as if it were a table.

15.5.5 What’s Next?

Sometimes, when changing data, you want your changes to have effects elsewhere in the database. The next lesson
will show you how to do this.
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15.6 Lesson: Rules

Rules allow the ”query tree” of an incoming query to be rewritten. One common usage is to implement views,
including updatable view. - Wikipedia
The goal for this lesson: To learn how to create new rules for the database.

15.6.1 Creating a logging rule

Say you want to log every change of phone_no in your people table in to a people_log table. So you set up a new
table:

create table people_log (name text, time timestamp default NOW());

In the next step, create a rule that logs every change of a phone_no in the people table into the people_log table:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

To test that the rule works, let’s modify a phone number:

update people set phone_no = '082 555 1234' where id = 2;

Check that the people table was updated correctly:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Now, thanks to the rule we created, the people_log table will look like this:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

备注: The value of the time field will depend on the current date and time.

15.6.2 In Conclusion

Rules allow you to automatically add or change data in your database to reflect changes in other parts of the database.
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15.6.3 What’s Next?

The next module will introduce you to Spatial Database using PostGIS, which takes these database concepts and
applies them to GIS data.
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Module: Spatial Database Concepts with PostGIS

Spatial Databases allow the storage of the geometries of records inside a Database as well as providing functionality
for querying and retrieving the records using these Geometries. In this module we will use PostGIS, an extension to
PostgreSQL, to learn how to setup a spatial database, import data into the database and make use of the geographic
functions that PostGIS offers.
While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from Boston
GIS user group. Another useful resource is the online PostGIS documentation.
There are also some more extensive tutorials on PostGIS and Spatial Databases created by Boundless that are now
hosted on the PostGIS’s website:

• Introduction to PostGIS
• PostGIS Database Tips and Tricks

See also PostGIS In Action.

16.1 Lesson: PostGIS Setup

Setting up PostGIS functions will allow you to access spatial functions from within PostgreSQL.
The goal for this lesson: To install spatial functions and briefly demo their effects.

备注: We will assume the use of PostGIS version 2.1 or newer in this exercise. The installation and database
configuration are different for older versions, but the rest of this material in this module will still work. Consult the
documentation for your platform for help with installation and database configuration.
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16.1.1 Installing under Ubuntu

Postgis is easily installed from apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Really, it’s that easy...

备注: The exact versions that will be installed depend on which version of Ubuntu you are using and
which repositories you have configured. After installing you can check the version by issuing a select
PostGIS_full_version(); query with psql or another tool.

To install a specific version (eg, PostgreSQL version 13 and PostGIS 3), you can use the following commands.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installing under Windows

Installing on Windows can be done from binary packages using a normal Windows installation dialogs.
First Visit the download page. Then follow this guide.
More information about installing on Windows can be found on the PostGIS website.

16.1.3 Installing on Other Platforms

The PostGIS website download has information about installing on other platforms including macOS and on other
Linux distributions

16.1.4 Configuring Databases to use PostGIS

Once PostGIS is installed, you will need to configure your database to use the extensions. If you have installed
PostGIS version > 2.0, this is as simple as issuing the following command with psql using the address database from
our previous exercise.

$ psql -d address -c "CREATE EXTENSION postgis;"

备注: Depending on your version, you could find more instructions on how to spatially enable a database at https:
//postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Looking at the installed PostGIS functions

PostGIS can be thought of as a collection of in-database functions that extend the core capabilities of PostgreSQL so
that it can deal with spatial data. By ’deal with’, we mean store, retrieve, query and manipulate. In order to do this, a
number of functions are installed into the database.
Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot
deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point
from text. First we use the psql command to find functions relating to point. If you are not already connected to the
address database, do so now. Then run:

\df *point*

This is the command we’re looking for: st_pointfromtext. To page through the list, use the down arrow, then
press Q to quit back to the psql shell.
Try running this command:

select st_pointfromtext('POINT(1 1)');

Result:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Three things to note:
• We defined a point at position 1,1 (EPSG:4326 is assumed) using POINT(1 1),
• We ran an sql statement, but not on any table, just on data entered from the SQL prompt,
• The resulting row does not make much sense.

The resulting row is in the OGC format called ’Well Known Binary’ (WKB). We will look at this format in detail in
the next section.
To get the results back as text, we can do a quick scan through the function list for something that returns text:

\df *text

The query we’re looking for now is st_astext. Let’s combine it with the previous query:

select st_astext(st_pointfromtext('POINT(1 1)'));

Result:

st_astext
------------

POINT(1 1)
(1 row)

Here, we entered the string POINT(1,1), turned it into a point using st_pointfromtext(), and turned it
back into a human-readable form with st_astext(), which gave us back our original string.
One last example before we really get into the detail of using PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));

What did that do? It created a buffer of 1 degree around our point, and returned the result as text.
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16.1.6 Spatial Reference Systems

In addition to the PostGIS functions, the extension contains a collection of spatial reference system (SRS) definitions
as defined by the European Petroleum Survey Group (EPSG). These are used during operations such as coordinate
reference system (CRS) conversions.
We can inspect these SRS definitions in our database as they are stored in normal database tables.
First, let’s look at the schema of the table by entering the following command in the psql prompt:

\d spatial_ref_sys

The result should be this:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

You can use standard SQL queries (as we have learned from our introductory sections), to view and manipulate this
table - though its not a good idea to update or delete any records unless you know what you are doing.
One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

select * from spatial_ref_sys where srid=4326;

Result:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

The srtext is the projection definition in well known text (you may recognise this from .prj files in your shapefile
collection).

16.1.7 In Conclusion

You now have PostGIS functions installed in your copy of PostgreSQL. With this you’ll be able to make use of
PostGIS’ extensive spatial functions.
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16.1.8 What’s Next?

Next you’ll learn how spatial features are represented in a database.

16.2 Lesson: Simple Feature Model

How can we store and represent geographic features in a database? In this lesson we’ll cover one approach, the Simple
Feature Model as defined by the OGC.
The goal for this lesson: To learn what the SFS Model is and how to use it.

16.2.1 What is OGC

The Open Geospatial Consortium (OGC), an international voluntary consensus standards organization, originated
in 1994. In the OGC, more than 370+ commercial, governmental, nonprofit and research organizations worldwide
collaborate in an open consensus process encouraging development and implementation of standards for geospatial
content and services, GIS data processing and data sharing. - Wikipedia

16.2.2 What is the SFS Model

The Simple Feature for SQL (SFS) Model is a non-topological way to store geospatial data in a database and defines
functions for accessing, operating, and constructing these data.

The model defines geospatial data from Point, Linestring, and Polygon types (and aggregations of them to Multi
objects).
For further information, have a look at the OGC Simple Feature for SQL standard.

16.2. Lesson: Simple Feature Model 489

https://www.ogc.org/standards/sfs


QGIS Training Manual

16.2.3 Add a geometry field to table

Let’s add a point field to our people table:

alter table people add column the_geom geometry;

16.2.4 Add a constraint based on geometry type

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for that
we need a constraint:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL);

This adds a constraint to the table so that it will only accept a point geometry or a null value.

16.2.5 Try Yourself

Create a new table called cities and give it some appropriate columns, including a geometry field for storing polygons
(the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

回答

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = 'ST_Polygon'::text );

16.2.6 Populate geometry_columns table

At this point you should also add an entry into the geometry_columns table:

insert into geometry_columns values
('','public','people','the_geom',2,4326,'POINT');

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain
geometry data.

备注: If the above INSERT statement causes an error, run this query first:

select * from geometry_columns;

If the column f_table_name contains the value people, then this table has already been registered and you
don’t need to do anything more.

The value 2 refers to the number of dimensions; in this case, two: X and Y.
The value 4326 refers to the projection we are using; in this case, WGS 84, which is referred to by the number 4326
(refer to the earlier discussion about the EPSG).
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Try Yourself

Add an appropriate geometry_columns entry for your new cities layer

回答

insert into geometry_columns values
('','public','cities','the_geom',2,4326,'POLYGON');

16.2.7 Add geometry record to table using SQL

Now that our tables are geo-enabled, we can store geometries in them:

insert into people (name,house_no, street_id, phone_no, the_geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

备注: In the new entry above, you will need to specify which projection (SRID) you want to use. This is because
you entered the geometry of the new point using a plain string of text, which does not automatically add the correct
projection information. Obviously, the new point needs to use the same SRID as the data-set it is being added to, so
you need to specify it.
If at this point you were using a graphical interface, for example, specifying the projection for each point would be
automatic. In other words, you usually won’t need to worry about using the correct projection for every point you
want to add if you’ve already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your people table. Also, we should try editing / adding
/ deleting records and then performing select queries in the database to see how the data has changed.
To load a PostGIS layer in QGIS, use the Layer ► Add PostGIS Layers menu option or toolbar button:

This will open the dialog:
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Click on the New button to open this dialog:
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Then define a new connection, e.g.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

To see whether QGIS has found the address database and that your username and password are correct, click
Test Connect. If it works, check the boxes next to Save Username and Save Password. Then click OK to create this
connection.
Back in the Add PostGIS Layers dialog, click Connect and add layers to your project as usual.
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Try Yourself

Formulate a query that shows a person’s name, street name and position (from the the_geom column) as plain text.

回答

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Result:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

As you can see, our constraint allows nulls to be added into the database.

16.2.8 In Conclusion

You have seen how to add spatial objects to your database and view them in GIS software.

16.2.9 What’s Next?

Next you’ll see how to import data into, and export data from, your database.

16.3 Lesson: Import and Export

Of course, a database with no easy way to migrate data into it and out of it would not be of much use. Fortunately,
there are a number of tools that will let you easily move data into and out of PostGIS.

16.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI Shapefile to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Under Windows, you have to perform the import process in two steps:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

You may encounter this error:
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ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

This is a known issue regarding the creation in situ of a spatial index for the data you’re importing. To avoid the error,
exclude the -I parameter. This will mean that no spatial index is being created directly, and you’ll need to create it
in the database after the data have been imported. (The creation of a spatial index will be covered in the next lesson.)

16.3.2 pgsql2shp

pgsql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

To export the data using a query:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL library and has to be installed separately. To export a table from PostGIS to GML, you can use this command:

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 数据库管理器

You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a
unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export
from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly
mention it here.

16.3.5 In Conclusion

Importing and exporting data to and from the database can be done in many various ways. Especially when using
disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.6 What’s Next?

Next we’ll look at how to query the data we’ve created before.
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16.4 Lesson: Spatial Queries

Spatial queries are no different from other database queries. You can use the geometry column like any other database
column. With the installation of PostGIS in our database, we have additional functions to query our database.
The goal for this lesson: To see how spatial functions are implemented similarly to ”normal” non-spatial functions.

16.4.1 Spatial Operators

When you want to know which points are within a distance of 2 degrees to a point(X,Y) you can do this with:

select *
from people
where st_distance(the_geom,'SRID=4326;POINT(33 -34)') < 2;

Result:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

备注: the_geom value above was truncated for space on this page. If you want to see the point in human-readable
coordinates, try something similar to what you did in the section ”View a point as WKT”, above.

How do we know that the query above returns all the points within 2 degrees? Why not 2 meters? Or any other unit,
for that matter?

回答

The units being used by the example query are degrees, because the CRS that the layer is using is WGS 84. This
is a Geographic CRS, which means that its units are in degrees. A Projected CRS, like the UTM projections, is in
meters.
Remember that when you write a query, you need to know which units the layer’s CRS is in. This will allow you to
write a query that will return the results that you expect.

16.4.2 Spatial Indexes

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial index
on the geometry column use:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Result:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

(续下页)
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(接上页)
| | nextval('people_id_seq'::regclass)

name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Modify the cities table so its geometry column is spatially indexed.

回答

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

16.4.4 PostGIS Spatial Functions Demo

In order to demo PostGIS spatial functions, we’ll create a new database containing some (fictional) data.
To start, create a new database (exit the psql shell first):

createdb postgis_demo

Remember to install the postgis extensions:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Next, import the data provided in the exercise_data/postgis/ directory. Refer back to the previous lesson
for instructions, but remember that you’ll need to create a new PostGIS connection to the new database. You can
import from the terminal or via DB Manager. Import the files into the following database tables:

• points.shp into building
• lines.shp into road
• polygons.shp into region

Load these three database layers into QGIS via theAdd PostGIS Layers dialog, as usual. When you open their attribute
tables, you’ll note that they have both an id field and a gid field created by the PostGIS import.
Now that the tables are imported, we can use PostGIS to query the data. Go back to your terminal (command line)
and enter the psql prompt by running:

psql postgis_demo

We’ll demo some of these select statements by creating views from them, so that you can open them in QGIS and see
the results.
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Select by location

Get all the buildings in the KwaZulu region:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Result:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Or, if we create a view from it:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Add the view as a layer and view it in QGIS:
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Select neighbors

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Result:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

在 QGIS：

Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to
potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have,
we could use a buffer intersect instead:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom

(续下页)
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FROM region

WHERE name = 'Hokkaido';

This creates a buffer of 100 meters around the region Hokkaido.
The darker area is the buffer:

Select using the buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != 'Hokkaido';

In this query, the original buffer view is used as any other table would be. It is given the alias a, and its geometry field,
a.the_geom, is used to select any polygon in the region table (alias b) that intersects it. However, Hokkaido
itself is excluded from this select statement, because we don’t want it; we only want the regions adjoining it.
在 QGIS：
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It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

This achieves the same result, without need for the interim buffer step:

16.4. Lesson: Spatial Queries 501



QGIS Training Manual

Select unique values

Show a list of unique town names for all buildings in the Queensland region:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Queensland';

Result:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Further examples ...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

You have seen how to query spatial objects using the new database functions from PostGIS.

16.4.6 What’s Next?

Next we’re going to investigate the structures of more complex geometries and how to create them using PostGIS.

16.5 Lesson: Geometry Construction

In this section we are going to delve a little deeper into how simple geometries are constructed in SQL. In reality, you
will probably use a GIS like QGIS to create complex geometries using their digitising tools; however, understanding
how they are formulated can be handy for writing queries and understanding how the database is assembled.
The goal of this lesson: To better understand how to create spatial entities directly in PostgreSQL/PostGIS.

16.5.1 Creating Linestrings

Going back to our address database, let’s get our streets table matching the others; i.e., having a constraint on the
geometry, an index and an entry in the geometry_columns table.

16.5.2 Try Yourself

• Modify the streets table so that it has a geometry column of type ST_LineString.
• Don’t forget to do the accompanying update to the geometry columns table!
• Also add a constraint to prevent any geometries being added that are not LINESTRINGS or null.
• Create a spatial index on the new geometry column

回答

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = 'ST_LineString'::text OR the_geom IS NULL);
insert into geometry_columns values ('','public','streets','the_geom',2,4326,

'LINESTRING');
create index streets_geo_idx

on streets
using gist
(the_geom);

Now let’s insert a linestring into our streets table. In this case we will update an existing street record:
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update streets
set the_geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Take a look at the results in QGIS. (You may need to right-click on the streets layer in the ’Layers’ panel, and choose
’Zoom to layer extent’.)
Now create some more streets entries - some in QGIS and some from the command line.

16.5.3 Creating Polygons

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices,
with the last and first being co-located:

insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

备注: A polygon requires double brackets around its coordinate list; this is to allow you to add complex polygons
with multiple unconnected areas. For instance

insert into cities (name, the_geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);

If you followed this step, you can check what it did by loading the cities dataset into QGIS, opening its attribute table,
and selecting the new entry. Note how the two new polygons behave like one polygon.

16.5.4 Exercise: Linking Cities to People

For this exercise you should do the following:
• Delete all data from your people table.
• Add a foreign key column to people that references the primary key of the cities table.
• Use QGIS to capture some cities.
• Use SQL to insert some new people records, ensuring that each has an associated street and city.

Your updated people schema should look something like this:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

(续下页)
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(接上页)
Check constraints:

"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =
'ST_Point'::text OR the_geom IS NULL)

Foreign-key constraints:
"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

回答

delete from people;
alter table people add column city_id int not null references cities(id);

(capture cities in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(33 33)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('IP Knightly',

32,
1,
'071 812 31 28',
1,F
'SRID=4326;POINT(32 -34)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(34 -34)');

If you’re getting the following error message:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

then it means that while experimenting with creating polygons for the cities table, you must have deleted some of
them and started over. Just check the entries in your cities table and use any id which exists.
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16.5.5 Looking at Our Schema

By now our schema should be looking like this:

16.5.6 Try Yourself

Create city boundaries by computing the minimum convex hull of all addresses for that city and computing a buffer
around that area.

16.5.7 Access Sub-Objects

With the SFS-Model functions, you have a wide variety of options to access sub-objects of SFS Geometries. When
you want to select the first vertex point of every polygon geometry in the table myPolygonTable, you have to do this
in this way:

• Transform the polygon boundary to a linestring:

select st_boundary(geometry) from myPolygonTable;

• Select the first vertex point of the resultant linestring:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Data Processing

PostGIS supports all OGC SFS/MM standard conform functions. All these functions start with ST_.

16.5.9 Clipping

To clip a subpart of your data you can use the ST_INTERSECT() function. To avoid empty geometries, use:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))
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select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));
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16.5.10 Building Geometries from Other Geometries

From a given point table, you want to generate a linestring. The order of the points is defined by their id. Another
ordering method could be a timestamp, such as the one you get when you capture waypoints with a GPS receiver.

To create a linestring from a new point layer called ’points’, you can run the following command:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

To see how it works without creating a new layer, you could also run this command on the ’people’ layer, although of
course it would make little real-world sense to do this.
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16.5.11 Geometry Cleaning

You can get more information for this topic in this blog entry.

16.5.12 Differences between tables

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword EXCEPT:

select * from table_a
except
select * from table_b;

As the result, you will get all records from table_a which are not stored in table_b.
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16.5.13 Tablespaces

You can define where postgres should store its data on disk by creating tablespaces:

CREATE TABLESPACE homespace LOCATION '/home/pg';

When you create a database, you can then specify which tablespace to use e.g.:

createdb --tablespace=homespace t4a

16.5.14 In Conclusion

You’ve learned how to create more complex geometries using PostGIS statements. Keep in mind that this is mostly to
improve your tacit knowledge when working with geo-enabled databases through a GIS frontend. You usually won’t
need to actually enter these statements manually, but having a general idea of their structure will help you when using
a GIS, especially if you encounter errors that would otherwise seem cryptic.
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QGIS数据处理指南

本单元由 Victor Olaya和 Paolo Cavallini提供。
目录：

17.1 引言

本指南介绍如何使用 QGIS处理框架。它假定您以前不了解处理框架或所依赖的任何应用程序，并认为
您具备 QGIS基本知识。关于脚本的章节假设您对 Python以及 QGIS Python API有一些基本知识。
本指南旨在自学或用于讲习班。

本指南中的示例使用 QGIS 3.4。它们可能不起作用，或者在该版本以外的版本中不可用。
本指南由一组循序渐进的小练习组成。如果您从未使用过处理框架，那么应该从头开始。如果以前有过
一些经验，可以随时略过课程。它们或多或少是相互独立的，每一个都引入了一些新概念或新元素，如
章节标题和每章开头的简短介绍所示。这样应该很容易找到涉及特定主题的课程。

有关所有框架组件及其用法更系统的描述，建议查看用户手册中的相应章节。将其与本指南一起用作帮
助文本。

本指南的所有练习均使用培训手册中的免费数据集，并参考数据中的数据。待下载的 zip文件包含与本
指南中的每个课程相对应的多个文件夹。在每个工程中，都可以找到 QGIS工程文件。只要打开，您就
可以开始上课了。

祝您学习愉快！
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17.2 开始前的重要警告

就像文字处理软件的手册未教您如何写小说或诗歌，或者 CAD教程没有教您如何计算建筑横梁的尺寸
一样，本指南不会讲授空间分析。相反，将向您展示如何使用 QGIS处理框架，这是执行空间分析的强
大工具。您需要学习理解该类型分析所需的概念。没有这些，使用框架及其算法就无任何意义，尽管您
可能会尝试一下。

让我们用示例更清晰地进行说明。

给定一组点和每个点的给定变量值，可以使用克里金 - Kriging地理算法从这些点计算栅格图层。该模块
的参数对话框如下所示。

看起来很复杂，对吧？

通过阅读本手册，您将学习如何使用该模块，如何在批处理过程中运行该模块一次性从数百个点图层创
建栅格图层，或者如果输入图层选择了一些点，会发生什么情况。而这些参数本身并没有解释。熟悉地
质统计学的经验丰富的分析师理解这些参数不会有问题。如果您不是其中一员，并且 sill、range或 nugget
对您来说并不是很熟悉的概念，那么您不应该使用克里金模块。更重要的是，您还远远没有准备好使用
克里金模块，因为它需要学习空间自相关或半变异函数之类的概念，而这可能您以前也没有听说过，或
者至少没有深入学习。应该首先研究和理解相关知识，然后回到 QGIS实际运行并执行分析。忽视这一
点将导致错误的结果和糟糕的 (很可能是无用的)分析。
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虽然并非所有算法都像克里金算法那样复杂 (其中一些算法甚至更复杂!)，几乎所有这些都需要理解所基
于的基本分析理论。如果没有这些知识，盲目使用很可能会导致糟糕的结果。

在没有扎实的空间分析基础知识的情况下使用地理算法，就像试图写一本小说而不懂语法或句法，甚至
不知道如何讲故事。您可能会得到一个结果，但它或许没有任何价值。请不要自欺欺人，不要以为在阅
读了本指南之后，已经能够进行空间分析并获得理想的结果。您还需要学习空间分析相关知识。

这里有不错的参考资料，您可以阅读以了解有关空间数据分析的更多信息。

地理空间分析 (第 3 版) ：原理、技术和软件工具综合指南，作者：Michael John De Smith、Michael F.
Goodchild和 Paul A. Longley
可在此处在线获取

17.3 设置处理框架

使用数据处理框架之前要做的第一件事是对其进行配置。没有太多的设置，所以这是一项简单的任务。

稍后，我们将展示如何配置用于扩展可用算法列表的扩展应用程序，但现在我们只准备使用框架本身。

数据处理框架是一个核心 QGIS插件，应该已经安装在您的系统中，这是因为它包含在 QGIS安装程序。
如果处于激活状态，您应该在菜单栏中看到名为数据处理的菜单。在那里，可以访问所有框架组件。

如果未找到该菜单，则必须在插件管理器中激活来启用插件。
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我们将使用的主要元素是工具箱。单击相应的菜单项，您将看到停靠在 QGIS窗口右侧的工具箱。
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工具箱包含所有可用算法的列表，并按来源划分为几个组。可以在设置 ►选项 ►数据处理中激活 (停
止)提供程序，我们将在本手册后面讨论该对话框。
默认情况下，只有不依赖第三方应用程序的提供程序 (即仅需要运行 QGIS元素的提供程序)才处于激活
状态。需要扩展应用程序的算法可能需要额外的配置。配置提供程序将在本手册后面的章节中介绍。

如果您已达到要求，现在就可以使用地理算法，不需要配置任何其他内容。我们已经可以运行第一个算
法了，将在下一课中继续进行。

17.4 工具箱 -运行我们的第一个算法

备注: 在本课，我们将运行首个算法，并从中获得第一个结果。

正如我们已经提到的，处理框架可以运行来自其他应用程序的算法，但它也包含不需要运行外部软件的
原生算法。为了开始探索处理框架，我们将运行其中一个原生算法，来计算多边形集的质心。

首先，打开与本课对应的 QGIS工程 - exercise_data > processing > first_alg > first_alg.qgs。它只包含一个带
有两个多边形的图层。
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现在转到工具箱顶部的文本框。这是搜索框，如果您在其中输入文本，它将过滤算法列表，只显示包含
输入文本的那些算法。如果存在与您的搜索相匹配但属于未激活提供程序的算法，则工具箱的下部将显
示一个附加标签。

输入 centroids，您应该会看到类似的内容。

搜索框是一个非常实用的工具，可以查找您正在寻找的算法。在对话框末端，扩展标签显示有一些算法
与您的搜索相匹配，但属于未激活提供程序的算法。如果单击该标签中的链接，算法列表还将包括来自
那些非激活提供程序的结果，这些结果将以浅灰色显示，并显示了用于激活每个非活动提供程序的链接。
稍后我们将看到如何激活扩展提供程序。
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要执行算法，只需在工具箱中双击其名称。双击 Polygon centroids算法时，将看到以下对话框。

所有算法都有类似的界面，基本上包含您必须填写的输入参数，以及您必须选择储存位置的输出。在这
种情况下，我们唯一的输入是带有多边形的矢量图层。

选择 Polygons图层作为输入图层。该算法有一个单一的输出，即质心图层。有两个选项可以定义数据输
出的保存位置：输入文件路径或将其保存到临时文件名。

如果要设置目标而不是将结果保存到临时文件，则输出格式由文件扩展名定义。要选择一种格式，只需
选择相应的文件扩展名 (如果您直接输入文件路径，则添加扩展名)。如果输入的文件路径扩展名与任何
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受支持的扩展名不匹配，则会将默认扩展名 (通常 .dbf用于表格，.tif用于栅格图层，.shp用于矢
量图层)附加到文件路径，并使用与该扩展名对应的文件格式保存图层或表格。
在本指南的所有练习中，我们将把结果保存到临时文件，这是因为无需保存供以后使用。如果您愿意，
请随时将其保存到永久位置。

警告: 关闭 QGIS后，将删除临时文件。如果您创建工程的输出保存为临时输出，那么当您稍后尝试
打开该工程时，QGIS会报错，因为该输出文件不存在。

配置算法对话框结束后，按运行按钮运行算法。

您将获得以下输出。

输出与输入具有相同的 CRS。地理算法假设所有输入图层共享相同的 CRS，并且不执行任何重投影。除
某些特殊算法 (例如重投影算法)外，输出也将具有相同的 CRS。我们很快就会看到更多关于这方面的信
息。

尝试使用不同的文件格式保存 (例如，使用 shp和 geojson作为扩展名)。此外，如果不希望在生成图
层后将其加载到 QGIS中，可以核对输出路径框下方的复选框。

17.5 More algorithms and data types

备注: In this lesson we will run three more algorithms, learn how to use other input types, and configure outputs to
be saved to a given folder automatically.

For this lessons we will need a table and a polygons layer. We are going to create a points layer based on coordinates
in the table, and then count the number of points in each polygon. If you open the QGIS project corresponding to
this lesson, you will find a table with X and Y coordinates, but you will find no polygons layer. Don’t worry, we will
create it using a processing geoalgorithm.
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The first thing we are going to do is to create a points layer from the coordinates in the table, using the Points layer from
table algorithm. You now know how to use the search box, so it should not be hard for you to find it. Double--click
on it to run it and get to its following dialog.
This algorithm, like the one from the previous lesson, just generates a single output, and it has three inputs:

• Table: the table with the coordinates. You should select here the table from the lesson data.
• X and Y fields: these two parameters are linked to the first one. The corresponding selector will show the name
of those fields that are available in the selected table. Select the XCOORD field for the X parameter, and the
YYCOORD field for the Y parameter.

• CRS: Since this algorithm takes no input layers, it cannot assign a CRS to the output layer based on them.
Instead, it asks you to manually select the CRS that the coordinates in the table use. Click on the button on the
left--hand side to open the QGIS CRS selector, and select EPSG:4326 as the output CRS. We are using this
CRS because the coordinates in the table are in that CRS.

Your dialog should look like this.

Now press the Run button to get the following layer (you may need to zoom full to reenter the map around the newly
created points):
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The next thing we need is the polygon layer. We are going to create a regular grid of polygons using the Create grid
algorithm, which has the following parameters dialog.

520 Chapter 17. QGIS数据处理指南



QGIS Training Manual

警告: The options are simpler in recent versions of QGIS; you just need to enter min and max for X and Y
(suggested values: -5.696226,-5.695122,40.24742,40.248171)

The inputs required to create the grid are all numbers. When you have to enter a numerical value, you have two
options: typing it directly on the corresponding box or clicking the button on the right--hand side to get to a dialog
like the one shown next.
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The dialog contains a simple calculator, so you can type expressions such as 11 * 34.7 + 4.6, and the result
will be computed and put in the corresponding text box in the parameters dialog. Also, it contains constants that you
can use, and values from other layers available.
In this case, we want to create a grid that covers the extent of the input points layer, so we should use its coordinates to
calculate the center coordinate of the grid and its width and height, since those are the parameters that the algorithm
takes to create the grid. With a little bit of math, try to do that yourself using the calculator dialog and the constants
from the input points layer.
Select Rectangles (polygons) in the Type field.
As in the case of the last algorithm, we have to enter the CRS here as well. Select EPSG:4326 as the target CRS, as
we did before.
In the end, you should have a parameters dialog like this:
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(Better add one spacing on the width and height: Horizontal spacing: 0.0001, Vertical spacing: 0.0001, Width:
0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) The case of X center is a bit tricky, see:
-5.696126+(( -5.695222+ 5.696126)/2)
Press Run and you will get the graticule layer.
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The last step is to count the points in each one of the rectangles of that graticule. We will use the Count points in
polygons algorithm.

Now we have the result we were looking for.
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Before finishing this lesson, here is a quick tip to make your life easier in case you want to persistently save your
data. If you want all your output files to be saved in a given folder, you do not have to type the folder name each
time. Instead, go to the processing menu and select the Options and configuration item. It will open the configuration
dialog.

In the Output folder entry that you will find in the General group, type the path to your destination folder.
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Now when you run an algorithm, just use the filename instead of the full path. For instance, with the configuration
shown above, if you enter graticule.shp as the output path for the algorithm that we have just used, the result
will be saved in D:\processing_output\graticule.shp. You can still enter a full path in case you want
a result to be saved in a different folder.
Try yourself the Create grid algorithm with different grid sizes, and also with different types of grids.

17.6 CRSs. Reprojecting

备注: In this lesson wewill discuss howProcessing uses CRSs. Wewill also see a very useful algorithm: reprojecting.

CRS’s are a great source of confusion for QGIS Processing users, so here are some general rules about how they are
handled by geoalgorithms when creating a new layer.

• If there are input layers, it will use the CRS of the first layer. This is assumed to be the CRS of all input layers,
since they should have the same one. If you use layers with unmatching CRS’s, QGIS will warn you about it.
Notice that the CRS of input layers is shown along with its name in the parameters dialog.

• If there are no input layer, it will use the project CRS, unless the algorithm contains a specific CRS field (as it
happened in the last lesson with the graticule algorithm)
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Open the project corresponding to this lesson and you will see two layers named 23030 and 4326. They both contain
the same points, but in different CRSs (EPSG:23030 and EPSG:4326). They appear in the same place because QGIS
is reprojecting on the fly to the project CRS (EPSG:4326), but they are not actually the same layer.
Open the Export/Add geometry columns algorithm.

This algorithm add new columns to the attributes table of a vector layer. The content of the columns depend on the
type of geometry of the layer. In the case of points, it adds new columns with the X and Y coordinates of each point.
In the list of available layers that you will find in the input layer field, you will see each one with its corresponding
CRS. That means that, although they appear in the same place in your canvas, they will be treated differently. Select
the 4326 layer.
The other parameter of the algorithm allows to set how the algorithm uses coordinates to calculate the new value
that it will add to the resulting layers. Most algorithms do not have an option like that, and just use the coordinates
directly. Select the Layer CRS option to just use coordinates as they are. This is how almost all geoalgorithms work.
You should get a new layer with exactly the same points as the other two layers. If you right click on the name of the
layer and open its properties, you will see that it shares the same CRS of the input layer, that is, EPSG:4326. When
the layer is loaded into QGIS, you will not be asked to enter the CRS of the layer, since QGIS already knows about
it.
If you open the attributes table of the new layer you will see that it contains two new fields with the X andY coordinates
of each point.
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Those coordinate values are given in the layer CRS, since we chose that option. However, even if you choose another
option, the output CRS of the layer would have been the same, since the input CRS is used to set the CRS of the
output layer. Choosing another option will cause the values to be different, but not the resulting point to change or
the CRS of the output layer to be different to the CRS of the input one.
Now do the same calculation using the other layer. You should find the resulting layer rendered exactly in the same
place as the other ones, and it will have the EPSG:23030 CRS, since that was the one of the input layer.
If you go to its attribute table, you will see values that are different to the ones in the first layer that we created.

This is because the original data is different (it uses a different CRS), and those coordinates are taken from it.
What should you learn from this? The main idea behind these examples is that geoalgorithms use the layer as it is in
its original data source, and completely ignore the reprojections that QGIS might be doing before rendering. In other
words, do not trust what you see in the canvas, but always have in mind that the original data will be used. That is not
so important in this case, since we are just using one single layer at a time, but in an algorithm that needs several of
them (such as a clip algorithm), layers that appear to match or overlay might be very far one from each other, since
they might have different CRSs.
Algorithms performs no reprojection (except in the reprojection algorithm that we will see next), so it is up to you to
make sure that layers have matching CRS’s.
An interesting module that deals with CRS’s is the reprojection one. It represents a particular case, since it has an
input layer (the one to reproject), but it will not use its CRS for the output one.
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Open the Reproject layer algorithm.

Select any of the layers as input, and select EPSG:23029 as the destination CRS. Run the algorithm and you will
get a new layer, identical to the input one, but with a different CRS. It will appear on the same region of the canvas,
like the other ones, since QGIS will reproject it on the fly, but its original coordinates are different. You can see that
by running the Export/Add geometry columns algorithm using this new layer as input, and veryfing that the added
coordinates are different to the ones in the attribute tables of both of the two layers that we had computed before.

17.7 Selection

备注: In this lesson we will see how processing algorithms handle selections in vector layers that are used as inputs,
and how to create a selection using a particular type of algorithm.

Unlike other analysis plugins in QGIS, you will not find in processing geoalgorithms any ”Use only selected features”
checkbox or similar. The behaviour regarding selection is set for the whole plugin and all its algorithms, and not for
each algorithm execution. Algorithms follow the following simple rules when using a vector layer.

• If the layer has a selection, only selected features are used.
• If there is no selection, all features are used.

Please note that you can change this behaviour by unselecting the relevant option in the Processing ► Options ►
General menu.
You can test that yourself by selecting a few points in any of the layers that we used in the last chapter, and running
the reprojection algorithm on them. The reprojected layer that you will obtain will contain only those points that
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were selected, unless there was no selection, which will cause the resulting layer to contain all points from the original
layer.
To make a selection, you can use any of the available methods and tools in QGIS. However, you can also use a
geoalgorithm to do so. Algorithms for creating a selection are found in the toolbox under Vector/Selection

Open the Random selection algorithm.

Leaving the default values, it will select 10 points from the current layer.
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You will notice that this algorithm does not produce any output, but modifies the input layer (not the layer itself, but
its selection). This is an uncommon behaviour, since all the other algorithms will produce new layers and not alter
the input layers.
Since the selection is not part of the data itself, but something that only exist within QGIS, these selection algorithms
only must be used selecting a layer that is open in QGIS, and not with the file selection option that you can find in the
corresponding parameter value box.
The selection we have just made, like most of the ones created by the rest of the selection algorithms, can also be
done manually from QGIS, so you might be wondering what is the point on using an algorithm for that. Although
now this might not make much sense to you, we will later see how to create models and scripts. If you want to make
a selection in the middle of a model (which defines a processing workflow), only a geoalgorithm can be added to a
model, and other QGIS elements and operations cannot be added. That is the reason why some processing algorithms
duplicate functionality that is also available in other QGIS elements.
By now, just remember that selections can be made using processing geoalgorithms, and that algorithms will only use
the selected features if a selection exists, or all features otherwise.

17.8 Running an external algorithm

备注: In this lesson we will see how to use algorithms that depend on a third-party application, particularly SAGA,
which is one of the main algorithm providers.

All the algorithms that we have run so far are part of processing framework. That is, they are native algorithms
implemented in the plugin and run by QGIS just like the plugin itself is run. However, one of the greatest features of
the processing framework is that it can use algorithms from external applications and extend the possibilities of those
applications. Such algorithms are wrapped and included in the toolbox, so you can easily use them from QGIS, and
use QGIS data to run them.
Some of the algorithms that you see in the simplified view require third party applications to be installed in your
system. One algorithm provider of special interest is SAGA (System for Automated Geospatial Analysis). First, we
need to configure everything so QGIS can correctly call SAGA. This is not difficult, but it’s important to understand
how it works. Each external application has its own configuration, and later in this same manual we will talk about
some of the other ones, but SAGA is going to be our main backend, so we will discuss it here.
If you are onWindows, the best way to work with external algorithms is to install QGIS using the standalone installer.
It will take care of installing all the needed dependencies, including SAGA, so if you have used it, there is nothing
else to do. You can open the settings dialog and go to the Providers/SAGA group.
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The SAGA path should already be configured and pointing to the folder where SAGA is installed.
If you have installed QGIS not using the standalone installer, then you must enter the path to your SAGA installation
(which you must have installed separately) there. The required version is SAGA 2.1 [this is changing according to
the releases of SAGA].
In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configuration.
Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from the console
(just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is also 2.1, but in
some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are some 2.1 packages
available, but they are not commonly installed and might have some issues, so if you prefer to use the more common
and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog, under the SAGA group.

532 Chapter 17. QGIS数据处理指南



QGIS Training Manual

Once SAGA is installed, you can launch a SAGA algorithm double clicking on its name, as with any other algorithm.
Since we are using the simplified interface, you do not know which algorithms are based on SAGA or in another
external application, but if you happen to double--click on one of them and the corresponding application is not
installed, you will see something like this.

In our case, and assuming that SAGA is correctly installed and configured, you should not see this window, and you
will get to the parameters dialog instead.
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Let’s try with a SAGA--based algorithm, the one called Split shapes layer randomly.

Use the points layer in the project corresponding to this lesson as input, and the default parameter values, and you
will get something like this (the split is random, so your result might be different).

The input layer has been split in two layers, each one with the same number of points. This result has been computed
by SAGA, and later taken by QGIS and added to the QGIS project.
If all goes fine, you will not notice any difference between this SAGA--based algorithm and one of the others that we
have previously run. However, SAGA might, for some reason, not be able to produce a result and not generate the
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file that QGIS is expecting. In that case, there will be problems adding the result to the QGIS project, and an error
message like this will be shown.

This kind of problems might happen, even if SAGA (or any other application that we are calling from the processing
framework) is correctly installed, and it is important to know how to deal with them. Let’s produce one of those error
messages.
Open the Create graticule algorithm and use the following values.
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We are using width and height values that is larger than the specified extent, so SAGA cannot produce any output. In
other words, the parameter values are wrong, but they are not checked until SAGA gets them and tries to create the
graticule. Since it cannot create it, it will not produce the expected layer, and you will see the error message shown
above.

备注: In SAGA >= 2.2.3, the command will adjust automatically wrong input data, so you’ll not get an error. To
provoke an error, use negative values for division.

Understanding this kind of problems will help you solve them and find an explanation to what is happening. As
you can see in the error message, a test is performed to check that the connection with SAGA is working correctly,
indicating you that there might be a problem in how the algorithm was executed. This applies not only to SAGA, but
also to other external applications as well.
In the next lesson we will introduce the processing log, where information about commands run by geoalgorithms is
kept, and you will see how to get more detail when issues like this appear.
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17.9 The processing log

备注: This lesson describes the processing log.

All the analysis performed with the processing framework is logged in QGIS logging system. This allows you to know
more about what has been done with the processing tools, to solve problems when they happen, and also to re--run
previous operations, since the logging system also implements some interactivity.
To open the log, click on the balloon at the bottom right, on the QGIS status bar. Some algorithms might leave
here information about their execution. For instance, those algorithms that call an external application usually log the
console output of that application to this entry. If you have a look at it, you will see that the output of the SAGA
algorithm that we just run (and that fail to execute because input data was not correct) is stored here.
This is helpful to understand what is going on. Advanced users will be able to analyze that output to find out why
the algorithm failed. If you are not an advanced user, this will be useful for others to help you diagnose the problem
you are having, which might be a problem in the installation of the external software or an issue with the data you
provided.
Even if the algorithm could be executed, some algorithms might leave warnings in case the result might not be right.
For instance, when executing an interpolation algorithm with a very small amount of points, the algorithm can run
and will produce a result, but it is likely that it will not be correct, since more points should be used. It’s a good idea
to regularly check for this type of warnings if you are not sure about some aspect of a given algorithm.
From the Processing menu, under the History section, you’ll find Algorithms. All algorithms that are executed, even
if they are executed from the GUI and not from the console (which will be explained later in this manual) are stored
in this section as a console call. That means that everytime you run an algorithm, a console command is added to the
log, and you have the full history of your working session. Here is how that history looks like:
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This can be very useful when starting working with the console, to learn about the syntax of algorithms. We will use
it when we discuss how to run analysis commands from the console.
The history is also interactive, and you can re--run any previous algorithm just by double--clicking on its entry. This
is an easy way of replicating the work we already did before.
For instance, try the following. Open the data corresponding to the first chapter of this manual and run the algorithm
explained there. Now go to the log dialog and locate the last algorithm in the list, which corresponds to the algorithm
you have just run. Double--click on it an a new result should be produced, just like when you run it using the normal
dialog and calling it from the toolbox.

17.9.1 高级

You can also modify the algorithm. Just copy it, open the Plugins ► Python console, click on Import class ► Import
Processing class, then paste it to re-run the analysis; change the text at will. To display the resulting file, type iface.
addVectorLayer('/path/filename.shp', 'Layer name in legend', 'ogr'). Otherwise,
you can use processing.runandload.

17.10 The raster calculator. No-data values

备注: In this lesson we will see how to use the raster calculator to perform some operations on raster layers. We
will also explain what are no--data values and how the calculator and other algorithms deal with them

The raster calculator is one of the most powerful algorithms that you will find. It’s a very flexible and versatile
algorithm that can be used for many different calculations, and one that will soon become an important part of your
toolbox.
In this lesson we will be performing some calculation with the raster calculator, most of them rather simple. This
will let us see how it is used and how it deals with some particular situations that it might find. Understanding that is
important to later get the expected results when using the calculator, and also to understand certain techniques that
are commonly applied with it.
Open the QGIS project corresponding to this lesson and you will see that it contains several raster layers.
Now open the toolbox and open the dialog corresponding to the raster calculator.
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备注: The interface is different in recent versions.

The dialog contains 2 parameters.
• The layers to use for the analysis. This is a multiple input, that meaning that you can select as many layers as
you want. Click on the button on the right--hand side and then select the layers that you want to use in the
dialog that will appear.

• The formula to apply. The formula uses the layers selected in the above parameter, which are named using
alphabet letters (a, b, c...) or g1, g2, g3... as variable names. That is, the formula a + 2 * b
is the same as g1 + 2 * g2 and will compute the sum of the value in the first layer plus two times the value
in the second layer. The ordering of the layers is the same ordering that you see in the selection dialog.

警告: The calculator is case sensitive.

To start with, we will change the units of the DEM from meters to feet. The formula we need is the following one:

h' = h * 3.28084

Select the DEM in the layers field and type a * 3.28084 in the formula field.

警告: For non English users: use always ”.”, not ”,”.

Click Run to run the algorithm. You will get a layer that has the same appearance of the input layer, but with different
values. The input layer that we used has valid values in all its cells, so the last parameter has no effect at all.
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Let’s now perform another calculation, this time on the accflow layer. This layer contains values of accumulated flow,
a hydrological parameter. It contains those values only within the area of a given watershed, with no--data values
outside of it. As you can see, the rendering is not very informative, due to the way values are distributed. Using the
logarithm of that flow accumulation will yield a much more informative representation. We can calculate that using
the raster calculator.
Open the algorithm dialog again, select the accflow layer as the only input layer, and enter the following formula:
log(a).
Here is the layer that you will get.

If you select the Identify tool to know the value of a layer at a given point, select the layer that we have just created,
and click on a point outside of the basin, you will see that it contains a no--data value.
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For the next exercise we are going to use two layers instead of one, and we are going to get a DEMwith valid elevation
values only within the basin defined in the second layer. Open the calculator dialog and select both layers of the project
in the input layers field. Enter the following formula in the corresponding field:

a/a * b

a refers to the accumulated flow layer (since it is the first one to appear in the list) and b refers to the DEM. What we
are doing in the first part of the formula here is to divide the accumulated flow layer by itself, which will result in a
value of 1 inside the basin, and a no--data value outside. Then we multiply by the DEM, to get the elevation value in
those cells inside the basin (DEM * 1 = DEM) and the no--data value outside (DEM * no_data = no_data)
Here is the resulting layer.

This technique is used frequently to mask values in a raster layer, and is useful whenever you want to perform calcu-
lations for a region other that the arbitrary rectangular region that is used by raster layer. For instance, an elevation
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histogram of a raster layer doesn’t have much meaning. If it is instead computed using only values corresponding to
a basin (as in he case above), the result that we obtain is a meaningful one that actually gives information about the
configuration of the basin.
There are other interesting things about this algorithm that we have just run, apart from the no--data values and how
they are handled. If you have a look at the extents of the layers that we have multiplied (you can do it double--clicking
on their names of the layer in the table of contents and looking at their properties), you will see that they are not the
same, since the extent covered by the flow accumulation layer is smaller that the extent of the full DEM.
That means that those layers do not match, and that they cannot be multiplied directly without homogenizing those
sizes and extents by resampling one or both layers. However, we did not do anything. QGIS takes care of this situation
and automatically resamples input layers when needed. The output extent is the minimum covering extent calculated
from the input layers, and the minimum cell size of their cellsizes.
In this case (and in most cases), this produces the desired results, but you should always be aware of the additional
operations that are taking place, since they might affect the result. In cases when this behaviour might not be the
desired, manual resampling should be applied in advance. In later chapters, we will see more about the behaviour of
algorithms when using multiple raster layers.
Let’s finish this lesson with another masking exercise. We are going to calculate the slope in all areas with an elevation
between 1000 and 1500 meters.
In this case, we do not have a layer to use as a mask, but we can create it using the calculator.
Run the calculator using the DEM as only input layer and the following formula

ifelse(abs(a-1250) < 250, 1, 0/0)

As you can see, we can use the calculator not only to do simple algebraic operations, but also to run more complex
calculation involving conditional sentences, like the one above.
The result has a value of 1 inside the range we want to work with, and no-data in cells outside of it.

The no-data value comes from the 0/0 expression. Since that is an undetermined value, SAGA will add a NaN (Not a
Number) value, which is actually handled as a no-data value. With this little trick you can set a no-data value without
needing to know what the no--data value of the cell is.
Now you just have to multiply it by the slope layer included in the project, and you will get the desired result.
All that can be done in a single operation with the calculator. We leave that as an exercise for the reader.
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17.11 Vector calculator

备注: In this lesson we will see how to add new attributes to a vector layer based on a mathematical expression,
using the vector calculator.

We already know how to use the raster calculator to create new raster layers using mathematical expressions. A
similar algorithm is available for vector layers, and generates a new layer with the same attributes of the input layer,
plus an additional one with the result of the expression entered. The algorithm is called Field calculator and has the
following parameters dialog.

备注: In newer versions of Processing the interface has changed considerably, it’s more powerful and easier to use.

Here are a few examples of using that algorithm.
First, let’s calculate the population density of white people in each polygon, which represents a census. We have two
fields in the attributes table that we can use for that, namely WHITE and SHAPE_AREA. We just have to divide them
and multiply by one million (to have density per square km), so we can use the following formula in the corresponding
field

( "WHITE" / "SHAPE_AREA" ) * 1000000

The parameters dialog should be filled as shown below.
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This will generate a new field named WHITE_DENS
Now let’s calculate the ratio between the MALES and FEMALES fields to create a new one that indicates if male
population is numerically predominant over female population.
Enter the following formula

"MALES" / "FEMALES"

This time the parameters window should look like this before pressing the OK button.
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In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the
formula should be: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.
We can use conditional functions to have a new field with male or female text strings instead of those ratio value,
using the following formula:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

The parameters window should look like this.
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A python field calculator is available in the Advanced Python field calculator, which will not be detailed here
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17.12 Defining extents

备注: In this lesson we will see how to define extents, which are needed by some algorithms, especially raster ones.

Some algorithms require an extent to define the area to be covered by the analysis they perform, and usually to define
the extent of the resulting layer.
When an extent is required, it can be defined manually by entering the four values that define it (min X, min Y, max
X, max Y), but there are other more practical and more interesting ways of doing it as well. We will see all of them
in this lesson.
First, let’s open an algorithm that requires an extent to be defined. Open the Rasterize algorithm, which creates a
raster layer from a vector layer.
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All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure how
the rasterization process should work. The two last parameters, on the other hand, define the characteristics of the
output layer. That means that they define the area that is covered (which is not necessarily the same area covered by
the input vector layer), and the resolution/cellsize (which cannot be inferred from the vector layer, since vector layers
do not have a cellsize).
The first thing you can do is to type the 4 defining values explained before, separated by commas.

That doesn’t need any extra explanation. While this is themost flexible option, it is also the less practical in some cases,
and that’s why other options are implemented. To access them, you have to click on the button on the right--hand
side of the extent text box.

Let’s see what each one of them does.
The first option is Use layer/canvas extent, which will show the selection dialog shown below.
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Here you can select the extent of the canvas (the extent covered by the current zoom), or the extension any of the
available layers. Select it and click on OK, and the text box will be automatically filled with the corresponding values.
The second option is Select extent on canvas. In this case, the algorithm dialog disappears and you can click and drag
on the QGIS canvas to define the desired extent.

Once you release themouse button, the dialog will reappear and the text boxwill already have the values corresponding
to the defined extent.
The last option is Use min covering extent from input layers, which is the default option. This will compute the min
covering extent of all layers used to run the algorithm, and there is no need to enter any value in the text box. In the
case of a single input layer, as in the algorithm we are running, the same extent can be obtained by selecting that same
input layer in the Use layer/canvas extent that we already saw. However, when there are several input layers, the min
covering extent does not correspond to any of the input layer extent, since it is computed from all of them together.
We will use this last method to execute our rasterization algorithm.
Fill the parameters dialog as shown next, and press OK.
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备注: In this case, better use an Integer (1 byte) instead of a Floating point (4 byte), since the NAME is an integer
with maximum value=64. This will result in a smaller file size and faster computations.

You will get a rasterized layer that covers exactly the area covered by the original vector layer.
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In some cases, the last option, Use min covering extent from input layers, might not be available. This will happen in
those algorithm that do not have input layers, but just parameters of other types. In that case, you will have to enter
the value manually or use any of the other options.
Notice that, when a selection exist, the extent of the layer is that of the whole set of features, and the selection is not
used to compute the extent, even though the rasterization is executed on the selected items only. In that case, you
might want to actually create a new layer from the selection, and then use it as input.

17.13 HTML outputs

备注: In this lesson we learn how QGIS handles outputs in HTML format, which are used to produce text outputs
and graphs.

All the outputs we have produced so far were layers (whether raster or vector). However, some algorithms generate
outputs in the form of text and graphics. All this outputs are wrapped in HTML files and displayed in the so--called
Results viewer, which is another element of the processing framework.
Let’s see one of those algorithms to understand how they work.
Open the project with the data to be used in this lesson and then open the Basic statistics for numeric fields algorithm.
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The algorithm is rather simple, and you just have to select the layer to use and one of its field (a numeric one). The
output is of type HTML, but the corresponding box works exactly like the one that you can find in the case of a raster
or vector output. You can enter a filepath or leave it blank to save to a temporary file. In this case, however, only the
html and htm extensions are allowed, so there is no way of altering the output format by using a different one.
Run the algorithm selecting the only layer in the project as input, and the POP2000 field, and a new dialog like the
one shown next will appear once the algorithm is executed and the parameters dialog is closed.
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This is the Results viewer. It keeps all the HTML result generated during the current session, easily accessible, so you
can check them quickly whenever you need it. As it happens with layers, if you have saved the output to a temporary
file, it will be deleted once you close QGIS. If you have saved to a non-temporary path, the file will remain, but it
will not appear in the Results viewer the next time you open QGIS.
Some algorithms generate text that cannot be divided into other more detailed outputs. That is the case if, for instance,
the algorithm captures the text output from an external process. In other cases, the output is presented as text, but
internally is divided into several smaller outputs, usually in the form of numeric values. The algorithm that we have
just executed is one of them. Each one of those values is handled as a single output, and stored in a variable. This
has no importance at all now, but once we move to the model designer, you will see that it will allow us to use those
values as numeric inputs for other algorithms.
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17.14 First analysis example

备注: In this lesson we will perform some real analysis using just the toolbox, so you can get more familiar with the
processing framework elements.

Now that everything is configured and we can use external algorithms, we have a very powerful tool to perform spatial
analysis. It is time to work out a larger exercise with some real--world data.
We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work (https://en.
wikipedia.org/wiki/John_Snow_%28physician%29), and we will get some interesting results. The analysis of this
dataset is pretty obvious and there is no need for sophisticated GIS techniques to end up with good results and
conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved by using different
processing tools.
The dataset contains shapefiles with cholera deaths and pump locations, and an OSM rendered map in TIFF format.
Open the corresponding QGIS project for this lesson.

The first thing to do is to calculate the Voronoi diagram (a.k.a. Thiessen polygons) of the pumps layer, to get the
influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
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Pretty easy, but it will already give us interesting information.
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Clearly, most cases are within one of the polygons
To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents a
building where deaths occured, and the number of deaths is stored in an attribute, we cannot just count the points.
We need a weighted count, so we will use the Count points in polygon (weighted) tool.
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The new field will be called DEATHS, and we use the COUNT field as weighting field. The resulting table clearly
reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other ones.
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Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in the
Pumps layer is to draw a line to the closest one. This can be done with the Distance to nearest hub tool, and using
the configuration shown next.
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The result looks like this:
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Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the
number of deaths, but the number of locations where cholera cases were found. It is a representative parameter, but
it is not considering that some locations might have more cases than other.
A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density
algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and
cellsize of the streets raster layer, we get something like this.
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Remember that, to get the output extent, you do not have to type it. Click on the button on the right-hand side and
select Use layer/canvas extent.
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Select the streets raster layer and its extent will be automatically added to the text field. You must do the same with
the cellsize, selecting the cellsize of that layer as well.
Combining with the pumps layer, we see that there is one pump clearly in the hotspot where the maximum density
of death cases is found.

17.15 Clipping and merging raster layers

备注: In this lesson we will see another example of spatial data preparation, to continue using geoalgorithms in
real-world scenarios.

For this lesson, we are going to calculate a slope layer for an area surrounding a city area, which is given in a vector
layer with a single polygon. The base DEM is divided in two raster layers that, together, cover an area much larger
than that around the city that we want to work with. If you open the project corresponding to this lesson, you will see
something like this.
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These layers have two problems:
• They cover an area that is too large for what we want (we are interested in a smaller region around the city
center)

• They are in two different files (the city limits fall into just one single raster layer, but, as it’s been said, we want
some extra area around it).

Both of them are easily solvable with the appropriate geoalgorithms.
First, we create a rectangle defining the area that we want. To do it, we create a layer containing the bounding box
of the layer with the limits of the city area, and then we buffer it, so as to have a raster layer that covers a bit more
that the strictly necessary.
To calculate the bounding box , we can use the Polygon from layer extent algorithm
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To buffer it, we use the Fixed distance buffer algorithm, with the following parameter values.
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警告: Syntax changed in recent versions; set both Distance and Arc vertex to .25

Here is the resulting bounding box obtained using the parameters shown above

It is a rounded box, but we can easily get the equivalent box with square angles, by running the Polygon from layer
extent algorithm on it. We could have buffered the city limits first, and then calculate the extent rectangle, saving one
step.

You will notice that the rasters has a different projection from the vector. We should therefore reproject them before
proceeding further, using theWarp (reproject) tool.
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备注: Recent versions have a more complex interface. Make sure at least one compression method is selected.

With this layer that contains the bounding box of the raster layer that we want to obtain, we can crop both of the
raster layers, using the Clip raster with polygon algorithm.
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Once the layers have been cropped, they can be merged using the SAGA Mosaic raster layers algorithm.
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备注: You can save time merging first and then cropping, and you will avoid calling the clipping algorithm twice.
However, if there are several layers to merge and they have a rather big size, you will end up with a large layer than it
can later be difficult to process. In that case, you might have to call the clipping algorithm several times, which might
be time consuming, but don’t worry, we will soon see that there are some additional tools to automate that operation.
In this example, we just have two layers, so you shouldn’t worry about that now.

With that, we get the final DEM we want.

Now it is time to compute the slope layer.
A slope layer can be computed with the Slope, Aspect, Curvature algorithm, but the DEM obtained in the last step is
not suitable as input, since elevation values are in meters but cellsize is not expressed in meters (the layer uses a CRS
with geographic coordinates). A reprojection is needed. To reproject a raster layer, the Warp (reproject) algorithm
can be used again. We reproject into a CRS with meters as units (e.g. 3857), so we can then correctly calculate the
slope, with either SAGA or GDAL.
With the new DEM, slope can now be computed.
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And here is the resulting slope layer.
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The slope produced by the Slope, Aspect, Curvature algorithm can be expressed in degrees or radians; degrees are a
more practical and common unit. In case you calculated it in radians, the Metric conversions algorithm will help us
to do the conversion (but in case you didn’t know that algorithm existed, you could use the raster calculator that we
have already used).
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Reprojecting the converted slope layer back with the Reproject raster layer, we get the final layer we wanted.

警告: todo: Add image

The reprojection processes might have caused the final layer to contain data outside the bounding box that we calcu-
lated in one of the first steps. This can be solved by clipping it again, as we did to obtain the base DEM.

17.16 Hydrological analysis

备注: In this lesson we will perform some hydrological analysis. This analysis will be used in some of the following
lessons, as it constitutes a very good example of an analysis workflow, and we will use it to demonstrate some advanced
features.

Objectives: Starting with a DEM, we are going to extract a channel network, delineate watersheds and calculate some
statistics.

1. The first thing is to load the project with the lesson data, which just contains a DEM.
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2. The first module to execute is Catchment area (in some SAGA versions it is called Flow accumulation (Top
Down)). You can use any of the others named Catchment area. They have different algorithms underneath,
but the results are basically the same.

3. Select the DEM in the Elevation field, and leave the default values for the rest of the parameters.
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Some algorithms calculate many layers, but the Catchment Area layer is the only one we will be using. You can
get rid of the other ones if you want.
The rendering of the layer is not very informative.
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To know why, you can have a look at the histogram and you will see that values are not evenly distributed (there
are a few cells with very high value, those corresponding to the channel network). Use the Raster calculator
algorithm to calculate the logarithm of the catchment value area and you will get a layer with much more
information
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4. The catchment area (also known as flow accumulation) can be used to set a threshold for channel initiation.
This can be done using the Channel network algorithm.

• Initiation grid: use the catchment area layer and not the logarithm one.
• Initiation threshold: 10.000.000
• Initiation type: Greater than

If you increase the Initiation threshold value, you will get a more sparse channel network. If you decrease it,
you will get a denser one. With the proposed value, this is what you get.
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The image above shows just the resulting vector layer and the DEM, but there should be also a raster layer with
the same channel network. That raster will be, in fact, the layer we will be using.

5. Now, we will use the Watersheds basins algorithm to delineate the subbasins corresponding to that channel
network, using as outlet points all the junctions in it. Here is how you have to set the corresponding parameters
dialog.
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And this is what you will get.
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6. This is a raster result. You can vectorise it using the Vectorising grid classes algorithm.
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Now, let’s try to compute statistics about the elevation values in one of the subbasins. The idea is to have a layer that
just represents the elevation within that subbasin and then pass it to the module that calculates those statistics.

1. First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip raster with
polygon algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the
DEM to the area covered by that polygon, since the algorithm is aware of the selection.
1. Select a polygon
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2. Call the clipping algorithm with the following parameters:
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The element selected in the input field is, of course, the DEM we want to clip.
You will get something like this.

2. This layer is ready to be used in the Raster layer statistics algorithm.
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The resulting statistics are the following ones.

We will use both the basin calculations procedure and the statistics calculation in other lessons, to find out how other
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elements can help us automate both of them and work more effectively.

17.17 Starting with the model designer

备注: In this lesson we will use the model designer, a powerful component that we can use to define a workflow and
run a chain of algorithms.

A normal session with the processing tools includes more than running a single algorithm. Usually several of them
are run to obtain a result, and the outputs of some of those algorithms are used as input for some of the other ones.
Using the model designer, that workflow can be put into a model, which will run all the necessary algorithms in a
single run, thus simplifying the whole process and automating it.
To start this lesson, we are going to calculate a parameter named Topographic Wetness Index. The algorithm that
computes it is called Topographic wetness index (twi).

As you can see, there are two mandatory inputs: Slope and Catchment area. There is also an optional input, but we
will not be using it, so we can ignore it.
The data for this lesson contains just a DEM, so we do not have any of the required inputs. However, we know how
to calculate both of them from that DEM, since we have already seen the algorithms to compute slope and catchment
area. So we can first compute those layers and then use them for the TWI algorithm.
Here are the parameter dialogs that you should use to calculate the 2 intermediate layers.
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备注: Slope must be calculated in radians, not in degrees.
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And this is how you have to set the parameters dialog of the TWI algorithm.
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This is the result that you will obtain (the default singleband pseudocolor inverted palette has been used for rendering).
You can use the twi.qml style provided.
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What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step.
That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just one
single step to do it instead of the three above. All the processes that we need are found in the toolbox, so what we
have to do is to define the workflow to wrap them. This is where the model designer comes in.

1. Open the modeler by selecting its menu entry in the processing menu.

Two things are needed to create a model: setting the inputs that it will need, and defining the algorithm that
it contains. Both of them are done by adding elements from the two tabs in the left-hand side of the modeler
window: Inputs and Algorithms.

2. Let’s start with the inputs. In this case we do not have much to add. We just need a raster layer with the DEM,
and that will be our only input data.

3. Double click on the Raster layer input and you will see the following dialog.

4. Here we will have to define the input we want:
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1. Since we expect this raster layer to be a DEM, we will call it DEM. That’s the name that the user of the
model will see when running it.

2. Since we need that layer to work, we will define it as a mandatory layer.
Here is how the dialog should be configured.

5. Click on OK and the input will appear in the modeler canvas.

6. Now let’s move to the Algorithms tab.
7. The first algorithm we have to run is the Slope, aspect, curvature algorithm. Locate it in the algorithm list,

double-click on it and you will see the dialog shown below.
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This dialog is very similar to the one that you can find when running the algorithm from the toolbox, but
the element that you can use as parameter values are not taken from the current QGIS project, but from the
model itself. That means that, in this case, we will not have all the raster layers of our project available for the
Elevation field, but just the ones defined in our model. Since we have added just one single raster input named
DEM, that will be the only raster layer that we will see in the list corresponding to the Elevation parameter.
Output generated by an algorithm are handled a bit differently when the algorithm is used as a part of a model.
Instead of selecting the filepath where you want to save each output, you just have to specify if that output is
an intermediate layer (and you do not want it to be preserved after the model has been executed), or it is a final
one. In this case, all layers produced by this algorithm are intermediate. We will only use one of them (the
slope layer), but we do not want to keep it, since we just need it to calculate the TWI layer, which is the final
result that we want to obtain.
When layers are not a final result, you should just leave the corresponding field. Otherwise, you have to enter a
name that will be used to identify the layer in the parameters dialog that will be shown when you run the model
later.

8. There is not much to select in this first dialog, since we do not have but just one layer in our model (The DEM
input that we created). Actually, the default configuration of the dialog is the correct one in this case, so you
just have to press OK. This is what you will now have in the modeler canvas.
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9. The second algorithm we have to add to our model is the catchment area algorithm. We will use the algorithm
named Catchment area (Paralell). We will use the DEM layer again as input, and none of the ouputs it produces
are final, so here is how you have to fill the corresponding dialog.
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Now your model should look like this.
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10. The last step is to add the Topographic wetness index algorithm, with the following configuration.

In this case, we will not be using the DEM as input, but instead, we will use the slope and catchment area layers
that are calculated by the algorithms that we previously added. As you add new algorithms, the outputs they
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produce become available for other algorithms, and using them you link the algorithms, creating the workflow.
11. In this case, the output TWI layer is a final layer, so we have to indicate so. In the corresponding textbox, enter

the name that you want to be shown for this output.
Now our model is finished and it should look like this.

12. Enter a name and a group name in the upper part of the model window.

13. Save it clicking on the Save button. You can save it anywhere you want and open it later, but if you save it in
the models folder (which is the folder that you will see when the save file dialog appears), your model will also
be available in the toolbox as well. So stay on that folder and save the model with the filename that you prefer.

14. Now close the modeler dialog and go to the toolbox. In the Models entry you will find your model.
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15. You can run it just like any normal algorithm, double-clicking on it.

As you can see, the parameters dialog, contain the input that you added to the model, along with the outputs
that you set as final when adding the corresponding algorithms.

16. Run it using the DEM as input and you will get the TWI layer in just one single step.

17.18 More complex models

备注: In this lesson we will work with a more complex model in the model designer.

The first model that we created in the previous chapter was a very simple one, with just one input and three algorithms.
More complex models can be created, with different types of inputs and containing more steps. For this chapter we
will work with a model that creates a vector layer with watersheds, based on a DEM and a threshold value. That
will be very useful for calculating several vector layers corresponding to different thresholds, without having to repeat
each single step each time.
This lesson does not contain instructions about how to create your model. You already know the necessary steps
(we saw them in a previous lesson) and you have already seen the basic ideas about the modeler, so you should try it
yourself. Spend a few minutes trying to create your model, and don’t worry about making mistakes. Remember: first
add the inputs and then add the algorithms that use them to create the workflow.

备注: In case you could not create the full model yourself and you need some extra help, the data folder corresponding
to this lesson contains an ’almost’ finished version of it. Open the modeler and then open the model file that you will
find in the data folder. You should see something like this.
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This model contains all the steps needed to complete the calculation, but it just has one input: the DEM. That means
that the threshold for channel definition uses a fixed value, which makes the model not as useful as it could be. That
is not a problem, since we can edit the model, and that is exactly what we will do.

1. First, let’s add a numerical input. That will ask the user for a numerical input that we can use when such a
value is needed in any of the algorithms included in our model.

2. Click on the Number entry in the Inputs tree, and you will see the corresponding dialog.
3. Fill it with the following values.

• Parameter name: Threshold for channel definition

• Default value: 1,000,000

Now your model should look like this.
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The input that we have just added is not used, so the model hasn’t actually changed. We have to link that input
to the algorithm that uses it, in this case the Channel network one. To edit an algorithm that already exists in
the modeler, just click on the pen icon on the corresponding box in the canvas.

4. Click on the Channel network algorithm and you will see something like this.
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The dialog is filled with the current values used by the algorithm. You can see that the Initiation threshold
parameter has a fixed value of 1,000,000 (this is also the default value of the algorithm, but any other value
could be put in there). However, you might notice that the parameter is not entered in a common text box, but
in a drop-down menu.

5. Unfold the threshold parameter menu and you will see something like this.

The input that we added is there and we can select it. Whenever an algorithm in a model requires a numerical
value, you can hardcode it and directly type it, or you can use any of the available inputs and values (remember
that some algorithms generate single numerical values. We will see more about this soon). In the case of a
string parameter, you will also see string inputs and you will be able to select one of them or type the desired
fixed value.

6. Select the Threshold for channel definition input in the Initiation threshold parameter.
7. Click on OK to apply the changes to your model. Now the design of the model should look like this.
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8. The model is now complete. Run it using the DEM that we have used in previous lessons, and with different
threshold values.
Below you have a sample of the result obtained for different values. You can compare with the result for the
default value, which is the one we obtained in the hydrological analysis lesson.

图 17.1: Threshold = 100,000
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图 17.2: Threshold = 1,0000,000

17.19 Numeric calculations in the modeler

警告: Beware, this chapter is not well tested, please report any issue; images are missing

备注: In this lesson we will see how to use numeric outputs in the modeler

For this lesson, we are going to modify the hydrological model that we created in the last chapter (open it in the
modeler before starting), so we can automate the calculation of a valid threshold value and we do not have to ask the
user to enter it. Since that value refers to the variable in the threshold raster layer, we will extract it from that layer,
based on some simple statistical analysis.
Starting with the aforementioned model, let’s do the following modifications:
First, calculate statistics of the flow accumulation layer using the Raster layer statistics algorithm.
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This will generate a set of statistical values that will now be available for all numeric fields in other algorithms.
If you edit the Channel network algorithm, as we did in the last lesson, you will see now that you have other options
apart from the numeric input that you added.
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However, none of this values is suitable for being used as a valid threshold, since they will result in channel networks
that will not be very realistic. We can, instead, derive some new parameter based on them, to get a better result. For
instance, we can use the mean plus 2 times the standard deviation.
To add that arithmetical operation, we can use the calculator that you will find in theGeoalgorithms/modeler/modeler-
tools group. This group contains algorithms that are not very useful outside of the modeler, but that provide some
useful functionality when creating a model.
The parameters dialog of the calculator algorithm looks like this:
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As you can see, the dialog is different to the other ones we have seen, but you have in there the same variables that
were available in the Threshold field in the Channel network algorithm. Enter the above formula and click on OK to
add the algorithm.

If you expand the outputs entry, as shown above, you will see that the model is connected to two of the values, namely
the mean and the standard deviation, which are the ones that we have used in the formula.
Adding this new algorithm will add a new numeric value. If you go again to the Channel network algorithm, you can
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now select that value in the Threshold parameter.

Click on OK and your model should look like this.
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We are not using the numeric input that we added to the model, so it can be removed. Right--click on it and select
Remove

警告: todo: Add image

Our new model is now finished.

17.20 A model within a model

警告: Beware, this chapter is not well tested, please report any issue; images are missing

备注: In this lesson we will see how to use a model within a bigger model.

We have already created a few models, and in this lesson we are going to see how we can combine them on a single
bigger one. A model behaves like any other algorithm, which means that you can add a model that you have already
created as part of another one that you create after that.
In this case, we are going to expand our hydrological model, by adding the mean TWI value in each of the basins that
it generates as result. To do that, we need to calculate the TWI, and to compute the statistics. Since we have already
created a model to calculate TWI from a DEM, it is a good idea to reuse that model instead of adding the algorithms
it contains individually.
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Let’s start with the model we used as starting point for the last lesson.

警告: todo: Add image

First, we will add the TWI model. For it to be available, it should have been saved on the models folder, since
otherwise it will not be shown in the toolbox or the algorithms list in the modeler. Make sure you have it available.
Add it to the current model and use the input DEM as its input. The output is a temporary one, since we just want
the TWI layer to compute the statistics. The only output of this model we are creating will still be the vector layer
with the watersheds.
Here is the corresponding parameters dialog:

警告: todo: Add image

Now we have a TWI layer that we can use along with the watersheds vector layer, to generate a new one which
contains the values of the TWI corresponding to each watershed.
This calculation is done using the Grid statistics in polygons algorithm. Use the layers mentioned above as input, to
create the final result.

警告: todo: Add image

The output of the Vectorize grid classes algorithm was originally our final output, but now we just want it as an
intermediate result. To change that, we have to edit the algorithm. Just double--click on it to see its parameters
dialog, and delete the name of the output. That will make it a temporary output, as it is by default.

警告: todo: Add image

This is how the final model should look like:

警告: todo: Add image

As you see, using a model in another model is nothing special, and you can add it just like you add another algorithm,
as long as the model is saved in the models folder and is available in the toolbox.

17.21 Using modeler-only tools for creating a model

备注: This lesson shows how to use some algorithms that are only available in the modeler, to provide additional
functionality to models.

The goal of this lesson is to use the modeler to create an interpolation algorithm that takes into account the current
selection, not just to use only selected features, but to use the extent of that selection to create the interpolated raster
layer.
The interpolation process involves two steps, as it has been already explained in previous lessons: rasterizing the
points layer and fill the no-data values that appear in the rasterized layer. In case the points layer has a selection, only
selected points will be used, but if the output extent is set to be automatically adjusted, the full extent of the layer will
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be used. That is, the extent of the layer is always considered to be the full extent of all features, not the one computed
from just the selected ones. We will try to fix that by using some additional tools into our model.
Open the modeler and start the model by adding the required inputs. In this case we need a vector layer (restricted
to points) and an attribute from it, with the values that we will use for rasterizing.

The next step is to compute the extent of the selected features. That’s where we can use the model-only tool called
Vector layer bounds. First, we will have to create a layer that has the extent of those selected features. Then, we can
use this tool on that layer.
An easy way of creating a layer with the extent of the selected features is to compute a convex hull of the input points
layer. It will use only the selected point, so the convex hull will have the same bounding box as the selection. Then we
can add the Vector layer bounds algorithm, and use the convex hull layer as input. It should look this in the modeler
canvas:
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The result from the Vector layer bounds is a set of four numeric values and a extent object. We will use both the
numeric outputs and the extent for this exercise.

We can now add the algorithm that rasterizes the vector layer, using the extent from the Vector layer bounds algorithm
as input.
Fill the parameters of the algorithm as shown next:
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The canvas should now look like.
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Finally, fill the no-data values of the raster layer using the Close gaps algorithm.

The algorithm is now ready to be saved and added to the toolbox. You can run it and it will generate a raster layer
from interpolating the selected points in the input layer, and the layer will have the same extent as the selection.
Here’s an improvement to the algorithm. We have used a harcoded value for the cellsize when rasterizing. This value
is fine for our test input layer, but might not be for other cases. We could add a new parameter, so the user enters the
desired value, but a much better approach would be to have that value automatically computed.
We can use the modeler-only calculator, and compute that value from the extent coordinates. For instance, to create
a layer with a fixed width of 100 pixels, we can use the following formula in the calculator.
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Now we have to edit the rasterize algorithm, so it uses the output of the calculator instead of the hardcoded value.
The final algorithm should look like this:
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17.22 Interpolation

备注: This chapter shows how to interpolate point data, and will show you another real example of performing
spatial analysis

In this lesson, we are going to interpolate points data to obtain a raster layer. Before doing it, we will have to do some
data preparation, and after interpolating we will add some extra processing to modify the resulting layer, so we will
have a complete analysis routine.
Open the example data for this lesson, which should look like this.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer of
crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for easily
identifying the most productive areas and also those where productivity can be improved.
The first thing to do is to clean--up the layer, since it contains redundant points. These are caused by the movement
of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter algorithm
will be useful for this. We will use it twice, to remove points that can be considered outliers both in the upper and
lower part of the distribution.
For the first execution, use the following parameter values.
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Now for the next one, use the configuration shown below.
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Notice that we are not using the original layer as input, but the output of the previous run instead.
The final filter layer, with a reduced set of points, should look similar to the original one, but it contains a smaller
number of points. You can check that by comparing their attribute tables.
Now let’s rasterize the layer using the Rasterize algorithm.
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The Filtered points layer refers to the resulting one of the second filter. It has the same name as the one produced by
the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will not be
using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the last filtered
layer.
The resulting raster layer looks like this.
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It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that
contained a point from the vector layer that we have just rasterized, and a no--data value in all the other ones. To fill
the missing values, we can use the Close gaps algorithm.
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The layer without no--data values looks like this.
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To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster layer
with the provided limits layer.
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And for a smoother result (less accurate but better for rendering in the background as a support layer), we can apply
a Gaussian filter to the layer.
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With the above parameters you will get the following result

17.22. Interpolation 619



QGIS Training Manual

17.23 More interpolation

备注: This chapter shows another practical case where interpolation algorithms are used.

Interpolation is a common technique, and it can be used to demonstrate several techniques that can be applied using
the QGIS processing framework. This lesson uses some interpolation algorithms that were already introduced, but
has a different approach.
The data for this lesson contains also a points layer, in this case with elevation data. We are going to interpolate it
much in the same way as we did in the previous lesson, but this time we will save part of the original data to use it
for assessing the quality of the interpolation process.
First, we have to rasterize the points layer and fill the resulting no--data cells, but using just a fraction of the points
in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the
interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a
previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead of
that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the algorithm.
As we have already seen, the rasterizing algorithmwill use only those selected points and ignore the rest. The selection
can be done using the Random selection algorithm. Run it with the following parameters.
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That will select 90% of the points in the layer to rasterize
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The selection is random, so your selection might differ from the selection shown in the above image.
Now run the Rasterize algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the no--data
cells [Cell resolution: 100 m].

To check the quality of the interpolation, we can now use the points that are not selected. At this point, we know the
real elevation (the value in the points layer) and the interpolated elevation (the value in the interpolated raster layer).
We can compare the two by computing the differences between those values.
Since we are going to use the points that are not selected, first, let’s invert the selection.
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The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the Add
raster values to points algorithm
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The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from the
interpolation. We have renamed it to interpolate and that layer name is the one that will be used for the name of the
field to add.
Now we have a vector layer that contains both values, with points that were not used for the interpolation.

Now, we will use the fields calculator for this task. Open the Field calculator algorithm and run it with the following
parameters.
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If your field with the values from the raster layer has a different name, you should modify the above formula accord-
ingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the interpolation,
each of them containing the difference between the two elevation values.
Representing that layer according to that value will give us a first idea of where the largest discrepancies are found.
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Interpolating that layer will get you a raster layer with the estimated error in all points of the interpolated area.
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You can also get the same information (difference between original point values and interpolated ones) directly with
GRASS ► v.sample.
Your results might differ from these ones, since there is a random component introduced when running the random
selection, at the beginning of this lesson.

17.24 Iterative execution of algorithms

备注: This lesson shows a different way of executing algorithms that use vector layers, by running them repeatedly,
iterating over the features in an input vector layer

We already know the model designer, which is one way of automating processing tasks. However, in some situations,
the modeler might not be what we need to automate a given task. Let’s see one of those situations and how to easily
solve it using a different functionality: the iterative execution of algorithms.
Open the data corresponding to this chapter. It should look like this.

You will recognize our well-known DEM from previous chapters and a set of watersheds extracted from it. Imagine
that you need to cut the DEM into several smaller layers, each of them containing just the elevation data corresponding
to a single watershed. That will be useful if you later want to calculate some parameters related to each watershed,
such as its mean elevation or it hypsographic curve.
This can be a lengthy and tedious task, especially if the number of watersheds is large. However, it is a task that can
be easily automated, as we will see.
The algorithm to use for clipping a raster layer with a polygon layer is called Clip raster with polygons, and has the
following parameters dialog.
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You can run it using the watersheds layer and the DEM as input, and you will get the following result.
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As you can see, the area covered by all the watershed polygons is used.
You can have the DEM clipped with just a single watershed by selecting the desired watershed and then running the
algorithm as we did before.

Since only selected features are used, only the selected polygon will be used to crop the raster layer.
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Doing this for all the watersheds will produce the result we are looking for, but it doesn’t look like a very practical
way of doing it. Instead, let’s see how to automate that select and crop routine.
First of all, remove the previous selection, so all polygons will be used again. Now open the Clip raster with polygon
algorithm and select the same inputs as before, but this time click on the button that you will find in the right--hand
side of the vector layer input where you have selected the watersheds layer.

This button will cause the selected input layer to be split into as many layer as feature are found in it, each of them
containing a single polygon. With that, the algorithm will be called repeatedly, one for each one of those single-
polygon layers. The result, instead of just one raster layer in the case of this algorithm, will be a set of raster layers,
each one of them corresponding to one of the executions of the algorithm.
Here’s the result that you will get if you run the clipping algorithm as explained.
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For each layer, the black and white color palette, (or whatever palette you are using), is adjusted differently, from its
minimum to its maximum values. That’s the reason why you can see the different pieces and the colors do not seem
to match in the border between layers. Values, however, do match.
If you enter an output filename, resulting files will be named using that filename and a number corresponding to each
iteration as suffix.

17.25 More iterative execution of algorithms

备注: This lesson shows how to combine the iterative execution of algorithms with the modeler to get more automa-
tion.

The iterative execution of algorithms is available not just for built-in algorithms, but also for the algorithms that you
can create yourself, such as models. We are going to see how to combine a model and the iterative execution of
algorithms, so we can obtain more complex results with ease.
The data the we are going to use for this lesson is the same one that we already used for the last one. In this case, instead
of just clipping the DEM with each watershed polygon, we will add some extra steps and calculate a hypsometric
curve for each of them, to study how elevation is distributed within the watershed.
Since we have a workflow that involves several steps (clipping + computing the hypsometric curve), we should go to
the modeler and create the corresponding model for that workflow.
You can find the model already created in the data folder for this lesson, but it would be good if you first try to create
it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so this model
will not generated any layers, but just a table with the curve data.
The model should look like this:
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Add the model to you models folder, so it is available in the toolbox, and execute it.
Select the DEM and watersheds basins.
The algorithm will generate tables for all the basins and place them in the output directory.
We can make this example more complex by extending the model and computing some slope statistics. Add the Slope
algorithm to the model, and then the Raster statistics algorithm, which should use the slope output as its only input.

If you now run the model, apart from the tables you will get a set of pages with statistics. These pages will be available
in the results dialog.
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17.26 The batch processing interface

备注: This lesson introduces the batch processing interface, which allows to execute a single algorithm with a set of
different input values.

Sometimes a given algorithm has to be executed repeatedly with different inputs. This is, for instance, the case when
a set of input files have to be converted from one format to another, or when several layers in a given projection must
be converted into another projection.
In that case, calling the algorithm repeatedly on the toolbox is not the best option. Instead, the batch processing
interface should be used, which greatly simplifies performing a multiple execution of a given algorithm. To run an
algorithm as a batch process, find it in the toolbox, and instead of double--clicking on it, right--click on it and select
Run as batch process.

For this example, we will use the Reproject algorithm, so find it and do as described above. You will get to the
following dialog.

If you have a look at the data for this lesson, you will see that it contains a set of three shapefiles, but no QGIS project
file. This is because, when an algorithm is run as a batch process, layer inputs can be selected either from the current
QGIS project or from files. That makes it easier to process large amounts of layers, such as, for instance, all the layers
in a given folder.
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Each row in the table of the batch processing dialog represents a single execution of the algorithm. Cells in a row
correspond to the parameter needed by the algorithm, which are not arranged one above the other, as in the normal
single--execution dialog, but horizontally in that row.
Defining the batch process to run is done by filling the table with the corresponding values, and the dialog itself
contains several tools to make this task easier.
Let’s start filling the fields one by one. The first column to fill is the Input layer one. Instead of entering the names
of each one of the layers we want to process, you can select all of them and let the dialog put one in each row. Click
on the button in the upper-left cell, and in the file selection dialog that will popup, select the three files to reproject.
Since only one of them is needed for each row, the remaining ones will be used to fill the rows underneath.

The default number of rows is 3, which is exactly the number of layers we have to convert, but if you select more
layers, new rows will be added automatically. If you want to fill the entries manually, you can add more rows using
the Add row button.
We are going to convert all those layers to the EPSG:23029 CRS, so we have to select that CRS in the second field.
We want the same on for all rows, but we do not have to do it for every single row. Instead, set that CRS for the first
row (the one at the top) using the button in the corresponding cell, and then double click on the column header. That
causes all the cells in the column to be filled using the value of the top cell.
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Finally, we have to select an output file for each execution, which will contain the corresponding reprojected layer.
Once again, let’s do it just for the first row. Click on the button in the upper cell and, in a folder where you want to
put your output files, enter a filename (for instance, reprojected.shp).
Now, when you click OK on the file selection dialog, the file does not automatically gets written to the cell, but an
input box like the following one is shown instead.

If you select the first option, only the current cell will be filled. If you select any of the other ones, all the rows below
will be filled with a given pattern. In this case, we are going to select the Fill with parameter value option, and then
the Input Layer value in the drop down menu below. That will cause the value in the Input Layer (that is, the layer
name) to be added to the filename we have added, making each output filename different. The batch processing table
should now look like this.
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The last column sets whether or not to add the resulting layers to the current QGIS project. Leave the default Yes
option, so you can see your results in this case.
Click on OK and the batch process will be run. If everything went fine, all your layers will have been processed, and
3 new layers would have been created.

17.27 Models in the batch processing interface

警告: Beware, this chapter is not well tested, please report any issue; images are missing

备注: This lesson shows another example of the batch processing interface, but this time using a model instead of
a built-in algorithm

Models are just like any other algorithm, and they can be used in the batch processing interface. To demonstrate that,
here is a brief example that we can do using our already well-known hydrological model.
Make sure you have the model added to your toolbox, and then run it in batch mode. This is what the batch processing
dialog should look like.

警告: todo: Add image

Add rows up to a total of 5. Select the DEM file corresponding to this lesson as the input for all of them. Then enter
5 different threshold values as shown next.
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警告: todo: Add image

As you see the batch processing interface can be run not just to run the same process on different datasets but also
on the same dataset with different parameters.
Click on OK and you should get 5 new layers with watersheds corresponding to the specified 5 threshold values.

17.28 Pre- and post-execution script hooks

备注: This lesson shows how to use pre- and post-execution hooks, which allow to perform additional operations
before and after actual processing.

Pre- and post-execution hooks are Processing scripts that run before and after actual data processing is performed.
This can be used to automate tasks that should be performed whenever an algorithm is executed.
The syntax of the hooks is identical to the syntax of Processing scripts, see the corresponding chapter in the QGIS
User Guide for more details.
In addition to all scripts features, in hooks you can use a special global variable named alg, which represents the
algorithm that has just been (or is about to be) executed.
Here is an example post-execution script. By default, Processing stores analysis results in temporary files. This script
will copy outputs to a specific directory, so they won’t be deleted after closing QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

In the first two lines we import the required Python packages: os --- for path manipulations, e.g. extracting file name,
and shutil --- for various filesystem operations like copying files. In the third line we import Processing outputs.
This will be explained in more detail later in this lesson.
Then we define a MY_DIRECTORY constant, which is the path to the directory where we want to copy analysis
results.
At the end of the script, we have the main hook code. In the loop we iterate over all algorithm outputs and check if
this output is a file-based output and can be copied. If so, we determine top-level directory in which output files are
located and then copy all files to our directory.
To activate this hook we need to open the Processing options, find the entry named Post-execution script file in the
General group, and specify the filename of the hook script there. the specified hook will be executed after each
Processing algorithm.
In a similar way, we can implement pre-execution hooks. For example, let’s create a hook to check input vectors for
geometry errors.

from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:

(续下页)
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(接上页)
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

As in the previous example, first we import required QGIS and Processing packages.
Then we iterate over all the algorithm parameters and if a ParameterVector parameter is found, we get the corre-
sponding vector layer object from it. We loop over all the features of the layer and check them for geometry errors.
If at least one feature contains an invalid geometry, we print a warning message.
To activate this hook we need enter its filename in the Pre-execution script file option in the Processing configuration
dialog. The hook will be executed before running any Processing algorithm.

17.29 Other programs

Module contributed by Paolo Cavallini - Faunalia

备注: This chapter shows how to use additional programs from inside Processing. To complete it, you must have
installed, with the tools of your operating system, the relevant packages.

17.29.1 GRASS

GRASS is a free and open source GIS software suite for geospatial data management and analysis, image processing,
graphics and maps production, spatial modeling, and visualization.
It is installed by default on Windows through the OSGeo4W standalone installer (32 and 64 bit), and it is packaged
for all major Linux distributions.

17.29.2 R

R is a free and open source software environment for statistical computing and graphics.
It has to be installed separately, together with a few necessary libraries (LIST). To enable the use of R in QGIS, the
Processing R Provider plugin must also be installed.
The beauty of Processing implementation is that you can add your own scripts, simple or complex ones, and they
may then be used as any other module, piped into more complex workflows, etc.
Test some of the preinstalled examples, if you have R already installed (remember to activate R modules from the
General configuration of Processing).
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17.29.3 Others

LASTools is a set of mixed, free and proprietary commands to process and analyze LiDAR data. Availability in
various operating system varies.
More tools are available through additional plugins, e.g.:

• LecoS: a suite for land cover statistics and landscape ecology
• lwgeom: formerly part of PostGIS, this library brings a few useful tools for geometry cleanup
• Animove: tools to analyse the home range of animals.

More will come.

17.29.4 Comparison among backends

Buffers and distances

Let’s load points.shp and type buf in the filter of the Toolbox, then double click on:
• Fixed distance buffer: Distance 10000
• Variable distance buffer: Distance field SIZE
• v.buffer.distance: distance 10000
• v.buffer.column: bufcolumn SIZE
• Shapes Buffer: fixed value 10000 (dissolve and not), attribute field (with scaling)

See how speed is quite different, and different options are available.
Exercise for the reader: find the differences in geometry output between different methods.
Now, raster buffers and distances:

• first, load and rasterize the vector rivers.shp with GRASS► v.to.rast.value; beware: cell size must be set
to 100 m, otherwise the computation time will be enormous; resulting map will have 1 and NULLs

• same, with SAGA ► Shapes to Grid ► COUNT (resulting map: 6 to 60)
• then, proximity (value= 1 for GRASS, a list of rivers ID for SAGA), r.buffer with parameters 1000,2000,3000,
r.grow.distance (the first of the two maps; the second will show the areas pertaining to each river, if done on
the SAGA raster).

融合（dissolve）

Dissolve features based on a common attribute:
• GRASS ► v.dissolve municipalities.shp on PROVINCIA
• QGIS ► Dissolve municipalities.shp on PROVINCIA
• OGR ► Dissolve municipalities.shp on PROVINCIA
• SAGA ► Polygon Dissolve municipalities.shp on PROVINCIA (NB: Keep inner boundaries must be
unselected)

备注: The last one is broken in SAGA <=2.10

Exercise for the reader: find the differences (geometry and attributes) between different methods.
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17.30 Interpolation and contouring

Module contributed by Paolo Cavallini - Faunalia

备注: This chapter shows how to use different backends to calculate different interpolations.

17.30.1 Interpolation

The project shows a gradient in rainfall, from south to north. Let’s use different methods for interpolation, all based
on vector points.shp, parameter RAIN:

警告: Set cell size to 500 for all analyses.

• GRASS ► v.surf.rst

• SAGA ► Multilevel B-Spline Interpolation

• SAGA ► Inverse Distance Weighted [Inverse distance to a power; Power: 4; Search radius: Global; Search
range: all points]

• GDAL ► Grid (Inverse Distance to a power) [Power:4]
• GDAL ► Grid (Moving average) [Radius1&2: 50000]

Then measure variation among methods and correlate it with distance to points:
• GRASS ► r.series [Unselect Propagate NULLs, Aggregate operation: stddev]
• GRASS ► v.to.rast.value on points.shp
• GDAL ► Proximity

• GRASS ► r.covar to show the correlation matrix; check the significance of the correlation e.g. with http:
//vassarstats.net/rsig.html.

Thus, areas far from points will have less accurate interpolation.

17.30.2 Contour

Various methods to draw contour lines [always step= 10] on the stddev raster:
• GRASS ► r.contour.step

• GDAL ► Contour

• SAGA ► Contour lines from grid [NB: in some older SAGA versions, output shp is not valid, known bug]
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17.31 Vector simplification and smoothing

Module contributed by Paolo Cavallini - Faunalia

备注: This chapter shows how simplify vectors, and smooth out sharp corners.

Sometimes we need a simplified version of a vector, to have a smaller file size and get rid of unnecessary details.
Many tools do this in a very rough way, andmiss the adjacency and sometimes the topological correctness of polygons.
GRASS is the ideal tool for this: being a topological GIS, adjacency and correctness are preserved even at very high
simplification levels. In our case, we have a vector resulting from a raster, thus showing a ”saw” pattern at borders.
Applying a simplification results in straight lines:

• GRASS ► v.generalize [Maximal tolerance value: 30 m]
We can also do the reverse, and make a layer more complex, smoothing out sharp corners:

• GRASS ► v.generalize [method: chaiken]
Try to apply this second command both to original vector and to the one from the first analysis, and see the difference.
Note that adjacency is not lost.
This second option can be applied e.g. to contour lines resulting from a coarse raster, to GPS tracks with sparse
vertices, etc.

17.32 Planning a solar farm

Module contributed by Paolo Cavallini - Faunalia

备注: This chapter shows how to use several criteria to locate the areas suitable for installing a photovoltaic power
station

First of all, create an aspect map from DTM:
• GRASS ► r.aspect [Data type: int; cell size:100]

In GRASS, aspect is calculated in degrees, counterclockwise starting from East. To extract only South facing slopes
(270 degrees +- 45), we can reclassify it:

• GRASS ► r.reclass

with the following rules:

225 thru 315 = 1 south
* = NULL

You can use the text file reclass_south.txt provided. Note that with these simple text files we can create also
very complex reclassifications.
We want to build a large farm, so we select only large (> 100 ha) contiguous areas:

• GRASS ► r.reclass.greater

Finally, we convert to a vector:
• GRASS ► r.to.vect [Feature type: area; Smooth corners: yes]

Exercise for the reader: repeat the analysis, replacing GRASS commands with analogous from other programs.

17.31. Vector simplification and smoothing 641

https://www.faunalia.eu/en
https://www.faunalia.eu


QGIS Training Manual

17.33 Use R scripts in Processing

Module contributed by Matteo Ghetta - funded by Scuola Superiore Sant’Anna
Processing (with theProcessing R Provider plugin) makes it possible to write and run R scripts inside QGIS.

警告: R has to be installed on your computer and the PATH has to be correctly set up. Moreover Processing
just calls the external R packages, it is not able to install them. So be sure to install external packages directly in
R. See the related chapter in the user manual.

备注: If you have package problems, it may be related to missing mandatory packages required by Processing, like
sp, rgdal and raster.

17.33.1 Adding scripts

Adding a script is simple. The easiest way is to open the Processing toolbox and choose Create new R script... from
the R menu (labelled with an R icon) at the top of the Processing Toolbox. You can also create the script in for
instance a text editor and save it in your R scripts folder (processing/rscripts). When it has been saved
there, it will be available for editing by right-clicking on the script name in the processing toolbox and then choose
Edit Script...).

备注: If you cannot see R in Processing, you have to activate it in Processing ► Options ► Providers

It opens a script editor window in which you have to specify some parameters before you can add the script body.
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17.33.2 Creating plots

In this tutorial we are going to create a boxplot of a vector layer field.
Open the r_intro.qgs QGIS project under the exercise_data/processing/r_intro/ folder.

Script parameters

Open the editor and start writing at the beginning of it.
Youmust specify some parameters before the script body:

1. The name of the group (plots in this case) in which you want to put your script (if the group does not exist, it
will be created):

##plots=group

You will find your script in the plots R group in the Processing toolbox.
2. You have to tell Processing that you want to display a plot (in this example):

##showplots

You will then find a link to the plot in the Result Viewer panel (can be turned on / off in View ► Panels and
with Processing ► Results Viewer).

3. You also need to tell Processing about your input data. In this example we want to create a plot from a field of
a vector layer:

##Layer=vector

Processing now knows that the input is a vector. The name Layer is not important, what matters is the vector
parameter.

4. Finally, you have to specify the input field of the vector layer (using the name you have provided above - Layer):

##X=Field Layer

Processing now knows that you need a field of Layer, and that you will call it X.
5. It is also possible to define the name of your script using name:

##My box plot script=name

If not defined, the file name will be used as the name of the script.
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Script body

Now that you have set up the heading of the script you can add the function:

boxplot(Layer[[X]])

boxplot is the name of the R function, the parameter Layer is the name that you have defined for the input dataset
and X is the name you have defined for the field of that dataset.

警告: The parameter X has to be within double square brackets ([[]]).

The final script looks like this:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Save the script in the default path suggested by Processing (processing/rscripts). If you have not defined a name in
the script heading, the file name you choose will become the name of the script in the Processing toolbox.

备注: You can save the script wherever you like, but Processing will then not be able to include it in the processing
toolbox automatically, so you have to upload it manually.

Now just run it using the button on the top of the editor window:
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Once the editor window has been closed, use the text box of Processing to find your script:

You can now fill the parameters required in the Processing algorithm window:
• for Layer choose sample_points
• for the X field choose value

Click on Run.
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The Result window should be automatically opened, if not, just click on Processing ► Result Viewer....
Click on the link in the viewer and you will see:
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备注: You can open, copy and save the image by right clicking on the plot.

17.33.3 Create a vector

You can also create a vector layer and have it automatically loaded into QGIS.
The following example has been taken from the Random sampling grid script that can be found in the online
collection of R scripts (the scripts in this online collection can be found in https://github.com/qgis/QGIS-Processing/
tree/master/rscripts).
The aim of this exercise is to create a random point vector layer using an input vector layer to restrict the extent using
the spsample function of the sp package.
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Script parameters

As before we have to set some parameters before the script body:
1. Specify the name of the group in which you want to put your script, in this case Point pattern analysis:

##Point pattern analysis=group

2. Define an input parameter (a vector layer) that will constrain the placement of the random points:

##Layer=vector

3. Set an input parameter for the number of points that are going to be created (Size, with a default value of
10):

##Size=number 10

备注: Since a default value (10) is defined, the user can change this number or can leave the parameter
without a number.

4. Specify that there is an output vector layer (called Output):

##Output=output vector

Script body

Now you can add the body of the function:
1. Use the spsample function:

pts=spsample(Layer, Size, type="random")

The function uses the Layer to constrain the placement of the points (if it is a line layer, a points will have to
be on one of the lines in the layer, if it is a polygon layer, a point will have to be within a polygon). The number
of points is taken from the Size parameter. The sampling method is random.

2. Generate the output (the Output parameter):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The final script looks like this:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Save it and run it, clicking on the run button.
In the new window type in the right parameters:

and click on run.
The result layer will be added to the table of contents and its points will be displayed on the map canvas:
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17.33.4 Text and graph output from R - syntax

Processing (with the Processing R Provider plugin) uses special syntax to get the results out of R:
• > before your command, as in >lillie.test(Layer[[Field]]) means the result should be sent to
R output (Result viewer)

• + after a plot enables overlay plots. For example plot(Layer[[X]], Layer[[Y]]) +
abline(h=mean(Layer[[X]]))

17.34 Predicting landslides

Module contributed by Paolo Cavallini - Faunalia

备注: This chapter shows how to create an oversimplified model to predict the probability of landslides.

First, we calculate slope (choose among various backends; the interested reader can calculate the difference between
the outputs):

• GRASS ► r.slope

• SAGA ► Slope, Aspect, Curvature

• GDAL Slope

Then we create a model of predicted rainfall, based on the interpolation of rainfall values at meteo stations:
• GRASS ► v.surf.rst (resolution: 500 m)

The probability of a landslide will be very roughly related to both rainfall and slope (of course a real model will use
more layers, and appropriate parameters), let’s say (rainfall * slope )/100:

• SAGA ► Raster calculator rain, slope: (a*b)/100 (or: GRASS ► r.mapcalc)
• then let’s calculate what are the municipalities with the greatest predicted risk of rainfall: SAGA ► Raster
statistics with polygons (the parameters of interest are Maximum and Mean)
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CHAPTER18

单元: 在 QGIS中使用空间数据库

In this module you will learn about how to use Spatial Databases with QGIS to manage, display and manipulate data
in the database as well as performing analysis by querying. We will primarily use PostgreSQL and PostGIS (which
were covered in previous sections), but the same concepts are applicable to other spatial database implementations
including SpatiaLite.

18.1 Lesson: Working with Databases in the QGIS Browser

In the previous 2 modules we looked at the basic concepts, features and functions of relational databases as well as
extensions that let us store, manage, query and manipulate spatial data in a relational database. This section will dive
deeper into how to effectively use spatial databases in QGIS.
The goal for this lesson: To learn how to interact with spatial databases using the QGIS Browser interface.

18.1.1 Follow Along: Adding Database Tables to QGIS using the Browser

We have already briefly looked at how to add tables from a database as QGIS layers, now lets look at this in a bit more
detail and look at the different ways this can be done in QGIS. Lets start by looking at the new Browser interface.

• Start a new empty map in QGIS.
• Open the Browser by clicking the Browser tab at the bottom of the Layer Panel
• Open the PostGIS portion of the tree and you should find your previously configured connection available (you
may need to click the Refresh button at the top of the browser window).
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• Double clicking on any of the table/layers listed here will add it to the Map Canvas.
• Right Clicking on a table/layer in this view will give you a few options. Click on the Properties item to look at
the properties of the layer.
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备注: Of course you can also use this interface to connect to PostGIS databases hosted on a server external to your
workstation. Right clicking on the PostGIS entry in the tree will allow you to specify connection parameters for a
new connection.

18.1.2 Follow Along: Adding a filtered set of records as a Layer

Now that we have seen how to add an entire table as a QGIS layer it might be nice to learn how to add a filtered set
of records from a table as a layer by using queries that we learned about in previous sections.

• Start a new empty map with no layers
• Click the Add PostGIS Layers button or select Layer ► Add PostGIS Layers from the menu.
• In the Add PostGIS Table(s) dialog that comes up, connect to the postgis_demo connection.
• Expand the public schema and you should find the three tables we were working with previously.
• Click the lines layer to select it, but instead of adding it, click the Set Filter button to bring up the Query
Builder dialog.

• Construct the following expression using the buttons or by entering it directly:

"roadtype" = 'major'
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• Click OK to complete editing the filter and click Add to add the filtered layer to your map.
• Rename the lines layer in the tree to roads_primary.

You will notice that only the Primary Roads have been added to your map rather than the entire layer.

18.1.3 In Conclusion

You have seen how to interact with spatial databases using the QGIS Browser and how to add layers to your map
based on a query filter.

18.1.4 What’s Next?

Next you’ll see how to work with the DBManager interface in QGIS for a more complete set of database management
tasks.

18.2 Lesson: Using DB Manager to work with Spatial Databases in
QGIS

We have already seen how to perform many database operations with QGIS as well as with other tools, but now it’s
time to look at the DB Manager tool which provides much of this same functionality as well as more management
oriented tools.
The goal for this lesson: To learn how to interact with spatial databases using the QGIS DB Manager.

18.2.1 Follow Along: Managing PostGIS Databases with DB Manager

You should first open the DBManager interface by selectingDatabase --> DBManager --> DBManager on the menu
or by selecting the DB Manager icon on the toolbar.

You should already see the previous connections we have configured and be able to expand the myPG section and its
public schema to see the tables we have worked with in previous sections.
The first thing you may notice is that you can now see some metadata about the Schemas contained in your database.
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Schemas are a way of grouping data tables and other objects in a PostgreSQL database and a container for permissions
and other constraints. Managing PostgreSQL schemas is beyond the scope of this manual, but you can find more
information about them in the PostgreSQL documentation on Schemas. You can use the DB Manager to create new
Schemas, but will need to use a tool like pgAdmin III or the command line interface to manage them effectively.
DB Manager can also be used to manage the tables within your database. We have already looked at various ways to
create and manage tables on the command line, but now lets look at how to do this in DB Manager.
First, its useful to just look at a table’s metadata by clicking on its name in tree and looking in the Info tab.
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In this panel you can see the General Info about the table as well the information that the PostGIS extension maintains
about the geometry and spatial reference system.
If you scroll down in the Info tab, you can see more information about the Fields, Constraints and Indexes for the table
you are viewing.
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Its also very useful to use DB Manager to simply look at the records in the database in much the same way you might
do this by viewing the attribute table of a layer in the Layer Tree. You can browse the data by selecting the Table tab.
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There is also a Preview tab which will show you the layer data in a map preview.
Right-clicking on a layer in the tree and clicking Add to Canvas will add this layer to your map.
So far we have only been viewing the database its schemas and tables and their metadata, but what if we wanted to
alter the table to add an additional column perhaps? DB Manager allows you to do this directly.

1. Select the table you want to edit in the tree
2. Select Table ► Edit Table from the menu, to open the Table Properties dialog.

You can use this dialog to Add Columns, Add geometry columns, edit existing columns or to remove a column
completely.
Using the Constraints tab, you can manage which fields are used as the primary key or to drop existing constraints.
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The Indexes tab can be used to add and delete both spatial and normal indexes.
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18.2.2 Follow Along: Creating a New Table

Now that we have gone through the process of working with existing tables in our database, let’s use DB Manager to
create a new table.

1. If it is not already open, open the DB Manager window, and expand the tree until you see the list of tables
already in your database.

2. From the menu select Table --> Create Table to bring up the Create Table dialog.
3. Use the default Public schema and name the table places.
4. Add the id, place_name, and elevation fields as shown below
5. Make sure the id field is set as the primary key.
6. Click the checkbox to Create geometry column and make sure it is set to a POINT type and leave it named

geom and specify 4326 as the SRID.
7. Click the checkbox to Create spatial index and click Create to create the table.
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8. Dismiss the dialog letting you know that the table was created and click Close to close the Create Table Dialog.
You can now inspect your table in the DB Manager and you will of course find that there is no data in it. From here
you can Toggle Editing on the layer menu and begin to add places to your table.

18.2.3 Follow Along: Basic Database Administration

The DB Manager will also let you do some basic database administration tasks. It is certainly not a substitute for a
more complete database administration tool, but it does provide some functionality that you can use to maintain your
database.
Database tables can often become quite large and tables which are being modified frequently can end up leaving
around remnants of records that are no longer needed by PostgreSQL. The VACUUM command takes care of doing
a kind of garbage collection to compact and optional analyze your tables for better performance.
Let us take a look at how we can perform a VACUUM ANALYZE command from within DB Manager.

1. Select one of your tables in the DB Manager Tree
2. Select Table ► Run Vacuum Analyze from the menu

PostgreSQL will now perform the operation. Depending on how big your table is, this may take some time to com-
plete.
You can find more information about the VACUUM ANALYZE process in the PostgreSQL Documentation on
VACUUM ANALYZE.
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18.2.4 Follow Along: Executing SQL Queries with DB Manager

DB Manager also provides a way for you to write queries against your database tables and to view the results. We
have already seen this type of functionality in the Browser panel, but lets look at it again here with DB Manager.

1. Select the lines table in the tree.
2. Select the SQL window button in the DB Manager toolbar.

3. Compose the following SQL query in the space provided:

select * from lines where roadtype = 'major';

4. Click the Execute (F5) button to run the query.
5. You should now see the records that match in the Result panel.

6. Click the checkbox for Load as new layer to add the results to your map.
7. Select the id column as the Column with unique integer values and the geom column as the Geometry column.
8. Enter roads_primary as the Layer name (prefix).
9. Click Load now! to load the results as a new layer into your map.
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The layers that matched your query are now displayed on your map. You can of course use this query tool to execute
any arbitrary SQL command including many of the ones we looked at in previous modules and sections.

18.2.5 Importing Data into a Database with DB Manager

We have already looked at how to import data into a spatial database using command line tools, so now let’s learn
how to use DB Manager to do imports.

1. Click the Import layer/file button on the toolbar in the DB Manager dialog.

2. Select the urban_33S.shp file from exercise_data/projected_data as the input dataset
3. Click the Update Options button to pre-fill some of the form values.
4. Make sure that the Create new table option is selected
5. Specify the Source SRID as 32722 and the Target SRID as 4326
6. Enable the checkbox to Create Spatial Index
7. Click OK to perform the import
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8. Dismiss the dialog letting you know that the import was successful
9. Click the Refresh button on the DB Manager Toolbar

You can now inspect the table in your database by clicking on it in the Tree. Verify that the data has been reprojected
by checking that the Spatial ref: is listed as WGS 84 (4326).
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Right clicking on the table in the Tree and a selecting Add to Canvas will add the table as a layer in your map.

18.2.6 Exporting Data from a Database with DB Manager

Of course DB Manager can also be used to export data from your spatial databases, so lets take a look at how that is
done.

1. Select the lines layer in the Tree and click the Export to File button on the toolbar to open the Export to
vector file dialog.

2. Click the ... button to select the Output file and save the data to your exercise_data directory as
urban_4326.

3. Set the Target SRID as 4326.
4. Click OK to initialize the export.
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5. Dismiss the dialog letting you know the export was successful and close the DB Manager.
You can now inspect the shapefile you created with the Browser panel.
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18.2.7 In Conclusion

You have now seen how to use the DB Manager interface in QGIS to manage your spatial databases, to execute SQL
queries against your data and how to import and export data.

18.2.8 What’s Next?

Next, we will look at how to use many of these same techniques with SpatiaLite databases.

18.3 Lesson: Working with SpatiaLite databases in QGIS

While PostGIS is generally used on a server to provide spatial database capabilities to multiple users at the same
time, QGIS also supports the use of a file format called SpatiaLite that is a lightweight, portable way to store an entire
spatial database in a single file. Obviously, these 2 types of spatial databases should be used for different purposes,
but the same basic principles and techniques apply to both. Let’s create a new SpatiaLite database and explore the
functionality provided to work with these databases in QGIS.
The goal for this lesson: To learn how to interact with SpatiaLite databases using the QGIS Browser interface.

18.3.1 Follow Along: Creating a SpatiaLite database with the Browser

Using the Browser panel, we can create a new SpatiaLite database and get it setup for use in QGIS.
1. Right click on the SpatiaLite entry in the Browser tree and select Create Database.
2. Specify where on your filesystem you want to store the file and name it qgis-sl.db.
3. Again right click on the SpatiaLite entry in the Browser tree and now select the New Connection item. Find the

file you created in the last step and open it.
Now that you have configured your new database you will find that the entry in Browser tree has nothing underneath
it and the only thing you can do at this point is to delete the connection. This is of course because we haven’t added
any tables to this database. Let’s go ahead and do that.

1. Find the button to create a new layer and use the dropdown to create a new SpatiaLite layer, or select Layer►
New ► New SpatiaLite Layer.

2. Select the database we created in the previous steps in the drop down.
3. Give the layer the name places.
4. Tick the checkbox next to Create an auto-incrementing primary key.
5. Add two attributes as shown in below
6. Click OK to create the table.
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7. Click the refresh button at the top of the Browser and you should now see your places table listed.
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You can right click on the table and view its properties as we did in the previous exercise.
From here you can start an editing session and start adding data to your new database directly.
We also learned about how to import data into a database using the DBManager and you can use this same technique
to import data into your new SpatiaLite DB.

18.3.2 In Conclusion

You have seen how to create SpatiaLite databases, add tables to them and use these tables as layers in QGIS.
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Appendix: Contributing To This Manual

To add materials to this course, you must follow the guidelines in this Appendix. You are not to alter the conditions
in this Appendix except for clarification. This is to ensure that the quality and consistency of this manual can be
maintained.

19.1 Downloading Resources

The source of this document is available at GitHub. Consult GitHub.com for instructions on how to use the git version
control system.

19.2 Manual Format

This manual is written using Sphinx, a Python document generator using the reStructuredText markup language.
Instructions on how to use these tools are available on their respective sites.

19.3 Adding a Module

• To add a new module, first create a new directory (directly under the top-level of the
qgis-training-manual directory) with the name of the new module.

• Under this new directory, create a file called index.rst. Leave this file blank for now.
• Open the index.rst file under the top-level directory. Its first lines are:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

You will note that this is a list of directory names, followed by the name index. This directs the top-level index
file to the index files in each directory. The order in which they are listed determines the order they will have in the
document.
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• Add the name of your new module (i.e., the name you gave the new directory), followed by /index, to this
list, wherever you want your module to appear.

• Remember to keep the order of the modules logical, such that later modules build on the knowledge presented
in earlier modules.

• Open your new module’s own index file ([module name]/index.rst).
• Along the top of the page, write a line of 80 asterisks (*). This represents a module heading.
• Follow this with a line containing the markup phrase |MOD| (which stands for ”module”), followed by the
name of your module.

• End this off with another line of 80 asterisks.
• Leave a line open beneath this.
• Write a short paragraph explaining the purpose and content of the module.
• Leave one line open, then add the following text:

.. toctree::
:maxdepth: 2

lesson1
lesson2

... where lesson1, lesson2, etc., are the names of your planned lessons.
The module-level index file will look like this:

*******************************************************************************
|MOD| Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Adding a Lesson

To add a lesson to a new or existing module:
• Open the module directory.
• Open the index.rst file (created above in the case of new modules).
• Ensure that the name of the planned lesson is listed underneath the toctree directive, as shown above.
• Create a new file under the module directory.
• Name this file exactly the same as the name you provided in the module’s index.rst file, and add the
extension .rst.

备注: For editing purposes, a .rst file works exactly like a normal text file (.txt).

• To begin writing the lesson, write the markup phrase |LS|, followed by the lesson name.
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• In the next line, write a line of 80 equal signs (=).
• Leave a line open after this.
• Write a short description of the lesson’s intended purpose.
• Include a general introduction to the subject matter. See the existing lessons in this manual for examples.
• Beneath this, start a new paragraph, beginning with this phrase:

**The goal for this lesson:**

• Briefly explain the intended outcome of completing this lesson.
• If you can’t describe the goal of the lesson in one or two sentences, consider breaking the subject matter up
into multiple lessons.

Each lesson will be subdivided into multiple sections, which will be addressed next.

19.5 Adding a Section

There are two types of sections: ”follow along” and ”try yourself”.
• A ”follow along” section is a detailed set of directions intended to teach the reader how to use a given aspect
of QGIS. This is typically done by giving click-by-click directions as clearly as possible, interspersed with
screenshots.

• A ”try yourself” section gives the reader a short assignment to try by themselves. It is usually associated with
an entry in the answer sheet at the end of the documentation, which will show or explain how to complete the
assignment, and will show the expected outcome if possible.

Every section comes with a difficulty level. An easy section is denoted by |basic|, moderate by |moderate|,
and advanced by |hard|.

19.5.1 Adding a ”follow along” section

• To start this section, write the markup phrase of the intended difficulty level (as shown above).
• Leave a space and then write |FA| (for ”follow along”).
• Leave another space and write the name of the section (use only an initial capital letter, as well as capitals for
proper nouns).

• In the next line, write a line of 80 minuses/dashes (-). Ensure that your text editor does not replace the default
minus/dash character with a long dash or other character.

• Write a short introduction to the section, explaining its purpose. Then give detailed (click-by-click) instructions
on the procedure to be demonstrated.

• In each section, include internal links, external links and screenshots as needed.
• Try to end each section with a short paragraph that concludes it and leads naturally to the next section, if
possible.
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19.5.2 Adding a ”try yourself” section

• To start this section, write the markup phrase of the intended difficulty level (as shown above).
• Leave a space and then write |TY| (for ”try yourself”).
• In the next line, write a line of 80 minuses/dashes (-). Ensure that your text editor does not replace the default
minus/dash character with a long dash or other character.

• Explain the exercise that you want the reader to complete. Refer to previous sections, lessons or modules if
necessary.

• Include screenshots to clarify the requirements if a plain textual description is not clear.
In most cases, you will want to provide an answer regarding how to complete the assignment given in this section. To
do so, you will need to add an entry in the answer sheet.

• First, decide on a unique name for the answer. Ideally, this name will include the name of the lesson and an
incrementing number.

• Create a link for this answer:

:ref:`Check your results <answer-name>`

• Open the answer sheet (answers/answers.rst).
• Create a link to the ”try yourself” section by writing this line:

.. _answer-name:

• Write the instructions on how to complete the assignment, using links and images where needed.
• To end it off, include a link back to the ”try yourself” section by writing this line:

:ref:`Back to text <backlink-answer-name>`

• To make this link work, add the following line above the heading to the ”try yourself” section:

.. _backlink-answer-name:

Remember that each of these lines shown above must have a blank line above and below it, otherwise it could cause
errors while creating the document.

19.6 Add a Conclusion

• To end a lesson, write the phrase |IC| for ”in conclusion”, followed by a new line of 80 minuses/dashes (-).
Write a conclusion for the lesson, explaining which concepts have been covered in the lesson.

19.7 Add a Further Reading Section

• This section is optional.
• Write the phrase FR for ”further reading”, followed by a new line of 80 minuses/dashes (-).
• Include links to appropriate external websites.
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19.8 Add a What’s Next Section

• Write the phrase |WN| for ”what’s next”, followed by a new line of 80 minuses/dashes (-).
• Explain how this lesson has prepared students for the next lesson or module.
• Remember to change the ”what’s next” section of the previous lesson if necessary, so that it refers to your new
lesson. This will be necessary if you have inserted a new lesson among existing lessons, or after an existing
lesson.

19.9 Using Markup

To adhere to the standards of this document, you will need to add standard markup to your text.

19.9.1 New concepts

• If you are explaining a new concept, you will need to write the new concept’s name in italics by enclosing it in
asterisks (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Emphasis

• To emphasize a crucial term which is not a new concept, write the term in bold by enclosing it in double
asterisks (**).

• Use this sparingly! If used too much, it can seem to the reader that you are shouting or being condescending.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 影像

• When adding an image, save it to the folder _static/lesson_name/.
• Include it in the document like this:

.. figure:: img/image_file.extension
:align: center

• Remember to leave a line open above and below the image markup.

19.9.4 Internal links

• To create an anchor for a link, write the following line above the place where you want the link to point to:

.. _link-name:

• To create a link, add this line:

:ref:`Descriptive link text <link-name>`

• Remember to leave a line open above and below this line.
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19.9.5 External links

• To create an external link, write it out like this:

`Descriptive link text <link-url>`_

• Remember to leave a line open above and below this line.

19.9.6 Using monospaced text

• When you are writing text that the user needs to enter, a path name, or the name of a database element such
as a table or column name, you must write it in monospaced text. For example:

Enter the following path in the text box: :kbd:`path/to/file`.

19.9.7 Labeling GUI items

• If you are referring to a GUI item, such as a button, you must write its name in the GUI label format. For
example:

To access this tool, click on the :guilabel:`Tool Name` button.

• This also applies if you are mentioning the name of a tool without requiring the user to click a button.

19.9.8 Menu selections

• If you are guiding a user through menus, you must use the menu ► selection ► format. For example:

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.

19.9.9 Adding notes

• You might need to a note in the text, which explains extra details that can’t easily be made part of the flow of
the lesson. This is the markup:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]
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19.9.10 Adding a sponsorship/authorship note

If you are writing a new module, lesson or section on behalf of a sponsor, you must include a short sponsor message
of their choice. This must notify the reader of the name of the sponsor and must appear below the heading of the
module, lesson or section that they sponsored. However, it may not be an advertisement for their company.
If you have volunteered to write a module, lesson or section in your own capacity, and not on behalf of a sponsor,
you may include an authorship note below the heading of the module, lesson or section that you authored. This must
take the form This [module/lesson/section] contributed by [author name]. Do not add
further text, contact details, etc. Such details are to be added in the ”Contributors” section of the Foreword, along
with the name(s) of the part(s) you added. If you only made enhancements, corrections and/or additions, list yourself
as an editor.

19.10 Thank You!

Thank you for contributing to this project! By so doing, you are making QGIS more accessible to users and adding
value to the QGIS project as a whole.
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准备练习数据

备注: 此流程适用于课程召集人，或希望为其课程创建本地化样本数据集的资深 QGIS用户。培训手册
提供了默认数据集，但如果您希望替换默认数据集，可以按照以下说明操作。

培训手册提供的样本数据是指 Swellendam镇及其周边地区，Swellendam位于南非西开普省开普敦以东约
2小时车程处。该数据集包含英语和南非荷兰语的要素名称。
任何人都可以毫无困难地使用此数据集，但您可能更喜欢使用来自自己国家或家乡的数据。如果如此，
您的本地化数据可用于单元 3至 7.2的所有课程。以后单元使用更复杂的数据源，这些数据源可能适用
也可能不适用于您所在的地区。

备注: 这些说明假设您精通 QGIS，并且不打算用作教学材料。

20.1 Try Yourself Create OSM based vector files

如果您希望课程所用的默认数据集替换为本地化数据，可以使用 QGIS内置工具轻松完成。您选择使用
的地区应具有合适的城市和农村混合区域，包括不同用途的道路、区域边界 (如自然保护区或农场)和地
表水 (如不同大小的河流)。

1. 新建 QGIS工程
2. 选择图层 ►数据源管理器，打开数据源管理器对话框
3. 在浏览器选项卡，展开 XYZ Tiles下拉菜单，然后双击开放街道地图项
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世界地图现在可以在地图画布上看到。

4. 关闭数据源管理器对话框
5. 移到到您想用作研究区域的地方

现在有了要从中提取数据的范围，让我们启用提取工具。

1. 转到插件 ►管理并安装插件...

2. 在全部选项卡的搜索框中键入 QuickOSM

3. 选择 QuickOSM插件，按安装插件按钮，然后关闭对话框。
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4. 从矢量 ► QuickOSM ► QuickOSM... 菜单执行新插件

5. 在快速查询选项卡的关键字下拉菜单中选择 building

6. 将值字段留空，这意味着您正在查询所有建筑。
7. 在下一个下拉菜单中选择画布范围
8. 展开下面的高级组，取消勾选右侧除多边形集之外的所有几何图形类型。
9. 按运行查询

新的 building图层将添加到图层面板，显示选定范围内的建筑。

10. 按上述方法提取其他数据：
1. 关键字 = landuse和多边形集几何图形类型。

2. 关键字 = boundary,值 = protected_area和多边形集几何图形类型。

3. 关键字 = natural,值 = water和多边形集几何图形类型。

4. 关键字 = highway和勾选线与线串集几何图形类型。
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5. 关键字 = waterway,值 = river和勾选线与线串集几何图形类型。

6. 关键字 = place和点几何图形类型。

此处理将图层添加为临时文件 (由其名称旁边的 图标标示)。

可以对您所在地区包含的数据进行采样，并查看结果。

我们现在需要保存生成的数据，以便在课程中使用。根据数据请使用 ESRI Shapefile、GeoPackage 和
SpatiaLite格式。
要将 place临时图层转换为其他格式，请执行以下操作：

1. 单击 place图层旁边的 图标，打开保存临时图层对话框。

备注: 如果需要更改临时图层的属性 (CRS、范围、字段⋯)，请使用导出 ►要素另存为... 上下文
菜单代替，并确保勾选将已保存的文件添加到地图中选项。这将添加一个新图层。

2. 选择 ESRI Shapefile格式

3. 使用 ... 按钮浏览到 exercise_data/shapefile/文件夹，并将文件另存为 places.shp。
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4. 按确定
在图层面板，临时 place图层将替换为保存的 places Shapefile图层，并移除其旁边的临时图标。

5. 双击图层打开其图层属性 ►源选项卡，并更新图层名以匹配文件名。
6. 对其他图层重复此过程，按如下方式重命名：

• natural_water变成 water

• waterway_river变成 rivers

• boundary_protected_area变成 protected_areas

每个生成的数据集都应保存在 exercise_data/shapefile/目录中。

下一步是从 building图层创建 GeoPackage文件，以便在课程中使用：

1. 单击 building图层旁边的 图标

2. 选择 GeoPackage格式

3. 将文件保存在 exercise_data/文件夹下的 training_data.gpkg

4. 默认情况下，图层名填充为文件名，将其替换为 buildings。

5. 按确定
6. 在属性对话框中重命名图层
7. 对 highway图层重复此过程，将其保存为同一个 GeoPackage数据库中的 roads。

最后一步是将其他的临时文件保存为 SpatiaLite文件。

1. 单击 landuse图层旁边的 图标

2. 选择 SpatiaLite格式

3. 将文件保存在 exercise_data/文件夹的 landuse.sqlite。默认情况下，图层名填充为文件
名，不需要修改。
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4. 按确定
您现在应该有一张这样的地图 (符号肯定会不同，因为当图层添加到地图时，QGIS会随机分配颜色)：

重要的是，您有 7个矢量图层需要匹配，并且所有这些图层都有一些数据。
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20.2 Try Yourself Create SRTM DEM tiff files

对于Module: Creating Vector Data和Module: Rasters两个单元，您还需要覆盖为课程选择地区的栅格图像
(SRTM DEM)。
CGIAR-CGI提供了一些 SRTM DEM，您可以从 https://srtm.csi.cgiar.org/srtmdata/下载。

您需要选择使用覆盖整个地区的图像。要查找范围坐标，请在 QGIS中使用 缩放到最大图层的范围，

并在状态栏的 范围框中拾取值。保留 GeoTiff格式。填写表格后，单击单击此处开始搜索 »按钮
并下载文件。

下载所需文件后，应将其保存在 exercise_data目录中的 raster/SRTM子文件夹下。

20.3 Try Yourself Create imagery tiff files

在单元Module: Creating Vector Data的 Follow Along: Data Sources课程中展示了三个学校运动场的特写
图像，学生们被要求将其数字化。因此，您需要使用新的 SRTM DEM tiff文件复制这些图像。不是必须
使用学校运动场：可以使用任何三种学校用地类型 (例如不同的学校建筑、操场或停车场)。
作为参考，示例数据中的图像为：
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20.4 Try Yourself Replace tokens

Having created your localized dataset, the final step is to replace the tokens in the substitutions.txt file so
that the appropriate names will appear in your localized version of the Training Manual.
您需要替换的标记如下：

• majorUrbanName: 默认为”Swellendam”，替换为您所在地区主要城镇的名称。
• schoolAreaType1: 默认为”田径场”，替换为您所在地区最大学校区域类型的名称。
• largeLandUseArea: 默认为”Bontebok National Park”，替换为您所在地区大型土地利用多边形的
名称。

• srtmFileName: 默认为 srtm_41_19.tif，将其替换为您的 SRTM DEM文件的文件名。
• 本地 CRS:默认为 WGS 84 / UTM 34S，您应该将其替换为您所在地区正确的 CRS。
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